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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide describes various solutions and integrations available for 
HP Business Availability Center.

This chapter includes:

 ➤  How This Guide Is Organized on page 11

 ➤  Who Should Read This Guide on page 13

 ➤  Getting More Information on page 13

How This Guide Is Organized

The guide contains the following parts:

 Part I HP Business Availability Center for SOA

Describes the tasks to perform in HP Business Availability Center to monitor 
your Service-Oriented Architecture (SOA) enterprise environment. 

 Part II HP Business Availability Center for SAP Applications

Describes how to install the SAP solution, the specific tasks involved in 
administering it, how the SAP discovery job discovers SAP-related CIs and 
general CIs (such as hosts) that are related to them, and provides 
information that can help troubleshooting the HP Business Availability 
Center SAP solution. 
11



Welcome to This Guide
 Part III HP Business Availability Center for Siebel Applications

Describes how to administer Business Availability Center for Siebel 
Applications solution, the specific tasks involved in administering it, how 
the Siebel discovery job discovers Siebel-related CIs and general CIs that are 
related to them, and provide information that can help troubleshooting 
Business Availability Center for Siebel Applications solution. 

 Part IV Business Availability Center APIs

Describes how to use the HP Business Availability Center generic data 
engine API to extract data from HP Business Availability Center for use with 
third-party or custom tools, as well as how to use the CMDB API to read/
write data from/to the CMDB and the Dashboard API to retrieve 
information about one or more views in an HP Business Availability Center 
system through a URL-based query to the database.

 Part V EMS Integrations

Describes how to build new integrations or customize out-of-the-box 
integrations for EMS (Enterprise Management Systems) applications, and 
how to integrate HP OVO data, HP ServiceCenter data, and NetScout 
nGenius data into HP Business Availability Center.

 Part VI Diagnostics Integration

Describes how to configure the integration between HP Diagnostics and HP 
Business Availability Center.

 Part VII Application Performance Lifecycle

Describes how to use the Application Performance Lifecycle to integrate 
between HP Business Availability Center and HP Performance Center, 
enabling you to construct load tests based on real-user transaction data 
collected by the Real User Monitor, and how to use the Business Process 
Recognition tool to discover business processes that can help you monitor 
what really matters.
12
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Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the the HP Business Availability Center Deployment Guide PDF.
13
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Part I

HP Business Availability Center for SOA
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1
HP Business Availability Center for SOA

This chapter describes Business Availability Center for SOA.

This chapter includes:

Concepts

 ➤  SOA Solution Overview on page 18

 ➤  HP Business Availability Center for SOA Architecture on page 19

 ➤  SOA Discovery and Dependency Mapping Modules on page 21

 ➤  Integration of HP Diagnostics Data with SOA on page 24

 ➤  Integration of HP SOA Systinet on page 26

 ➤  SiteScope Monitors for SOA on page 28

 ➤  SOA Views and Reports on page 29

 ➤  Anti-Aging Enrichment on page 37

Tasks

 ➤  Monitor SOA Environment in Dashboard – Workflow on page 38

 ➤  Monitor SOA Environment in Dashboard – Scenarios on page 43

 ➤  Enrich the SOA Model From Scripts Defined in Monitor Administration 
on page 51

 ➤  Deploy SiteScope SOA Monitors on page 55

 ➤  Run Business Process Monitor Transactions for SOA on page 57

 ➤  Customize SOA Reports on page 59

Reference

 ➤  Service-Oriented Architecture User Interface on page 60
17
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Troubleshooting and Limitations on page 110
Concepts

SOA Solution Overview

HP Business Availability Center enables you to monitor your SOA 
environment, by monitoring the performance of SOA components within 
the environment. The data is collected by different HP Business Availability 
Center components:

➤ Discovery and Dependency Mapping jobs identify and map the SOA-based 
applications in your system from the UDDI registry, and from the Web 
services deployed onto IBM WebSphere, BEA WebLogic, Oracle Application 
Server, and IIS containers. For more information, see “SOA Discovery and 
Dependency Mapping Modules” on page 21.

➤ Dedicated SiteScope monitors collect Web service metrics and UDDI server 
health data. For more information, see “SiteScope Monitors for SOA” on 
page 28.

SiteScope data is displayed in the SOA reports and in the SOA views. 

➤ Business Process Monitors collect Web service performance data using 
Business Process Monitor transactions that run Web services scripts. For 
more information, see “Run Business Process Monitor Transactions for SOA” 
on page 57. 

➤ Diagnostics probes collect Web service performance and availability metrics 
directly on the Web server machines. For more information, see “Integration 
of HP Diagnostics Data with SOA” on page 24. 

Diagnostics data is displayed in the SOA reports and in the SOA views. 

Business Process Monitor and SiteScope are used for synthetic monitoring of 
Web services while Diagnostics is used for real monitoring of Web services 
calls. 

The collected data is used to build the SOA views and reports available from 
Applications > Business Availability Center for SOA. For details, see “SOA 
Views and Reports” on page 29.
18



Chapter 1 • HP Business Availability Center for SOA
You can create SLAs centered around your HP Business Availability Center 
for SOA Web Services CIs to gain visibility into performance or availability 
issues that affect these SLAs. For details about SLAs, see “Service Level 
Management - Overview” in Using Service Level Management. 

CIs that originate from Systinet (they represent HP SOA Systinet Web 
Services) can also be added to SLAs. For details about Systinet CIs, see 
“Integration with HP SOA Systinet” in Using Service Level Management. You 
can drill down to HP SOA Systinet during agreement creation or editing to 
view contract information for Web services in HP SOA Systinet. For details 
about the drill down, see “Systinet Web Service Data” in Using Dashboard.

HP Business Availability Center for SOA Architecture

The following illustration shows the components of the HP Business 
Availability Center for SOA: 
19



Chapter 1 • HP Business Availability Center for SOA
All monitors create their own topology in the CMDB. In addition to the user 
transactions, Business Process Monitor also sends topology data and SOA 
samples (events and performance) to the CMDB. Automatic discovery adds 
more information about the SOA CIs and their relationships in the CMDB. 

The architecture of the HP Business Availability Center for SOA solution 
includes the following components:

➤ The DDM Probe communicates with HP Universal CMDB. In such a case, 
HP Universal CMDB and HP Business Availability Center use the same 
CMDB. HP Universal CMDB server collects information on changes made to 
a CI’s properties (changes of the SOA infrastructure: hosts, application 
servers, and so on) and functional changes of the Web services (changes to 
WSDL; for example if a new parameter or a new operation was added or if an 
operation was removed). This information is stored in the History database, 
and is available in the SOA-related views in HP Business Availability Center. 
For details about the History database, see the HP Business Availability Center 
Database Guide PDF. For details about the change feature, see “View Changes 
Made to SOA CIs” on page 43.

The discovery jobs are used by the DDM Probe to discover, identify, and 
map the SOA-based applications in your system, starting from the UDDI 
registry, and from Web services deployed onto IBM Websphere, BEA 
WebLogic, Oracle Application Server, and IIS (Internet Information 
Services). This information is then used to create SOA-related CIs and other 
CIs in the CMDB. It also creates the hierarchy of CIs displayed in the SOA 
UDDI Registry, the SOA Web Services, the SOA Rogue Services, and other 
views. A rogue service is a service which is not registered in the UDDI 
registry.

➤ Business Process Monitor collects data on the performance and availability 
of the Web services by running transactions that run Web services scripts. 
The CIs and relationships for the incoming Business Process Monitor 
samples are created by the Business Process Monitoring source adapter 
(described in “Business Process Monitoring Source Adapter Details” in Model 
Management). For details about the samples, see “Data Samples for Business 
Process Monitor” in Reference Information.
20
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➤ The Diagnostics Monitor monitors real user traffic to the Web services and 
operations and sends the information to the Diagnostics server. The 
Diagnostics server sends, using SDK, the topology to the CMDB  and the 
samples to HP Business Availability Center. Depending on the incoming 
Diagnostics samples, the appropriate KPIs and rules are assigned to the CIs 
by the SOA KPI Assignment group. Diagnostics data is available in the SOA 
reports when you select the Real Data parameter. For details, see each report 
description in “Service-Oriented Architecture User Interface” on page 60.

➤ SiteScope monitors the Web services and retrieves Web services metrics and 
UDDI server health data. When working with SiteScope 9.50, the CIs and 
relationships for the incoming SiteScope samples are created by the 
SiteScope KPI Assignments (described in “SiteScope KPI Assignment Group 
Overview” in Using Dashboard). SiteScope data is available in the SOA reports 
when you select the Synthetic parameter. For details, see each report 
description.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Introduction 
to Dashboard” in Using Dashboard.

SOA Discovery and Dependency Mapping Modules

HP Business Availability Center includes discovery patterns for monitoring 
your SOA environment. 

The Discovery and Dependency Mapping modules (containing discovery 
jobs/patterns), listed in this section, are involved in discovering the Web 
services and WSDL files that relate to your SOA infrastructure. When a 
module is run, it creates CIs for the discovered elements in the CMDB. The 
appropriate HP Business Availability Center views are automatically 
populated with the created CIs, according to the TQL for each view.
21
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Note: HP Business Availability Center supports nested WSDL files (mapped 
to Configuration File CIs). A WSDL file contains several sections that can be 
mapped to different Configuration File CIs. For example the service 
operations can be mapped to one CI and the service binding information to 
a different CI. This practice enables sharing similar definitions across Web 
services. 

The modules are listed in the following table:

Module (A - Z) Description

Application - Webservices 
Module

The module contains the UDDI Registry pattern and 
is mainly responsible for mapping the service 
providers, Web services, and WSDL files that are 
discovered from the UDDI registry (for UDDI 
versions 2 and 3). This information is presented in 
the SOA UDDI view. 

For information on the Application - Webservices 
module, see “Universal Description Discovery and 
Integration (UDDI) Discovery” in Discovery and 
Dependency Mapping Guide.

For details about the SOA UDDI view, see “SOA 
Views and Reports” on page 29.

Note: WSDL files should be placed in the UDDI 
registry according to the following UDDI hierarchy 
(from the UDDI technical specification by OASIS): 
BusinessService > TemplateBinding > TModel > 
OverViewDoc. They cannot be found in any other 
location.
22



Chapter 1 • HP Business Availability Center for SOA
J2EE - WebLogic module The module discovers Web services and their WSDL 
files, deployed onto BEA WebLogic servers. The 
resulting CIs for the Web services, Web service 
operations, and configuration files are presented in 
the WebLogic Topology view (along with other 
components discovered on the WebLogic servers) 
and added to the SOA Web Services view and SOA 
UDDI view, as relevant.

For information on the J2EE - WebLogic module, see 
“WebLogic Discovery”  in Discovery and Dependency 
Mapping Guide.

For details about the SOA UDDI and SOA Web 
Services views, see “SOA Views in Dashboard” on 
page 29.

J2EE - WebSphere module The module discovers WSDL files deployed onto 
IBM WebSphere servers, and parses the WSDL to 
identify the Web service components. The resulting 
CIs for the Web services, Web service operations, 
and configuration files are presented in the 
WebSphere Topology view (along with other 
components discovered on the WebSphere servers) 
and added to the SOA Web Services view and SOA 
UDDI view, as relevant. 

For information on the J2EE - WebSphere module, 
see “WebSphere Discovery” in Discovery and 
Dependency Mapping Guide.

For details about the SOA UDDI and SOA Web 
Services views, see “SOA Views in Dashboard” on 
page 29.

Oracle Application Server 
module

The module discovers the Oracle E-Business Suite.

Module (A - Z) Description
23
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Integration of HP Diagnostics Data with SOA

HP Business Availability Center  with HP Diagnostics, enables you to view 
end-to-end performance information in HP Business Availability Center 
applications, for Web services that are monitored by HP Diagnostics. You 
can also directly access the HP Diagnostics application to view Web services 
reports. 

The Web service information is collected by HP Diagnostics probes installed 
on the Web Server machine. The probes detect Web service traffic on the 
machine and identify Web service operations for the Web services. Part of 
the monitoring data, collected for each Web service operation, is stored in  
HP Diagnostics, the rest of the data is stored in HP Business Availability 
Center. 

HP Diagnostics sends the topology of Web services, which includes the Web 
service, its operations and also the monitors, to the CMDB, but does not 
send the WSDL files. The SOA KPI Assignment group assigns the KPIs and 
rules appropriate for each CI in the topology depending on the samples 
received by HP Business Availability Center. 

Web Servers - IIS module The module discovers Web services and their WSDL 
files deployed onto Microsoft IIS servers. The 
discovery process creates CIs for the discovered Web 
services, Web service operations, and configuration 
(WSDL) files. These CIs are added to the SOA Web 
Services view and SOA UDDI view, as relevant, and 
the Web service CIs are presented in the IIS 
Topology view (along with other components 
discovered on the IIS servers). 

For information on the Web Servers - IIS module, 
see “Internet Information Services (IIS) Discovery” 
in Discovery and Dependency Mapping Guide.

For details about the SOA UDDI and SOA Web 
Services views, see “SOA Views in Dashboard” on 
page 29.

Module (A - Z) Description
24
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The key attributes of a Web service are its target name space and service 
name. (For information on the view, see “SOA Views in Dashboard” on 
page 29.) 

For information on deploying the HP Diagnostics probes, and accessing the 
HP Diagnostics application from HP Business Availability Center, see the 
HP Diagnostics User’s Guide (accessible from the HP Business Availability 
Center Help menu after registering the HP Diagnostics server).

Note: HP Diagnostics monitoring is supported for Web services based on 
SOAP over HTTP/S protocols.

Availability Calculation
The availability of a Web service/operation is calculated using the 
error_count field of the SOA Performance sample. Depending on the data 
source, the availability errors may include SOAP faults. The data sources fill 
in the error_count field according to the following table:

Data Source 
(Types of Samples)

Error_count Field (part of the SOA Performance sample)

SOAP Services
REST Web Services

SOAP Faults HTTP Errors

Business Process 
Monitor

(performance and 
error samples)

ALL

All errors generated by 
the Business Process 
Monitor are real errors.

ALL

Reported as an error in 
the Performance 
sample.

None

SiteScope

(performance sample)

ALL 

All errors generated by 
the SiteScope scripts 
are real errors.

ALL

Reported as an error in 
the Performance 
sample.

None
25
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Integration of HP SOA Systinet

HP Business Availability Center supports integration with the HP SOA 
Systinet platform, enabling you to better manage and monitor your business 
services, and to understand the business impact of Web services. The 
integration also enables you to streamline the contracts information defined 
in HP SOA Systinet with your SLAs in HP Business Availability Center.

For details on enabling the integration, see “Enable HP SOA Systinet 
Integration” on page 40.

The integration with HP SOA Systinet provides the capabilities described in 
the following sections:

➤ HP SOA Systinet service model is available in HP Business Availability Center

Diagnostics

(performance, event, 
and error samples)

Only configured SOAP 
faults

The Receiver SOAP 
faults is considered as 
an error by default. 
The VersionMismatch, 
MustUnderstand, 
DataEncoding, and 
UnknownSender SOAP 
faults are not 
considered as errors for 
the Performance 
sample but are sent as 
events in the event 
sample.

The payload capture 
information is stored 
only in Diagnostics.

None

Diagnostics does not 
have the ability to 
recognize HTTP errors.

HTTP status code 
5xx-6ss are 
considered as server 
side errors and are 
reported in 
error_count 
towards availability 
calculation 

Data Source 
(Types of Samples)

Error_count Field (part of the SOA Performance sample)

SOAP Services
REST Web Services

SOAP Faults HTTP Errors
26
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You can run the discovery UDDI registry pattern to discover the content of 
your HP SOA Systinet Registry, so that the HP SOA Systinet service model is 
available in HP Business Availability Center. For details, see “Universal 
Description Discovery and Integration (UDDI) Discovery” in Discovery and 
Dependency Mapping Guide.

➤ You can use the links available in Dashboard, Service Level Management 
and HP Business Availability Center for SOA, to open HP SOA Systinet 
directly at the page for the selected Web service

HP SOA Systinet provides information on the Web service, such as the 
contracts on the service, policies and their compliancy, usage plans, and 
other general information. This can be useful for problem isolation and 
understanding the business impact. 

When defining an SLA in Service Level Management, you can use the link to 
HP SOA Systinet to view the contract information in HP SOA Systinet and 
then configure the SLA accordingly in HP Business Availability Center. For 
details on the link, see “Integration with HP SOA Systinet” in Using Service 
Level Management.

In Dashboard, you can link to HP SOA Systinet to open the page for the 
selected Web service. For details on the link, see “Go to Report” in Using 
Dashboard.

➤ In HP SOA Systinet, you can view service performance status (availability, 
performance, and so on) derived from HP Business Availability Center

You can also link to the health report in HP Business Availability Center for 
the selected service. This information can help consumers understand and 
evaluate service status. 

For information on HP SOA Systinet, including service contracts and how to 
view service performance status derived from HP Business Availability 
Center, see the HP SOA Systinet documentation.
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SiteScope Monitors for SOA

You deploy dedicated SiteScope monitors to collect Web service metrics and 
UDDI server health data. The collected data is used to calculate KPI values in 
the SOA views, and can be viewed in reports of the HP Business Availability 
Center for SOA application.

SiteScope monitors for SOA monitoring can be deployed from the Monitor 
Deployment Wizard, or from System Availability Management. 

The SiteScope monitors used to monitor your SOA environment are:

➤ UDDI Monitor. Used to perform a search in the UDDI Server. Each time that 
the monitor is run, SiteScope checks if the UDDI Server can find a business 
entity. For details, see “UDDI Monitor Overview” in Using System Availability 
Management.

➤ Web Service Monitor. Used to check the availability of a Web service 
accepting Simple Object Access Protocol (SOAP) requests. The Web Service 
Monitor checks that the service can send a response to the client in a certain 
amount of time and verifies that the SOAP response is correct based on 
match specifications. For details, see “Web Service Monitor Overview” in 
Using System Availability Management.

➤ Technology Web Service Integration Monitor. Used to integrate Web service 
event data or metrics data from an existing EMS system to HP Business 
Availability Center. This monitor can only be deployed from System 
Availability Management, not from the Monitor Deployment Wizard. For 
details, see “Technology Web Service Integration Monitor Overview” in 
Using System Availability Management.
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SOA Views and Reports

The SOA views present Web services performance, availability, and 
throughput (load on the Web service) information collected by SiteScope, 
Business Process Monitor, and Diagnostics monitors, about monitoring 
traffic to selected Web services, operations, endpoints, or servers. The data 
enables you to analyze the detected performance issues, and helps you to 
identify the cause of delays. In addition, the views display information 
about the system status impacting the Web service as well as change 
information.

If the Web service is discovered on an application server (WebLogic, 
WebSphere, Oracle Application Server, or IIS) the Web service has a 
relationship with its host (the host is a child of the Web service; if you 
monitor the host CPU for example, it has a System KPI that propagates to 
the Web service). This helps to triage Web service problems, when the Web 
service has a performance/availability problem due to a system issue. 

This section includes the following topics:

➤ “SOA Views in Dashboard” on page 29

➤ “SOA Topology Discovered by SiteScope” on page 33

➤ “Accessing Other Information” on page 33

➤ “CIs Discovered by the Discovery Process” on page 34

➤ “HP Business Availability Center for SOA Reports” on page 35

SOA Views in Dashboard
HP Business Availability Center for SOA displays information about the 
performance, availability, and throughput of the UDDI registry, Web 
services, operations, SiteScope monitors, SiteScope Web services monitors, 
and nested WSDL in the following views:
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➤ SOA Monitored Web Services View

Includes all of the web services that were discovered by Discovery and 
Dependency Mapping or created by SiteScope, Business Process Monitor or 
HP Diagnostics, and stored in the CMDB and that are currently monitored. 

The TQL for the view is built as follows:
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➤ SOA Web Service View

Includes all of the web services that were discovered and stored in the 
CMDB. 

The TQL for the view is built as follows:

➤ SOA Rogue Services View

Includes all of the web services that were discovered and stored in the 
CMDB and that are not registered in the UDDI registry. They also appear in 
the SOA Web Services View.

The TQL for the view is built as follows:
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➤ The SOA UDDI View

The SOA UDDI view represents information obtained by running the UDDI 
discovery. The SOA UDDI view includes the UDDI registries and all the Web 
services that were discovered from the UDDI registries. It also includes their 
operations and WSDL. The Web service providers (represented by the 
business unit) are also discovered and related to their respective Web 
services. The business unit level represents the service provider.

Note: Nested WSDL files are mapped to the Configuration File CIs. For 
details, see “View Configuration File CI Details” on page 42.

The TQL for the view is built as follows:
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SOA Topology Discovered by SiteScope
In addition, the SOA UDDI view includes the following topology, which is 
created for the SiteScope Web Service monitor. The CIs are created only for 
the monitored entities according to the counters that you selected.

Note: The SiteScope Web Service Monitor CI replaces the legacy SiteScope 
Monitor CI  for the Web Service monitor instances when upgrading from 
previous versions of SiteScope to SiteScope 9.50. During the upgrade, the 
SiteScope Monitor CI is removed from the CMDB, which causes it to also be 
removed automatically from instance views that included it or from SLAs to 
which it was attached.

Accessing Other Information
From the SOA views you can:

➤ Drill down to the HP Business Availability Center for SOA reports that 
present detailed metrics information about the performance, availability, 
and throughput over time, as well as the total number of calls, the number 
of calls that are slow or end with a SOAP fault, the least available Web 
services/operations, the slowest Web services/operations, consumer 
information, and server information, and so on. 

➤ Use the context menu to access additional information; for example to 
access the HP Diagnostics application. For details, see “Menu Options” in 
Using Dashboard.
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➤ Access User reports. User reports provide a list of all of the defined custom 
reports, trend reports, and custom links that have been defined in the 
system, that the current user has permissions to view. You can display the 
reports in Excel format, create custom reports, and trend reports, and so on. 
For details, see “Report Manager Overview” in Reports.

CIs Discovered by the Discovery Process
The following CIs are discovered by the SOA discovery processes. For details, 
see “SOA Discovery and Dependency Mapping Modules” on page 21.

The default KPIs are described in “List of Dashboard KPIs and Their Details” 
in CI Attribute Customization. 

The CIs discovered by the discovery process are:

CI Name Icon Description

UDDI Registry  The UDDI Registry CI represents all of the 
UDDI registries that were discovered in your 
network.

Business Unit The Business Unit CI represents the service 
providers discovered in your network.

Web Service 
Monitor

The Web Service Monitor CI represents the 
Web services monitors discovered in your 
network.

Web Services The Web Services CI represents the Web 
services discovered in your network.

Web Service 
Operation

The Web Service Operation CIs represent the 
operations discovered in your network.

Configuration 
File

The Configuration File CIs represent the URL of 
the WSDL page used by the Web service. 
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HP Business Availability Center for SOA Reports
The HP Business Availability Center for SOA reports enable you to 
proactively monitor the availability, response time, throughput, number of 
calls, number of SOAP faults, and number of slow calls, to selected Web 
services or operations, by selected consumer or server. 

You use the SOA reports to view and analyze the health of access to Web 
services or operations.

For details on working with HP Business Availability Center reports, see 
“Reports User Interface” in Reports.

This section includes the following topics:

➤ “Report Access and Permissions” on page 35

➤ “Business Availability Center for SOA Reports” on page 36

➤ “Data Aggregation” on page 36

Report Access and Permissions

The availability of report data for a specific user is dependent on the profile 
access permissions granted that user. Furthermore, access to specific data 
within a profile can also be limited by the administrator using report filters. 
For details on granting permissions, see “Permissions Tab” in Platform 
Administration. 

For details on setting report filters, see “Profile Entity Maintenance 
Overview” in Platform Administration and “Active Filter Dialog Box” on 
page 61.

In addition, the SOA reports permissions is based on the views permissions. 
An SOA report (except for the Top Metrics Report) is dependent on the 
selected view. You are able to display only views for which you have 
permission. 

Only views that are assigned to SOA are available in the SOA reports. A view 
can be assigned to SOA in the view properties. For details, see “Create New 
View/View Properties Dialog Box” in Model Management.  
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Business Availability Center for SOA Reports

The Business Availability Center for SOA tab includes the following reports:

➤ Health report. Displays health metrics for the selected Web services, 
operations, consumers, or endpoints in a selected view. For details, see 
“Health Report” on page 71.

➤ Top Metrics report. Displays the top metrics information about the traffic to 
and from all of the monitored Web services or operations. For details, see 
“Top Metrics Report” on page 97.

➤ Metrics Over Time report. Displays the performance, over time, measuring 
access to selected Web services or operations, by an endpoint, or a 
consumer. For details, see “Metrics Over Time Report” on page 85.

➤ Consumer Summary report. Displays specific metrics for all of the 
consumers accessing the selected Web services or operations in a selected 
view. For details, see “Consumer Summary Report” on page 65.

➤ Server and Endpoint Summary report. Displays a drillable summary of the 
metrics for all of the servers on which the selected Web services or 
operations of a selected view are running. For details, see “Server and 
Endpoint Summary Report” on page 90.

The data displayed in some of the reports is obtained from the Diagnostics, 
or SiteScope monitors.

Data Aggregation

HP Business Availability Center uses data aggregation to make data handling 
and management more efficient and to improve the speed and performance 
of report generation. For more information on data aggregation in 
HP Business Availability Center, see “Data Aggregation” in Reference 
Information.
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Anti-Aging Enrichment

When you run a Web services script, the script checks the CMDB for the 
Web service CIs mentioned in the script. If the CI already exists, the script 
adds the Business Process Monitor CI subtree to the Web Service CI -> 
Operations CI topology. If the CI does not exist, the Business Process 
Monitor creates the Web Service CI -> Operations CI -> Business Process 
Monitor CI topology. 

The BPM_WS_ANTI_AGING anti-aging TQL is run periodically in the 
CMDB. It searches for the Web Service CI -> Operations CI -> Business 
Process Monitor CI graph. When it encounters the graph, it automatically 
postpones the deletion of those CIs. 

When you erase the script from Monitor Administration, the Business 
Process Monitor CI is erased from the CMDB, the Web Service CI -> 
Operations CI topology becomes incomplete and is therefore automatically 
deleted by the aging mechanism.  

Tasks
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Monitor SOA Environment in Dashboard – Workflow

This section describes the processes to monitor an SOA environment in 
Dashboard, and gives examples.

Note: 

➤ If you want to discover all the Web Services attached to your network, or 
if you are working with a large amount of Web Services, you must use 
Discovery and Dependency Mapping to discover the SOA architecture on 
your network. 

➤ If you want to Monitor Web Services without discovering them first or if 
you know the Web Services WSDL files, you do not need to perform 
Discovery and Dependency Mapping as the SiteScope and Business 
Process Monitor monitors are able to build the CI topology and to 
transfer data directly from the WSDL files. 

➤ Diagnostics analyzes the calls and detects the Web Services, and uses that 
knowledge to build the CI topology and to transfer data to HP Business 
Availability Center.

This task includes the following steps:

➤ “Valid License” on page 39

➤ “Perform Discovery and Dependency Mapping – Optional” on page 39

➤ “Enable HP Diagnostics Integration and Deploy Diagnostics Probes” on 
page 39

➤ “Enable HP SOA Systinet Integration” on page 40

➤ “Deploy SiteScope Monitors” on page 40

➤ “Create Business Process Profiles” on page 40

➤ “Customize How you Monitor SOA in Dashboard” on page 41

➤ “Enrich the SOA Model From Scripts Defined in Monitor Administration” 
on page 41

➤ “Customize SOA Reports” on page 41
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➤ “View SOA Information in Dashboard” on page 41

➤ “View Configuration File CI Details” on page 42

➤ “View Changes Made to SOA CIs” on page 43

 1 Valid License
To view the HP Business Availability Center for SOA application, you must 
have an HP Business Availability Center for SOA license. For details, see 
“License Management Overview” in Platform Administration.

 2 Perform Discovery and Dependency Mapping  – Optional
You can deploy the appropriate discovery patterns to discover the SOA 
architecture on your network. HP Business Availability Center includes 
discovery patterns for monitoring your SOA environment. The discovery 
patterns are deployed from Admin > Universal CMDB > Discovery > Job 
Configuration.

➤ UDDI Monitor. Used to discover Web Services in the UDDI Server. Each time 
that the monitor is run, SiteScope checks if the UDDI Server can find a Web 
Service. For details, see “UDDI Monitor Overview” in Using System 
Availability Management.

➤ Application Server. Discover Web Services running on application servers 
instances (IIS, Weblogic and others).

 For information on deploying and running discovery, see “Package 
Administration Overview” in Model Management and “Discovery and 
Dependency Mapping – Overview” in Discovery and Dependency Mapping 
Guide.

For information on the SOA discovery modules, see “SOA Discovery and 
Dependency Mapping Modules” on page 21.

 3 Enable HP Diagnostics Integration and Deploy Diagnostics 
Probes
To view metrics collected by HP Diagnostics probes installed on the Web 
server machines, register the Diagnostics server in HP Business Availability 
Center. For details, see “HP Diagnostics and HP Business Availability Center 
Integration” on page 469.
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Note: HP Diagnostics monitoring is supported for Web services based on 
SOAP over HTTP/S protocols.

 4 Enable HP SOA Systinet Integration
If you are running HP SOA Systinet, you can integrate it with HP Business 
Availability Center to enable more unified management and monitoring of 
your business services, and to understand the business impact of Web 
services. The integration also enables you to streamline the contracts 
information defined in HP SOA Systinet with your SLAs in HP Business 
Availability Center.

To enable the HP SOA Systinet and HP Business Availability Center 
integration, you must register the HP SOA Systinet server in HP Business 
Availability Center. Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select BAC for SOA, and locate 
the Systinet server host and port entry in the BAC for SOA - Systinet 
Settings table. Define the host name and port, if required.

 5 Deploy SiteScope Monitors
If you want dedicated SiteScope monitors to provide metrics on your SOA 
components, you must deploy the monitors. For details, see “Deploy 
SiteScope SOA Monitors” on page 55.

 6 Create Business Process Profiles
If you want your SOA views to include performance metrics for running 
transactions on your Web servers, you must define the Business Process 
profiles and transactions. For details, see “Run Business Process Monitor 
Transactions for SOA” on page 57.
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 7 Customize How you Monitor SOA in Dashboard
You can customize the KPI assignment groups that attach to pre-defined CIs, 
KPIs, rules, tooltips, context menus, and context menu items, under 
specified conditions. You can modify the following KPI assignment groups:

➤ The Business Process Monitor KPI assignment group and the Diagnostics KPI 
assignment group. For details, see “SOA KPI Assignment Group Details” in 
Using Dashboard.

➤ The SiteScope KPI assignment groups. For details, see “SiteScope KPI 
Assignment Group Overview” in Using Dashboard.

 8 Enrich the SOA Model From Scripts Defined in Monitor 
Administration
If required, you can enrich the SOA model using scripts that define Web 
Services. Those scripts are created in Virtual User Generator and run in 
Monitor Administration. For details, see “Enrich the SOA Model From 
Scripts Defined in Monitor Administration” on page 51.

 9 Customize SOA Reports
You can customize SOA reports. For details, see “Customize SOA Reports” on 
page 59. 

 10 View SOA Information in Dashboard
Once your SOA monitoring environment is set up, you can view SOA 
monitoring data in Dashboard, Service Level Management, and the 
HP Business Availability Center for SOA application using views and reports. 
For details, see “SOA Views and Reports” on page 29.
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 11 View Configuration File CI Details
Right-click a Configuration File CI in the SOA UDDI View, select Properties, 
and click Show document content to display the contents of the 
configuration file that displays the contents of the WSDL page 
corresponding to the URL. For details, see “Properties Dialog Box” in Model 
Management.

Note: Nested WSDL files are mapped to the Configuration File CIs. 

Example

Nested WSDL appear in View Explorer as a list of Configuration File CIs 
under the main Configuration File CI. For example:

http://<server_name>/uddi/doc/wsdl/account.wsdl
http://<server_name>/uddi/doc/wsdl/account_binding.wsdl
http://<server_name>/uddi/doc/wsdl/account_portType.wsdl
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 12 View Changes Made to SOA CIs
Changes made to the properties of all types of CIs (changes of the SOA 
infrastructure: hosts, application servers, and so on) and functional changes 
of the web services (changes to WSDL; for example if a new parameter or a 
new operation were added or if an operation was removed) are discovered 
by different types of discoveries. Those changes are displayed in the Change 
report available as a context menu option for each one of the relevant CI 
types. 

For details about the Change report, see “Change Report Page” in Model 
Management. 

For details about the UDDI Registry, WebSphere, WebLogic, and IIS 
discoveries, see “Discovery and Dependency Mapping Content” in Discovery 
and Dependency Mapping Guide.

Monitor SOA Environment in Dashboard – Scenarios

This section provides scenarios that show how you can use the Business 
Availability Center for SOA reports to find the source of problems.

This section includes the following topics:

➤ “Availability Problem – Scenario” on page 43

➤ “Performance Problem – Scenario” on page 46

➤ “Throughput Problem – Scenario” on page 49

Availability Problem – Scenario
The Dashboard Console page displays, in the SOA Web Services view, a 
service availability problem. There is no problem with the system. The 
problem seems to be with the MedRecWebServices web service.

You want to drill down to the SOA Health report to understand where the 
problem is located. Click the down arrow to the right of the CI and select Go 
to Report > Web Services Health.
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The Health Report displays the health of the operations. 
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A suspect operation is found. Select the appropriate operation and click the 
button  to access Diagnostics for the selected operation.  

Diagnostics displays the SOAP fault that caused the problem. 

You can view the SOAP fault information to find the root cause of the 
problem. For details, see HP Diagnostics documentation.
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Performance Problem – Scenario
The Dashboard Console page displays, in the SOA Web Services view, a 
service performance problem. There is no problem with the system. The 
problem seems to be with the SlowService web service.

To drill down to the SOA Health report, click the down arrow to the right of 
the CI in the Console page, and select Go to Report > Web Services Health.

The Health Report opens.  

A suspect operation is found. Click the appropriate operation.
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The Health report for the relevant operation opens. Scroll down and view 
the graphs.  

The Throughput graph does not indicate service overload. 
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Select the operation and click  the Drill down to Diagnostics Operations 
View button  to drill down to Diagnostics. 

In Diagnostics, you can drill down from each instance to its call profile. 
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You can then view the layers breakdown of the Web Service operations and 
find out how much time was spent in each layer (Web Service, database, and 
so on). For details, see HP Diagnostics documentation. 

Throughput Problem – Scenario
The Dashboard Console page displays, in the SOA Web Services view, a 
service performance problem. There is no problem with the system. The 
problem seems to be with the MedRecWebServices web service.

To drill down to the SOA Health report, click the down arrow to the right of 
the CI in the Console page, and select Go to Report > Web Services Health.
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A problematic operation (addRecord) is found. Both the response time and 
throughput of the operation indicate a problem. A suspected reason for the 
response time would be an overloaded service. You can view the correlation 
between the response time and the throughput in the Metrics section.  

After you assess that the reason is a throughput problem, you can drill down 
and find the consumers that overload the service.
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Enrich the SOA Model From Scripts Defined in Monitor 
Administration

Enrich the SOA model with scripts to create a relationship between Host CIs 
and Web Service CIs, and to view status changes for the Web Service CI 
when the status of the Host CI monitored by SiteScope changes.

This feature is supported for Virtual User Generator/Service Test 9.10, 
LoadRunner 9.10, and Business Process Monitor 7.50.

Business Process Monitor sends SOA data via HTTP, using the BAC API. Web 
Data Entry (WDE) converts the data into two UDX samples: SOA 
Performance and SOA Event (errors are reported in this sample). The 
samples are sent according to the schedule. 

When Business Process Monitor sends samples, the data is displayed in the 
HP Business Availability Center for SOA Application under the Synthetic 
data type.

Limitations:

➤ To be supported, a Web Service script must have a WSDL version 1.1, and 
the WSDL file, which describes the Web Service and the Web Service 
operations,  supplied with the script should  use WSDL version 1.1.

➤ REST Web Services can be monitored by Business Process Monitor, but 
SOA data reporting is not supported (they do not have a WSDL file); only 
regular errors are reported. SOAP_request calls are not supported as they 
do not have WSDL.

➤ Virtual User Generator/LoadRunner do not support WebServices 
protocols on Unix.

➤ Drilldown operations are not supported between SOA and End User 
Management reports.
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This task includes the following steps:

➤ “Record a Script in Virtual User Generator” on page 52

➤ “Add the Web Service Script to Monitor Administration” on page 53

➤ “Run the Web Service Script” on page 53

 1 Record a Script in Virtual User Generator
You can define Web Services inside scripts in Virtual User Generator/Service 
Test 9.10 or LoadRunner 9.10. You can record Web Service calls with 
different operations. Each operation call is then reported as a different 
transaction. For details about defining scripts in Virtual User Generator, see 
Virtual User Generator documentation.

A Web Service script does not need to include user transactions to produce 
data. If more than one script uses the same CI, a single CI is created. A CI is 
deleted if none of the scripts uses it.

For each SOA script, Virtual User Generator creates a file. The file is used by 
the End User Management administrator to add the relevant SOA CIs to the 
model (Web Service, Operation, and Monitor CIs). The file is generated or 
updated after each save/update operation is done using Virtual User 
Generator/Service Test. The file is included in the runtime files used for 
exporting to a zip file using Virtual User Generator. 

Note: If you are using legacy scripts recorded with Virtual User Generator up 
to version 9.0, data reporting is supported by Business Process Monitor, but 
the SOA CIs must be added to the model. To add the SOA CIs, download the 
script from CRS, open the script in Virtual User Generator 9.10 once and 
save the script (the script is saved to the new format), upload the new script 
version in CRS, and reload script version in End User Management for 
relevant monitors.
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For each web service call, the following line is added to the file, regardless of 
the status of the web service call:

<operation_name>; <web_service_name>; <target_namespace>; 
<wsdl_name/location>

where <wsdl_name/location> is required to locate the relevant WSDL if 
there is more than one WSDL.

An operation called more than once in the script  is represented by one line 
in the file. The order of the operations in the script is not important. 

WSDL files should be imported into the script. 

If you override manually the endpoint (name of port) address in Virtual User 
Generator, the new address is reported to Business Process Monitor.

Business Process Monitor ignores the Define each step as a transaction 
option in Virtual User Generator settings.

The WSDL file and the Operations file are zipped together with other script 
files.

If more than one WSDL file is created for one Web Service script (set of 
hierarchic WSDL files), Virtual User Generator places them in one folder.

 2 Add the Web Service Script to Monitor Administration
To add the Web Service script to Monitor Administration, upload it to the 
Central Repository Service (CRS), and assign it to a specific Business Process 
Monitor profile and host with a specific scheduling. For details about CRS, 
see “Central Repository Service - Overview” in Platform Administration.

 3 Run the Web Service Script
If you have set the SOA license, you are running the script in Virtual User 
Generator, and the operations file appears in the script, the Enable SOA 
breakdown option is automatically enabled in Monitor Administration, and 
the SOA Performance and SOA Events samples from the operation are 
reported to HP Business Availability Center. 

Business Process Monitor sets the Define each step as a transaction option = 
true when the script is a Web Service script.
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Business Process Monitor plays the script and reports SOA samples by 
wrapping each operation call within an automatic transaction. The 
automatic transaction is provided by LoadRunner. The automatic 
transactions are not displayed in Monitor Administration and are not 
counted in the licensed number of transactions for Business Process 
Monitor.

Business Process Monitor can distinguish between SOA faults and other 
faults (HTTP or other).

If the operation already exists (added to the CMDB by Discovery and 
Dependency Mapping), the SOA KPI assignment group uses the existing 
operations CIs. The SOA Monitor CI and the BPM Web Service Monitor CIs, 
as well as their performance and the event, are displayed in the SOA UDDI 
view in Dashboard.

When you attach a Web Service script to a profile, a CI is created. The CI 
status is changed to No data when the profile is stopped, when you do not 
attach it to a monitor, or if the script is old.

The following topology is created in the CMDB: Web Service CI -> 
Operations CI -> Business Process Monitor CI. The topology is maintained 
by the anti-aging enrichment mechanism. For details, see “Anti-Aging 
Enrichment” on page 37.

BPM for SOA CIs are included in the model only when the CMDB includes 
the following information: 

➤ WS name, OP name, and target name space CIs exist and the enable field 
value is true for these CIs. 

➤ Each operation (add/remove/update script, version/change check box) in 
Monitor Administration updates this information.
54



Chapter 1 • HP Business Availability Center for SOA
Deploy SiteScope SOA Monitors

Note: Perform this task only when working with SiteScope 9.0.

You deploy dedicated SiteScope monitors to collect Web service metrics and 
UDDI server health data. The collected data is used to calculate KPI values in 
the SOA views, and can be viewed in reports of the HP Business Availability 
Center for SOA application.

SiteScope monitors for SOA monitoring can be deployed from the Monitor 
Deployment Wizard, or from System Availability Management. 

This task includes the following steps:

➤ “Use the Monitor Deployment Wizard” on page 55

➤ “Manually Attach SiteScope Monitors” on page 57

 1 Use the Monitor Deployment Wizard
You can create and map SiteScope monitors directly onto the SOA CIs 
created by the discovery process, using the Monitor Deployment Wizard. 
The SiteScope monitoring CIs generated by the SiteScope monitors are then 
deployed onto the UDDI Registry and Web Service Operation CIs, creating a 
Monitored By relationship between them. For details, see “Monitor 
Deployment Wizard” in Using System Availability Management. 

Example

 a Proceed as explained in “Monitor Deployment Wizard” in Using System 
Availability Management.

 b In the left pane of the Select Configuration Items to Monitor page, select 
the relevant SOA view. Select the CIs you would like monitored and 
move them to the right pane.
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Note: You can map Web service operations to Web Service Monitors and  
UDDI Registry CIs to the UDDI Registry Monitors.

If the Web Service Operation CIs that you move to the right pane are 
already monitored, then they are displayed in italics with an Already 
monitored message.

 c Click Next. The Select Templates to Apply page opens. The left pane lists 
all the available templates in the wizard, including the Web Services 
Monitors and UDDI Monitors templates used for the SOA monitors, and 
the SiteScope templates for host if the hosts on which the Web services 
are deployed are also selected. Expand the template to see the monitors 
that are deployed by the template. The right pane lists the CI types (CITs) 
for the CIs selected in the previous page of the wizard.

If you added Web Service Operation CIs to the right pane at the previous 
stage of the wizard, then the wizard automatically matches them with 
the Web Services Monitors template, and displays the Web Service 
Operation CIT in the right pane with the template attached.

 d Proceed with the wizard as indicated in “Monitor Deployment Wizard” 
in Using System Availability Management. 

The added Web Service Monitor CIs are given default names as follows: 
Synthetic Monitor On <name of relevant Web Service Operation CI>
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 2 Manually Attach SiteScope Monitors
If the monitors are deployed from System Availability Management, you 
must manually attach them to SOA discovery CIs. This is done in Admin > 
Universal CMDB > Modeling > IT Universe Manager. For details, see 
“Working with CIs” in Model Management.

For details about the SiteScope monitors used to monitor your SOA 
environment, see “SiteScope Monitors for SOA” on page 28.

Run Business Process Monitor Transactions for SOA

You can deploy Business Process profiles containing transaction monitors to 
actively monitor Web service performance. The transaction monitors run 
scripts that emulate Web service requests from end users, supplying 
end-to-end availability and response time metrics from varied and remote 
locations. The metrics are used for the BPM Transaction from Location CIs 
that are created in the CMDB.

You map the created business process monitoring CIs to the SOA CIs created 
by the discovery process, to produce an integrated SOA Web Services view.

Note: Business process monitoring data is not available in the HP Business 
Availability Center for SOA application.

This task includes the following steps:

➤ “Create Scripts in HP Virtual User Generator” on page 58

➤ “Define Business Process Profiles” on page 58

➤ “View Business Process Monitoring CIs in the Views” on page 58
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 1 Create Scripts in HP Virtual User Generator
Create scripts in HP Virtual User Generator that emulate the Web service 
requests. For details, see HP Virtual User Generator User’s Guide.

 2 Define Business Process Profiles
Use the following steps:

 a Define Business Process profiles in Admin > System Availability 
Management, using the Business Process Profile Wizard. 

 b Add to the profiles,  the relevant transaction monitors that run the 
HP Virtual User Generator scripts for Web service requests. 

 c Assign the profiles to Business Process Monitor machines/instances at the 
required locations. 

For details, see “Creating Business Process Profiles and Monitors Overview” 
in Using End User Management.

 3 View Business Process Monitoring CIs in the Views
To see the business process monitoring CIs immediately in the views, 
synchronize the Business Process Monitoring source adapter in the Admin > 
Universal CMDB > Source Manager page. (Alternatively, wait for the 
automatic synchronization to take place.)

Note: To include location information in the business process monitoring 
CI hierarchy, set the Business Process Monitoring source adapter to use the 
Transaction/Location hierarchy structure. For more information, see  
“Business Process Monitoring Source Adapter Details” in Model Management.

Once Business Process Monitor has run the scripts, the resulting BPM 
Transaction from Location CIs are added to the CMDB and displayed in the 
monitors views and the End Users views. For information on the hierarchy 
of these views, see “Business Process Monitoring Source Adapter Details” in 
Model Management.
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To map the SOA CIs in the SOA Web Services view (discovered during the 
discovery process) to the relevant Business Process Step CIs and BPM 
Transaction from Location CIs, you must manually attach the business 
process monitoring CIs to the higher level CIs. This is done in Admin > 
Universal CMDB > Modeling > IT Universe Manager. For details, see 
“Attaching Existing CIs” in Model Management.

Customize SOA Reports

You can customize SOA reports.

Note: All the steps in the task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Customize the Number of Web Services or Operations Displayed in the 
SOA Reports” on page 59

➤ “Customize the Number of Elements Displayed in the Top Metrics Reports” 
on page 60

 1 Customize the Number of Web Services or Operations 
Displayed in the SOA Reports
You can customize the number of Web services or operations that can be 
displayed in an SOA report. The default value is 20.

To customize the number of Web services or operations that can be 
displayed in an SOA report, access the Admin > Platform > Setup and 
Maintenance > Infrastructure Settings page, click choose Applications, select 
BAC for SOA, locate the BAC for SOA - General Settings table, and set the 
required value of the Max. number of selectable CIs in SOA reports 
parameter.
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 2 Customize the Number of Elements Displayed in the Top 
Metrics Reports
You can customize the number of elements that can be displayed in a Top 
Metrics report. The default value is 5. 

To customize the number of elements that can be displayed in a Top Metrics 
report, access the Admin > Platform > Setup and Maintenance > 
Infrastructure Settings page, click choose Applications, select BAC for SOA, 
locate the BAC for SOA - General Settings table, and set the required value 
of the Top Metrics Size parameter.

Reference

Service-Oriented Architecture User Interface

This section describes:

 ➤  Active Filter Dialog Box on page 61

 ➤  Consumer Summary Report on page 65

 ➤  Health Report on page 71

 ➤  Metrics Over Time Report on page 85

 ➤  Server and Endpoint Summary Report on page 90

 ➤  Top Metrics Report on page 97
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Active Filter Dialog Box

Web Service/Operations Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to filter SOA reports. The Active Filter 
includes the following tabs: 

➤ Web Services/Operations

➤ Metrics when you access the dialog box from the 
Metrics Over Time report. 

➤ Endpoint/Consumers 

➤ Views when you access the dialog box from the Top 
Metrics report. The dialog box displays the Views 
that you allowed to see.

To Access: In the Health, Top Metrics, Metrics Over 
Time, Consumer Summary, or Server and Endpoint 
Summary reports, click Active Filters.

Important 
Information

You can also select items from both tabs to create more 
complex filters.

GUI Element (A-Z) Description

Number of Selected 
Operations

Indicates the number of Operation CIs that you have 
selected.

Number of Selected 
Web Services

Indicates the number of Web Service CI that you have 
selected.

Search Click to search for a specific CI in the current view or 
in all views. For details, see “Search for CIs in Search 
Mode” in Model Management.
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Metrics Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selected CIs Select one of the following:

➤ Web Services. Displays a check box only for the Web 
services CIs appearing in the view. 

➤ Operations. Displays a check box only for the 
operation CIs appearing in the view. 

You can select up to 20 Web services or operations. This 
number can be modified in the Infrastructure Settings. 
For details, see “Customize the Number of Web Services 
or Operations Displayed in the SOA Reports” on 
page 59.

View Select the appropriate view and select the relevant CIs 
in the view. Only views for which the user has 
permission and that have been assigned to SOA are 
displayed in the list. For additional information on the 
available views, see “SOA Views in Dashboard” on 
page 29.

Important 
Information

The Metrics tab is displayed when you click Active 
Filter in the Metrics Over Time report.

GUI Element (A-Z) Description

<Metrics> Select the metrics you want to display in the report.

GUI Element (A-Z) Description
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Endpoint/Consumer Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Consumer You can:

➤ Filter by consumer information, for consumers 
registered in HP Diagnostics, by entering one of the 
following:

➤ The consumer ID (it can be an IP address, IP 
range, HTTP header, or payload in SOAP 
requests).

➤ The consumer subunit name, which is the name 
of the IP range where the customer is located.

➤ The consumer details taken from the payload; for 
example Web Service http custom header value or 
Web service SOAP payload value (soap-header/
soap-envelope/soap-body). 

The consumer information can be any string, up to 
100 characters, including wildcards.

Note: For performance reasons, the wildcard can 
only be located on the right most side on the string.

For details, see HP Diagnostics Installation and 
Configuration Guide.

➤ Enter Other to search for all non-registered 
consumers that access the server or endpoint listed 
in the Server IP or End Point box.
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Views

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Endpoint Enter the monitored endpoint. The value depends on 
the data source. 

For HP Diagnostics, it is the application server instance 
name (defined in HP Diagnostics). 

For Business Process Monitor and SiteScope, it is the 
port name/endpoint (depending on the WSDL version) 
that the user select from the WSDL when creating the 
script/monitor.

Server IP Enter the server IP number to display information 
about the consumers accessing specific servers.

You can also use a wildcard (*) as the end of the string.

GUI Element (A-Z) Description

<Views> Select a view. 

The View box lists the views you are allowed to display.

This dialog box is displayed when you click Active 
Filters in the Top Metrics report.

GUI Element (A-Z) Description
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Consumer Summary Report

Report Settings

Description Displays specific metrics for all of the consumers 
accessing the selected Web services or operations in a 
selected view. 

To Access: Select Application > Business Availability 
Center for SOA, click the Business Availability Center 
for SOA tab, and select the Consumer Summary Report 
option in the Business Availability Center for SOA tab.

Important 
Information

When you select Real, the Consumer Summary Report 
displays information only for the consumers that were 
registered in the Diagnostics system. All other 
consumers are aggregated and presented as Others.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard – Workflow” 
on page 38

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 61.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope and 
Business Process monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 
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Consumer Summary Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the health metrics for all of the consumers 
accessing the selected Web services or operations. If, in 
the Active Filters, you also select specific consumer, 
endpoint or server, the health metrics are further 
filtered by these selections.

Important 
Information

The Consumer Summary area is the same in the View 
as Graph and View as Table tabs.

Useful Links “Availability Calculation” on page 25

GUI Element (A-Z) Description

Click to drill down to the Health Report for the 
selected element. For details, see “Health Report” on 
page 71.

# of Calls The total number of calls accessed by the specific 
consumer.

# of Errors The total number of failed calls by the specific 
consumer. A failed call is a call that was not performed 
due to the unavailability of the Web services or 
operations.  

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.
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# of Slow Calls The number of slow calls by the specific consumer. A 
slow call is a call with a response time longer than the 
predefined threshold.

Note: The value displayed by # of Slow Calls is different 
from the value of the Total Threshold Violation in 
HP Diagnostics. In HP Diagnostics the Total Threshold 
Violation includes the overall number of violation from 
all the calls and in HP Business Availability Center # of 
Slow Calls includes only the violations of the successful 
calls.

# of SOAP Faults The total number of SOAP faults that occurred in calls 
by the specific consumer.

Availability The availability of the selected Web services or 
operations accessed by the specific consumer. The 
availability is calculated as the number of successful 
calls made by the specific consumer divided by the 
total number of calls made by the specific consumer, 
multiplied by 100.

The background is colored according to the 
comparison between the Web service worst availability 
and the threshold specified in the Availability KPI 
definition. For details, see “How Dashboard KPIs Work” 
in Using Dashboard.

Consumer The consumer information. For details on the different 
consumer details, see the Consumer description in the 
End Point/Consumer Tab in  “Active Filter Dialog Box” 
on page 61.

Click the consumer name to drill down to the Health 
Report for the selected element. For details, see “Health 
Report” on page 71.

GUI Element (A-Z) Description
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Response Time (sec.) The average response time (in seconds) of the selected 
Web services or operations accessed by the specific 
consumer. 

The background is colored according to the 
comparison between the Web service worst response 
time and the threshold specified in the Response Time 
KPI definition. For details, see “How Dashboard KPIs 
Work” in Using Dashboard.

Throughput (calls 
per min.)

The number of calls, per minute by the specific 
consumer. 

The background is colored according to the 
comparison between the Web service worst throughput 
and the threshold specified in the Throughput KPI 
definition. For details, see “How Dashboard KPIs Work” 
in Using Dashboard.

GUI Element (A-Z) Description
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Worst Consumer Area

\

Description Displays the successful and faulty calls of the worst five 
consumers accessing the selected Web services, 
operations, or servers.

Important 
Information

The Worst Consumer displays the same information in 
the View as Graph and View as Table tabs.

Each tab in the graph represents a different consumer 
and displays the number of successful calls (in green) 
and the number of failed calls (in purple).

Move the mouse over a tab in the graph to display a 
tooltip. Hover above a tab to display a tooltip that 
indicates the consumer, the number of errors, 
succesfull calls, SOAP faults, and the number of 
successful calls.

 

The X-axis displays the consumer information while 
the Y-axis displays the number of calls.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

# of Calls The total number of calls accessed by the specific 
consumer.

# of Errors The total number of failed calls by the specific 
consumer. A failed call is a call that was not performed 
due to the unavailability of the Web services or 
operations.

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.

# of SOAP Faults The total number of SOAP faults that occurred in calls 
by the specific consumer.

# of Successful calls The number of successful consumer calls.

<drill down> Click a bar to access the Health report filtered for the 
consumer.

Consumer The consumer information. For details on the different 
consumer details, see “Active Filter Dialog Box” on 
page 61.

Click the consumer name to drill down to the Health 
Report for the selected element. For details, see “Health 
Report” on page 71.
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Health Report

Description Displays health metrics for the selected Web services, 
operations, server, endpoint, or consumer in a selected 
view.

To Access: Select:

➤ Applications > Dashboard, select a view in View 
Explorer:

➤ In View Explorer, right-click a specific Web 
Service or Operation CI, and select the Go to 
Report > Health Report option. The Health 
Report is filtered by the specific Web service or 
operation. For details, see “Customize Dashboard 
Display and Refresh Rate” in Using Dashboard

➤ In the Console, or Filters tab, right-click a specific 
Web Service or Operation CI, and select Go to 
Report > Health Report. The Health Report is 
filtered by the specific Web service or operation. 
For details, see “Customize Dashboard Display 
and Refresh Rate” in Using Dashboard

➤ Applications > Business Availability Center for SOA, 
and select the Health Report option in the Business 
Availability Center for SOA tab.
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Important 
Information

To enable you to uncover all available Web Services/
operations, the Health report automatically shows all 
selected Web Services/operations even when they do 
not have data. You can also check if the Web Service/
operation has only Synthetic data or no data at all 
(Real or Synthetic) and decide to remove the Web 
Service/operation from the list in the filter.

Note: You must configure the REST Web Services in the 
HP Diagnostics application. Once configured, their 
topology is sent by HP Diagnostics to the UCMDB. 
REST Web Services are not SOAP Web Services, 
therefore they provide errors and not SOAP faults. 
Consequently, the Health report does not display REST 
Web Services in the report areas that display SOAP 
faults. The Health report displays how many requests 
were made to the URL corresponding to the REST Web 
Service and how many of those requests failed.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard – Workflow” 
on page 38

Useful Links “Availability Calculation” on page 25
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Report Settings

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 61.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope and 
Business Process monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

When you select Real, each level of the report (except 
for Endpoint) also displays data for Synthetic. When 
you select Synthetic, the report displays only 
information relevant to Synthetic.
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Health Summary Area

When you select more than one service in the Active Filter, the report 
displays the following data:

When you select one service in the Active Filter, the report displays the 
following data:
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Depending on the selection you made in the Active 
filter, the Health summary area can display:

➤ A list of same level items (Web services, operations, 
endpoints, consumers). 

➤ A tree (Web service/Operations, Operation/
Endpoints, Endpoints). 

To display other metrics information, click the required 
item. See above for details.

Important 
Information

The Health Summary area is the same in the View as 
Graph and View as Table tabs.

Click the required element in the Health Summary 
report to access details about the health of the 
element’s components. For details about the elements’ 
components, see “Health Summary Area” on page 74.

Use the breadcrumbs to go back up the levels you 
drilled down.

GUI Element (A-Z) Description

Click to access the Consumer Summary report for the 
selected element. For details, see “Consumer Summary 
Report” on page 65.

Click to access the Metrics Over Time report for the 
selected element. For details, see “Metrics Over Time 
Report” on page 85. 

Note: This drill down (Diagnostics Operations) is 
available only for non-Web Service CIs. 

Select a CI in the table, and click the button to access 
the Diagnostics report relevant for the CI (for example 
the Diagnostics Operations view for an Operation CI) 
for the selected element. For details, see the 
HP Diagnostics User’s Guide.
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Note: This drill down (Diagnostics Web Service 
Topology) is available only for Web Service CIs. 

Select a Web Service CI, and click the button to access 
the Diagnostics Service Topology view for the selected 
Web Service CI. The graph displays the real-time 
connections that exist between the selected Web 
Service CI and other Web Service CIs, for the same 
timeframe as the report. For details, see HP Diagnostics 
User’s Guide.  

Click to access the HP SOA Systinet application, 
focused on the relevant Web service. This option is 
relevant only when there is an integration between 
HP Business Availability Center and HP SOA Systinet. 
For details on the integration with HP SOA Systinet, see 
“Integration of HP SOA Systinet” on page 26.

<Real> # of Calls The total of calls to the specific item. This is a metrics 
taken from the Diagnostics sample.

<Real> # of Errors The total number of failed calls based on the data from 
the Diagnostics data collector. A failed call is a call that 
was not performed due to availability problems of the 
Web services operations. It can be a receiver SOAP fault 
or an HTTP status code of 5xx-6xx if the call is to a 
REST service. Note that not all REST services use HTTP 
status code to indicate failure.

GUI Element (A-Z) Description
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<Real> # of SOAP 
Faults

The total number of SOAP faults that occurred in calls 
by the specific consumer based on the data from the 
Diagnostics data collector.

<Real> Availability The availability of the item based on the data from the 
Diagnostics data collector. The background is colored 
according to the thresholds specified in the Availability 
KPI definition. The availability is calculated as the 
number of successful calls to the item, divided by the 
total number of calls to the item, and multiplied by 
100.

<Real> Throughput 
(Calls/Min.)

The number of calls to the item per minute based on 
the data from the Diagnostics data collector. The 
background is colored according to the thresholds 
specified in the Throughput KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

<Real>
Response Time (sec.)

The response time (in seconds) of the item based on 
the data from the Diagnostics data collector. The 
background is colored according to the thresholds 
specified in the Response Time KPI definition. For 
details, see “How Dashboard KPIs Work” in Using 
Dashboard.

<Synthetic>
Response Time (sec.)

The response time (in seconds) of the item based on 
the data from the SiteScope or Business Process 
monitors. The background is colored according to the 
thresholds specified in the Response Time KPI 
definition. For details, see “How Dashboard KPIs Work” 
in Using Dashboard.

GUI Element (A-Z) Description
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Metrics Area

Service
Operation
Service/Operations
Operation/Endpoint
Endpoint

The name of the item whose health metrics are 
provided in the Health Summary. 

Click the required element to access details about the 
health of the element’s components. For details about 
the elements’ components, see “Health Summary Area” 
on page 74.

Synthetic Availability 
(%)

The availability of the item based on the data from the 
SiteScope or Business Process monitors. The 
background is colored according to the thresholds 
specified in the Availability KPI definition. The 
availability is calculated as the number of successful 
calls to the item, divided by the total number of calls to 
the item, and multiplied by 100.

Note: If you monitor the same Web Service with both 
SiteScope and Business Process Monitor (not 
recommended), the threshold defined in Business 
Process Monitor is used to color the background.

Description The Metrics area displays metrics information for the 
item listed in the first row of the Health Summary area. 
If multiple items were selected in the Active Filters, the 
SOAP Faults area displays the average information for 
all of the selected items.

Important 
Information

You can drill down from each point in the graphs to 
display more detailed information about the period of 
time represented by that point. You can drill down to 
the smallest unit of time (1 hour).

GUI Element (A-Z) Description
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Graph Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Availability (%) The graph displays the availability of the item over the 
selected time frame of the report in graph format. It 
displays both real and synthetic data when the Real 
Data Type is selected, or only synthetic data when the 
Synthetic Data Type is selected. The legend indicates 
what is displayed.

Note: The Availability of a service in a Real data source 
does not always display the reality. For example, if the 
server is down, the calls do not get to the Web service, 
the Availability of a service in a Real data source 
indicates that no one called the Web service while the 
Availability of a service under Synthetic data source 
indicates that the situation is bad. 

Response Time (sec) The graph displays the response time (in seconds) of 
the item over the selected time frame of the report in 
graph format.

The Response Time graph displays information about 
the Average Response Time (sec.) (purple line), the 
Max Response Time (sec.) (turquoise line), and the Min 
Response Time (sec.) (orange line).
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Throughput The graph displays the number of calls to the item per 
minute, over the selected time frame of the report in 
graph format.

The title line of the Metrics area includes the name of 
the item whose metrics are displayed. If the Health 
Summary area displays a tree of Operation/Servers the 
title line of the Metrics area is Aggregated data for 
selected operations.

GUI Element (A-Z) Description
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Table Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

# of Calls The total number of calls to the item, per time unit.

# of Errors The total number of calls to the item, that failed due to 
availability problems of the item, per time unit. 

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.

# of SOAP Faults The total number of calls to the item, that failed due to 
a SOAP fault, per time unit. 

Availability (%) The availability of the item, based on the data from the 
Diagnostics data collector, per time unit. 

Max Response Time 
(sec.)

The highest response time (in seconds) of the item, per 
time unit.

Min Response Time 
(sec.)

The lowest response time (in seconds) of the item, per 
time unit.

Response Time (sec.) The response time (in seconds) of the item, per time 
unit.

Synthetic Availability 
(%)

The availability of the item, based on the data from the 
SiteScope monitors, per time unit. 

Throughput (Calls/
Min)

The number of calls to the item per minute of the time 
unit.

Time The time units (hour) of the selected time period.
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SOAP Faults Area

Graph Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The SOAP Faults area displays information for the item 
listed in the first row of the Health Summary area. If 
multiple items were selected in the Active Filters, the 
SOAP Faults area displays average information for all of 
the selected items.

Important 
Information

➤ If you have selected to display synthetic data, the 
SOAP Faults area displays only the Worst Consumers 
graph.

➤ If you have selected to display real data, the SOAP 
Faults area displays all the graphs listed below.

GUI Element (A-Z) Description

# of Errors Shows the number of calls to the specific item that 
ended in a SOAP fault over the selected time period.

The title line of the SOAP Faults area or of the SOAP 
Faults table includes the name of the item whose 
metrics are displayed. If the Health Summary area 
displays a tree of Operation/Servers the title line of the 
SOAP Faults area is Aggregated data for selected 
operations.

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.
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Pie chart Represents the faults distribution by type of SOAP fault 
that occurred when accessing the item during the 
specified time period. The types of error are: 
VersionMismatch, MustUnderstand, Sender, Receiver, 
and DataEncodingUnknown. The tooltip displays the 
number of faults of the type represented by the slice. 
The legend lists the SOAP Fault types.

Worst Consumers Displays, for the five worst consumers (with the largest 
number of faulty calls), the number of successful calls 
(in orange) and the number of calls that ended in error 
or SOAP faults (in purple) to the item.

GUI Element (A-Z) Description
83



Chapter 1 • HP Business Availability Center for SOA
Table Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

SOAP Faults 
Distribution

Shows the percentage of the occurrence of each type of 
SOAP fault compared to the total number of SOAP 
faults: VersionMismatch, MustUnderstand, Sender, 
Receiver, or DataEncodingUnknown.

SOAP Faults and 
Errors Overtime

Displays the total number of calls to the selected item 
that ended in a SOAP fault and the total number of 
calls to the selected item that ended in an error, over 
the selected time period, per unit of time.

Worst Consumers Displays the number of calls to the selected item that 
ended in an error in the # of Errors column,the 
number of calls to the selected item that ended in a 
SOAP fault in the # of SOAP Faults column, the 
number of successful calls to the selected item in the # 
of Successful Calls column, and the total number of 
calls in the # of Calls column, per consumer, for the 
five worst consumers (with the largest number of faulty 
calls).
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Metrics Over Time Report

Description Displays the performance of selected metrics related to 
a selected view and selected CIs, over time.

To Access: Select Applications > Business Availability 
Center for SOA, and select the Metrics Over Time 
Report option in the Business Availability Center for 
SOA tab.

Important 
Information

Move the mouse over a tab in the appropriate graphs to 
display the tooltip that includes the information listed 
in the table. 

➤ For a Web service:
 

➤ For an operation:
 

The tooltip displays the following information:

➤ Namespace. The namespace of the Web service.

➤ Web Service/Operation. The name of the selected 
Web service/operation.

➤ <metric>. The value of the metric at this point.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard – Workflow” 
on page 38
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Report Settings

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 61.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope and 
Business Process monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 
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Graph and Table Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<graph details> The View as Graph tab displays the selected metric 
performance of the selected Web services, operations, 
endpoints, or consumers, during the selected time 
frame of the report.

The graph legend indicates the color used to display 
the metric information of the Web services if Web 
services were selected or operations if Operations were 
selected in the Active Filters.

<right-click a point in 
the graph>

To display the Available Drilldowns menu, and select:

➤ Drill Down to Health Report. To display the Health 
report for the selected Web service or operation for 
the selected time period. For details, see “Health 
Report” on page 71

➤ Time Range Drill Down. To display the metrics for 
the selected Web service or operation for the 
selected time period.
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<table details> The View as Table tab displays the selected Web 
services, or operations performance of the selected 
metric, during the selected time frame of the report.

The table displays the Web service and/or operation, 
the namespace of the Web service, and the value of the 
metric per time unit.

Generate Click to generate the report.

GUI Element (A-Z) Description
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Metrics Select the metric whose performance during the 
selected time period, you want to display. You can 
select: 

➤ Availability. The average availability (in percentage) 
of the selected Web services or operations, running 
on the selected servers, and accessed by the selected 
consumer during the selected time frame of the 
report.

➤ Throughput. The number of calls running on the 
selected server, by the selected consumer, per 
minute, during the selected time frame of the report.

➤ Avg. Response Time (sec.). The average response 
time (in seconds) of the selected Web services or 
operations, running on the selected server, by the 
selected consumer during the selected time frame of 
the report. 

➤ # of Calls. The total number of calls, running on the 
selected server, by the selected consumer, during the 
selected time frame of the report.

➤ # of Errors. The total number of faulty calls, running 
on the selected server, by the selected consumer, 
during the selected time frame of the report. A faulty 
call is a call that fails due to the unavailability of the 
called item.

➤ # of Slow Calls. The total number of slow calls, 
running on the selected server, by the selected 
consumer, during the selected time frame of the 
report. A slow call is a call with a response time that 
is longer than the predefined threshold.

➤ # of SOAP Faults. The total number of SOAP faults 
that occurred in calls by the specific consumer.

View as Graph tab Click to display the report in graph format.

View as Table tab Click to display the report in table format.

GUI Element (A-Z) Description
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Server and Endpoint Summary Report

Report Settings

Description Displays a drillable summary of the metrics for all of 
the servers or endpoints on which the selected Web 
services or operations of a selected view are running. 

To Access: Select Application > Business Availability 
Center for SOA, click the Business Availability Center 
for SOA tab, and select the Server and Endpoint 
Summary Report option in the Business Availability 
Center for SOA tab.

Important 
Information

When you select Real, the report displays information 
only for the consumers that were registered in the 
Diagnostics system. All other consumers are aggregated 
and presented as Others. 

The report is available only if the Server IP field exists 
in the sample.

Move the mouse over a tab in a graph to display a 
tooltip that indicates the number of errors, successfull 
calls, SOAP faults, and the total number of calls to the 
selected server. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard – Workflow” 
on page 38

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.
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Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 61.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope and 
Business Process monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

Report Granularity Select one of the following:

➤ Servers. To display the Server and Endpoint 
Summary report with information about the servers.

➤ Endpoints. To display the Server and Endpoint 
Summary report with information about the 
endpoints.

GUI Element (A-Z) Description
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Server/Endpoint Summary Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the health metrics for all of the servers/
endpoints on which the selected Web services or 
operations are running. If, in the Active Filters, you 
also select specific endpoint or consumer, the health 
metrics are further filtered by the selected endpoint or 
consumer.

Important 
Information

The Server Summary area is the same in the View as 
Graph and View as Table tabs.

GUI Element (A-Z) Description

Select an elements and click the button to drill down to 
the Health Report for the selected element. For details, 
see “Health Report” on page 71.

# of Calls The total number of calls to the server accessed by the 
Web services, operations, or consumer.
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# of Errors The total number of errors that occurred in calls by the 
specific consumer.

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.

# of Slow Calls The number of slow calls that occurred in calls by the 
specific consumer. 

A slow call is a call with a response time that is longer 
than a predefined threshold.

Note: The value displayed by # of Slow Calls is different 
from the value of the Total Threshold Violation in 
HP Diagnostics. In HP Diagnostics the Total Threshold 
Violation includes the overall number of violation from 
all the calls and in HP Business Availability Center # of 
Slow Calls includes only the violations of the successful 
calls.

# of SOAP Faults The total number of SOAP faults that occurred in calls 
by the specific consumer.

Availability (%) The availability of the server accessed by the selected 
Web services, operations, or consumer. The availability 
is calculated as the number of successful calls made to 
the server divided by the total number of calls made to 
the server, multiplied by 100.

The background is colored according to the threshold 
specified in the Availability KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

Endpoint The name of the endpoint.

Note: This column is displayed only when you select 
the Endpoints report granularity.

Click the endpoint to drill down to the Health Report 
for the selected element. For details, see “Health 
Report” on page 71.

GUI Element (A-Z) Description
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Response Time (sec.) The average response time (in seconds) of the server 
accessed by the selected Web services, operations, or 
consumer. 

The background is colored according to the threshold 
specified in the Response Time KPI definition. For 
details, see “How Dashboard KPIs Work” in Using 
Dashboard.

Server The IP number of the server.

Click the gray arrow to the right of the server to display 
drill down menu options where you can select the Drill 
Down to Health Report or Drill Down to Endpoint 
Summary Report options to access the relevant report 
for the element.

Throughput (calls 
per min.)

The number of calls, per minute, to the server by the 
selected Web services, operations, or consumer.

The background is colored according to the threshold 
specified in the Throughput KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

GUI Element (A-Z) Description
94



Chapter 1 • HP Business Availability Center for SOA
Worst Server Area

Description Displays the successful and faulty calls of the worst five 
servers/endpoints accessed by the selected Web 
services, operations, or consumer.

Important 
Information

The Worst Server area and the Worst Endpoint area 
display the same information in the View as Graph and 
View as Table tabs.

Each tab in the graph represents one of the five worst 
servers or endpoints and displays the number of 
successful calls (in red) and the number of faulty calls 
(in purple).
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

# of Calls The total number of calls to the server accessed by the 
Web services, operations, or consumer.

# of Errors The number of calls to the server that ended with an 
error.

Configurable: The SOAP faults affecting the availability 
can be configured in HP Diagnostics when the call is 
monitored by HP Diagnostics.

# of SOAP Faults The total number of SOAP faults that occurred in calls 
by the specific consumer.

# of Successful calls The number of calls to the server that were successful.

Endpoint The name of the worst endpoint.

Server The IP number of the worst server.
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Top Metrics Report

Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the top metrics information about the traffic 
to and from all of the monitored Web services or 
operations in a specific view. 

To Access: Select Applications > Business Availability 
Center for SOA, and select the Top Metrics option in 
the Business Availability Center for SOA tab.

Important 
Information

Move the mouse over a tab in the appropriate graphs to 
display the tooltip that includes the information listed 
in the table. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard – Workflow” 
on page 38

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.
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Top Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 61.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope and 
Business Process monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

GUI Element (A-Z) Description

From the View as Table tab, click the Health report drill 
down button corresponding to:

➤ a specific Web service to open the Health Report of 
the Web service’s operation in table format. 

➤ a specific operation, to open the Health Report of 
the operation’s servers in table format. 

<bar in graph> From the View as Graph tab, click the bar that 
corresponds to:

➤ a specific Web service to open the Health Report of 
the Web service’s operations in graph format.

➤ a specific operation to open the Health Report of the 
operation’s servers in graph format.

Report Granularity Select:

➤ Web services to display the top metrics information 
for the selected Web services.

➤ Operations to display the top metrics information 
for the selected operations.

GUI Element (A-Z) Description
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Web Services-Related Graphs

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Least Active Web 
Services

Displays the five Web services that received the lowest 
number of calls (that is, were least used), during the 
selected time frame of the report. Each tab represents 
the total number of calls to the Web service.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.
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Least Available Web 
Services

Displays the availability of the five Web services with 
the lowest availability, during the selected time frame 
of the report. The availability is calculated as the 
number of successful calls to the Web service, divided 
by the total number of calls to the Web service, and 
multiplied by 100.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.

GUI Element (A-Z) Description
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Most Active Web 
Services

Displays the five Web services with the highest number 
of calls, during the selected time frame of the report. 
Each tab represents the total number of calls to the 
Web service.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.

GUI Element (A-Z) Description
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Slowest Web Services Displays the five slowest Web services in the selected 
time frame of the report. A slow Web service is defined 
as having the longest response time (no matter the 
threshold value). Each tab represents the average of the 
response times for the Web service during the time 
frame of the report.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.

Web Services with 
Most Errors

Displays the five Web services with the largest number 
of failed values, during the selected time frame of the 
report. Each tab represents the total number of calls 
that ended in errors, received by the Web service.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.

GUI Element (A-Z) Description
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Web Services-Related Table

The Least Active Web Services, Slowest Web Services, Web Services with 
Most SOAP Faults, Web Services with Most Slow Calls, Most Active Web 
Services, or Least Active Web Services table in the Top Metrics Report screen 
includes the following elements:

Web Services with 
Most Slow Calls

Displays the five Web services with the highest number 
of slow calls, in the selected time frame of the report. A 
slow call is defined as a call that lasts longer than a 
predefined threshold. Each tab represents the total 
number of slow calls received by the Web service.

This graph is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web 
Services-Related Table” on page 103.

GUI Element (A-Z) Description

# of Calls The total number of calls to the specific Web service 
during the selected time frame of the report.

# of Errors The number of calls to the specific Web service, 
during the selected time frame of the report, that 
failed due to the unavailability of the Web service.

Configurable: The SOAP faults affecting the 
availability can be configured in HP Diagnostics 
when the call is monitored by HP Diagnostics.

GUI Element (A-Z) Description
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# of Slow Calls The number of slow calls to the specific Web service 
during the selected time frame of the report. A slow 
call is a call with a response time that is longer than 
a predefined threshold. 

Note: The value displayed by # of Slow Calls is 
different from the value of the Total Threshold 
Violation in HP Diagnostics. In HP Diagnostics the 
Total Threshold Violation includes the overall 
number of violation from all the calls and in 
HP Business Availability Center # of Slow Calls 
includes only the violations of the successful calls.

# of SOAP Faults The number of calls to the specific Web service, 
during the selected time frame of the report, that 
ended in SOAP faults.

Availability (%) The average availability of the Web service during 
the selected time frame of the report. The 
availability is calculated as the number of successful 
calls to the Web service, divided by the total 
number of calls to the Web service, and multiplied 
by 100. 

Avg. Response Time (sec.) The average response time (in seconds) of the Web 
service during the selected time frame of the report.

Name The name of the selected Web service.

NameSpace The name space of the Web service.

GUI Element (A-Z) Description
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Operations-Related Graphs

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Least Active 
Operations 

Displays the five operations that received the lowest 
number of calls (that is, were least used), during the 
selected time frame of the report. Each tab represents 
the total number of calls to the operation.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.
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Least Available 
Operations

Displays the availability of the five operations with the 
lowest availability, during the selected time frame of 
the report. The availability is calculated as the number 
of successful calls to the operation, divided by the total 
number of calls to the operation, and multiplied by 
100.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.

Most Active 
Operations

Displays the five operations with the highest number 
of calls, during the selected time frame of the report. 
Each tab represents the total number of calls to the 
operation.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.

GUI Element (A-Z) Description
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Operations with 
Most Errors

Displays the five operations with the largest number of 
calls with errors, during the selected time frame of the 
report. Each tab represents the total number of errors 
received by the operation.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.

Operations with 
Most Slow Calls

Displays the five operations with the highest number 
of slow calls, in the selected time frame of the report. 
A slow call is defined as a call that lasts longer than a 
predefined threshold. Each tab represents the total 
number of slow calls received by the operation.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.

GUI Element (A-Z) Description
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Slowest Operations The Slowest Operations graph displays the five slowest 
operations in the selected time frame of the report. A 
slow operation is defined as having the longest 
response time (no matter the threshold value). Each 
tab represents the average of the response times for the 
operation during the time frame of the report.

This graph is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see 
“Operations-Related Table” on page 109.

GUI Element (A-Z) Description
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Operations-Related Table

The Least Active Operations, Slowest Operations, Operations with Most 
SOAP Faults, Operations with Most Slow Calls, Most Active Operations, or 
Least Active Operations tables includes the following elements:

GUI Element (A-Z) Description

# of Calls The total number of calls to the specific operation 
during the selected time frame of the report.

# of Errors The number of calls to the specific operation, 
during the selected time frame of the report, that 
failed due to the unavailability of the operation.

Configurable: The SOAP faults affecting the 
availability can be configured in HP Diagnostics 
when the call is monitored by HP Diagnostics.

# of Slow Calls The number of slow calls to the specific operation 
during the selected time frame of the report. A slow 
call is a call with a response time that is longer than 
a predefined threshold. 

Note: The value displayed by # of Slow Calls is 
different from the value of the Total Threshold 
Violation in HP Diagnostics. In HP Diagnostics the 
Total Threshold Violation includes the overall 
number of violation from all the calls and in 
HP Business Availability Center # of Slow Calls 
includes only the violations of the successful calls.

# of SOAP Faults The total number of SOAP faults that occurred in 
calls by the specific consumer.

The column is displayed only when you select the 
Real data type.

Availability (%) The average availability of the operation during the 
selected time frame of the report. The availability is 
calculated as the number of successful calls to the 
operation, divided by the total number of calls to 
the operation, and multiplied by 100.
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Troubleshooting and Limitations

The SOA reports reflect the relative view of the user. Therefore, if in a 
customized view, specific operations are attached to a Web service, the SOA 
reports based on the view display information related only to the Web 
service and the selected operations. Other operations connected to the Web 
service in the CMDB are not displayed.

If the monitors attached to the operations are not added to the customized 
view, the SOA reports display information that does not take into 
consideration the thresholds defined in the monitors.

Avg. Response Time (sec.) The average response time (in seconds) of the 
operation during the selected time frame of the 
report. 

Name The name of the operation.

NameSpace The name space of the Web service that runs the 
operation.

Web Service The name of the Web service that runs the 
operation.

GUI Element (A-Z) Description
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HP Business Availability Center for SAP 
Applications 

This chapter includes information about deploying HP Business Availability 
Center for SAP Applications solution.

This chapter includes:

Concepts

 ➤  HP Business Availability Center for SAP Applications – Overview on page 114

 ➤  HP Business Availability Center for SAP Applications License on page 115

 ➤  HP Business Availability Center for SAP Applications Architecture 
on page 116

 ➤  Business Process Monitor Measurements in SAP Systems View – Details 
on page 118

 ➤  SiteScope Measurements in SAP Systems View on page 124

 ➤  SAP Systems View on page 126

 ➤  SAP Service on page 129

 ➤  Collecting SAP System Information on page 130

 ➤  CCMS Counters on page 131

Tasks

 ➤  Deploy HP Business Availability Center for SAP Applications on page 133

 ➤  Deploy the SAP CCMS Monitor to Retrieve Measurements from the SAP 
System on page 135

 ➤  Activate the SAP Service on page 140
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 ➤  Install HP Business Availability Center for SAP Applications on page 141

 ➤  Create Monitors on page 146

 ➤  Use a Business Process Monitor Profile to Simulate SAP Users on page 147

 ➤  Display SAP Information in Dashboard on page 154

Reference

 ➤  Default CIs in the SAP Systems View on page 155

 ➤  SAP-Related KPIs on page 159

 ➤  SAP-Related Menu Options on page 160

 ➤  HP Business Availability Center for SAP Applications User Interface 
on page 160

Troubleshooting and Limitations on page 172
Concepts

HP Business Availability Center for SAP Applications – 
Overview

The HP Business Availability Center for SAP Applications, integrating 
SiteScope, Business Process Monitor, and HP Universal CMDB enables you 
to gain visibility and control over your mission-critical SAP systems and 
applications.

The SAP solution provides:

➤ A single operation console consolidating all SAP monitoring information.

➤ Automatic discovery and modeling of SAP-related elements, as well as their 
relations to other systems in the organization’s IT.

➤ Change discovery and notification, for quicker problem resolution.

➤ Display of transport deployment impact, for move-to-production risk 
analysis.

➤ Proactive monitoring of end-user experience in SAP systems.

➤ A bridge between IT and line-of-business people using SAP Solution 
Manager business processes hierarchy monitoring.
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➤ The ability to distinguish between SAP-specific problems and general ones. 

➤ Examination, over time, of SAP CCMS monitoring data.

➤ Service Level Management of SAP systems’ service level commitments. 

In addition, you can create SLAs centered around your HP Business 
Availability Center for SAP Applications SAP transaction CIs to gain 
visibility into performance or availability issues that affect these SLAs. For 
details about SLAs, see “Service Level Management - Overview” in Using 
Service Level Management. 

HP Business Availability Center for SAP Applications 
License

The HP Business Availability Center for SAP Applications license unlocks the 
following functionality in HP Business Availability Center, helping to 
shorten time-to-value and minimize MTTR:

➤ The SAP Systems pattern view, displaying a hierarchical view of SAP 
applications and infrastructure.

➤ Automatic linkage of Business Process Monitor transactions to the SAP 
transactions they are monitoring.

➤ Automatic linkage of SiteScope measurements to their respective SAP 
infrastructure.

➤ SAP-specific KPIs that allow differentiation between SAP-related issues and 
non-SAP ones.

➤ Show Impact and Problem Isolation access from the Dashboard for quick 
visualization of change impact.

➤ SAP-specific change reports, summarizing the impact transports have on 
transactions in the SAP system.
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HP Business Availability Center for SAP Applications 
Architecture

The architecture of HP Business Availability Center for SAP Applications is 
illustrated in the following diagram:

Most of the SAP CIs are created by automatic discovery. The configuration 
for these CIs is saved into the CMDB. Some of the relationships to Business 
Process Monitor and SiteScope CIs are created by automatic mechanisms 
unique to HP Business Availability Center for SAP Applications.
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The architecture of HP Business Availability Center for SAP Applications 
includes the following components:

➤ The DDM Probe discovers SAP-related entities and the general entities (such 
as hosts) that are related to them using CCMS. The DDM Probe 
communicates with the CMDB using a Remote Function Call (RFC) with a 
Java Connector (JCo).

➤ SiteScope SAP CCMS Solution Set communicates with the SAP system and 
retrieves CCMS monitoring data using a Remote Function Call (RFC) with a 
Java Connector (JCo).

➤ Business Process Monitor collects data on the performance and availability 
of Business Process Monitor transactions carried out on the SAP system.

➤ HP Universal CMDB Server collects change information from the CMDB 
and stores it in the History database.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Introduction 
to Dashboard” in Using Dashboard.
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Business Process Monitor Measurements in SAP Systems 
View – Details

You can view the Business Process Measurement in the SAP Systems view in 
different locations in the SAP hierarchy. 

View Hierarchy When Adhering to the Naming 
Conventions for Business Process Steps and When Using 
the Transaction/Location Hierarchy Structure
If you have used the naming convention for the Business Process Step, and 
you have set the Hierarchy structure of the Business Process Monitoring 
source adapter to Transaction/Location then the view displays the following 
structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed 
under a Business Process Step CI, under a SAP Transaction CI, under 
several levels of SAP Application Component CIs, under a SAP System CI. 
For example:
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➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Business Process Step CI under the Contained group CI (Business 
Processes). For example:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed 
under a Contained Location CI itself under a Contained group CI 
(Locations) under the SAP System CI. For example:

For details on the types of hierarchy, see “New/Edit Source Adapter 
Dialog Box” in Model Management.
119



Chapter 2 • HP Business Availability Center for SAP Applications
View Hierarchy When Not Adhering to Naming 
Convention for Business Process Steps and When Using 
the Transaction/Location Hierarchy Structure
If the Business Process Steps do not follow the naming conventions, and 
you have set the Hierarchy structure of the Business Process Monitoring 
source adapter to Transaction/Location, then the view displays the following 
structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed 
under a Business Process Step CI, under a SAP Transaction CI, under 
several levels of SAP Application Component CIs, under a SAP System CI. 
For example:
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➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Business Process Step CI under the Contained group CI (Business 
Processes). For example:

➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Contained Location CI, under a Contained group CI (Locations), 
under a SAP System CI. For example:

For details on the types of hierarchy, see “New/Edit Source Adapter 
Dialog Box” in Model Management.
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View Hierarchy When Adhering to Naming Conventions 
for Business Process Steps and Regular Hierarchy 
Structure
If the Business Process Steps follow the naming conventions and you have 
set the Hierarchy structure of the Business Process Monitoring source 
adapter to Regular, then the view displays the following structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed 
without the location information, under a Business Process Step CI, 
under a SAP Transaction CI, under several levels of SAP Application 
Component CIs, under a SAP System CI. For example:

➤ The BPM Monitor (BPM transaction from location CIT) without location 
information, is also displayed under a Business Process Step CI under the 
Contained group CI (Business Processes). For example:
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View Hierarchy When Not Adhering to the Naming 
Convention for Business Process Steps and Regular 
Hierarchy Structure
If a Business Process Step does not follow the naming conventions and you 
have set the Hierarchy structure of the Business Process Monitoring source 
adapter to Regular, then the view displays the following structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed 
under a Business Process Step CI, under a SAP Transaction CI, under 
several levels of SAP Application Component CIs, under a SAP System CI, 
without the location information. For example:
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➤ The BPM Monitor (BPM transaction from location CIT) without location 
information, is also displayed under a Business Process Step CI under the 
Contained group CI (Business Processes). For example:

For details on the types of hierarchy, see “New/Edit Source Adapter 
Dialog Box” in Model Management.

SiteScope Measurements in SAP Systems View

SiteScope monitors are displayed in the SAP Systems view only if they are 
linked to hosts. To display them elsewhere in the hierarchy, advanced users 
must modify the TQL of the SAP System.

➤ The SiteScope Measurement is displayed under a SAP Work Process CI, under 
SAP R/3 Application Server CI, under an instance of a Contained Group CI, 
under a SAP System CI. For example: 
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➤ The SiteScope Measurement is displayed under a SAP R/3 Application Server 
CI, under an instance of a Contained Group CI, under a SAP System CI. For 
example:

➤ The SiteScope Measurement is displayed under a SAP System CI. For 
example:
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➤ The SiteScope Measurement is displayed under a Database CI, under an 
instance of a Contained Group CI, under a SAP System CI. For example:

SAP Systems View

You can view SAP information in the SAP Systems view in Dashboard. For 
details about how to work with the Console tab, see “Console Page” in Using 
Dashboard.

The SAP Systems view in View Explorer appears as follows:
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The following graph describes the various layers and drill-downs available in 
the topology of the SAP Systems view:
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Topologies

In addition, the SAP Systems view includes the following topologies, which 
are created by specific SiteScope monitors:

➤ SAP CCMS topology discovered by SiteScope:

SiteScope creates the following topology for the SiteScope SAP CCMS 
monitor. The CIs are created only for the monitored entities according to 
the counters that you selected.

Note: The Database CI is always a child of the Host CI that you specified in 
the monitor definition even if it is actually running on another host.
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➤ SAP Work Processes topology discovered by SiteScope:

SiteScope creates the following topology for the SiteScope SAP Work 
Processes monitor. The CIs are created only for the monitored entities 
according to the counters that you selected.

SAP Service

The SAP service is assigned to the Modeling Data Processing Server. It is a 
configuration service that enables HP Business Availability Center to work 
with data that is in SAP format.

For details about how to view a service status using the JMX Web console, 
see “High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF.
129



Chapter 2 • HP Business Availability Center for SAP Applications
The SAP Service is responsible for the following advantages:

➤ Intelligent relation of monitoring information.

➤ Installation on the modeling processing server (5 server installation).

➤ Loading occurs after the CMDB and Viewing System services are loaded.

➤ Registration on 3 TQLs and notification on every change in each one of 
those TQLs.

➤ Check of the service activity in the JMX console. For details, see “Activate 
the SAP Service” on page 140.

➤ Automatic linkage of SiteScope measurements or BPM scripts with 
standardized names. For details, see “Follow the Naming Conventions for 
Naming Business Process Steps” on page 150.

➤ Creation of Business Process and Locations container and connection of the 
appropriate Business Process Steps to the containers. A Business Process Step 
connected manually to the SAP transaction would also be connected to 
these containers. For details, see “Attach Business Process Steps to a SAP 
Transaction without Following the Naming Conventions” on page 151.

➤ Works after the BPM source adapter and SiteScope source adapters (when 
you are working with SiteScope 9.0) have been synchronized.

Collecting SAP System Information

The Automatic Discovery component discovers the actual SAP IT entities 
and stores them as CIs in the CMDB.

All configuration actions of SAP CIs are performed inside the CMDB 
Administration application. All SAP CIs appear in the SAP Systems view 
under a root CI called SAP Systems. 

All SAP system metrics are monitored by SiteScope monitors.
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SAP business processes/transactions are simulated using Business Process 
Monitor pre-recorded VUGen scripts. Each script includes one or more 
Business Process Steps and are executed from a specific location. All Business 
Process Monitor-related CIs are stored in the CMDB as non-SAP-related CIs 
with links to the appropriate SAP-related CIs.

Information about the SAP System is available in Dashboard in all of the 
relevant tabs like other information.

The SAP Systems views includes information from the SAP IT entities, SAP 
system metrics monitored by SiteScope monitors, and information about 
the SAP business processes/transactions simulated by Business Process 
Monitor scripts.

CCMS Counters

The CCMS Counters Dynamic Nodes collect the samples from SiteScope and 
display them as CIs under the elements they are monitoring. 

To view these CIs, select Applications > Dashboard, click Console, select SAP 
Systems in the View list, and click Background.

The Console page displays the samples from SiteScope.
131



Chapter 2 • HP Business Availability Center for SAP Applications
Move the mouse over the CI to display a tooltip that provides information 
about the CI, its status, the rule that calculates the status of the SAP KPI, the 
values returned by the monitor the last time it ran, the measurement names, 
and the monitor type. The tooltips includes the following information:

➤ CI Name. The name of the CI.

➤ Status. The status of the CI (calculated according to one of the status 
calculation methods). It may also display:

➤ Not up to date for decayed CIs, indicating that the CI has passed its 
timeout period. (For a SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped when a Business Process profile is stopped.

➤ Calculation Rule. The name of the rule that calculates the KPI status or 
value.

➤ Held Status Since. The date and time since which this CI has held its current 
operational status.

➤ Message. The values returned by the monitor the last time it ran, as 
displayed in SiteScope. This may simply be the retrieval time and file size or 
it may include specific parameters for a server component.

➤ Last Update. The date and time that the last update for the CI was received 
by Dashboard. This information is not always displayed.

➤ Measurement. The name of the measurement from SiteScope. This 
information is not always displayed.

➤ Monitor. The monitor type that the CI represents. This information is not 
always displayed.

Tasks
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Deploy HP Business Availability Center for SAP 
Applications 

This section describes the processes to follow to display SAP information in 
Dashboard, and gives examples.

This task includes the following steps:

➤ “Prerequisites” on page 133

➤ “Install HP Business Availability Center for SAP Applications” on page 134

➤ “Run SAP Discovery” on page 134

➤ “Create a Business Process Monitor Profile” on page 134

➤ “Create Monitors” on page 134

➤ “Modify SiteScope KPI Assignment Group” on page 134

➤ “Display SAP Information in Dashboard” on page 135

➤ “Add an Application Server to the SAP System” on page 135

 1 Prerequisites
Ensure that the following software is installed before you install the SAP 
solution:

➤ DDM Probe. Used to perform the discovery of SAP topology in your 
organization. For details, see “Discovery and Dependency Mapping” in 
Discovery and Dependency Mapping Guide.

➤ SiteScope. Used to integrate the SiteScope data collector into the 
HP Business Availability Center for SAP Applications solution. For details, 
see the HP SiteScope Deployment Guide PDF.

➤ Business Process Monitor. Used to integrate the Business Process Monitor 
data into the HP Business Availability Center for SAP Applications solution. 
For details, see “Introducing Business Process Monitor” in HP Business 
Process Monitor Administrator’s Guide.
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Note: You must have a SAP license to view the SAP Systems view in 
HP Business Availability Center.

 2 Install HP Business Availability Center for SAP Applications
Install HP Business Availability Center for SAP Applications.

For details, see “Install HP Business Availability Center for SAP Applications” 
on page 141.

 3 Run SAP Discovery
You can run SAP discovery to discover SAP elements and SAP topology. For 
details, see “SAP Discovery” in Discovery and Dependency Mapping Guide.

 4 Create a Business Process Monitor Profile

Business Process Monitor profiles are used to simulate SAP users to obtain 
performance and availability information on the SAP transactions.

For details, see “Use a Business Process Monitor Profile to Simulate SAP 
Users” on page 147.

 5 Create Monitors
You can create a SAP CCMS monitor and general SiteScope monitors to get 
the complete picture: Database Query Monitor, Ping Monitor, and so on. For 
details, see “Create Monitors” on page 146.

 6 Modify SiteScope KPI Assignment Group
If required, when you are working with SiteScope 9.50, you can modify the 
existing SiteScope KPI assignments. For details, see “Assignment Groups 
Page” in Using Dashboard.
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 7 Display SAP Information in Dashboard
You can display SAP information in Dashboard in different views and 
reports. For details, see “Display SAP Information in Dashboard” on 
page 154.

 8 Add an Application Server to the SAP System
When you add a new application server to the SAP System, you must clear 
the Report SAP Topology to HP Business Availability Center option,  save the 
Monitor definition, and then select the option again and save the monitor 
definition, in order for the monitor to recognize the new application server.

Deploy the SAP CCMS Monitor to Retrieve Measurements 
from the SAP System

The SAP CCMS monitor retrieves and reports measurements from SAP's 
centralized monitoring system CCMS. CCMS is used to monitor all servers, 
components and resources in the SAP R/3® System from one single 
centralized server, facilitating problem discovery and problem diagnosis. For 
details, see “SAP CCMS Monitor Overview” in Using System Availability 
Management.

Note: The SAP CCMS Monitor is an optional SiteScope feature whose license 
is provided with the SAP solution.

This task includes the following steps:

➤ “Deploy a CCMS Monitor Using the SiteScope CCMS Solution Template” on 
page 136

➤ “Attach SiteScope to HP Business Availability Center” on page 137

➤ “Check That the Monitor Is Set to Report All Monitors and Measurements” 
on page 137
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➤ “Synchronize the SiteScope Source Adapter” on page 137

➤ “Connect the SAP CCMS Measurements to the Appropriate Elements of the 
SAP Hierarchy” on page 138

➤ “Check/View the SiteScope Measurements in the SAP View” on page 140

 1 Deploy a CCMS Monitor Using the SiteScope CCMS Solution 
Template
The MonitorSetSSServer.mset solution template is the most effective way to 
deploy a CCMS monitor. 

To deploy a CCMS monitor using the SiteScope CCMS solution template:

 a Access SiteScope using System Availability Management in HP Business 
Availability Center or directly using the URL: http://
<SiteScope_server>:8080/<HP_BAC_web_application_context_name 
(usually topaz)>/.

 b Select Admin > System Availability Center. 

 c Right-click the appropriate SiteScope in the Enterprise tree, and select 
New Group.

 d Enter the name of the group in the Group Name box in the Main Settings 
area.

 e Click OK.

 f Expand Solution Sets, right-click SAPR3Solution, and select Copy.

 g Right-click the new group you have created, and select Paste.

 h In the Main Settings area, enter the following information:

➤ The name of the SAP System in the TARGET_SERVER_NAME box.

➤ The user name in the USER_NAME box.

➤ The password in the Password box.

➤ The number of the SAP system in the SYSTEM_NUMBER box.

➤ The number of the client to which you connect SiteScope in the 
CLIENT_NUMBER box.

 i Click OK.
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 2 Attach SiteScope to HP Business Availability Center
Make sure that SiteScope is attached to HP Business Availability Center. For 
details, see “New SiteScope Page” in Using System Availability Management.

 3 Check That the Monitor Is Set to Report All Monitors and 
Measurements
To view SiteScope measurements, you must check that the monitor is set to 
report all monitors and measurements information.

To check that the monitor is set to Report All Monitors and Measurements:

 a Select Admin > System Availability Center.

 b Double-click the appropriate CCMS monitor under the appropriate 
group, select Properties, and expand the HP Business Availability Center 
Login area.

 c Check that the value of the Logging to HP Business Availability Center is 
set to Report everything (all monitors and all measurements).

 4 Synchronize the SiteScope Source Adapter
If you are working with SiteScope 9.0, you can synchronize the SiteScope 
source adapter immediately or you can wait for the automatic 
synchronization to take place. For details, see “Source Manager Page” in 
Model Management.
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 5 Connect the SAP CCMS Measurements to the Appropriate 
Elements of the SAP Hierarchy
The SAP CCMS measurements are connected to the appropriate elements of 
the SAP hierarchy as follows:

 a A SAP CCMS measurement can reside only under a System, R/3 
Application Server, Work Process, or Database CIT.

 b The linkage is performed based on the CCMS measurement's name that 
includes the name of the appropriate CI. 

A CCMS measurement name has the following syntax: <field1>/<field2>/
<field3>. If the fields in the CCMS name include the name of an R/3 
Application Server, System ID, Work Process name, or Database name, 
the CCMS measurement is attached to the appropriate CI as follows:

For more details about the SAP hierarchy, see “Default CIs in the SAP 
Systems View” on page 155.

<field1> <field2> <field3> Attached to CI

R/3 Application 
Server name

System ID Work Process 
name

Attached to the 
specified work process

R/3 Application 
Server name

System ID N/A Attached to the 
specified R/3 
application server

System ID N/A N/A Attached to the 
specified SAP system

System ID Database 
name

N/A Attached to the 
specified database
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Example

If you have the following CCMS measurements, the first three CCMS 
measurements are attached to the Background CI (Work Process) under the 
R/3 Services CI (R/3 Application Server), under the Host CI, and the other 
group of measurements are attached to the Dialog Work Process under the 
R/3 Services (R/3 Application Server) under the Host calderone_MI6_00.
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 6 Check/View the SiteScope Measurements in the SAP View
SiteScope monitors are displayed in the SAP view only if they are connected 
to hosts. To display them elsewhere in the hierarchy, advanced users must 
modify the TQL of the SAP System. For details, see “SiteScope Measurements 
in SAP Systems View” on page 124.

Note: If SiteScope measurements names are too long and are truncated in 
Dashboard, you can change the CIT default label to RegExp(data_name, 
(.*[/].*[/].*[/])(.*),2) instead of just data_name. Only the beginning of the 
path and the last part of the measurement's name are displayed instead of 
the entire measurement name (including the path). If you change the CIT 
default label, you must also change all references in the code and in the TQL 
layout from display_label to data_name. 

Activate the SAP Service

Check that the SAP Service is activated (it is activated by default). If 
necessary, activate it manually. For details, see “High Availability for the 
Data Processing Server” in the HP Business Availability Center Deployment 
Guide PDF.

To manually activate the SAP Service:

 1 In the browser, enter (using JMX login credentials):
 http://<HP Business Availability Center server name>
:8080/jmx-console/

 2 Double-click service=Verticals External Enrichment Service listed under 
Topaz.

 3 The JMX MBean View for Verticals External Enrichment Service opens.
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 4 Specify:

➤ performLinkage. The customer ID and the relevant linkage used to 
perform (CCMS/BPM AUTO/BPM manual.

➤ createTqlListeners. Use for debugging.

➤ Start. Starts the service.

➤ Stop. Stops the service.

Install HP Business Availability Center for SAP 
Applications 

Note: An existing Business Process Monitor machine can be leveraged for 
running SAP scripts as well.

Deploying the SAP solution includes setting the appropriate licenses, 
connecting SAP Java Connector on the SiteScope machine, and setting the 
DDM Probe.

This task includes the following steps:

➤ “Set the License for the SAP Solution” on page 142

➤ “Install the SAP Java Connector on the SiteScope Machine” on page 143

➤ “Set the SiteScope License” on page 143

➤ “Perform the DDM Probe Post-Installation Procedure” on page 144

➤ “Restart the Discovery Agent” on page 145
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 1 Set the License for the SAP Solution
Do the following:

➤ Set the license for the SAP solution.

Log in to HP Business Availability Center, select Admin > Platform > Setup 
and Maintenance > License Management. Click New License Key to open 
the New License Key page, and enter a valid license key in the License key 
box. The license key includes the SAP solution. Click OK to save the change. 
Verify that the value of Business Availability Center for SAP in the 
Applications area is Licensed. It is recommended to restart HP Business 
Availability Center at this point.

When setting the SAP solution license, verify that the license also contains 
the Auto Discovery license (customers with HP Business Availability Center 
for SAP license also receive the Auto Discovery license).

If the SAP solution license was set while installing HP Business Availability 
Center, the SAP jobs are automatically deployed and added to the CMDB.

If the SAP solution license was set after installing HP Business Availability 
Center, you must deploy the jobs manually or restart HP Business 
Availability Center so the SAP jobs are deployed automatically (this is the 
recommended procedure).

Note: The SAP-related jobs: SAP.zip, SAP_discovery.zip, and 
SAP_monitoring.zip are at the following location on the machine where 
CMDB is installed:
<HP Business Availability Center root directory>\mam_lib\packages.

➤ Check that the jobs are deployed:

Select Admin > Universal CMDB > Modeling > It Universe Manager and 
check that the SAP views are listed in the View list in View Explorer.
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 2 Install the SAP Java Connector on the SiteScope Machine
Once SiteScope is installed, install SAP Java connector on the SiteScope 
machine, as follows:

 a Download the SAP JCo package from the Tools & Services window of SAP 
JCo in SAP Service Marketplace:
https://websmp101.sap-ag.de/~form/
sapnet?_SHORTKEY=01100035870000463649

 b Extract sapjco-ntintel-2.0.8.zip to a temporary directory (for example, 
C:\temp) on the SiteScope machine.

 c Copy sapjco.jar from the temporary directory to the <SiteScope root 
directory>\SiteScope\WEB-INF\lib directory on the SiteScope machine.

 d Copy sapjcorfc.dll from the temporary directory to the <SiteScope root 
directory>\SiteScope\bin directory on the SiteScope machine.

 e Copy librfc32.dll from the temporary directory, in the SiteScope machine 
to:

➤ the %winnt%\system32 directory

➤ the <SiteScope root directory>\SiteScope\bin directory

If there is an old version of the librfc32.dll file already in the 
<SiteScope root directory>\bin or in the %winnt%\system32 
directory, you should replace it. 

 f Restart SiteScope as follows: on the SiteScope machine, go to Start > 
Programs > Administration Tools > Services, find SiteScope service and 
restart it.

 3 Set the SiteScope License
To set the SiteScope license appropriate for your system:

 a Launch SiteScope by entering the following URL in a browser:  
http://<SiS_machine_name>:8080

 b Choose Preferences > General Preferences.

 c Click Edit.

 d Click Insert valid license keys.
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 e In the License Number box, enter a valid SiteScope license key.

 f In the Option Licenses box, enter the SiteScope license keys appropriate 
for the SAP solution.

Make sure to insert a license for: EMS monitors, SAP monitors, and the 
SAP R/3 solution template.

 g Click OK to approve the changes.

 4 Perform the DDM Probe Post-Installation Procedure
After installing the DDM Probe, perform the post-installation procedure (see 
below) and restart the DDM Probe. If the DDM Probe is already running 
before you perform the post-installation procedure, stop it and restart it 
afterwards.

To perform the DDM Probe post-installation:

 a Download the SAP JCo package from the Tools & Services window of SAP 
JCo in SAP Service Marketplace:
https://websmp101.sap-ag.de/~form/
sapnet?_SHORTKEY=01100035870000463649 

 b Extract sapjco-ntintel-2.0.8.zip to a temporary directory (for example: 
C:\temp) on the HP Business Availability Center machine.

 c Create a new sap directory (in lowercase) in the 
<HP Business Availability Center root directory>
\DiscoveryProbe\root\ext\ directory on the machine where the DDM 
Probe is installed.

 d Copy sapjco.jar from the temporary directory to the 
<HP Business Availability Center root directory>
\DiscoveryProbe\root\ext\sap\ directory on the machine where the 
DDM Probe is installed.

 e Copy sapjcorfc.dll from the temporary directory to the 
<HP Business Availability Center root directory>
\DiscoveryProbe\root\ext\sap\ directory on the machine where the 
DDM Probe is installed.

 f Copy librfc32.dll from the temporary directory to the 
%winnt%\system32 directory.
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 g Verify that the MSVCR71.dll and MSVCP71.dll files are located in the 
%winnt%\system32 directory. 

 5 Restart the Discovery Agent
Use the following steps:

 a On the DDM Probe machine, access: Start > Programs > 
Business Availability Center > Administration > Discovery Agent

 b This starts the DDM Probe and opens a CMD console.

 c Wait until the console displays the following lines: Finished startup 
sequence
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Create Monitors 

You create a SAP CCMS monitor and general SiteScope monitors to get the 
complete picture.

This task includes the following steps:

➤ “Create a SAP CCMS Monitor” on page 146

➤ “Create General Monitors” on page 146

 1 Create a SAP CCMS Monitor
The SAP CCMS monitor retrieves and reports measurements using SAP 
centralized monitoring system CCMS. CCMS is used to monitor all servers, 
components, and resources in the SAP R/3® System from one single 
centralized server facilitating problem discovery and problem diagnosis.

For details on creating a SAP CCMS Monitor, see “SAP CCMS Monitor 
Overview” in Using System Availability Management.

SAP CCMS Monitor solution template is the most effective way to deploy a 
CCMS monitor. For details, see “Deploy a CCMS Monitor Using the 
SiteScope CCMS Solution Template” on page 136.

 2 Create General Monitors
You create general SiteScope monitors to get the complete picture. For 
example, use:

➤ Database Query monitor. For details, see “Database Query Monitor 
Overview” in Using System Availability Management.

➤ Ping monitor, and so on. For details, see “Ping Monitor Overview” in Using 
System Availability Management.
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Use a Business Process Monitor Profile to Simulate SAP 
Users

Use Business Process Monitor profiles to simulate SAP users and obtain 
performance and availability information on the SAP transactions.

You can view Business Process Steps under the SAP view to enable you to 
analyze what happens in the SAP system.

This task includes the following steps:

➤ “Create a Business Process Monitor Profile” on page 147

➤ “Select the Appropriate Protocol” on page 147

➤ “Select the Appropriate Run-Time Settings” on page 147

➤ “Edit the Script” on page 148

➤ “Synchronize the Business Process Monitoring Source Adapter” on page 149

➤ “Attach Business Process Monitor Transactions to SAP Application 
Components” on page 150

➤ “Check/View the Business Process Monitor Measurements in the SAP 
Systems View” on page 153

 1 Create a Business Process Monitor Profile
You create a business process profile in End User Management. For details, 
see “Creating Business Process Profiles and Monitors Overview” in Using End 
User Management.

 2 Select the Appropriate Protocol
In HP Virtual User Generator (VuGen), SAP scripts are recorded using the 
SAPGUI protocol. You must select the SAPGUI protocol when you create a 
new script. For details, see HP Virtual User Generator User’s Guide.

 3 Select the Appropriate Run-Time Settings
In VuGen, open the Run-Time settings window, and select the 
SAPGUI:General node. Select Show SAP client during replay and clear Take 
Active screenshots during replay to give more accurate user experience 
times. For details, see HP Virtual User Generator User’s Guide.
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 4 Edit the Script
You can edit the script to make sure the password is recorded properly and 
to check and correct the script’s connection parameters.

To edit the script:

 a Make sure the password is recorded correctly. Remove the stars and 
replace with the required password.

 b Check the script’s connection parameters and if necessary, delete the 
string that appears after the system number in the first parameter.
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The result is as follows:

 5 Synchronize the Business Process Monitoring Source Adapter
You can synchronize the Business Process Monitoring source adapter 
immediately or you can wait for the automatic synchronization to take 
place. For details, see “Source Manager Page” in Model Management.
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 6 Attach Business Process Monitor Transactions to SAP 
Application Components
To display Performance and Availability information, Business Process Steps 
must be attached to SAP transactions.

You can connect BMP transactions to a SAP transaction in two different 
ways:

➤ Follow the naming conventions for the BMP transaction names. For details, 
see “Follow the Naming Conventions for Naming Business Process Steps” on 
page 150.

➤ Do not follow the naming conventions for the BMP transaction names and 
manually link a Business Process Step to a SAP transaction. For details, see 
“Attach Business Process Steps to a SAP Transaction without Following the 
Naming Conventions” on page 151.

If you do not follow the naming conventions, be careful when deleting links 
between SAP transactions and Business Process Steps. For details, see “Delete 
Links Between SAP Transactions and Business Process Steps” on page 152.

Follow the Naming Conventions for Naming Business Process 
Steps

To logically connect Business Process Steps to a SAP transaction, the 
Business Process Step name should have the following format:
<tran_name>_ _<sys_name>_ _<BPM_tran_name>

➤ tran_name. The name of the SAP transaction to which you want to attach 
the Business Process Step.

➤ sys_name. The name of the SAP System on which the transaction is run (for 
example, MI7).

➤ BPM_tran_name. The unique name of the Business Process Step. 

Any set of alphanumeric and mixed case characters are supported (special 
characters are not allowed). It is good practice to name the transaction so 
that the name indicates what occurs in that set of dialog steps.
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Note: You assign the appropriate name to a Business Process Step when you 
record it. For details, see HP Virtual User Generator User’s Guide.

For example, the names of the Business Process Steps assigned to the SAP 
transaction VA01 in the MI7 SAP System should start with: va01_ _mi7_ 

In the SAP Systems View, a Business Process Steps node that is displayed 
under a specific SAP transaction is a container under which all relevant 
transactions are located.

It is important to split a SAP transaction into a few Business Process Monitor 
transactions so that you are able to pinpoint the problem. For example, if 
each step of the SAP transaction is a separate Business Process Monitor 
transaction, you can find the exact part of the SAP transaction where the 
problem occurs.

Attach Business Process Steps to a SAP Transaction without 
Following the Naming Conventions

If you do not want to follow the naming conventions for the Business 
Process Steps, go to System Availability Management and build a Business 
Process Monitor profile. 

You can then manually connect Business Process Steps with SAP 
transactions. Select Admin > Universal CMDB > Modeling > IT Universe 
Manager, and select SAP View in the View list. Right-click the SAP 
transaction that you want to monitor using the BPM profile and select 
Attach Related CI to open the Attach Related CIs wizard. Select one of the 
monitor views (System Monitors view or End User Monitors view) in the 
Views list. Expand and select the Business Process Step to which you want to 
connect the SAP transaction, and select the Monitored By for SAP 
relationship type, as well as the Allow CI Update option. 

For details, see “Attach Related CIs Wizard” in Model Management.
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Delete Links Between SAP Transactions and Business Process 
Steps

SiteScope measurements and Business Process Monitor transactions are 
attached under the appropriate level of the SAP hierarchy. For details, see 
“Default CIs in the SAP Systems View” on page 155.

A TQL runs in the background and returns:

➤ CCMS measurements that are not linked to SAP entities. Most of the CCMS 
measurements’ names indicate to which SAP entities they should be 
attached in the hierarchy.

➤ Business Process Monitor transactions that are not attached to a SAP and 
follow the naming convention. The name of the Business Process Monitor 
transaction indicates to which SAP entity it should be attached. 

➤ Business Process steps that are manually attached to a SAP transaction. A 
Business Process Step is automatically attached to the Business Process 
container that was created by the Business Process Step, the Business Process 
Step is monitored by SAP. For details, see “Attach Business Process Steps to a 
SAP Transaction without Following the Naming Conventions” on page 151.

If the Business Process Monitor source adapter was assigned the Transaction/
Location option, a copy of the location information is attached to the 
Locations container. For details on these types of hierarchy, see “New/Edit 
Source Adapter Dialog Box” in Model Management.
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If you delete a link between a SAP transaction and its child Business Process 
Step transaction, then the following happens:

➤ If you followed the naming convention for the Business Process Step 
transaction, the link between the SAP transaction and its child Business 
Process Step is automatically recreated at the next synchronization.

➤ If you did not follow the naming convention and created a manual link 
between the SAP transaction and a Business Process Step transaction, then 
when you delete the link:

➤ If the Business Process Monitoring source adapter was assigned the 
Transactions/locations option, the Location container is not deleted. 

You can manually delete it. Delete the Location container only if the 
deleted Business Process Step transaction is the only CI attached to this 
location. If other Business Process Step transactions are attached to this 
location, delete only the links between the Business Process Monitor 
(BPM transaction from location) and the Location container.

➤ If the Business Process Monitoring source adapter was assigned the 
Regular option, the Business Process container is not deleted. You must 
manually delete the links between the Business Process container and the 
detached Business Process Step transaction.

For details about the Transactions/locations or Regular options, see “New/
Edit Source Adapter Dialog Box” in Model Management.

 7 Check/View the Business Process Monitor Measurements in the 
SAP Systems View
You can view the Business Process Measurement in the SAP Systems view in 
different locations in the SAP hierarchy. For details, see “Business Process 
Monitor Measurements in SAP Systems View – Details” on page 118.
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Display SAP Information in Dashboard

You can display SAP information in Dashboard using one of the following 
views or reports:

➤ View SAP data in Dashboard. For details, see “SAP Systems View” on 
page 126.

➤ View the CIs affected by a root cause CI. Select a CI, which is defined by a 
correlation rule as a root cause CI, and to display all of the CIs that are 
affected by it. For details, see “Show Impact Report” on page 162.

➤ View the root cause CIs. Retrieve root cause information for CIs that are 
affected by a chain of correlation rules. For details, see “Troubleshooting and 
Limitations” on page 172.

➤ View Changes Made to SAP System CIs. Changes made to the properties of 
all types of CIs are discovered by different types of discoveries. For details, 
see Performing a SAP Discovery in Application Administration. Those 
changes are displayed in the Change report available as a right-click menu 
option for each one of the relevant CI types. For details, see “Change Report 
Page” in Model Management.

Some of the changes made to the SAP Transactions CIs are caused by the 
corresponding Transport CIs. Those specific changes are processed by 
correlation rules in discovery and are displayed in the SAP Transaction 
Changes report and the SAP Transport Changes report:

➤ Display a SAP Transaction Changes report. The report displays and track 
changes made to a SAP Transaction CI when a transport was discovered. 
For details, see “SAP Transaction Changes Report” on page 166.

➤ Display a SAP Transport Changes report. The report includes the 
transports discovered in the past week, the changes that are included in 
each transport, and under each change the SAP transaction that is 
impacted by this change. For details, see “SAP Transport Changes Report” 
on page 169.
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➤ Display Configuration File, Software Component File, and Support Package 
File Information. You can display additional information for specific CIs:

➤ Configuration File information. For details, see “Configuration File Page” 
on page 161.

➤ Software components file information. For details, see “Software 
Components File Information” on page 163.

➤ Support packages file information. For details, see “Support Packages File 
Information” on page 164. 

You can also access this information by selecting Admin > Universal CMDB 
> Modeling > IT Universe Manager > Properties. For details, see “Properties 
Dialog Box” in Model Management.

Reference

Default CIs in the SAP Systems View

The SAP System CIs are listed in the following table:

CI Type (A-Z) Description

Application Gateway An Internet Transaction Server (ITS) component.

The CI establishes the connection to the R/3 System 
and performs the processing of tasks that are required 
to move data between R/3 applications and the 
Internet.

BPM Monitor Represents Business Process Monitor entities.

Business Process Step These CIs (BPM transactions inside a script) are 
emulated SAP transactions executed on a Business 
Process Monitor machine. They are used to supply 
proactive monitoring of end user experience.

Business Processes A logical container that contains all of the Business 
Process steps attached to all of the SAP transactions.

CCMS Counters These CIs (also called Measurements) are  information 
elements, relevant to SAP, retrieved from SAP CCMS 
(Computer Center Management System).
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Client An organizational and legal CI in the SAP system. The 
main objective of the client is to keep the data isolated. 
The data in a client can only be visible within that 
client; it cannot be displayed or changed by another 
client. Each client on a system can represent a unique 
working environment.

Configuration File The system/servers configuration parameters.

Contained Locations These CIs are created as part of the Business Process 
Monitor hierarchy when working with the 
Transactions/locations option.

Database A database management system holding the data tier, 
including all of the SAP elements: SAP transactions, 
programs, work processes, and so on. This is not a 
SAP-specific CI.

Hosts A logical unit, grouping together Host CIs.

A Host CI represents the physical machine on which a 
server is installed. This is not a SAP-specific element.

Locations A logical unit, grouping together Contained Locations 
CIs.

To separate the SAP Business Process steps locations 
status from the Location CI (from the Business Process 
Monitor), the Contained Locations CIs are created by 
the SAP solution and are connected to the SAP Business 
Process steps (identified by following the naming 
convention or by manually linking them).

The regular Location CI is connected to all Business 
Process steps both regular and SAP, but the Contained 
Location CI is connected only to the SAP Business 
Process steps.

The Locations information represents the locations 
specified in Admin > Universal CMDB, select the CI and 
click the Properties tab, locate the Location Name 
property.

CI Type (A-Z) Description
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Monitor SiteScope entities used to monitor the various CIs that 
exist in the CMDB. The monitors that are most likely 
to appear in the SAP view are host monitors: CPU, 
memory, disk space, and so on. These monitors appear 
in the SAP view only if they are manually attached to 
the Host CI.

R/3 Application 
Server

SAP R/3 Application Server is SAP’s integrated software 
solution for client/server and distributed open systems. 

R/3 Application servers and databases are displayed 
under Hosts. You can also have several levels of hosts 
under the Hosts CI, SiteScope Monitor CIs, and CCMS 
Monitor CIs.

SAP Application 
Component

May include other SAP Application Components and 
some SAP transactions with some common 
denominator.

SAP Applications A logical unit, grouping together Application 
Components.

SAP System A logical unit, grouping together SAP-related CIs (and 
possibly other CIs as well) into one homogeneous SAP 
deployment. 

SAP Transaction Part of a business process defined in the SAP System. It 
is comprised of request-response couples called dialog 
steps. The end user uses SAP transactions to carry out 
actions on the SAP System.

Software Component Represents a software component installed on the SAP 
System, for example: SAP_ABA (cross-application 
component), SAP_HR (human resources), and so on.

Solution Manager 
Projects

Includes SAP Business Project CIs, SAP Scenario CIs, 
SAP Business Process CIs, and SAP Business Process Step 
CIs. Solution Manager Projects hierarchy is specified by 
the user in SAP Solution Manager.

Support Package Contains quality improvements for the SAP system, or 
adjustments due to legal changes.

CI Type (A-Z) Description
157



Chapter 2 • HP Business Availability Center for SAP Applications
Transports Represents packaged change requests that include the 
changes that are to be deployed onto the system. 

Web Gateway An Internet Transaction Server (ITS) component. A web 
server extension that establishes the connection 
between ITS and the Web server and forwards user 
requests to the Application Gateway.

Work Processes A logical, single-instance representation of all of the 
work processes of the same type existing on the R/3 
server.

Several types of work processes are available:

➤ Dialog Work Process. Executes dialog programs 
(ABAP).

➤ Update Work Process. Responsible for asynchronous 
database changes (controlled by a COMMIT WORK 
statement in a dialog work process).

➤ Update2 Work Process. Used for statistical, 
non-critical updates (for example, result 
calculations).

➤ Background Work Process. Executes time-dependent 
or event-controlled background jobs.

➤ Enqueue Work Process. Executes locking operations 
(if SAP transactions have to synchronize 
themselves).

➤ Spool Work Process. Performs print formatting (to 
printer, file, or database).

CI Type (A-Z) Description
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SAP-Related KPIs

Different Key Performance Indicators (KPIs) are displayed depending on the 
selected CI. For details about the displayed KPIs, see “Default CIs in the SAP 
Systems View” on page 155.

The following table lists the SAP-related KPIs displayed in the Console tab:

The other KPIs displayed in the views are not SAP-related. For more details 
about those KPIs, see “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.

GUI Element (A-Z) Description

SAP The SAP KPI indicates problems related to the SAP 
infrastructure that are reported by CCMS.

Transactions At the group level, displays the worst status of all of the 
child CIs. 

At the monitor level, displays the worst status of the 
Performance and Availability KPIs for the CI. 

Locations At the group level, displays the worst status of all of the 
child CIs.

At the monitor level, displays the worst status of the 
Performance and Availability KPIs for the CI. 
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SAP-Related Menu Options

A list of all of the context menu options available in the SAP Systems view is 
available in “Customize Dashboard Display and Refresh Rate” in Using 
Dashboard.

Different menu options are available depending on the type of CIs:

HP Business Availability Center for SAP Applications User 
Interface

This section describes:

 ➤  Configuration File Page on page 161

 ➤  Show Impact Report on page 162

 ➤  Software Components File Information on page 163

 ➤  Support Packages File Information on page 164

 ➤  Problem Isolation Report on page 165

 ➤  SAP Transaction Changes Report on page 166

 ➤  SAP Transport Changes Report on page 169

Context Menu Option Type of CI

Show Impact All SAP-specific CI types

Problem Isolation All SAP-specific CI types

SAP Transport Changes Report SAP System and SAP Transports CIs

SAP Transaction Changes Report SAP System and SAP Transaction CIs
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Configuration File Page

Description Displays the contents of the configuration file. Details 
about the SAP configuration file are provided in the 
SAP product documentation.

To Access: Right-click a Configuration File CI in the 
SAP Systems View, select Properties, and click Show 
document content. 
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Show Impact Report

Description Enables you to display all of the CIs that are affected by 
the selected CI, which is defined as a root cause by a 
correlation rule. The report also displays the CI’s 
statuses. 

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
Show Impact. 

Important 
Information

For details about correlation rules, see “Correlation 
Manager” in Model Management.

Included in Tasks “Display SAP Information in Dashboard” on page 135
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Software Components File Information

GUI Element (A-Z) Description

Indicates the root cause CI.

Indicates a CI that is part of the correlation rule, but is 
neither the root cause CI nor an affected CI. 

Indicates an affected CI.

Description Displays the contents of the software components file. 

To Access: Right-click a Software Component CI in the 
SAP Systems View, select Properties, and click Show 
document content. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Support Packages File Information
.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Description The description of the package.

Name The name of the software component.

Package Level The level of the package.

Release The release number.

Description Displays the contents of the support packages file. 

To Access: Right-click a Support Package CI in the SAP 
Systems View, select Properties, and click Show 
document content. 

GUI Element (A-Z) Description

Description The description of the package.

Name The name of the support package.

Type The type of support package.
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Problem Isolation Report

Description Enables you to retrieve root cause information for CIs 
that are affected by a chain of correlation rules. The 
report displays a logical map that describes a chain of 
trigger/affected CITs that affect the CI.

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
Problem Isolation. For details, see “Customize 
Dashboard Display and Refresh Rate” in Using 
Dashboard.

Included in Tasks “Display SAP Information in Dashboard” on page 135

Important 
Information

For details about correlation rules, see “Correlation 
Manager” in Model Management.

GUI Element (A-Z) Description

<Relationship> The relationships represent the Correlation rule you 
defined in Correlation Manager. For details, see 
“Correlation Definition Dialog Box” in Model 
Management.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that were defined in the 
severity list for that state in System Type Manager. For 
details, see “Create/Update List/Enumeration 
Definition Dialog Box” in CI Attribute Customization.
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SAP Transaction Changes Report
166



Chapter 2 • HP Business Availability Center for SAP Applications
SAP System Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to display and track changes made to a 
SAP Transaction CI when a transport was discovered. 
The SAP Transaction Change report displays 
information about the SAP systems with changed 
transactions, and under each transaction the SAP 
transports that have changed during the past week 
(you can modify the default).

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
SAP Transaction Changes report. 

For details, see “Customize Dashboard Display and 
Refresh Rate” in Using Dashboard.

Included in Tasks “Display SAP Information in Dashboard” on page 135

GUI Element (A-Z) Description

Name The name of the SAP system with a new transaction.
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SAP Transaction Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

SAP Transport Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Devclass The development class that includes the transaction.

Name The name of the SAP transaction that has changed.

Program The name of the program that runs the transaction.

Program Version The version of the program that runs the transaction.

Screen The first screen that opens when you load the 
transaction.

GUI Element (A-Z) Description

Creation Date The date when the transport was created.

Description The description of the transport.

Name The name of the transport that has changed.

Target System The target system for non-local transport.

User The name of the user who created the transport.
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SAP Transport Changes Report

Description The table displays information about the SAP systems 
with the transports discovered during the past week 
(this default is configurable), for each transport the 
changes that are included in the transport, and for 
each change, the SAP transaction that is impacted by 
this change.

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
SAP Transaction Changes report. 
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SAP System Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

Customization: 

➤ By default, transports that are older than a month 
are automatically deleted from the CMDB. To 
modify the default, select Admin > Universal CMDB 
> Modeling > Enrichment Manager, expand SAP, 
select TQL, right-click SAP_Old_Transports in the 
map, and select Node conditions. Access the 
Attribute condition dialog box, assign the required 
condition for the Actual Delete Time - (date) 
attribute. 

➤ You can configure the time period during which the 
transport discovery takes place. Select Admin > 
Universal CMDB > Modeling > Report Manager, 
expand SAP, right-click SAP_Transports in the map, 
and select Node conditions. Access the Attribute 
condition dialog box, assign the required condition 
for the Last Access Time - (date) attribute. 

Included in Tasks “Display SAP Information in Dashboard” on page 135

GUI Element (A-Z) Description

Name The name of the SAP system.
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SAP Transport Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

SAP Transport Change Level Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Creation Date The date when the transport was created.

Description The description of the transport.

Name The name of the transport that has changed.

Target System The target system for non-local transport.

User The name of the user who created the transport.

GUI Element (A-Z) Description

Devclass The development class that includes the transaction.

Name The real name of the transaction.

Object Name The change that was made.

Object Type The object that changed.

Program The name of the program that runs the transaction.

Program Version The version of the program that runs the transaction.

Screen The first screen that opens when you load the 
transaction.

Title The name of the transaction followed by (SAP 
Transaction).
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Troubleshooting and Limitations

This section provides information that can help troubleshoot problems that 
may occur when working with HP Business Availability Center for SAP 
Applications.

This section includes the following topics:

➤ “The SAP KPI Remains Uninitialized” on page 172

➤ “CCMS Does Not Manage to Monitor a SAP System” on page 173

➤ “The Performance and Availability KPIs Remain Uninitialized” on page 173

➤ “SAP Business Process Monitor Scripts Do Not Execute” on page 174

➤ “Unable to Log Into HP Business Availability Center” on page 174

➤ “Limitations” on page 175

The SAP KPI Remains Uninitialized
If the SAP KPI remains uninitialized, check the following solutions in the 
order listed below:

 1 Make sure the SAP CCMS monitor is set to send samples to HP Business 
Availability Center in the monitor’s Logging to HP Business Availability 
Center property in System Availability Management.

 2 Check the following file to ensure that the samples arrive to the Business 
Logic Engine:
<HP Business Availability Center root 
directory>\log\EJBContainer\TrinitySamples.log

 3 Check that the samples arrive to the bus in the following file:
<HP Business Availability Center root directory>\log\core\
dispatcher_log.txt

 4 Check that the samples are sent in the following file:
<SiteScope root directory>\logs\topaz_all.log.1

 5 If you see values in the measurements' KPIs that are not colored, check the 
threshold definition in System Availability Management.
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 6 Restart SiteScope, detach it, and reattach it.

 7 Check time synchronization between HP Business Availability Center and 
its management database.

CCMS Does Not Manage to Monitor a SAP System
If CCMS does not manage to monitor a SAP System, check the following 
solutions in the order listed below:

 1 If you are able to connect to the SAP System using SAP Logon, run the rz20 
transaction.

 2 Open SAP CCMS Monitor Templates > Entire System, and check if a tree is 
displayed.

➤ If there is no tree, there might be a problem with the job that is 
collecting CCMS information. Contact your SAP administrator.

➤ If there is a tree, check that the names of the application server and of 
the system match, in content and case, the ones used in SiteScope.

The Performance and Availability KPIs Remain 
Uninitialized
If the Performance and Availability KPIs remain uninitialized, check the 
following solutions in the order listed below:

 1 Check that the samples arrive, in the file:
<HP Business Availability Center root 
directory>\log\EJBContainer\TrinitySamples.log

 2 Try and run Business Process Monitor as a specific user.

 3 Check time synchronization between HP Business Availability Center and 
its Management database.

 4 Check the minute’s synchronization between Business Process Monitor and 
HP Business Availability Center.
173



Chapter 2 • HP Business Availability Center for SAP Applications
SAP Business Process Monitor Scripts Do Not Execute
If the SAP Business Process Monitor scripts do not execute, check the 
following solutions in the order listed below:

 1 Verify that SAP Logon is installed on the Business Process Monitor server.

 2 Check that the SAP Business Process Monitor scripts run in HP Virtual User 
Generator (VuGen) and check the script’s connection parameters. For 
details, see “Edit the Script” on page 148.

 3 Register DLLs under <Business_Process_Monitor_install_directory>\bin, as 
follows:

➤ regsvr32 SapGuiActiveScreen.dll

➤ regsvr32 SapGuiReplayEvents.dll

➤ regsvr32 ActiveScreen.dll

Unable to Log Into HP Business Availability Center
If you are unable to log into HP Business Availability Center, check the 
following solutions in the order listed below:

 1 Check that the last line in the following file:
<SiteScope root directory>\log\jboss_boot.log
displays the following information: JBoss .... started in ...

 2 If you are able to connect using port 8080 explicitly, give the Read and 
Execute permission to Everyone for the following DLLs in 
<Windows installation directory>\System32:

➤ msvcr71.dll

➤ msvcp71.dll

➤ mfc71.dll

➤ atl71.dll
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 3 If SiteScope is installed on the same machine as HP Business Availability 
Center, check that HP Business Availability Center is already running before 
you start SiteScope.

Note: It is not recommended to install HP Business Availability Center and 
SiteScope on the same machine.

Limitations

➤ An existing Business Process Monitor machine can be leveraged for running 
SAP scripts as well.

➤ The SAP CCMS Monitor is an optional SiteScope feature whose license is 
provided with the SAP solution.

➤ You must have a SAP license to view the SAP_Systems view in HP Business 
Availability Center.

➤ Transports that are older than a month are automatically deleted from the 
CMDB. The default is configurable.
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HP Business Availability Center for Siebel 
Applications 

This chapter describes the HP Business Availability Center for Siebel 
Applications solution.

This chapter includes:

Concepts

 ➤  HP Business Availability Center for Siebel Applications – Overview 
on page 180

 ➤  Diagnostics Tools on page 182

 ➤  License on page 186

 ➤  Architecture on page 187

 ➤  Working with Firewalls on page 188

 ➤  Siebel Monitors on page 189

 ➤  The Siebel Service on page 190

 ➤  Siebel Views on page 191

Tasks

 ➤  Deploy HP Business Availability Center for Siebel Applications – Workflow 
on page 194

 ➤  Configure HP Business Availability Center for Siebel Applications 
on page 211

 ➤  Verify Diagnostics-Related Settings on page 212

 ➤  Delete Links Between Siebel Applications and Business Process Steps 
on page 216
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 ➤  Deploy the SiteScope Siebel Monitors on page 216

 ➤  Display Siebel Information in Dashboard on page 225

 ➤  Create Customized Deployment Validator Tests on page 228

 ➤  Customize HP Business Availability Center for Siebel Applications 
on page 230

Reference

 ➤  Context Menu Options on page 232

 ➤  Default CITs in the Siebel View on page 234

 ➤  HP Business Availability Center for Siebel Applications User Interface 
on page 237

Troubleshooting and Limitations on page 274
Concepts

HP Business Availability Center for Siebel Applications – 
Overview

HP Business Availability Center for Siebel Applications, integrating 
SiteScope, Business Process Monitor, and HP Universal CMDB, enables you 
to gain visibility and control over your mission-critical Siebel applications.

The Siebel solution provides:

➤ A single operation console consolidating all Siebel monitoring information. 

➤ Automatic discovery and modeling of Siebel-related elements, as well as 
their relationships to other systems in the organization’s Information 
Technology (IT) department.

➤ Change discovery and notification for quicker problem resolution. 

➤ Proactive monitoring of end-user experience in Siebel enterprises. 

➤ The ability to distinguish between Siebel-specific problems and general 
ones.

➤ Management of Siebel-related service level commitments. 
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Note: You must have an HP Business Availability Center for Siebel 
Applications license to view the Siebel Enterprises view in HP Business 
Availability Center.

HP Business Availability Center for Siebel Applications consolidates Siebel 
components and business processes in the Siebel Enterprises view to gain 
real-time visibility over the entire Siebel infrastructure from a business 
perspective.

HP Business Availability Center for Siebel Applications also monitors, 
reports, and issues alerts on the performance and functionality of the Siebel 
eBusiness applications and servers that comprise your Siebel Enterprise 
business process infrastructure. 

Using HP Business Availability Center for Siebel Applications, your IT 
operation can analyze how each link in the Siebel Enterprise chain is 
affecting the user experience of customers, partners, suppliers, and 
employees. This enables your IT team to more accurately assess the resulting 
impact on business performance. It also enables the IT team, Siebel 
application support team, and Siebel Expert Services to take any steps that 
might be necessary to maximize availability, performance, and service levels 
to provide quality of service for all Siebel applications and end users.

The Siebel Enterprises view is available in the Dashboard. For details, see 
“View Configuration File CI – Details” on page 227.

Right-click the CIs in the Siebel Enterprises view to access additional 
information and diagnostics tools. For details on the context menu, see 
“Context Menu Options” on page 232. For details on the diagnostics tools, 
see below.

In addition, you can create SLAs centered around your HP Business 
Availability Center for Siebel Applications Siebel Application CIs to gain 
visibility into performance or availability issues that affect these SLAs. For 
details about SLAs, see “Service Level Management - Overview” in Using 
Service Level Management. 
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Diagnostics Tools

You access the HP Business Availability Center for Siebel Applications 
information from the Applications menu. The following diagnostics tools 
are available:

This section includes the following topics:

➤ “SARM - User Trace Breakdown” on page 182

➤ “Database Breakdown Diagnostic” on page 184

➤ “Tasks Diagnostic Tool” on page 185

➤ “Siebel Processes Tool” on page 185

SARM - User Trace Breakdown
The Siebel SARM - User Trace Breakdown tool enables you to view Siebel real 
user monitoring information. The diagnostic tool processes the data in the 
User Session Trace output files produced by Siebel Application Response 
Measurement (SARM) process. 

This data can be retrieved for a specific user in a specific time frame. It can 
also be retrieved for a specific transaction of a prerecorded script. For details, 
see “SARM - User Trace Breakdown (Run the Diagnostics Tool) Page” on 
page 241 and “SARM - User Trace Breakdown Dialog Box” on page 244 or 
“Siebel Views” on page 191.

The tool records logs for each Siebel transaction activity in the Web server or 
in the application server. It also records data about how long each 
transaction remains in each tier of the Siebel enterprise: Network, Web 
Server, Application Server, and Database. Siebel SARM tool logs Siebel real 
user monitoring data into binary SARM files (with .sarm extension). The 
transaction activity itself is written into the .sarm files.

HP Business Availability Center interacts with SARM Analyzer (a Siebel tool) 
using remote API calls to SiteScope. These calls activate a batch file, which 
copies files from Siebel, and then uses the SARM Analyzer to generate 
user-readable files from the Siebel files. The user-readable files are then 
copied using SiteScope remote API to HP Business Availability Center.
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The SARM - User Trace Breakdown diagnostic tool is built over the Siebel's 
SARM tool. It produces required CSV and XML files as part of the analysis 
process, in which the Siebel SARM Analyzer package is utilized. The tool also 
analyzes and displays a graphical view of the results. It retrieves the SARM 
data for a specific user, in a specific time frame. It enables retrieving the 
SARM data for a specific Business Process Monitor transaction that belongs 
to a prerecorded script with Siebel breakdown enabled.

In the SARM - User Trace Breakdown tab, you can compare this breakdown 
per user sessions, user transactions, or application servers to enable you to 
identify the prime suspect for performance problems. You can also drill 
down within these logs to determine which layer is responsible for the slow 
response.

The SARM - User Trace Breakdown diagnostic tool is activated on demand. 

Note: The Virtual User Generator script must be recorded using the Siebel 
Web protocol. Select the Enable Siebel Breakdown check box while 
configuring the Business Process Monitor in System Availability 
Management. For details, see “Edit Transaction Monitor Page” in Using End 
User Management.

Details about how to use the SARM - User Trace Breakdown diagnostics tool 
are provided in the “SARM - User Trace Breakdown (Run the Diagnostics 
Tool) Page” on page 241.
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Database Breakdown Diagnostic
The Siebel Database Breakdown diagnostics tool enables you to determine 
the cause of slow database response time by analyzing the database activity 
carried out as a result of running a Business Process Step and to extract 
comprehensive information regarding database time spent by various SQLs. 
The database activity is logged into database logs created on the Siebel 
application server. 

You analyze Siebel database SQL activity by examining information in the 
Siebel application server logs. These logs contain a record of SQLs carried 
out as a result of Siebel components activity.

Logs are constantly created and updated on the Application Server. 
However, most of the time they are only logging errors, and do not include 
the extensive information that Database Breakdown can display. To log the 
extensive database time distribution information, the log level needs to be 
brought up.

When the user runs Database Breakdown, after defining the analysis' scope 
(Siebel Enterprise, Application, Business Process Step, and so on, Business 
Availability Center for Siebel Applications automatically increases (through 
SiteScope) the database log level for the selected component (if a specific 
component was selected). 

Then, Business Availability Center for Siebel Applications instructs the 
Business Process Monitor to run the transaction you selected. During the 
transaction run, as a result of the higher log level, database-related 
information is written into the application server log. 

When the transaction has finished running, the database log level for the 
selected component is returned to normal by HP Business Availability 
Center for Siebel. 

For details, see “Siebel Database Breakdown Configuration Report” on 
page 259 and “Siebel Database Breakdown Analysis Report” on page 262.
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Tasks Diagnostic Tool
The Siebel tasks diagnostic tool enables you to view details of the Siebel 
Application Server tasks, for each monitored Siebel Enterprise. For details, 
see “Siebel Views” on page 191.

Using the Siebel Tasks Diagnostics tool, you can:

➤ Retrieve details of the Siebel Application Server tasks that are running, or 
were run, on each Siebel Enterprise

➤ Choose to view details of all tasks, regardless of status, or details of only 
these tasks with a specific status

➤ Choose to view task details for all components in all component groups on 
all Siebel Application Servers, or for specific components in specific 
component groups on specific Siebel Application Servers

For details, see “Tasks Diagnostics Tool Report” on page 271 and “Tasks 
Diagnostics Tool - Advanced Filter Dialog Box” on page 273.

Siebel Processes Tool 
The Siebel Processes Diagnostic tool enables you to view details of the 
operating system processes running on the various Siebel Application 
Servers, for each monitored Siebel Enterprise. For details, see “Siebel Views” 
on page 191.

To ensure that Diagnostics tools work properly, check the 
Diagnostics-related settings. For details, see “Verify Diagnostics-Related 
Settings” on page 212.

Using SiteScope, you can retrieve details of the Siebel Application Server 
processes that are running, or were run, on each Siebel Enterprise. You can 
view the details of all processes, regardless of status, or you can view only 
the processes with a specific status. Similarly, you can choose to view process 
details for all components in all component groups on all Siebel Application 
Servers, or for specific components in specific component groups on specific 
Siebel Application Servers.
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When an application has performance/availability issues, you may use the 
Siebel Processes tool to verify that all Siebel processes are up and running 
and that none of the processes is using 100% CPU.

For details, see “Processes Report” on page 238 and “Processes Tool - 
Advanced Filter Dialog Box” on page 240.

License

The HP Business Availability Center for Siebel Applications license unlocks 
the following functionality in HP Business Availability Center, helping to 
shorten time-to-value and MTTR:

➤ The Siebel Enterprises pattern view, displaying a hierarchical view of Siebel 
applications and infrastructure.

➤ Automatic linkage of Business Process Monitor transactions to the Siebel 
transactions they are monitoring.

➤ Automatic linkage of SiteScope measurements to their respective Siebel 
infrastructure.

➤ Siebel-specific KPIs that allow differentiation between Siebel-related issues 
and non-Siebel ones.

➤ Siebel diagnostics – SARM, Database Breakdown, Tasks, Processes – for 
in-depth, in-context data on the Siebel environment.
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Architecture

The architecture of HP Business Availability Center for Siebel Applications is 
illustrated in the following diagram: 

Most of the Siebel CIs are created by automatic discovery. The configuration 
for these CIs is saved into the CMDB. Some of the relationships to Business 
Process Monitor and SiteScope CIs are created by automatic mechanisms 
specific to the HP Business Availability Center for Siebel Applications.

The architecture of the Business Availability Center for Siebel Applications 
solution includes the following components:

➤ The DDM Probe discovers Siebel-related CIs and other CIs (such as hosts) 
that are related to them. 

➤ The Real User Monitor Probe monitors real user traffic and sends it to the 
Real User Monitor engine, that processes and stores it.
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➤ SiteScope communicates with the Siebel Enterprise system and retrieves 
system monitoring information using the srvrmgr CLI tool. It is also used as 
a middleware for all of the Siebel diagnostics tools.  

➤ Business Process Monitor collects data on the performance and availability 
of the Siebel Enterprise by running transactions that correspond to Business 
Process Steps. It is also used for Database Breakdown, and can be leveraged 
in SARM; for example, user sessions can be correlated to the corresponding 
Business Process Monitor transactions.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Using 
Dashboard” in Using Dashboard.

Working with Firewalls

To work with firewalls, you must install a firewall with a Virtual Private 
Network (VPN) between:

➤ HP Business Availability Center and the Business Process Monitor to view 
Siebel Application Response Measurement (SARM) - user trace breakdown 
and/or database breakdown information.

➤ HP Business Availability Center and SiteScope to view all diagnostics 
information.
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The following diagram illustrates a possible deployment involving firewalls:

Siebel Monitors

The SiteScope monitors used to monitor Siebel are:

➤ Siebel Application Server. Uses Siebel Server Manager client to monitor all 
aspects of Siebel application servers. For details about the monitor, see 
“Siebel Application Server Monitor Overview” in Using System Availability 
Management.

➤ Siebel Web Server. Watches Siebel server login session statistics and gauges 
the performance of Siebel Server Object Managers and database. For details 
about the monitor, see “Siebel Web Server Monitor Overview” in Using 
System Availability Management.
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➤ Siebel Log Monitor. Monitors the Siebel log files by searching for entries 
containing a specific event type or subtype. For details about the monitor, 
see “Siebel Log File Monitor Overview” in Using System Availability 
Management.

These monitors must be deployed. For details, see “Deploy the SiteScope 
Siebel Monitors” on page 216.

The Siebel Service

The Siebel Service is a configuration service that provides the following 
advantages:

➤ Automatic linkage of SiteScope measurements to the relevant CIs based on 
measurement name.

➤ Automatic linkage of Business Process Steps with standardized names to the 
application they are monitoring. For details, see “Specify a Transaction/
Location or Regular Hierarchy in the Business Process Monitor Source 
Adapter” on page 208.

➤ Creation of a Business Process and Locations container and connection of 
the Business Process Steps monitoring Siebel, and their respective locations, 
to the containers. For details, see “Specify a Transaction/Location or Regular 
Hierarchy in the Business Process Monitor Source Adapter” on page 208.

The Siebel Service starts working after BPM source adapters and SiteScope 
source adapters (if you are working with SiteScope 9.0) have been 
synchronized.

For details about how to view a service status with the JMX Web console, see 
“High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF.

The Siebel Service must be activated. For details, see “Check If the Siebel 
Service Is Activated” on page 220.
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Siebel Views

The Siebel Enterprises view is enabled by default; the other Siebel views 
must be enabled before they are displayed.

In Dashboard, access the Siebel Enterprises view to view information about 
the Siebel IT entities, the Siebel enterprise metrics monitored by SiteScope 
monitors, and information about the Siebel business processes/transactions 
simulated by Business Process Monitor scripts.

The Siebel Enterprises view appears as follows:
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The following graph describes the various layers and drill-downs available in 
the topology of the Siebel Enterprises view. 

Note: The CIs, their hierarchy, and their KPIs are detailed in “Default CITs in 
the Siebel View” on page 234.

The Siebel Topology and Siebel Web Topology views are created when you 
run the discovery job. They display the results of the Siebel discovery and 
are intermediate views whose information is included in the Siebel 
Enterprises view.
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The Siebel Service uses the Siebel BPM Locations Linkage, Siebel BPM 
Locations Linkage Automatic, Siebel BPM Locations Linkage Manual, Siebel 
Host Monitor Linkage, and Siebel SiteScope Measurement Linkage views to 
automatically link measurements and monitors to CIs. These views are used 
for debugging purposes.

In addition, the Siebel Enterprises view includes the following topologies, 
which are created by specific SiteScope monitors:

➤ Siebel Application Server topology discovered by SiteScope:

SiteScope creates the following topology for the SiteScope Siebel Application 
Server monitor. The CIs are created only for the monitored entities 
according to the counters that you selected.
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➤ Siebel Web Server topology discovered by SiteScope:

SiteScope creates the following topology for the SiteScope Siebel Web Server 
monitor. The CIs are created only for the monitored entities according to 
the counters that you selected.

Tasks

Deploy HP Business Availability Center for Siebel 
Applications – Workflow

This section describes the processes to follow to view Siebel data in 
Dashboard, and gives examples.

This task includes the following steps:

➤ “Prerequisites” on page 195

➤ “Check the Siebel License in HP Business Availability Center” on page 197

➤ “Check the Siebel License in SiteScope” on page 197

➤ “Deploy the Siebel Monitoring Package” on page 197

➤ “Copy the srvrmgr Tool to the DDM Probe Server” on page 198
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➤ “Copy SARM Analyzer and srvrmgr Tool to the SiteScope Server” on 
page 198

➤ “Perform Discovery” on page 198

➤ “Configure Specific Siebel CIs Manually” on page 198

➤ “Change the Business Process Monitor Hierarchy Structure to Transactions/
Locations” on page 198

➤ “Configure HP Business Availability Center for Siebel Applications” on 
page 285

➤ “Activate The Siebel Service” on page 199

➤ “Modify SiteScope KPI Assignment Group” on page 199

➤ “Configure HP Business Availability Center for Siebel Applications” on 
page 199

➤ “Check That the Deployment Was Successful” on page 199

➤ “Display Siebel Information in Dashboard” on page 200

 1 Prerequisites
Ensure that the following software is installed before you install the 
HP Business Availability Center for Siebel Applications:

➤ Requirements. The requirements are as follows:

➤ Siebel 7.5.3, 7.7, or 7.8

➤ SiteScope 8.5

Note: 

SiteScope monitors are not tested for SiteScope UNIX installation.

If the SiteScope machine is located outside the HP Business Availability 
Center LAN, you must configure the Virtual Private Network (VPN) to 
enable SiteScope to communicate with the HP Business Availability Center 
Gateway Server. 
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➤ Business Process Monitor 4.5.2 or later

➤ DDM Probe 6.5

➤ The version of the Siebel Application Response Measurement Analyzer 
(SARM) package that is appropriate for the Siebel version you have 
installed. If you are working with SARM in Siebel version 7.8, use SARM 
Analyzer for Siebel version 7.7.

➤ The Siebel Server Manager version that is appropriate for the Siebel 
version you have installed. 

➤ Support Matrix. 

The support matrix for HP Business Availability Center for Siebel 
Applications is as follows:

➤ DDM Probe. Used to perform the discovery of Siebel topology in your 
organization. For details, see Discovery and Dependency Mapping Guide.

➤ SiteScope. Used to integrate the SiteScope data collector into the 
HP Business Availability Center for Siebel Applications. For details, see the 
HP SiteScope Deployment Guide PDF. 

Siebel Version 
Solaris Operating System Version (on 
the Siebel Servers) 

Windows Operating 
System Version (on 
the Siebel Servers) 

Siebel 7.5.3 ➤ Solaris 5.9 - Supported not tested 

➤ SARM on mixed environment - 
Not supported 

Windows 2000 

Siebel 7.7 Solaris 9 Windows 2000 

Siebel 7.8 

(to work with 
SARM you 
must use 
SARMAnalyzer 
version 7.7)

Solaris 9 - Supported not tested Windows 2000 
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➤ Business Process Monitor. Used to integrate the Business Process Monitor 
data collector into the HP Business Availability Center for Siebel 
Applications. For details, see HP Business Process Monitor Administrator’s 
Guide.

➤ Siebel. Install the applications you want to integrate into HP Business 
Availability Center. For details, see the Siebel documentation.

➤ Optional - Real User Monitor. Required to integrate the Real User Monitor 
Probe to monitor real user traffic and sends it to the RUM engine, that 
processes and stores it. For details, see “Real User Monitor Administration” 
in Using End User Management.

 2 Check the Siebel License in HP Business Availability Center
Check that the appropriate Siebel licenses are set in HP Business Availability 
Center:

➤ The license for running the HP Business Availability Center for Siebel 
Applications.

➤ The license to enable the necessary amount of Business Process 
transactions to run.

To check that the licenses are set properly or to update the licenses, select 
Admin > Platform > Setup and Maintenance > License Management. 

 3 Check the Siebel License in SiteScope
Check that the license that enables the definition of SiteScope Siebel 
monitors and deployment of Siebel solution templates is set properly in 
SiteScope. For details, see “Siebel Solution Templates” in Using System 
Availability Management.

 4 Deploy the Siebel Monitoring Package
Deploy the Siebel Monitoring package. For details, see “Package Manager” in 
Model Management.
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 5 Copy the srvrmgr Tool to the DDM Probe Server
The srvrmgr tool is used to extract data about the enterprise's structure from 
Siebel. To copy the srvrmgr tool to the DDM Probe server, copy the srvrmgr 
Command Line Interface (CLI) tool from the Siebel server to any folder on 
the DDM Probe server. It is recommended to run the Siebel connection test 
to validate the srvrmgr installation. For details, see“Copy the srvrmgr Tool 
to the DDM Probe Server” on page 202.

 6 Copy SARM Analyzer and srvrmgr Tool to the SiteScope Server
On SiteScope, the srvrmgr tool is launched by the Siebel Application Server 
monitor and is used to get the metrics. 

SARM Analyzer is used for analyzing SARM data, so that it can be displayed 
in Business Availability Center for Siebel Applications's SARM - User Trace 
Breakdown tab.

For details, see “Copy the srvrmgr Tool and the SARM Analyzer Tool to the 
SiteScope Server – Details” on page 203.

 7 Perform Discovery
You run Siebel discovery to discover Siebel elements and Siebel topology. For 
details, see “Siebel Discovery” in Discovery and Dependency Mapping Guide.

 8 Configure Specific Siebel CIs Manually
When you run the Siebel discovery, the process creates CIs for the 
discovered components in the CMDB. In addition to the CI’s properties that 
are automatically defined by the discovery process, you must manually 
define some properties so the Monitor Deployment Wizard and the Siebel 
diagnostics tools can run correctly. For details, see “Configure Specific Siebel 
CIs Manually” on page 200.

 9 Change the Business Process Monitor Hierarchy Structure to 
Transactions/Locations
Click Admin > Universal CMDB > Source Manager, click the Edit button  for 
the Business Process source adapter, and change the hierarchy structure to 
Transaction/Locations in the Hierarchy Structure parameter. 
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 10 Activate The Siebel Service
If you are working with SiteScope 9.0, the Siebel Service starts working after 
Business Process Monitor and SiteScope source adapters have been 
synchronized. The Siebel service is automatically activated when you have 
entered the appropriate license for HP Business Availability Center for Siebel 
solution. For additional information about the Siebel Service, see “The Siebel 
Service” on page 190.

For details about how to view a service status with the JMX Web console, see 
“High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF. Check that the Siebel Service is 
activated (it is activated only if you have a license). If necessary activate it 
manually. For details, see “Check If the Siebel Service Is Activated” on 
page 220.

 11 Modify SiteScope KPI Assignment Group
If required, when you are working with SiteScope 9.50, you can modify the 
existing SiteScope KPI assignments. For details, see “Assignment Groups 
Page” in Using Dashboard.

 12 Configure HP Business Availability Center for Siebel 
Applications
To monitor your Siebel eBusiness applications and servers using HP Business 
Availability Center for Siebel Applications, you must first set up the Siebel 
monitoring environment. For details, see “Configure HP Business 
Availability Center for Siebel Applications” on page 211.

 13 Check That the Deployment Was Successful
Run the predefined tests that check that HP Business Availability Center for 
Siebel Applications deployment was successful. For details, see “Siebel 
Deployment Validator Page” on page 264.

For a description of the existing tests and their parameters, see “List of 
Predefined Tests for Siebel Deployment Validator” on page 266.
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To change the default parameters, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select Siebel, 
and locate the Deployment Validator tests definitions entry in the Siebel - 
Siebel Deployment Validator table. Modify the parameter values in the XML 
file.

Note: You can also create your own tests. For details, see “Create Customized 
Deployment Validator Tests” on page 228.

Example – Check That Deployment is Complete

Run all the Deployment Validator tests, fix the problems discovered by 
failed tests, and rerun the failed tests.

Example – Diagnostics Tool (SARM) is Not Working

Run the Deployment Validator tests in the relevant category, fix the 
problems discovered by failed tests, and rerun the failed tests.

 14 Display Siebel Information in Dashboard
HP Business Availability Center for Siebel Applications is ready. After all 
these steps are completed, you can view Siebel data in the Dashboard, use 
diagnostic tools, and so on. For details, see “Display Siebel Information in 
Dashboard” on page 225.

Configure Specific Siebel CIs Manually
When you run the Siebel discovery, the process creates CIs for the 
discovered components in the CMDB. In addition to the CI’s properties that 
are automatically defined by the discovery process, you must manually 
define some properties so the Monitor Deployment Wizard and the Siebel 
diagnostics tools can run correctly. 

You manually define properties in IT Universe Manager. For details on 
defining properties for a CI, see “CIT-Specific Properties” in IT Universe 
Manager Administration.
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The following properties remain empty and must be entered manually.

CI Type Properties Description

Siebel 
Enterprise

Admin user name The name of the user used to login to 
Server Manager.

Admin password The password of the user used to login to 
Server Manager.

SARM Script Path The path to the location of the Siebel 
Application Response Measurement 
(SARM) Analyzer package on the SiteScope 
server. The path is relative to the SiteScope 
server. 

Server Manager 
Script Path

The path to the location of Server 
Manager package on the SiteScope server. 
The path is relative to the SiteScope server. 
For details, see “Copy the srvrmgr Tool 
and the SARM Analyzer Tool to the 
SiteScope Server – Details” on page 203.

Siebel 
Application

Emulated 
Transaction User 
Name

The name of the user used in the script 
that analyzes the application. It is the 
default user name that appears when 
configuring the Database Breakdown tool.

Siebel Web 
Server 
Extension

SARM Log Folder The log folder to which SARM log files are 
written on the Web Server Extension's 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_web_server_extension_name>\
<log_directory>
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Note: In addition, you must check that the connection parameters used to 
connect to SiteScope monitors are the ones that exist in the various relevant 
CIs (Enterprise, Application Server, and so forth). For details, see “Matching 
Connection Parameters to SiteScope” on page 277.

Copy the srvrmgr Tool to the DDM Probe Server
The srvrmgr tool is used to extract data about the enterprise's structure from 
Siebel.

Note: If you are working with different versions of Siebel in your 
organization, make sure you use a srvrmgr with a version that is appropriate 
for the Siebel server.

Siebel 
Application 
Server

SARM Log Folder The log folder to which SARM files are 
written on the Application Server 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_app_server_name>\<log_direct
ory>

Log Folder The log folder to which Siebel general log 
files are written on the Application Server 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_app_server_name>\<log_direct
ory>

CI Type Properties Description
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To copy the srvrmgr tool to the DDM Probe server, proceed as follows:

 1 Copy the srvrmgr Command Line Interface (CLI) tool from the Siebel server 
to any folder on the DDM Probe server. It is recommended to run the Siebel 
connection test to validate the srvrmgr installation. 

 2 To run the connection test, open the command line on the DDM Probe 
server and change directory to the location of the srvrmgr.exe file. Run from 
the command line:
>srvrmgr /e [site_name] /g [gateway_host] /u [username] /p [password] 

If the connection is established successfully, you must see the srvrmgr 
prompt and the status message about the number of connected servers, as 
follows:

Copy the srvrmgr Tool and the SARM Analyzer Tool to the 
SiteScope Server – Details

Note: If you are working with different versions of Siebel in your 
organization, make sure you use a srvrmgr and a SARM Analyzer with a 
version that is appropriate for the SiteScope server. For details, see “Context 
Menu Options” on page 232.
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This section provides details about the processes used to copy the srvrmgr 
tool and the SARM Analyzer tool to the SiteScope server.

 1 Copy the srvrmgr Tool to the SiteScope Server
This section describes how to copy the svrmgr tool to the SiteScope server.

 a Copy the srvrmgr Command Line Interface (CLI) tool from the Siebel 
server to any folder on the SiteScope server.

Note: It is recommended to run the Siebel connection test to validate the 
srvrmgr installation.

 b To run a connection test, open the command line on the SiteScope server 
and change directory to the location of the srvrmgr.exe file.

 c Run from the command line:
>srvrmgr /e [site_name] /g [gateway_host] /u [username] /p [password]

Note: For the connection to work properly you must check that the user 
and password you are using have the correct permission for a remote 
connection. For details, see “Perform the Remote Connection from 
SiteScope to Siebel” on page 205.
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If the connection is established successfully, you should see the srvrmgr 
prompt and the status message about the number of connected servers, 
as follows:

 2 Copy the SARM Analyzer Tool to the SiteScope Server
To copy the SARM Analyzer tool to the SiteScope server, copy the SARM 
Analyzer tool from the Siebel server to a folder on the SiteScope server.

Note: If your site includes a large number of Web servers, it is better to use 
multiple SiteScopes to distribute the work done by the SARM Analyzer tool 
between these SiteScopes. In such a case, copy SARM Analyzer to each 
SiteScope.

 3 Perform the Remote Connection from SiteScope to Siebel
All Siebel servers (Windows and UNIX) must be defined as remote servers on 
the SiteScope server. For details, see the “Microsoft Windows Remote 
Preferences” or “UNIX Remote Preferences” in Using System Availability 
Management.
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 4 Run the SiteScope Service with a Domain User
SiteScope should run under a domain user who has permissions to run 
server manager and SARMAnalyzer and also has read access to the log 
folders on the Siebel servers (Web servers and application servers).

Use a Business Process Profile to Simulate Siebel Users
This section provides details about how to use Siebel transactions to 
simulate Siebel users and obtain performance and availability information 
on the Siebel application. 

You can use Business Process profiles to group several transactions.

 1 Prerequisites
In the HP Virtual User Generator (VuGen), check that:

➤ When recording scripts on VuGen for Siebel, you only use the Siebel-Web 
protocol. For details see HP Virtual User Generator User’s Guide.

➤ You record scripts with a special user created for monitoring/diagnostics 
purposes on Siebel.

➤ You set a think time separator of 10 seconds for the script transactions used 
for Siebel diagnostics. The VuGen script includes discrete transactions 
(transactions that do not include lr_think_time() within them) and that it 
uses the lr_think_time(…) functions to separate between the VuGen 
transactions. 

➤ The script must not be too long (recommended no more than five 
transactions per script) since the Diagnostics tools need to run the whole 
script every time you want to analyze a specific transaction. For example, if 
a problematic transaction is located close to the end of the script, you would 
have to run all the previous transactions to reach the problematic one. If 
you need to record more transactions, record an additional script.

➤ Optionally, the Run-Time Settings should be configured for setting 
appropriate values: Think-Time-Replay policy, Timeout values, logging 
options, Proxy, Browser Emulation, and so on.

You can only use Vugen scripts with Siebel applications.
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 2 Select the Appropriate Protocol
You must select the Siebel-Web protocol when you create a new script, 
because, in HP Virtual User Generator (VuGen), Siebel scripts are recorded 
using the Siebel-Web protocol. For details, see HP Virtual User Generator User’s 
Guide.

In HP Business Availability Center, you can attach Business Process Monitor 
transactions to Siebel application components automatically or manually. 
For details, see “Specify a Transaction/Location or Regular Hierarchy in the 
Business Process Monitor Source Adapter” on page 208.

To select the appropriate protocol:

 a In VuGen, select New to open the New Virtual User page.

 b Select New Single Protocol Script.

 c Select the Siebel-Web protocol.

 3 Create a Business Process Profile
You can create business process profiles in End User Management. For 
details, see “Managing Business Process Profiles Overview” in Using End User 
Management.

 4 Synchronize the Business Process Monitoring Source Adapter 
to Enter Business Process Monitor CIs in the CMDB
To view data in the Siebel Enterprises view in Dashboard, the Business 
Process Monitor source adapter must be synchronized. 

You can synchronize the Business Process Monitoring source adapter 
immediately or you can wait for the automatic synchronization to take 
place.

For details, see the action buttons in “Source Manager Page” in Model 
Management.
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 5 Specify a Transaction/Location or Regular Hierarchy in the 
Business Process Monitor Source Adapter
To display location information in the Siebel view(s), select the Transaction/
Location type of hierarchy to the Business Process Monitor source adapter. 
To hide location information, select the Regular type of hierarchy. For 
details about the option, see “Template Elements” in Model Management.

Attach Business Process Monitor Transactions to Siebel 
Application Components

To display Performance and Availability information on Siebel applications, 
you must attach Business Process Step CIs to Siebel Application CIs. 

If the Business Process Monitor source adapter was assigned the Transaction/
Location option a copy of the location information is attached to the 
Locations container. For details about the option, see “Template Elements” 
in Model Management.

You can connect Business Process Steps to a Siebel application in two ways:

➤ Follow the naming conventions for Siebel Business Process Steps names. 

➤ Do not follow the naming conventions for the Business Process Steps 
names. In this case, you must manually link a Business Process Step to a 
Siebel application. 

For details, see “Specify a Transaction/Location or Regular Hierarchy in the 
Business Process Monitor Source Adapter” on page 208.

If you do not follow the naming conventions, be careful when deleting links 
between Siebel applications and Business Process Steps. For details, see 
“Delete Links Between Siebel Applications and Business Process Steps” on 
page 216.
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Automatically attach Business Process Steps to a Siebel 
Application CI by Following the Naming Convention

To automatically connect Business Process Steps to a Siebel application, use 
the following format for the Business Process Step names:
<app_name>_ _<ent_name>_ _<BPM_tran_name>

➤ app_name. The name of the Siebel application to which you want to attach 
the Business Process Step.

➤ ent_name. The name of the Siebel Enterprise on which the Siebel 
application is run.

➤ BPM_tran_name. The unique name of the Business Process Step. 

Any set of alphanumeric and mixed case characters are supported (special 
characters are not allowed). It is good practice to name the transaction so 
that the name indicates what occurs in it.

Make sure the double underscore do not have spaces between them.

Note: You assign the appropriate name to a Business Process Step when you 
record it. For details, see HP Virtual User Generator User’s Guide.

Attach Business Process Steps to a Siebel Application CI 
Without Following the Naming Convention

After you have built a Business Process profile, you must manually connect 
Business Process Steps with Siebel Application CIs. To attach Business 
Process Steps to a Siebel Application CI without following the naming 
convention:

 a Select Admin > Universal CMDB > Modeling > IT Universe Manager.

 b Select Siebel Enterprises in the View list.

 c Right-click the Siebel Application CI that you want to monitor using the 
BPM profile and select Attach Monitoring CI to open the Attach Related 
CIs wizard. For details, see “Attach Related CIs Wizard” in Model 
Management.

 d Select End User Monitors View in the Views list.
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 e Expand and select the Business Process Step to which you want to 
connect the Siebel Application CI. You can select more than one.

 f Click the right arrow to move the CI to the right-hand box. 

 g Click Next. 

 h In the Relationship Type list, select Monitoring By Siebel.

 i Select Allow CI Update. 

 j Click Finish.

 6 Deploy the SiteScope Siebel Monitors
Deploy the SiteScope Siebel monitors. For details, see “Deploy the SiteScope 
Siebel Monitors” on page 216.

 7 View SARM Data in Business Process Steps
To view Siebel Application Response Measurement (SARM) data in Business 
Process Steps in the HP Business Availability Center for Siebel Applications 
SARM - User Trace Breakdown diagnostics tool, you must select the Enable 
Siebel Breakdown property for each Siebel transaction monitor in the 
Business Process profile. When you do not select the property, the 
Transactions tab is empty.
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To see SARM data under Business Process Steps, select Admin > End User 
Management, right-click the relevant transaction monitor and select Edit, 
and in the Transaction Breakdown Settings area, select the Enable Siebel 
Breakdown parameter.

Configure HP Business Availability Center for Siebel 
Applications 

This section describes the detailed steps used to configure the Siebel 
monitoring environment.

This task includes the following steps:

➤ “Create Business Process Profiles That Emulate Siebel Application Users” on 
page 212

➤ “Deploy SiteScope Monitors for the Siebel Templates Using the Monitor 
Deployment Wizard” on page 212
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➤ “Go Through the Diagnostics Checklist” on page 212

 1 Create Business Process Profiles That Emulate Siebel 
Application Users
You can use Siebel transactions to simulate Siebel users and obtain 
performance and availability information on the Siebel application. You use 
Business Process profiles to group several transactions.

For information on creating Business Profiles, see “Use a Business Process 
Profile to Simulate Siebel Users” on page 206.

 2 Deploy SiteScope Monitors for the Siebel Templates Using the 
Monitor Deployment Wizard
You can use SiteScope monitors to monitor Siebel. For more information 
about the monitors, see “Siebel Monitors” on page 189.

For details about deploying the SiteScope Siebel monitors, see “Deploy the 
SiteScope Siebel Monitors” on page 216.

 3 Go Through the Diagnostics Checklist
Check that the Diagnostics-related settings correctly set up to ensure that 
Diagnostics work properly.

For details, see “Verify Diagnostics-Related Settings” on page 212.

Verify Diagnostics-Related Settings

This section provides details about the Diagnostics-related settings that 
ensure that Diagnostics work properly.

This task includes the following steps:

➤ “Check the Diagnostics-Related Settings for Siebel” on page 213

➤ “Check the Diagnostics-Related Settings for SiteScope” on page 213

➤ “Diagnostics-Related Settings for HP Business Availability Center” on 
page 214
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 1 Check the Diagnostics-Related Settings for Siebel
Check that:

➤ The SiteScope user has at least read-only access to the log directories of all 
Web and Application Servers.

➤ The SiteScope user has administrative privileges on all Siebel servers or, if 
this is not possible, give the permissions specified at the Microsoft Help and 
Support site (http://support.microsoft.com/
default.aspx?scid=kb;en-us;Q300702).

➤ You have defined a special Siebel user to be used by Business Process 
Monitor profiles. This user should be used only for that purpose.

➤ Siebel Breakdown is enabled for the script that monitors the Siebel 
application. For details, see “Managing Business Process Profiles Overview” 
in Using End User Management.

➤ Siebel Server Manager and SARM Analyzer. Check that:

➤ The srvrmgr package and SARM Analyzer package are installed on a 
SiteScope machine (they are needed for running the Diagnostics tools). 
You copy Siebel Server Manager and the SARM Analyzer to a SiteScope 
machine (preferably) or, if this is not possible, to another machine where 
it can be executed by a SiteScope user. For details, see “Copy the srvrmgr 
Tool and the SARM Analyzer Tool to the SiteScope Server – Details” on 
page 203.

➤ The SiteScope user on Siebel Server Manager has execution permissions 
when both SiteScope and Siebel are running on UNIX.

 2 Check the Diagnostics-Related Settings for SiteScope
Check that:

➤ SiteScope service is running under a domain account (not a local system). 
This domain account (SiteScope user) must have the permissions specified 
in “Check the Diagnostics-Related Settings for Siebel” on page 213.

➤ Each Siebel Web and Application Server is defined as Remote NT or Remote 
UNIX appropriately. Remote UNIX machines must be defined using the 
Telnet protocol. Additionally, in the initialize shell environment field, enter 
stty cols 1024; stty tabs; $SHELL.
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➤ SiteScope has access permissions to the Siebel machines. Check that the 
account SiteScope Service is running in Services (in Windows NT) or in the 
process (on UNIX).

➤ The log and SARM log folders on Siebel Web Server and Application Server 
are accessible from the SiteScope machine.

➤ SiteScope is attached to the Gateway Server.

➤ SiteScope has an additional license for Siebel Monitors.

 3 Diagnostics-Related Settings for HP Business Availability 
Center
Check that:

➤ All the HP Business Availability Center for Siebel Applications configuration 
parameters of the Enterprise, and Siebel Servers are spelled correctly, the 
appropriate case is used, and there are no blank spaces at the end of the 
parameter string. 

➤ There is no inconsistency in the treatment of the SiteScope host name 
between the SiteScope profile and System Availability Management (either 
defined with domain or as an IP address). Also, check that SiteScope can 
communicate with the Siebel server.

Diagnostics cannot access a SiteScope located in an outer LAN. The solution 
is to define SiteScope in System Availability Management using the host 
name provided by the SiteScope server. If the SiteScope server cannot be 
accessed using such a host name from the Gateway Server the host name 
must be defined in the hosts file in the operating system of all the Gateway 
Servers (for Windows NT, the location is: 
C:\WINNT\system32\drivers\etc\hosts; for some UNIX environments, the 
location is: /etc/hosts; in other UNIX environments it is in the .rhosts file). 

➤ The SiteScope you are using for diagnostics is attached (click 
Admin > System Availability Management in HP Business Availability 
Center).

➤ You are using a dedicated SiteScope for diagnostics purposes, when working 
with medium to large Siebel deployments.
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➤ The time zone and time definitions of the SiteScope server used for 
diagnostic purposes (on which SARM Analyzer and srvrmgr are installed) are 
synchronized with the Siebel server time zone and time definition.

➤ You have network access (without firewalls or through VPN) to the Business 
Process Monitor servers (port 2696) you are going to use for diagnostics 
purposes. 

➤ For each Business Process Monitor server used for Diagnostics, you can open 
the http://<BPM_server>:2696/ page from the Gateway Server.

➤ All paths you set in HP Business Availability Center for Siebel Applications 
configuration are relative to SiteScope; for example: if they are local on 
SiteScope (Server Manager, SARM analyzer) use the local path, otherwise use 
the complete network path.

➤ You have a license for Siebel on the Gateway Server (select Admin > Platform 
> Setup and Maintenance > License Management to verify this).

➤ SiteScope data arrives to HP Business Availability Center. 

Consult the dispatcher.txt log file with the appropriate log level to check 
that information. You can update the log level of the dispatcher log in the 
first line of the 
<HP Business Availability Center root directory>
\conf\core\DataService\DataService_logs.ini\dispatcher_log.cfg file on 
the Gateway Server. Change the value of LogLevel to debug5. This causes 
the samples from SiteScope to appear in the dispatcher.txt file.

For details about SiteScope samples, see “Data Samples for SiteScope” in 
Reference Information.

Note: It is recommended to increase the log level only for a short period, so 
HP Business Availability Center performance is not affected.

➤ The user of your Siebel Application in HP Business Availability Center for 
Siebel Applications Configuration has appropriate permissions in the Siebel 
Site and the password is correct.
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Delete Links Between Siebel Applications and Business 
Process Steps

If you delete a link between a Siebel Application CI and its child Business 
Process Step transaction, then the following happens:

➤ If you follow the naming convention for the Business Process Step 
transaction, the link between the Siebel transaction and its child Business 
Process Step is automatically recreated at the next synchronization.

➤ If you do not follow the naming convention and created a manual link 
between the Siebel transaction and a Business Process Step transaction, then 
when you delete the link:

➤ If the Business Process Monitoring source adapter was assigned the 
Transactions/locations option, the Contained Location CI is not deleted. 

Delete the Contained Location CI only if the deleted Business Process 
Step transaction is the only CI attached to this location. If other Business 
Process Step transactions are attached to this location, delete only the 
links between the Business Process Monitor (BPM transaction from 
location) and the Location container.

➤ If the Business Process Monitoring source adapter was assigned the 
Regular option, the link between the BP Step and the BP Steps container 
is not automatically deleted, and you should delete it.

For details about the Transactions/locations or Regular options, see 
“Template Elements” in Model Management.

Deploy the SiteScope Siebel Monitors

This section provides the detailed steps to use to deploy SiteScope Siebel 
monitors.

You can deploy the Siebel monitors using the Monitor Deployment Wizard 
or the Siebel solution templates.
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Both techniques leverage the concept of solution sets. Solution sets 
automate the creation of the monitors that should be used, and include 
built-in threshold information. Essentially, they encompass monitoring best 
practices.

The task includes the following steps:

➤ “Use the Monitor Deployment Wizard” on page 217

➤ “Using the Siebel Solution Templates” on page 219

➤ “Synchronize the SiteScope Source Adapter to Enter SiteScope CIs in the 
CMDB” on page 219

 1 Use the Monitor Deployment Wizard
Use the Monitor Deployment Wizard to deploy Siebel monitors. For details, 
see “Monitor Deployment Wizard” in Using System Availability Management.

In the Monitor Deployment wizard, in the left pane of the Select 
Configuration Items to Monitor page, select the Siebel Enterprises view. 
Select the CIs you would like monitored and move them to the right pane. 
In the Select Templates to Apply page, the left pane lists all the available 
templates in the wizard. The names of the Siebel-specific templates start 
with Siebel. The child objects are the monitors that are deployed by the 
template. The right pane lists the CI Types of all the CIs selected in the 
previous page.
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If the wizard is able to match templates to the selected CI Types, the CI Type 
is listed with the applicable template as a child object:

Note: When deploying monitors on Siebel objects, the CI Types appearing 
in the right pane may be Siebel CI Types.
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 2 Using the Siebel Solution Templates
To create a SiteScope monitor that can monitor a Siebel Enterprise, you can 
run dedicated solution templates. Two kinds of solution templates are 
available for each solution (one for UNIX and one for Windows):

For details about running the solution template, see “Siebel Solution 
Templates” in Using System Availability Management.

 3 Synchronize the SiteScope Source Adapter to Enter SiteScope 
CIs in the CMDB
If you are working with SiteScope 9.0, to view data in the Siebel Enterprises 
view in Dashboard, the SiteScope source adapter must be synchronized. 

You can synchronize the SiteScope source adapter immediately or you can 
wait for the automatic synchronization to take place.

For details, see the action buttons in “Source Manager Page” in Model 
Management.

Solution 
Templates For 
Unix

Solution 
Templates For 
Windows

Description

Siebel Appl Server 
for UNIX

Siebel Appl 
Server For 
Windows

Deploy a set of monitors that test both 
Siebel-specific and general statistics on 
the Siebel Application servers.

Siebel Gateway 
Server For UNIX

Siebel Gateway 
Server For 
Windows

Deploy a set of monitors that test 
machine and OS-oriented statistics of 
Siebel Gateway servers.

Siebel Web Server 
For UNIX

Siebel Web Server 
For Windows

Deploy a set of monitors that test both 
Siebel-specific and general statistics on 
Siebel Web servers installed. 
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Check If the Siebel Service Is Activated
This section explains how to check if the Siebel Service is activated.

The Siebel Service is a configuration service for automatic linkage. For 
details, see “The Siebel Service” on page 190.

The Siebel Service starts working after BPM source adapter and SiteScope 
source adapter (if you are working with SiteScope 9.0) have been 
synchronized. The Siebel service is automatically activated when you have 
entered the appropriate license for HP Business Availability Center for Siebel 
Applications. 

Check that the Siebel Service is activated (it is activated only if you have a 
license). If necessary activate it manually. For details about how to view a 
service status with the JMX Web console, see “High Availability for the Data 
Processing Server” in the HP Business Availability Center Deployment Guide 
PDF.

Note: If you enter a new license in an old HP Business Availability Center 
installation, you may need to restart the Modeling server to activate the 
service. 

To view if the Siebel Service is activated:

 1 In the browser, enter, using JMX login credentials:
 http://<HP Business Availability Center server name>
:8080/jmx-console/

 2 Double-click service=hac-manager listed under Topaz.

 3 In the JMX MBean View for hac-manager that opens, click the Invoke 
button corresponding to the listAllAssignments parameter. 
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Run the Siebel Database Breakdown Diagnostic Tool
This section provides details about running the Siebel Database Breakdown 
diagnostics tool.

When the user runs Database Breakdown, after defining the analysis scope 
(Siebel Enterprise, Application, Business Process Step, and so on), 
HP Business Availability Center for Siebel Applications automatically 
increases (through SiteScope) the database log level for the selected 
component (if a specific component was selected). 

Then, HP Business Availability Center for Siebel Applications instructs the 
Business Process Monitor to run the transaction you selected. During the 
transaction run, as a result of the higher log level, database-related 
information is written into the application server log. 

When the transaction has finished running, the database log level for the 
selected component is returned to normal by HP Business Availability 
Center for Siebel Applications.

To run the Database Breakdown tool, select Applications > Business 
Availability Center for Siebel > Database Breakdown to open the Siebel 
Database Breakdown Configuration page. For details, see “Siebel Database 
Breakdown Configuration Report” on page 259.

You can also access this page filtered for the selected CI, when you 
right-click the CI and select the Siebel Database Breakdown option. For 
details, see “Customize Dashboard Display and Refresh Rate” in Using 
Dashboard.

Run the SARM - User Trace Breakdown Diagnostics Tool – 
Details
This section describes how to run the SARM - User Trace Breakdown 
diagnostics tool.

You can view data about the activity taking place in the Web server(s) and 
application server(s) at a specific Siebel Enterprise and for a specific user, in a 
specified period of time. HP Business Availability Center searches all of the 
SARM files at the Siebel Enterprise, looks for the sessions of the specified 
user, fetches the appropriate files, runs the SARM analyzer, and lists all of 
the sessions used by the user.
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The task includes the following steps:

➤ “Configure the SARM - User Trace Breakdown Diagnostic Tool” on page 222

➤ “Use the SARM Logs for a Specific Web and Application Server” on page 224

➤ “Results” on page 224

 1 Configure the SARM - User Trace Breakdown Diagnostic Tool
To configure the SARM - User Trace Breakdown diagnostics tool, select 
Applications > Business Availability Center for Siebel > SARM - User Trace 
Breakdown to open the SARM - User Trace Breakdown Diagnostic Tool 
page. For details, see “SARM - User Trace Breakdown (Run the Diagnostics 
Tool) Page” on page 241.

Example

Select the Siebel Enterprise for which you want to view SARM User Trace 
Breakdown data, enter the name of the user whose activity you want to trace 
in the User box, and click the linked date in From or To to open a calendar. 
Select a new date and time to change the default date and time.
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After you configure the SARM, you can:

➤ Invoke a specific Business Process Monitor script. You can view data 
about a Business Process Monitor transaction of a specific script running 
in the Web server(s) and application server(s) at a specific Siebel 
Enterprise, and in a specified period of time. HP Business Availability 
Center invokes the Business Process Monitor transaction, and then 
analyzes the relevant session. For details, see “Invoke Business Process 
Monitor Script” on page 243.

➤ Specify where the files can be found:

➤ Automatically collected Web and application server logs. You can run 
the SARM - User Trace Breakdown diagnostic tool on automatically 
collected Web and application server logs. 

➤ The SARM logs of a specific application server and Web server. You 
can run the SARM - User Trace Breakdown diagnostic tool on the 
SARM logs of a specific application server and Web server. 

➤ An already generated user session trace XML file for a Siebel 
Enterprise, a user, and a specific time frame. You can run the SARM - 
User Trace Breakdown diagnostic tool on an already generated user 
session trace XML file for a site, a user, and a specific time frame. 
HP Business Availability Center searches all of the SARM files at the 
Siebel Enterprise, looks for the sessions of the specified user, fetches 
the appropriate files, runs the SARM analyzer, and lists all of the 
sessions used by the user that were active within the time frame. 
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For details, see “Advanced Options Area” on page 243.

You can then run the diagnostic tool. 

 2 Use the SARM Logs for a Specific Web and Application Server
Run the SARM - User Trace Breakdown diagnostic tool, the SARM - User 
Trace Breakdown page indicates the status of each step in the procedure. For 
details, see “SARM - User Trace Breakdown Dialog Box” on page 244.

After the process is complete, the page closes and the diagnostic results are 
displayed on the SARM - User Trace Breakdown - Analysis page. 

 3 Results
The data is then displayed and you can generate different views and pie 
charts to display the data in a user-friendly manner in the SARM - User Trace 
Breakdown page. For details, see “Siebel Views” on page 191.
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Display Siebel Information in Dashboard

HP Business Availability Center for Siebel Applications is ready. After all 
these steps are completed, you can view Siebel data in the Dashboard, use 
diagnostic tools, and so on. You can display Siebel information in 
Dashboard as follows:

➤ View Siebel information in the Siebel views. For details about the views, see 
“Siebel Views” on page 191.

To enable the other Siebel views, select Dashboard & Service Level 
Management in the View Properties dialog box. For details, see “Create New 
View/View Properties Dialog Box” in Model Management.

➤ View the SARM - User Trace Breakdown Diagnostic report. HP Business 
Availability Center for Siebel Applications SARM Diagnostics is a user trace 
breakdown diagnostic tool that processes the data in the User Session Trace 
output files produced by Siebel’s SARM process. This data can be retrieved 
for a specific user in a specific time frame. It can also be retrieved for a 
specific transaction of a prerecorded script. 

To run the tool, see “Run the SARM - User Trace Breakdown Diagnostics Tool 
– Details” on page 221.

To display the information, see “Siebel Views” on page 191.

➤ View the Siebel Database Breakdown Diagnostic report. The Siebel 
Database Breakdown diagnostic tool enables you to analyze database logs 
created on the Siebel application server, and extract comprehensive 
information regarding database time spent by various SQLs. 

To run the tool, see “Run the Siebel Database Breakdown Diagnostic Tool” 
on page 221.

To display the information, see “Siebel Database Breakdown Analysis 
Report” on page 262.
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➤ View the Tasks Diagnostics Tool report. The Siebel tasks diagnostic tool 
enables you to view details of the Siebel Application Server tasks, for each 
monitored Siebel Enterprise. For details, see “Tasks Diagnostics Tool Report” 
on page 271.

➤ View the Processes Tool report. The Siebel Processes tool enables you to 
view details of the Siebel Application Server processes, for each monitored 
Siebel Enterprise. For details, see “Processes Report” on page 238.

➤ View Changes Made to Siebel Enterprise CIs. You can assign CIs to keep 
change information. For details on assigning CIs to keep change 
information, see the HP Universal CMDB documentation. 

When the discovery process discovers changes made to the properties of 
these CIs, the changes are displayed in the Change report available as a 
context menu option for each one of the relevant CI types. For details about 
the Change report, see “Change Report Page” in Model Management.

➤ View Configuration File CI Details. For details, see “View Configuration File 
CI – Details” on page 227.
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View Configuration File CI – Details
You can view configuration file details:

➤ siebel.cfg file. Right-click the relevant Siebel Application Server CI in the 
Siebel Enterprises view, select Properties, and click Show document content 
to display the details of the siebel.cfg file. The siebel.cfg configuration file 
displays information taken from the application server installation. 
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➤ parameters.cfg file. Right-click the relevant Configuration File CI in the 
Siebel Enterprises view, select Properties, and click Show document content 
to display details of the parameters.cfg file. The parameters.cfg. file 
includes the output of the list parameters for component command using 
srvrmgr. 

You can also access this information by selecting Admin > Universal CMDB > 
Modeling > IT Universe Manager > Properties. For details, see “Properties Dialog 
Box” in Model Management.

Create Customized Deployment Validator Tests

You can create customized Deployment Validator tests and add them to the 
existing list of tests or replace existing tests with your own.

To create a customized Deployment Validator test:

 1 Create a Java class that checks the problem.

 2 Create a resource file and save it in the following directory:
<HP Business Availability Center source directory>\AppServer\resources.
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 3 Add the test definition to the list of tests. To add a test, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Siebel, and open the XML file associated with the 
Deployment Validator test definitions entry in the Siebel - Siebel 
Deployment Validator table and add or remove tests. 

For example, a typical test entry is as follows:

It includes the name of the class and the name of the test resource file. The 
resource file includes the name of the test, description, category, error 
messages, and so forth. 

For example, a typical resource file format is as follows:

 4 Save and restart HP Business Availability Center.

Note: When you add or remove a test in the Deployment Validator test 
definitions XML file, the previous test results are discarded and you must 
rerun the complete list of tests.

 <test 
class="com.mercury.topaz.siebel.admin.deployment.validator.backend.tests.SiebelPac
kageDeploymentTest" resources="siebel.package.deployment.test"/>

# SiebelEnterprisesViewTest properties
siebel.enterprises.test.name=Siebel Enterprises View Test
siebel.enterprises.test.desc=Checks that the Siebel Enterprises view contains Siebel 
Enterprises with descendants Siebel Application Server, Siebel Web Server Extension 
and Siebel Gateway
siebel.enterprises.test.category=BAC
siebel.enterprises.test.no.site=No Siebel Enterprise CI was found.
siebel.enterprises.test.no.site.specific=Siebel Enterprise &#39;{0}&#39; was not found.
siebel.enterprises.test.not.valid.site=Siebel Enterprise &#39;{0}&#39; doesn&#39;t 
have descendant {1}.
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Customize HP Business Availability Center for Siebel 
Applications

You can customize HP Business Availability Center for Siebel Applications  
using the capabilities listed in this section.

The task includes the following topics:

➤ “Save the Generated XML Files After Generating the SARM Report” on 
page 230

➤ “Specify the Default SiteScope Monitors” on page 231

➤ “Specify the SiteScope Monitor Used to Execute Siebel Diagnostics Tools” on 
page 231

➤ “Change the Default Timeout for the Execution of a SiteScope Monitor” on 
page 231

➤ “Increase the Default Timeout for Either a SARM Task or a SARM Analyzer 
Execution” on page 232

 1 Save the Generated XML Files After Generating the SARM 
Report
After the generation of the SARM report, the generated XML files are 
automatically deleted from the SiteScope and HP Business Availability 
Center.

To prevent the deletion and save the generated XML files after generating 
the SARM report, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Siebel, and locate the 
Siebel - Siebel SARM Breakdown area. Modify the following parameters:

➤ Remove SARM results temporary directory from BAC. If you give this 
parameter the value false, then the XML files are saved in the 
<HP Business Availability Center center server>\AppServer\webapps
\site.war\Imgs\chartTemp\offline directory.

➤ Remove SARM results temporary directory from SiteScope. If you give this 
parameter the value false, then the XML files are saved in the <SiteScope 
installation directory>\cache\tempbyage\
<TimeStamp>_SIEBEL_SARM\<web_server>_<App_server> directory.
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 2 Specify the Default SiteScope Monitors
Specify the default SiteScope monitors you want to work with.

To specify the default SiteScope monitors, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Siebel, and locate the Default SiteScopes for SARM diagnostics entry in the 
Siebel - Siebel SARM Breakdown table. Modify the value by entering one of 
the following:

➤ The SiteScope monitor names separated by semicolons (for example: 
rca3;rca4)

➤ ALL to use all attached SiteScope monitors

 3 Specify the SiteScope Monitor Used to Execute Siebel 
Diagnostics Tools
Specify the default SiteScope agent/profile used to execute Siebel diagnostics 
tools when using the context menus options listed in the Go to Siebel 
Diagnostics context menu. For details, see “Go to Siebel Diagnostics” in 
“Menu Options” in Using Dashboard.

To specify the default SiteScope monitors, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Siebel, and locate the Default SiteScope for Diagnostic drilldown from the 
Dashboard entry in the Siebel - General Settings table. Enter the name of the 
default SiteScope that is being used from Dashboard to execute diagnostic 
tools.

 4 Change the Default Timeout for the Execution of a SiteScope 
Monitor
If the Siebel.ejb.log, located on the Center server, indicates that an 
execution of a SiteScope monitor timed-out, change the default timeout for 
the execution of this monitor.

To change the default timeout for the execution of a SiteScope Monitor, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Verticals, and locate the SiteScope monitor 
timeout in seconds entry in the Vertical - SiteScope Remote Control Settings 
table. Modify the parameters’s value. The parameter indicates the default 
timeout for the execution of a SiteScope monitor. 
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 5 Increase the Default Timeout for Either a SARM Task or a SARM 
Analyzer Execution
If the <SiteScope root directory>\tools\sarmDiagnostics\logSiteScope
\sarmanalyzer.log indicates that a SARM task or SARMAnalyzer execution 
has been timed-out, increase the default timeout for either a SARM task or a 
SARM analyzer execution.

To increase the default timeout for either a SARM task or a SARM analyzer 
execution, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Siebel, and locate the 
Siebel - Siebel SARM Breakdown table. Modify the following parameters:

➤ SARM task timeout in seconds. Indicates the default timeout for the 
execution of a SARM task (analyzing Web Server file, analyzing Application 
Server files, and so on).

➤ SarmAnalyzer command timeout in seconds. Indicates the default timeout 
for the execution of sarmanalyzer.exe (used to generate CSV or XML files).

Reference

Context Menu Options

In the Siebel-related views, right click CIs to display a list of the context 
menu options available in the Siebel Enterprises view. For details, see 
“Customize Dashboard Display and Refresh Rate” in Using Dashboard.

The context menu options available from the Siebel-specific CITs are listed 
in “Go to Siebel Diagnostics” in Using Dashboard. An additional context 
menu option is Cross-Performance Report accessed by using the Siebel 
Cross-Performance option. For details, see “Go to Report” in Using 
Dashboard.
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Different context menu options are available depending on the type of 
Siebel-specific CIs you right-click:

Type of CIT Context Menu Option

Siebel Site Siebel Database Breakdown 

Siebel SARM 

Siebel Application Siebel Database Breakdown 

Siebel Application Server Cross-Performance Report

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Component Group Cross-Performance Report 

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Component Cross-Performance Report 

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Web Server 
Extension

Cross-Performance Report

Siebel Web Application Cross-Performance Report
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Default CITs in the Siebel View

In Dashboard, access the Siebel Enterprises view to view information about 
the Siebel IT entities, the Siebel enterprise metrics monitored by SiteScope 
monitors, and information about the Siebel business processes/transactions 
simulated by Business Process Monitor scripts.

The Siebel Enterprises view appears as follows:

The CITs are as follows:

CIT (A-Z) Icon Description

BPM Transaction/
Location

The BPM Transaction/Location CIs represent 
a BP Step/Location intersection (a specific 
transaction running at a specific location).

Business Process Step The Business Process Steps (BPM transactions 
inside a script) CIs are emulated Siebel 
transactions executed on a Business Process 
Monitor machine. They are used to supply 
proactive monitoring of end user experience.

Configuration File The Configuration File CIs represent the 
siebel.cfg configuration file that includes 
information from the application server 
installation or the parameters.cfg that 
includes the output of the list parameters for 
component command using srvrmgr.
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Contained Group The Group CI is a logical container. This is 
not a Siebel-specific CI. The Siebel 
Enterprises view includes the following 
groups: Applications, Business Processes, 
Hosts, and Locations.

Contained Location The Contained Location CIs are created as 
part of the Business Process Monitor 
hierarchy when working with the 
Transactions/locations option. They 
represent the locations from which the BP 
Steps monitoring Siebel are run.

Database The Database CI represents the database that 
is holding the data tier. This is not a 
Siebel-specific CI. 

Host A Host CI represents the physical machine 
on which a server is installed. This is not a 
Siebel-specific element.

Siebel Application The Siebel Application CI represents the 
Siebel complete solution for an 
organization’s needs in a certain area. For 
example: marketing, call center, and so 
forth.

Siebel Application 
Server

The Siebel Application Server CI represents a 
server running the business logic tier that 
supports both back-end and interactive 
processes for every Siebel client. 

Siebel Component The Component CI represents a process 
running on the Siebel Application Server, 
which encapsulates some Siebel application 
functionality. 

Siebel Component 
Group

The Component Group CI represents an 
administrative grouping of components 
comprising an application running on the 
Siebel Application Server. 

CIT (A-Z) Icon Description
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Siebel Enterprise The Siebel Enterprise CI represents the 
logical grouping of Siebel Application Servers 
that support the same group of users 
accessing a common database server.

Siebel Gateway The Siebel Gateway server is a coordinating 
server that routes requests to the correct 
component and provides enhanced 
scalability, load balancing, and high 
availability across the Siebel Enterprise.

Siebel Web Server 
Extension

The Siebel Web Server Extension CI 
represents the Siebel Web Server Extension 
installed on the Web server.

Siebel Web 
Application

The Siebel Web Application CI represents the 
application URL as it exists on the Siebel 
Web Server Extension.

SiteScope 
Measurement

The SiteScope Measurement CI is not a 
Siebel-specific CI. However, in the Siebel 
Enterprises view, it usually represents a 
metric of a Siebel monitor; for example, the 
Siebel Application Server monitor.

Note: If SiteScope measurements names are 
too long and are truncated in Dashboard, 
you can change the CIT default label to be 
RegExp(data_name, (.*[/].*[/].*[/])(.*),2) 
instead of just data_name. In such a case, 
only the beginning of the path and the last 
part of the measurement's name are 
displayed instead of the entire measurement 
name (including the path). If you change the 
CIT default label, you must also change all 
references in the code and in the TQL layout 
from display_label to data_name. 

Web Server The Web Server CI represents the Web server 
that forwards requests to the Siebel 
enterprise. 

CIT (A-Z) Icon Description
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HP Business Availability Center for Siebel Applications 
User Interface

This section describes:

 ➤  Processes Report on page 238

 ➤  Processes Tool - Advanced Filter Dialog Box on page 240

 ➤  SARM - User Trace Breakdown (Run the Diagnostics Tool) Page on page 241

 ➤  SARM - User Trace Breakdown Dialog Box on page 244

 ➤  SARM - User Trace Breakdown - Analysis Report on page 246

 ➤  Siebel Database Breakdown Configuration Report on page 259

 ➤  Siebel Database Breakdown Analysis Report on page 262

 ➤  Siebel Deployment Validator Page on page 264

 ➤  Siebel Deployment Validator Test Summary Dialog Box on page 269

 ➤  Tasks Diagnostics Tool Report on page 271

 ➤  Tasks Diagnostics Tool - Advanced Filter Dialog Box on page 273
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Processes Report

Description Enables you to view details of the Siebel Application 
Server processes, for each monitored Siebel Enterprise. 

To Access: Applications > Business Availability Center 
for Siebel > Processes 

You can also access this page filtered for a selected CI, 
when you right-click the CI in Dashboard and select 
the Show Processes option. For details, see “Go to 
Siebel Diagnostics” in Using Dashboard.

Important 
Information

➤ To sort the processes by a specific column, click the 
column heading.

➤ To move between pages, use the First, Previous, 
Next, and Last arrows  above the 
table.

Included in Tasks “View Configuration File CI – Details” on page 227
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced Options If necessary, click to open the Processes Diagnostics 
Tool - Advanced Filter page. For details, see “Processes 
Tool - Advanced Filter Dialog Box” on page 240.

Apply Click to display the process diagnostic information. 
The process information you requested is retrieved 
from the Siebel Application Servers and displayed on 
the Tasks Diagnostic Tool page.

Component The name of the component. If the process does not 
have a task attached, then the Component column is 
empty.

Component Group Select the name of the component groups. Select All 
component groups to display the process diagnostics 
for all of the component groups.

Component Group The name of the component group. If the process does 
not have a task attached, then the Component Group 
column is empty.

CPU (%) The percentage of the host machine CPU that the 
relevant process instance is currently using.

Enterprises Select the name of the Siebel Enterprise.

Memory (KB) The amount of memory (in KB) that the relevant 
process instance is currently using.

Process ID The process identifier.

Process Type The name of the operating system process that deals 
with the Siebel process.

Server Select the name of the application server. Select All 
servers to display the process diagnostics for all of the 
application servers.

Server The name of the server on which the process runs.
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Processes Tool - Advanced Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Use the advanced filter to filter the list of processes you 
want to display.

To Access: In the Processes Diagnostics Tool page, click 
the Advanced Filter linke. 

GUI Element (A-Z) Description

Process Id Enter the process ID.

Process Type Select the type of process. Select All process types to 
display the process diagnostics for all of the process 
types.

Siebel Components Select the Siebel component. Select All components to 
display the process diagnostics for all of the Siebel 
components.

Using SiteScope Select the SiteScope machine you want to use to 
retrieve process information.
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SARM - User Trace Breakdown (Run the Diagnostics Tool) 
Page

Description HP Business Availability Center for Siebel 
Applications SARM Diagnostics is a user trace 
breakdown diagnostic tool that processes the data in 
the User Session Trace output files produced by Siebel’s 
SARM process. This data can be retrieved for a specific 
user in a specific time frame. It can also be retrieved for 
a specific transaction of a prerecorded script. 

You can then:

➤ Invoke a specific Business Process Monitor script. 
For details, see “Invoke Business Process Monitor 
Script” on page 243.

➤ Specify where the files can be found:

➤ Automatically collected Web and application 
server logs. 

➤ The SARM logs of a specific application server and 
Web server. 

➤ An already generated user session trace XML file 
for a Siebel Enterprise, a user, and a specific time 
frame. 

To Access: Select Applications > Business Availability 
Center for Siebel > SARM - User Trace Breakdown to 
open the SARM - User Trace Breakdown Diagnostic 
Tool page. 

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Siebel SARM 
option. For details, see “Customize Dashboard Display 
and Refresh Rate” in Using Dashboard.

Important 
Information

HP Business Availability Center does not support 
SiteScope 8.7 and earlier. 

Included in Tasks “View Configuration File CI – Details”
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced Options You can run the SARM - User Trace Breakdown 
diagnostic tool on:

➤ automatically collected Web and application server 
logs.

➤ the SARM logs of a specific application server and 
Web server. 

➤ an already generated user session trace XML file for a 
site, a user, and a specific time frame. HP Business 
Availability Center searches all of the SARM files at 
the Siebel Enterprise, looks for the sessions of the 
specified user, fetches the appropriate files, runs the 
SARM analyzer, and lists all of the sessions used by 
the user that were active within the time frame. 

Enterprises Select the Siebel Enterprise for which you want to view 
SARM User Trace Breakdown data.

From ... To Click the linked date in From or To to open a calendar 
and select a new date and time to change the default 
date and time.

Invoke Business 
Process Monitor 
Script area

You can view data about a Business Process Monitor 
transaction of a specific script running in the Web 
server(s) and application server(s) at a specific Siebel 
Enterprise, and in a specified period of time. 
HP Business Availability Center invokes the Business 
Process Monitor transaction, and then analyzes the 
relevant session. See below for details.

User Enter the name of the user whose activity you want to 
trace.
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Invoke Business Process Monitor Script

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Advanced Options Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Application Select the application.

Host Select the location of the Business Process Monitor 
running the script.

Invoke Script Click to invoke the script transaction.

Script Select the script.

GUI Element (A-Z) Description

Automatically collect 
files

Select to run SARM - User Trace Breakdown diagnostics 
on all Web and application servers at the Siebel 
Enterprise. Then select the SiteScope(s) used to collect 
the data in the Using SiteScope list. This is the default.

Run Click to run the diagnostics tool. The resulting 
information is displayed in the SARM - User Trace 
Breakdown - Analysis screen. For details, see “Siebel 
Views” on page 191.

Specify a User 
Session Trace File

Select Specify a User Session Trace File to work on an 
already generated user session trace XML file. 

In the User Session Trace File box, enter the path to the 
trace file. The path is relative to the SiteScope machine.

Then select the SiteScope(s) used to collect the data in 
the Using SiteScope list.
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SARM - User Trace Breakdown Dialog Box

Specify the SARM 
logs folders 

Select Specify the SARM logs folders to run SARM - 
User Trace Breakdown diagnostics only on the specified 
Web and application servers for the Siebel Enterprise:

➤ In the Application Servers box, enter the path to the 
SARM logs of the application server(s).

➤ In the Web Servers box, enter the path to the SARM 
logs of the Web server(s).

The paths are relative to the SiteScope machine.

Then select the SiteScope(s) used to collect the data in 
the Using SiteScope list. This is the default.

Using SiteScope Enter the SiteScope(s) used to collect the data.

Description When you run the SARM - User Trace Breakdown 
diagnostic tool, the SARM - User Trace Breakdown page 
indicates the status of each step in the procedure.

Important 
Information

After the process is complete, the page closes and the 
diagnostic results are displayed on the SARM - User 
Trace Breakdown - Analysis page. For details, see “Siebel 
Views” on page 191.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Analyze Results and 
Prepare Charts

When the status indicator shows running stripes, the 
final results are being analyzed and charts are prepared. 
When the status indicator is complete, the loading has 
completed.

Check SiteScopes 
connectivity

When the status indicator shows running stripes, the 
SiteScopes connectivity is being checked. When the 
status indicator is complete, the operation has 
completed.

Extract Application 
Servers’ session data

When the status indicator shows running stripes, the 
application server session data is being extracted. 
When the status indicator is complete, the extraction 
has completed.

Load Web Servers’ 
session data

When the status indicator shows running stripes, the 
Web server session data is being loaded. When the 
status indicator is complete, the loading has 
completed.

Processing The progress in the current step.

Total Progress Indicates the total progress of the SARM - User Trace 
Breakdown diagnostic tool.
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SARM - User Trace Breakdown - Analysis Report
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Description Enables you to view:

➤ Summary tab. A chart that displays the 
segmentation between the average Application 
Server time, Web Server time, Network time, and 
Database time for all of the relevant requests that 
were found in the files. For details, see “Summary 
Tab” on page 248.

➤ Sessions tab. The time distribution of the various 
sessions. For details, see “Sessions Tab” on page 249.

➤ Transaction tab. For each Business Process Monitor 
transaction, the timestamp of the session it belongs 
to, the session id, the application server name, the 
average total time of all requests that belong to that 
transaction, the number of request and the maximal 
request time. For details, see “Transactions Tab” on 
page 251.

➤ Application Server tab. A comparison between 
application servers in terms of times' distribution. 
For details, see “Application Servers” on page 253.

➤ Requests tab. For each request, the request detailed 
information. For details, see “Requests Tab” on 
page 254.

To Access: Running the user trace breakdown 
diagnostic tool. For details, see “SARM - User Trace 
Breakdown (Run the Diagnostics Tool) Page” on 
page 241.

Included in Tasks “View Configuration File CI – Details”
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Summary Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view a chart that displays the 
segmentation between the average Application Server 
time, Web Server time, Network time, and Database 
time for all of the relevant requests that were found in 
the files.  

GUI Element (A-Z) Description

<drill down> Drilling down one of the segments in the chart 
provides a pie chart that displays the segmentation 
between the sub areas of that segment. If there is 
another level of specification (available in Siebel 7.7), 
you can then drill down to the sub area level.

You can then click segments of the Area Breakdown 
chart to open the corresponding Sub Area Breakdown 
chart (if it exists). For details, see below.

<pie chart> The chart displays the segmentation between the 
average Application Server time, Web Server time, 
Network time, and Database time for all of the relevant 
requests that were found in the files.
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The breakdown is as follows:

Sessions Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Layer Breakdown Area Breakdown Sub Area Breakdown

Web Server N/A N/A

Application Server Application Manager Request Receipt (sessID SeqID)

Object Manager Session Re-Login

Communications Server 
Services

Communications Client 
Invoke Method 

Communications Server 
Invoke Method

Build Web Page Build View Layout

Show Applet, Build View Data

Build Applet

Get View Layout

Database Database Connector N/A

Network N/A N/A

Description Enables you to view the time distribution of the 
various sessions. 

GUI Element (A-Z) Description

Application Server The name of the application server on which the 
session is running.

Avg. Request Time 
(sec)

The average time the request spent in the session.

Date The timestamp of the session.
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Layer Breakdown The breakdown of the layer into its areas relative to the 
time spent by the session in each area: Web Server, 
Application Server, Database, and Network. Tooltips 
display the average time the session spent in each area.

Max Request Time 
(sec)

The maximum time spent by a request in the session. 
Scroll to the right to see the rest of the information.

No. of Requests The number of requests that ran in the session.

Session Id The ID of the session. You can drill the session ID to 
display information about the session requests. For 
details, see “Requests Tab” on page 254.

Summary You can select one or more sessions and click Summary 
to display a summary chart for the sessions you 
selected. For details, see “Summary Tab” on page 248.

Task ID The ID of the task the request belongs to.

Web Server The name of the Web server on which the session is 
running.

GUI Element (A-Z) Description
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Transactions Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view, for each Business Process Monitor 
transaction, the timestamp of the session it belongs to, 
the session id, the application server name, the average 
total time of all requests that belong to that 
transaction, the number of request and the maximal 
request time. 

GUI Element (A-Z) Description

<drill down a 
transaction>

Displays all of the requests that belong to that 
transaction. For details, see “Requests Tab” on 
page 254.

<tooltip> Click any part of the chart to get the tooltip that 
indicates the time the transaction spent in the layer, 
area, or sub area.

Application Server The name of the application server on which the 
transaction ran.
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BPM Time This column displays the time the invoked transaction 
ran in Business Process Monitor (only when the 
transaction is invoked using Invoke Business Process 
Monitor Script). This value is larger than the value in 
the Total Time column as it includes client time, 
network time, and so on.

Note: The BPM Time is displayed only when the SARM 
User Session Trace breakdown diagnostics has been run 
after invoking a BPM script monitoring the Siebel 
Application. Some additional tuning of Siebel 
Application\Web Server environment variables is 
required. This is due to the fact that the flush ratio of 
SARM files is approximately five times slower in the 
Web Server than in the Application Server, and 
therefore running SARM with the default value of 
SARM_MaxFileSize variable might not be enough for 
the SARM User Trace Breakdown diagnostic tool to 
return data. For details, see “Troubleshooting 
SARM-Related Issues” on page 278.

Date The date when the transaction ran.

Layer Breakdown The breakdown of the layer into its areas relative to the 
time spend by the transaction in each area: Web Server, 
Application Server, Database, and Network. Tooltips 
display the average time the transaction spent in each 
area.

Max. Request Time The maximum time spent by any of the requests in the 
transaction.

No. of Requests The number of transaction requests that ran in this 
application server.

Session ID The ID of the session.

Task ID The ID of the task the transaction belongs to.

Total Time The total time the transaction ran in Siebel.

GUI Element (A-Z) Description
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Application Servers

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Transaction Name The name of the transaction.

Web Server The name of the Web server on which the transaction 
ran.

Description Enables you to view a comparison between application 
servers in terms of times' distribution. 

GUI Element (A-Z) Description

<drill down an 
application server>

Displays all of the requests that were executed on that 
application server. For details, see “Requests Tab” on 
page 254.

Application Server. The name of the application server. You can drill the 
session ID to display information about the application 
server. For details, see “Requests Tab” on page 254.

Avg. Request Time The average time spent by a request executing in this 
application server.

Layer Breakdown The time consumption breakdown by layers into its 
areas relative to the time spent by the request in each 
area: Web Server, Application Server, Database, and 
Network. Tooltips display the average time the request 
spent in each area.

Max. Request Time The maximum time a request spent in this application 
server.

GUI Element (A-Z) Description
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Requests Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

No. of Requests The number of requests that ran in this application 
server.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 248.

Description Enables you to view, for each request, the request 
detailed information.

GUI Element (A-Z) Description

Application Server The name of the application server on which the task 
ran.

BPM Time Displays the time the invoked request ran in Business 
Process Monitor (only when the request is invoked 
using Invoke Business Process Monitor Script). This 
value is larger than the value in the Total Time column 
as it includes client time, network time, and so on. 

Note: The BPM Time is displayed only when the SARM 
User Session Trace breakdown diagnostics has been run 
after invoking a BPM script monitoring the Siebel 
Application. Some additional tuning of Siebel 
Application\Web Server environment variables is 
required. This is due to the fact that the flush ratio of 
SARM files is approximately five times slower in the 
Web Server than in the Application Server, and 
therefore running SARM with the default value of 
SARM_MaxFileSize variable might not be enough for 
the SARM User Trace Breakdown diagnostic tool to 
return data. For details, see “Troubleshooting 
SARM-Related Issues” on page 278.

GUI Element (A-Z) Description
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Date The date when the request ran.

Layer Breakdown The time consumption breakdown by layers into its 
areas relative to the time the request spent in each area: 
Web Server, Application Server, Database, and Network. 
Tooltips display the average time the request spent in 
each area.

Request ID The ID of the request. 

You can drill the request ID to display information 
about the area where the request ran. For details, see 
“Area Details Area” on page 256.

Session ID The ID of the session on which the request ran. Scroll 
to the right to see the rest of the information.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 248.

Task ID The ID of the task the request belongs to.

Total Time  The total time spent to execute a request.

Transaction Name  The name of the transaction the request belongs to.

Web Server The name of the Web server on which the task ran.

GUI Element (A-Z) Description
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Area Details Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Area Name The name of the area where the request ran. You can 
drill the area name to display information about its sub 
areas. For details, see “Sub Area Details Area” on 
page 257.

Avg. Execution Time The average time spent by the request executing in the 
area.

Exclusive Memory 
Max Allocated Sub 
Area

The amount of memory used by requests that entered 
only this area.

Max Execution Time The maximum time spent by the request executing in 
the area.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

No. of Sub Areas The number of sub areas in the area.

Non-Recursive 
Invocations

The number of times requests were invoked 
(non-recursive invocation) in the area.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the area.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 248.

Total Execution Time The total time spent by the request executing in the 
area.
256



Chapter 3 • HP Business Availability Center for Siebel Applications
Sub Area Details Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Area Name The name of the area where the sub area is located.

Avg. Execution Time The average time spent by the request executing in the 
sub area.

Exclusive Memory 
Max Allocated 
Instance

The amount of memory used by requests that entered 
only this sub area.

Max Execution Time The maximum time spent by the request executing in 
the sub area.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

No. of Instances The number of instances of the request.

Non-Recursive 
Invocations

The number of times requests were invoked 
(non-recursive invocation) in the sub area. Scroll to the 
right to see the rest of the information.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the sub area.

Sub Area Name The name of the sub area where the request ran. You 
can drill the sub area name to display information 
about the session requests. For details, see “Instance 
Details Area” on page 258.
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Instance Details Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 248.

Total Execution Time The total time spent by the request executing in the 
sub area.

GUI Element (A-Z) Description

Area Name The name of the area where the request ran. 

Avg. Execution Time The average time spent by the request executing in the 
instance.

Instance Name The name of the instance where the request ran.

Max Execution Time The maximum time spent by the request executing in 
the instance.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

Non-Recursive 
Invocations

The number of times requests were invoked 
(non-recursive invocation) in the instance.=Scroll to 
the right to see the rest of the information.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the instance.

Sub Area Name The name of the sub area where the request ran. 

GUI Element (A-Z) Description
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Siebel Database Breakdown Configuration Report

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 248.

Total Execution Time The total time spent by the request executing in the 
instance.

Description Enables you to run the Database Breakdown tool.

To Access: Select Applications > Business Availability 
Center for Siebel > Database Breakdown to open the 
Siebel Database Breakdown Configuration page.

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Siebel 
Database Breakdown option. For details, see 
“Customize Dashboard Display and Refresh Rate” in 
Using Dashboard.

Included in Tasks “View Configuration File CI – Details” on page 227

GUI Element (A-Z) Description
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Selection Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Available Transactions Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select an application In the list, select the Siebel application for which you 
want to analyze data.

Select an enterprise In the list, select the Siebel Enterprise.

User Name The value in the User Name box appears automatically 
when you select the application. The appropriate user 
name has been entered manually by your 
administrator after discovery has taken place and the 
monitoring script was recorded, but you can override 
it. For details, see “Deploy the SiteScope Siebel 
Monitors” on page 216.

Description Lists the transactions when you select a Siebel 
Enterprise and an application in the top part of the 
page. Click the Business Process Monitor transaction 
whose activity you want to analyze. (The list of 
transactions includes only those for which you have 
permissions.)

Important 
Information

For diagnostic purposes it is recommended to use a 
script running a dedicated user. This enables you to 
make sure diagnosis results refer to the Business Process 
Monitor transaction intended to be analyzed.
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Advanced Options Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Analyze Click to display the Siebel Tier Breakdown and Siebel 
Database SQL Breakdown pie charts. For details, see 
“Siebel Database Breakdown Analysis Report” on 
page 262.

Select a server Select a Siebel Application Server in the list. You can 
also leave All servers selected.

Select a Siebel 
component

Select a Siebel component in the list. Only the log level 
for that component is brought up. 

Using SiteScope Select the SiteScope machine you want to use to 
monitor the Siebel component in the list.
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Siebel Database Breakdown Analysis Report

An example of the report:
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An example of the detail of one segment of the pie chart:

Description Analyze the Siebel database logs that you have created 
to determine which of the component SQL operations, 
or parts of operations, were responsible for slow 
database response time.

To Access: Click Analyze on the Siebel Database 
Breakdown: Configuration (Advanced Option) page.

Included in Tasks “View Configuration File CI – Details” on page 227
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Siebel Deployment Validator Page

GUI Element (A-Z) Description

Siebel Database SQL 
Breakdown Pie Chart

Displays a breakdown of up to 15 of the most 
time-consuming SQLs.

Siebel Tier 
Breakdown Pie Chart

Shows the transaction’s database time relative to its 
application time.

Specific SQL 
Breakdown Pie Chart

Click, in the Siebel Database SQL Breakdown pie chart, 
a section representing the required SQL, to view the 
database-specific time distribution of that specific SQL. 
For each SQL operation, you can view the various 
database times: preparation time, execution time, 
initial fetch time, total time, and write time (time 
stamp). This enables you to isolate the exact segment 
responsible for the delay in the database response time. 
Underneath the Specific SQL Breakdown pie chart, you 
can view the corresponding SQL statement.

Description Enables you to execute all or part of the predefined 
tests that detect known problems that can occur while 
deploying HP Business Availability Center for Siebel 
Applications.

To access: Click Admin > Siebel Configuration.

Included in Tasks ➤ “Deploy HP Business Availability Center for Siebel 
Applications – Workflow” on page 194

➤ “Create Customized Deployment Validator Tests” on 
page 228

Useful Links “List of Predefined Tests for Siebel Deployment 
Validator” on page 266
264



Chapter 3 • HP Business Availability Center for Siebel Applications
The dialog box includes the following elements (in alphabetical order):

GUI Element (A-Z) Description

Select a test and click the button to run the test.

Select a test and click the button to stop the test.

Click to display the Siebel Deployment Validator Test 
Summary dialog box.

Click to display/hide the tests that ran successfully.

Displays the test execution progress:

➤ How many tests are running

➤ How many tests failed

➤ How many tests ended

Status The status of the test. It indicates that:

➤  – The test is in waiting mode.

➤  – The test is running.

➤  – The test has been performed successfully.

➤  – The test failed.
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List of Predefined Tests for Siebel Deployment Validator

Test Name The name of the test. Predefined tests enable you to 
detect known problems that may occur during HP 
Business Availability for Siebel Applications 
deployment. For a list of available tests and their 
description, see “List of Predefined Tests for Siebel 
Deployment Validator” on page 266.

A combination of parameter’s values is used to create 
the appropriate test. The values can be:

➤ @ALL@. The test checks all the appropriate items 
represented by the parameter (for example, the 
Siebel Enterprises View Test checks that the Siebel 
Enterprises view contains all the appropriate CIs for 
all Siebel Enterprises sites). 

➤ @ANY@. The test checks at least one appropriate 
item represented by the parameter (for example, the 
SiteScope Connection Test checks that at least one 
SiteScope working with the Windows operating 
system is attached to HP Business Availability 
Center). 

➤ @<value>@. Some of the parameters can only be set 
to @ALL@ or to some specific value. For example, 
the BPM Script Execution Test parameters creates the 
following test: run at least one of the BPMScripts 
(BPMScripts = @ANY@) connected to the Siebel 
Enterprise CI (Enterprises = @siebel@) on all the 
locations available (Locations = @ALL@).

Description The test description.

Category The application related to the test: BAC, BPM, or Siebel.

Execution Time The time and date when the test was last run.

GUI Element (A-Z) Description
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The predefined tests are listed below. 

Test Name 
(A - Z)

Checks That: Category Parameters

BPM 
Adapter 
Mode Test

The Business Process Monitor source adapter 
is in Transaction\Location mode.

If the test fails, see “Errors That Occur when 
Building the Siebel Enterprises View” on 
page 275.

BAC None

BPM 
Transaction 
Execution 
Test

The BPM Transaction can be executed.

If the test fails, see “Errors That Occur when 
Building the Siebel Enterprises View” on 
page 275.

If the test fails, see “Error: Could Not Run 
BPM Transaction” on page 294.

You can test one or more of the following 
cases:

➤ Specific transactions. The test is successful 
when all the specified transactions run 
successfully in all locations and Enterprises. 
This test configuration is recommended to 
test the availability of specific transactions.

➤ Specific locations. The test is successful 
when at least one transaction is successful 
in all the specified locations and for all 
Enterprises. This test configuration is 
recommended to test the availability of 
specific locations.

➤ All transactions, locations, and Enterprises. 
The test is successful when at least one 
transaction is successful in all locations and 
Enterprises. This test configuration is 
recommended to test the availability of all 
transactions, locations, and Enterprises.

BPM ➤ Locations = 
@ALL@ 

➤ BPMTransactions 
= @ANY@ 

➤ Enterprises = 
@ALL@ 
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Siebel 
Application 
Server 
Settings Test

The Log folder and SARM log folder are 
defined for the Siebel Application Server, and 
are accessible.

BAC ➤ Enterprises = 
@ALL@

➤ AppServers = 
@ALL@

➤ SiteScopes = 
@ALL@

Siebel 
Application 
Structure 
Test

At least one Siebel Application is linked to the 
selected Siebel Enterprise CI that has, at least, 
one child BPM Transaction CI.

BAC Enterprises = @ALL@

Siebel 
Enterprise 
SARM 
Analyzer 
Setting Test

The sarmAnalyzer path is defined and the 
folder is accessible from the Siebel Enterprise 
application.

BAC ➤ Enterprises = 
@ALL@

➤ SiteScopes = 
@ALL@

Siebel 
Enterprise 
Srvrmgr 
Settings Test

The Admin user name, Admin password and 
srvrmgr path are defined for the Siebel 
Enterprise, and the srvrmgr can be launched.

BAC ➤ Enterprises = 
@ALL@

➤ SiteScopes = 
@ALL@

Siebel 
Enterprises 
View Test

The Siebel Enterprises view contains Siebel 
Enterprises CIs with child Siebel Application 
Server, Siebel Web Server Extension, and 
Siebel Gateway CIs.

BAC Enterprises = @ALL@

Siebel 
Package 
Deployment 
Test

The Siebel_monitoring.zip package is 
deployed on HP Universal CMDB.

If the test fails, see “Siebel Enterprises View Is 
Not Found” on page 277.

BAC None

Siebel Tasks 
List 
Command 
Test

Checks the list tasks command of the Siebel 
server manager.

If the test fails, see “Errors That Occur when 
Building the Siebel Enterprises View” on 
page 275.

Siebel ➤ Enterprises = 
@ALL@

➤ SiteScopes = 
@ALL@

Test Name 
(A - Z)

Checks That: Category Parameters
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Siebel Deployment Validator Test Summary Dialog Box

The dialog box includes the following elements (in alphabetical order):

Siebel Web 
Server 
Extension 
Settings Test

The SARM log folder is defined for the Siebel 
Web Server Extension and is accessible.

BAC ➤ Enterprises = 
@ALL@

➤ WSE = @ALL@

➤ SiteScopes = 
@ALL@

SiteScope 
Connection 
Test

The SiteScope working with the Windows 
operating system is attached to HP Business 
Availability Center.

If the test fails, see “Errors That Occur when 
Building the Siebel Enterprises View” on 
page 275.

BAC SiteScopes = @ANY@

Description Displays the results of the Siebel Deployment Validator 
test run.

To access: Select a Deployment Validator test and click 
the Test Summary button .

GUI Element (A-Z) Description

Category The application related to the test: BAC, BPM, or Siebel.

Description The test description.

Error details The error message that explains why the test failed.

Last execution date Date when the test was last run.

Last time test passed Date when the test was last run successfully.

Test Name 
(A - Z)

Checks That: Category Parameters
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Status The status of the test. It indicates that:

➤  – The test is in waiting mode.

➤  – The test is running.

➤  – The test has been performed successfully.

➤  – The test failed.

Test Name The name of the test.

Test Parameters Click to open the area. The area lists the parameters 
used to run the test and their values and indicates 
where in the Infrastructure Settings you can modify the 
test parameters, add new tests, or delete existing tests.

GUI Element (A-Z) Description
270



Chapter 3 • HP Business Availability Center for Siebel Applications
Tasks Diagnostics Tool Report

Description Enables you to view details of Siebel Application Server 
tasks.

To Access: Select Applications > Business Availability 
Center for Siebel > Tasks to open the Task Diagnostics 
Tool page.

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Show Tasks 
in Error or Show Running Tasks option. For details, see 
“Customize Dashboard Display and Refresh Rate” in 
Using Dashboard.

Important 
Information

➤ To sort the tasks by a specific column, click the 
column heading.

➤ To move between pages, use the arrows 
 above the table.

Included in Tasks “View Configuration File CI – Details” on page 227
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced Filter If necessary, click the link to filter the list of tasks. For 
details, see “View Configuration File CI – Details” on 
page 227.

Apply When you click the button, the task information you 
requested is retrieved from the Siebel Application 
Server(s) and displayed on the Tasks Diagnostic Tool 
page.

CC_ALIAS The name of the component the task belongs to.

CC_INCARN_NO The number of times the task was restarted.

CC_RUNMODE The mode used to execute the task: Interactive or 
Batch.

CG_ALIAS The name of the component group the task belongs to.

Enterprise Select the Siebel site/enterprise for which you want to 
view task data.

Status Select the specific status—Running, Paused, Stopping, 
Completed, Exited with Error, or Killed. Alternatively, 
you can select to view tasks of all statuses.

SV_NAME The name of the server on which the task is running.

TK_DISP_RUNSTATE The state of the task: Running, Paused, Stopping, 
Completed, Exited with Error, or Killed. 

TK_END_TIME The time when the task stopped executing.

TK_IDLE For future use.

TK_LABEL The name of the user who is running the tasks. Some 
tasks (such as the ones belonging to the system 
component group) do not have a user.

TK_PARENT_T The task that caused this task to execute.
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Tasks Diagnostics Tool - Advanced Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

TK_PID The operating system process ID that deals with the 
task. One process can handle more than one task. This 
column displays data only for tasks whose 
TK_DISP_RUNSTATE is running.

TK_PING_TIM For future use.

TK_START_TIME The time when the task started to execute.

TK_STATUS A description of the task—added by the task. If 
TK_DISP_RUNSTATE is Exited with Error, TK_STATUS 
displays the error message.

TK_TASKID The ID of the task.

TK_TASKTYPE The urgency of the task.

User To focus on the tasks of a specific user, fill in the user 
name in the User box.

Description Use the advanced filter to filter the list of tasks you 
want to display.

To Access: In the Task Diagnostics Tool page, click the 
Advanced Filter link to open the Tasks Diagnostics Tool 
Advanced Filter page.

GUI Element (A-Z) Description

Component Select the specific component for which you want to 
view task data.

Component group Select the specific component group for which you 
want to view task data.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

This section includes troubleshooting for the HP Business Availability 
Center for Siebel Applications.

This section includes the following topics:

➤ “Troubleshooting Errors in Logs” on page 274

➤ “Troubleshooting Siebel Enterprises View” on page 276

➤ “Troubleshooting Diagnostics Tools” on page 277

➤ “Troubleshooting SARM-Related Issues” on page 278

➤ “Troubleshooting Database Breakdown” on page 292

➤ “Troubleshooting Processes” on page 295

➤ “Troubleshooting Tasks” on page 296

Troubleshooting Errors in Logs
Logs are available to help you debug problems with Siebel views and 
problems that occur when using the Siebel diagnostics tools. 

This section includes the following topics:

➤ “Errors That Occur when Building the Siebel Enterprises View” on page 275

➤ “Errors That Occur when Running One of the Diagnostics Tools” on 
page 276

Server Select the specific server whose task data you want to 
view.

Using SiteScope Select the SiteScope machine you want to use to 
retrieve task data from the Siebel Application Server, if 
you do not want HP Business Availability Center for 
Siebel Applications to use the default SiteScope 
machine.

GUI Element (A-Z) Description
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Errors That Occur when Building the Siebel Enterprises View

When this type of error occurs, run the following tests to pinpoint the 
problem:

➤ SiteScope Connection Test

➤ BPM Adapter Mode Test

➤ Siebel Task List Command Test

➤ BPM Transaction Execution Test

For details about the tests, see “List of Predefined Tests for Siebel 
Deployment Validator” on page 266.

You can also check the Siebel.ejb.log file (on the Modeling server). It 
includes information about all the automatic links between the Business 
Process Monitor or SiteScope and the Siebel CIs whether these links worked 
correctly or not.

For details about the automatic links, see “Use a Business Process Profile to 
Simulate Siebel Users” on page 206.

To debug the log:

 1 Open the <HP Business Availability Center root 
directory>\conf\core\Tools\log4j\EJB\topaz.properties file

 2 In the line that follows, change ${loglevel} to debug. The lines should be as 
follows: 
log4j.category.com.mercury.topaz.vertical=debug, vertical.appender
log4j.category.com.mercury.am.bac.vertical.rules=debug, vertical.appender

 3 Open the error log, located on the Modeling server at the following 
location:
<HP Business Availability Center root directory>\log
\EJBContainer\Siebel.ejb.log

 4 Locate the #define appender for vertical module line.

 5 You can now analyze the log information.
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 6 After you complete the debugging tasks, make sure to change debug back to 
${loglevel} in the lines that follows #define appender for vertical module. 
The lines should be as follows:
log4j.category.com.mercury.topaz.vertical=${loglevel}, vertical.appender
log4j.category.com.mercury.am.bac.vertical.rules=${loglevel}, 
vertical.appender

Errors That Occur when Running One of the Diagnostics Tools

The Siebel.ejb.log file (on the Center server) includes detailed information 
about the operations that take place in the Siebel Diagnostics tools.

For details about the Siebel Diagnostics tools, see “HP Business Availability 
Center for Siebel Applications” on page 177.To debug the log:

 1 Open the <HP Business Availability Center root 
directory>\conf\core\Tools\log4j\EJB\topaz.properties file

 2 In the line that follows, change ${loglevel} to debug. The line should be as 
follows:
log4j.category.com.mercury.topaz.siebel=debug, siebel.appender

 3 Open the error log, located on the Center server at the following location:
<HP Business Availability Center root directory>\log
\EJBContainer\Siebel.ejb.log

 4 Locate the #define appender for siebel line.

 5 You can now analyze the log information.

 6 After you have completed the debugging tasks, make sure to change debug 
back to ${loglevel} in the line that follows #define appender for siebel. The 
line should be as follows:
log4j.category.com.mercury.topaz.siebel=${loglevel}, siebel.appender

Troubleshooting Siebel Enterprises View
This section describes issues related to the Siebel Enterprises View and how 
to solve these problems.

This section includes the following topics:

➤ “Siebel Enterprises View Is Not Found” on page 277

➤ “Session Data Is Not Available” on page 277
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➤ “Task Data Is Not Available” on page 277

Siebel Enterprises View Is Not Found

If the "Siebel Enterprises" view is not found, or if the Siebel Package 
Deployment Test fails, check that the Siebel Monitoring package appears in 
the Package Manager. For details, see “Package Manager” in Model 
Management.

For details about the Siebel Package Deployment Test, see “List of 
Predefined Tests for Siebel Deployment Validator” on page 266.

Session Data Is Not Available

If, in the view, the Sessions KPI is empty, it might be because the No. of 
Running Sessions measurement is not monitored for an application server/
component in the relevant Siebel Application Server monitor. 

Task Data Is Not Available

If, in the view, the Tasks in Error KPI is empty, it might be because the No. of 
Tasks in Error measurement is not monitored for an application server/
component in the relevant Siebel Application Server monitor.

Troubleshooting Diagnostics Tools
This section describes issues related to the Diagnostics tools and how to 
solve these problems.

Matching Connection Parameters to SiteScope

When one of the diagnostics tools is activated, a temporary SiteScope 
monitor is created, run, and then erased. The connection parameters used 
are the ones that exist in the various relevant CIs (Enterprise, Application 
Server, and so on).
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You must check that the connection parameters (user name, password, 
enterprise name, and gateway name) used in the CIs must conform to the 
parameters used in the permanent SiteScope monitors monitoring the Siebel 
Enterprise. (If the connection parameters do not match, then most 
diagnostics features do not work.) For example, the same user name and 
password needs to be utilized in the Siebel Enterprise configuration and in 
the permanent monitors defined in SiteScope.

If a problem occurs, check the SiteScope error log (in SiteScope under the 
logs directory) and the Siebel log and check the list of parameters used to 
access SiteScope and Siebel. For details about the Siebel log, see “Errors That 
Occur when Running One of the Diagnostics Tools” on page 276. 

Troubleshooting SARM-Related Issues
This section describes issues related to Siebel Application Response 
Measurement (SARM) and how to solve these problems.

This section includes the following topics:

➤ “Large Log Files” on page 279

➤ “Siebel Application Response Monitoring (SARM)” on page 279

➤ “SARM Does Not Work” on page 287

➤ “SARM Data Does Not Generate Properly” on page 288

➤ “SARM Analyzer Crashes” on page 289

➤ “SARM Analyzer Fails to Run” on page 289

➤ “SARM Configuration Issues” on page 290

➤ “Sitescope Server Failed to Access a Siebel SARM Folder or File” on page 290

➤ “Operation Completed with Several Errors” on page 291

➤ “Timed-out Execution of a SARM Task or SARMAnalyzer Execution” on 
page 291

➤ “No Working Sitescope Server Could Be Found” on page 291
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Large Log Files

The Siebel logging mechanism for an application is sometimes configured in 
such way that all log data is written to a few large log files instead of creating 
a separate log file per task. Large log files are a problem because parsing takes 
a long time.

To solve the problem, two solutions are available:

➤ The Siebel administrator should configure the relevant parameters so that 
each task writes to a separate log data file. 

➤ The Siebel administrator should provide:

➤ A script to be used before running the diagnostic tools. That script should 
set the logging mechanism to log each task into a separate file. This is 
required when you want to use the Database Breakdown reports and may 
also be relevant when the Siebel Log Monitor is configured. Consult 
Siebel documentation for more detailed instructions.

➤ A script to be used after running the diagnostics tool. That script should 
switch the log level back to its initial state.

Siebel Application Response Monitoring (SARM)

This section describes how to improve Siebel configuration so SARM works 
properly and how to solve SARM-related issues in Siebel.

This section includes the following topics:

➤ “Enabling SARM for Siebel” on page 280

➤ “Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 284

➤ “Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 284

➤ “Tips” on page 285

➤ “SARM on the Windows NT Platform” on page 285

➤ “SARM on the UNIX Platform” on page 285
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Enabling SARM for Siebel

You can control Siebel Application Response Monitoring (SARM) using 
Siebel server parameters and environment variables. To enable SARM, you 
must enable specific SARM parameters for the Web server using 
environment variables and for the Siebel Server using Server Manager or the 
Siebel Server Manager Graphical User Interface. When a component starts 
up in the Siebel Enterprise, it checks the status of the following SARM 
parameters:

➤ For Siebel 7.5.3:

Name of SARM 
Parameter in the Web 
Server

Name of SARM 
Parameter for 
Application Server

Description

SIEBEL_SarmEnabled SARMEnabled Indicates whether SARM is enabled or disabled 
for a Siebel Server Component. The default 
value is false. This parameter can be set at the 
Siebel Enterprise level, Siebel Application 
Server level, or Siebel Component level.

SIEBEL_SarmMaxMemory SARMMaxMemory The maximum size of the SARM memory. This 
parameter can be set at the Siebel Server or 
Siebel Server Component level. 

SIEBEL_SarmMaxFileSize SARMMaxFileSize The maximum size of a SARM file. SARM 
continues to append file segments to the 
current file until the maximum size is reached. 
When the limit is reached, SARM starts a new 
file. The default value is 20,000,000 (~20 MB) 
and is specified in bytes.
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➤ For Siebel 7.7 or 7.8:

You can enable SARM for the Web server only at the Web server level, and 
for the application server either at the Application Server level, or at the 
component level (see the procedures below for more details).

To enable SARM for Siebel at the Web server level:

 1 Update the values of the appropriate environment variables parameters 
listed in the table above.

 2 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 284 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 284.

 3 Restart the Siebel server for the new values to take effect.

Name of SARM 
Parameter in the Web 
Server

Name of SARM 
Parameter for 
Application 
Server

Description

SIEBEL_SARMBufferSize SARMBufferSize The size of the SARM buffer. The default value is 
5,000,000 bytes (~5MB). 

SIEBEL_SARMLevel SARMLevel The SARM granularity level. The default value is 0. 
This parameter can be set at the Siebel Server or 
Siebel Server Component level.

SIEBEL_SARMFileSize SARMFileSize The maximum size of a SARM data file. The default 
value is 15,000,000 bytes (~15MB).

SIEBEL_SARMMaxFiles SARMMaxFiles The maximum number of SARM files determines 
how many SARM files should be saved for a session. 
The recommended value is 5.

SIEBEL_SarmPeriod SARMPeriod The SARM period is the time when SARM outputs 
the stored data to the SARM log file regardless of the 
Buffer size. The default value is 3.
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Note: SARM is disabled by default. 

To enable SARM for Siebel at the Application level from the environment 
variables:

 1 Update the values of the appropriate environment variables parameters 
listed in the table above.

 a Check whether the settings for the SarmMaxMemory and 
SarmMaxFileSize parameters are appropriate since these parameters 
determine how soon SARM flushes its data to a disk, and how large the 
SARM files can be. For details on the recommendations for these 
parameters settings, see “Calculating the SarmMaxFileSize Parameter for 
Siebel 7.5.3” on page 284 or “Calculating the SarmMaxFileSize Parameter 
for Siebel 7.7 or 7.8” on page 284.

 b Restart the Siebel server for the new values to take effect.

Note: 

➤ The Application Server Parameters can be updated from either the 
environment variables or from the Siebel Server user interface (follow the 
procedure below). If the parameters are defined both in the user interface 
and the environment variables, the environment variables override the 
user interface definitions. 

➤ SARM is disabled by default. 

To enable SARM for Siebel at the Application Server level from the Siebel 
Server user interface:

 1 In Siebel Server Manager Graphical User Interface, select Site Map > Server 
Administration > Servers > Server Parameters.

 2 In the Server Parameters List Applet, query for SARM.

 3 Update the values of the appropriate parameters listed in the table above.
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 4 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 284 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 284.

Note: 

➤ The Application Server Parameters can be updated from either the 
environment variables (follow the procedure above) or from the Siebel 
Server user interface (follow the procedure below). If the parameters are 
defined both in the user interface and the environment variables, the 
environment variables override the user interface definitions. 

➤ SARM is disabled by default. 

To enable SARM for Siebel at the component level:

 1 In Siebel Server Manager Graphical User Interface, select Site Map > Server 
Administration > Servers > Component Parameters.

 2 In the Component Parameters List Applet, query for SARM.

 3 Update the values of the appropriate parameters listed in the table above.

Note: SARM is disabled by default. 

 4 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 284 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 284.
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Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3

This section describes the SarmMaxFileSize parameter settings 
recommended for working with SARM in Siebel 7.5.3.

The amount of data that is written per second can be calculated in the 
following way:
37kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/
<nbr_of_server_components_instances>

For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component of the application, the file size should be:
37*20*60/3 = 14,800 Kb. Therefore the SARM Data File Size Limit should be 
set to 15,000,000. The buffer size should be set to 4,000,000. The growth 
rates of the Web server data is 1/5 the growth of the Application Server data.

Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8

This section describes the SarmMaxFileSize parameter settings 
recommended for working with SARM in Siebel 7.7 or 7.8.

The amount of data that is written per second in Siebel 7.7 or 7.8 depends 
on the granularity level and can be calculated in the following way:

➤ Level 1 (SIEBEL_SarmLevel=1). The calculation is as follows:
10kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/
<nbr_of_server_components_instances>

For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component, the file size should be: 10*20*60/3 = 
4,000 Kb. Therefore, the SARM Data File Size Limit should be set to: 
4,000,000.

➤ Level 2 (SIEBEL_SarmLevel=2). To store more data. The calculation is as 
follows:
60kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/ 
<nbr_of_server_components_instances>
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For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component, the file size should be: 60*20*60/3 = 24,000 
Kb. Therefore, the SARM Data File Size Limit should be set to: 24,000,000.

Tips

 1 To save disk space, it is recommended to enable SARM only for Object 
Manager components since Siebel is only measuring the Object Managers 
time for the User Session trace.

 2 If you restart the Siebel Application Server or the Web server regularly it is 
recommended to search, in the log folder, for old SARM files that can be 
deleted. Every time you restart the server a new log file, which includes the 
Process ID, is created. Only five log files with the same Process ID are kept at 
a time (the older ones are overwritten). Files with other Process IDs must be 
deleted manually. This procedure saves disk space and also improves the 
efficiency of the User Session Breakdown. 

It is best if the number of SARM files saved in the SARM folders is minimal. 
Save only the files you want to retrieve data from. Other files can be moved 
to another folder (not to a sub-directory of the SARM folder) and can be 
used later. Too many SARM files in the SARM directories cause the SARM 
tool to work more slowly.

SARM on the Windows NT Platform

When working with the SARM tool in Siebel 7.8, use SARM Analyzer for 
Siebel version 7.7.

SARM on the UNIX Platform

When working with the SARM tool on a UNIX platform, check that the 
following requirements are met:

➤ For Siebel 7.7 and 7.8

➤ When working with the SARM tool in Siebel 7.8, use SARM Analyzer for 
Siebel version 7.7.

➤ The SARM feature is supported only if SiteScope is installed on a 
Windows NT platform.
285



Chapter 3 • HP Business Availability Center for Siebel Applications
➤ A connection must exist between SiteScope and the Siebel machine. The 
SiteScope user must have permission to read from the relevant directories 
(it means that the user has to be declared as a mounting point machine 
user and as a UNIX user).

➤ For Siebel 7.5.3

Note: The SARM user trace breakdown diagnostic tool is not recommended 
for use on Siebel 7.5.3 running on UNIX. It only works for full UNIX 
environments (in Siebel 7.7 you can work with mixed environments). This 
is a limitation from Siebel. For example, in Siebel 7.5.3, the SARMAnalyzer 
tool cannot work on files from different environments; therefore, if you use 
SARMAnalyzer for the Windows NT platform you must work only with the 
Windows NT environment.

➤ The SiteScope user has execution permissions for the server manager and 
the SARM Analyzer.

➤ A mount point must exist between the SiteScope machine and the Siebel 
machine.

➤ The SiteScope user must have permissions to read from the relevant 
directories on the Siebel machine.

➤ Make the following changes to the start-monitor and start-service scripts 
located in the <SiteScope>/classes directory: insert all the variables that 
are related to LD_LIBRARY_PATH from the siebenv.sh file (generally 
located in the siebsrvr directory), and set them to be accurate (insert all 
the definitions from the siebenv.sh file). This definition is needed to run 
srvrmgr and SARMAnalyzer on the SiteScope machine with mount. It is 
recommended to copy the srvrmgr and SARMAnalyzer directories to 
SiteScope for better performance.
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SARM Does Not Work

Ensure that all steps of the following checklist are followed.

 1 Check that the SARM Analyzer path that you defined for the Siebel 
Enterprise is accessible through SiteScope, by running the Siebel Enterprise 
SARM Analyzer Setting Test. For details, see “Siebel Deployment Validator 
Page” on page 264.

 2 Check that at least one Web Server, one Application Server, and one 
Gateway Server have been discovered during the discovery process, by 
running the Siebel Enterprises View Test. For details, see “Siebel Deployment 
Validator Page” on page 264.

 3 Check that the SARM log folder defined for the Web Server is accessible 
through SiteScope, by running the Siebel Web Server Extension Setting Test. For 
details, see “Siebel Deployment Validator Page” on page 264.

 4 Check that the SARM log folder defined for the Application Server is 
accessible through SiteScope, by running the Siebel Application Server Setting 
Test. For details, see “Siebel Deployment Validator Page” on page 264.

 5 Check that SiteScope is running with a user on the SiteScope machine:

➤ In the SiteScope machine, open Services.

➤ Right-click the SiteScope service to open its properties.

➤ Click the Log On tab.

➤ Check that This Account is checked.

➤ Check that the user name and password are correct.

 6 To run the SARM Analyzer tool, check that the directory 
<SiteScope_root_directory>\tools\sarmdiagnostics exists on the SiteScope 
server.

 7 Check that Siebel Server Manager properties are defined properly for the 
Siebel Enterprise, in IT universe (select Admin > Universal CMDB > Modeling 
> IT Universe Manager) in HP Business Availability Center (for more 
information, see “Matching Connection Parameters to SiteScope” on 
page 277).

 8 Check that SiteScope is attached.
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 9 If you checked the entire list and SARM still does not work, check the 
following options:

➤ “SARM Data Does Not Generate Properly” on page 288

➤ “SARM Analyzer Crashes” on page 289

SARM Data Does Not Generate Properly

If the No Relevant Sessions error message is issued when you know that you 
should have data, SARM might not generate properly.

To identify the problem: 

 1 Open one the XML files located in the relevant SiteScope in the following 
directory: <SiteScope installation directory>\cache\tempbyage
\<TimeStamp>_SIEBEL_SARM\ <web_server>_<App_server>

Note: If there are no XML files in that directory follow the next procedure.

 2 Select any of the last requests in the XML file:

➤ If the request does not include a <SiebsrvrDetails> section with a 
<Group> node under it, then Siebel is not generating the SARM data 
properly.

➤ If the request does include a <SiebsrvrDetails> section with a <Group> 
node under it, then follow the procedures below. For details, see below or 
“SARM Analyzer Fails to Run” on page 289.

To solve the problem:

 1 The generated XML files are being deleted from the SiteScope and 
HP Business Availability Center after the generation of the SARM report. To 
see them you should first select the appropriate settings to save these files 
and not delete them. For details, see “Save the Generated XML Files After 
Generating the SARM Report” on page 230.

 2 Delete all the SARM files from the Application Server and from the Web 
server. 

 3 If this does not help, restart the Siebel machine.
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SARM Analyzer Crashes

If the No Relevant Sessions error message is issued when you know that you 
should have data, SARM Analyzer might have crashed because the requests 
counter was reset to 0 in the middle of the session without any logical 
reason. Another indication is that it takes at least five minutes for this error 
to appear, because the execution of the batch files in SiteScope times out.

To identify the problem: 

SARM Analyzer has crashed if any one of the following situations occurs:

➤ A message (No relevant sessions were found) is issued, indicating that there 
are no sessions when you know there should be sessions.

➤ The timestamp of the crash<nnn> file in the SARM Analyzer folder 
corresponds to the time when you ran the User Session Trace. This 
indication almost always occurs.

➤ An error message is issued in the SiteScope machine. This indication is rare.

To solve the problem:

Connect to the Siebel Web server, and delete (locally) the last SARM binary 
file from the Web server log folder. 

If this does not help and the problem occurs again, restart the Siebel 
machine. 

SARM Analyzer Fails to Run

When you run the SARM Analyzer from a remote machine (not locally on 
the SiteScope machine), the SARM Analyzer fails to run.

To identify the problem: 

SARM Analyzer failed to run if any one of the following situations occurs:

➤ A message (No relevant sessions were found) is issued, indicating that there 
are no sessions when you know there should be sessions.

➤ One of the following errors was added to the SiteScope sarmAnalyzer.log log 
in <SiteScope installation directory> 
\Tools\sarmDiagnostics\log\sarmAnalyzer.log during the execution of the 
SARM diagnostics:
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➤ Failed to analyze app server SARM files

➤ SarmAnalyzer failed

➤ Error running command: <command_name>

Note: The problem occurs because of a different domain or because of 
permissions issues.

To solve the problem: 

Check that SiteScope can communicate with the Siebel server.

SARM Configuration Issues

SARM configuration is not correct, if SARM is configured to store data for a 
long period of time (several days), or if processing takes too long.

To solve the problem: 

Configure SARM correctly.

Sitescope Server Failed to Access a Siebel SARM Folder or File

After running SARM Diagnostics, the error message A Sitescope server failed 
to access a Siebel SARM folder or file. Make sure all SiteScope servers have 
the proper permissions. is displayed.

This usually happens because the user name used to log to the SiteScope 
Service does not have the appropriate permissions to access the SARM folder 
on the Web or application server.

To solve the problem:

 1 Go through steps 3 to 8 of the SARM Does Not Work procedure above. For 
details, see “SARM Does Not Work” on page 287.

 2 Log in to one of the SiteScope machines with the SiteScope username and 
password, and try to access the SARM folders defined in HP Business 
Availability Center. 
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Operation Completed with Several Errors

After running SARM Diagnostics, the error message The operation 
completed with several errors. Please check the logs for more information. 
is displayed.

This error can be caused by a number of reasons, including unexpected 
SARMAnalyzer output, network issues, or Server manager errors. 

To check the errors that occurred, go through the following log files and 
search for error messages logged around the time you invoked User Session 
Breakdown:

➤ On the HP Business Availability Center Gateway server: 
<HP Business Availability Center root directory>
/log/EJBContainer/siebel.ejb.log

➤ On the SiteScope machine: 
<SiteScope root directory>/tools/sarmDiagnostics/log/sarmAnalyzer.log

Timed-out Execution of a SARM Task or SARMAnalyzer 
Execution

If the sarmAnalyzer.log (SiteScope) indicates that a SARM task or 
SARMAnalyzer execution has been timed-out, increase the default timeout 
for either a SARM task or a SARM analyzer execution. For details, see 
“Increase the Default Timeout for Either a SARM Task or a SARM Analyzer 
Execution” on page 232.

If the Siebel.ejb.log (on the Gateway Server) indicates that an execution of a 
SiteScope monitor got timed-out, change the default timeout for the 
execution of this monitor. For details, see “Increase the Default Timeout for 
Either a SARM Task or a SARM Analyzer Execution” on page 232.

No Working Sitescope Server Could Be Found

If the message No working SiteScope server could be found to process 
SARM data. is issued when running SARM Diagnostics, proceed as explained 
in this section.
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To solve the problem:

 1 Open the Advanced Options section of the User Trace Breakdown page in 
HP Business Availability Center. For details, see “Siebel Views” on page 191.

 2 Verify that the SiteScope servers that are selected in Using SiteScope: list are 
the servers you want to use for SARM diagnostics.

 3 Go through steps 5- 8 (of the SARM Does Not Work section) for these 
servers. For details, see “SARM Does Not Work” on page 287.

 4 If this does not help, restart the SiteScope servers.

Troubleshooting Database Breakdown
This section describes how to solve Database Breakdown-related issues.

This section includes the following topics:

➤ “Problem When Searching for a Task Using the Siebel Database Breakdown 
Tool” on page 293

➤ “Only the Total Database Time Chart and Not the 15 SQLs Chart Is 
Displayed” on page 293

➤ “Error: Cannot Raise Log Level” on page 294

➤ “Error: Could Not Retrieve Log File” on page 294

➤ “Error: Could Not Run BPM Transaction” on page 294

➤ “Limitation: The Siebel Log Monitor Does not Work on a UNIX Platform” 
on page 295

➤ “Error: Database Breakdown Analysis Data for the Transaction Cannot Be 
Displayed” on page 295
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Problem When Searching for a Task Using the Siebel Database 
Breakdown Tool

If the Siebel Enterprise uses a gateway with an additional SSL that supplies 
dynamic IDs for every user session, searching for the proper tasks using the 
Siebel Database Breakdown tool may be problematic. 

To solve the problem:

A possible solution is to find the correlation in the VuGen script and to 
update the Siebel Application’s user in the Siebel Application Configuration. 

To do so, select Admin > Universal CMDB, select the Siebel Enterprises view, 
select the appropriate Siebel Application CI in View Explorer, and select the 
Properties tab. In the Other Properties area, enter the appropriate user name 
in the Emulated Transaction User Name box, and click OK. 

Note: It is recommended to use a script with no more than five transactions 
when using the Database Breakdown diagnostics. 

Only the Total Database Time Chart and Not the 15 SQLs Chart 
Is Displayed

When the Siebel Database SQL Breakdown pie chart displays only the total 
database time chart and not the 15 SQLs chart, then there were no 
significant SQL queries to display. The chart displays only the 15 SQL 
queries that were the most time consuming. If all SQLs were under 1% of the 
total execution time of the transaction, then this information is not 
displayed. For details, see “Siebel Database Breakdown Analysis Report” on 
page 262.
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Error: Cannot Raise Log Level

The error message: Cannot raise log level is issued in one of the following 
situations:

➤ A server manager has not been copied to the SiteScope server. For details, see 
“Copy the srvrmgr Tool and the SARM Analyzer Tool to the SiteScope Server 
– Details” on page 203.

➤ You did not configure the correct parameters for the Siebel Enterprise CI. For 
details, see “Matching Connection Parameters to SiteScope” on page 277.

➤ There is no license for Siebel in the SiteScope. For details, see “Check the 
Siebel License in SiteScope” on page 197. 

Error: Could Not Retrieve Log File

When the error message: Could not retrieve log file is issued, check the log 
folder of the server where the Siebel application is located. Ensure that it is 
shared and that there is access to it from SiteScope, so the user can open the 
shared folder from the SiteScope and copy files from it. Check also that all 
the relevant Siebel servers have a remote definition on the SiteScope. For 
details, see “Microsoft Windows Remote Preferences” in Using System 
Availability Management.

Error: Could Not Run BPM Transaction

When the error message: Could not run BPM transaction is issued or when 
the BPM Transaction Execution Test fails, one of the following situations 
may have occurred:

➤ The Business Process Monitor server is down.

➤ The connection from HP Business Availability Center to the Business Process 
Monitor is problematic.

➤ There is a problem with the Business Process Monitor script.

To solve the problem, access the Business Process Monitor and run the 
transaction manually to check if there is a problem with the Business 
Process Monitor.

For details about the BPM Transaction Execution Test, see “List of Predefined 
Tests for Siebel Deployment Validator” on page 266.
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Limitation: The Siebel Log Monitor Does not Work on a UNIX 
Platform

The SiteScope Siebel Log monitor does not work when logs are located on a 
UNIX platform.

Error: Database Breakdown Analysis Data for the Transaction 
Cannot Be Displayed

The error message: Database breakdown analysis data for the transaction 
cannot be displayed. This might be because the analysis filters currently set 
for the transaction exclude the existing data. is displayed when the time 
zone and time definitions of the SiteScope server or Business Process 
Monitor server used for the Database Breakdown tool are not synchronized 
with the Siebel server time zone and time definition.

A workaround is to synchronize the time zone and time definition of the 
servers and if they are synchronized, to rerun the Database Breakdown tool.

Troubleshooting Processes
This section describes how to solve processes-related issues.

Processes Tool Does Not Function Or Files Do Not Get Through 
SiteScope

➤ Check that the SiteScope user has permission to log to the Siebel machines. 

➤ If another user is currently running SiteScope or ran SiteScope when the 
SiteScope server had not been booted, restart the SiteScope machine and the 
SiteScope service.

➤ Check that all Siebel servers are defined as remote servers on the SiteScope 
server.
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Troubleshooting Tasks
This section describes how to solve task-related issues.

No. of tasks in error Counter

The No. of tasks in error counter reports all the tasks that have exited with 
error in the last hour.

In the advanced options of the SiteScope monitor, if you configure the 
Siebel Tasks Time Window parameter to 0, the No. of tasks in error counter 
displays all the tasks regardless of their start time.
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HP Business Availability Center APIs

The following APIs are included with HP Business Availability Center:

➤ Generic Reporting Engine API. Enables extraction of data from the Business 
Availability Center database for use with third-party or custom tools. For 
details, see “Working with the Generic Reporting Engine API” on page 301.

➤ CMDB API. Enables writing configuration item definitions and topological 
relations to the CMDB (Configuration Management Database), and 
querying the information with TQL and ad hoc queries. For details, see 
“Working with the HP Universal CMDB API” on page 325.

➤ Dashboard API. Enables retrieving information about one or more views in 
an HP Business Availability Center system through a URL-based query to the 
database. For details, see “Working with the Dashboard API” on page 395.
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Working with the Generic Reporting 
Engine API 

Note to HP Software-as-a-Service customers: For details on how to use the 
Generic Reporting Engine API in an HP Software-as-a-Service environment, 
contact HP Software-as-a-Service Support.

This chapter explains how to manually work with the Generic Reporting 
Engine API to extract data from HP Business Availability Center for use with 
third-party or custom tools.

This chapter includes:

 ➤  Introducing the Generic Reporting Engine API on page 302

 ➤  Data Returned on page 303

 ➤  Querying with a Browser on page 304

 ➤  Using the Web Service on page 305

 ➤  Supported SQL Syntax on page 305

 ➤  Query Limitations on page 306

 ➤  Date-Time Values on page 307

 ➤  byTime Function on page 308

 ➤  Query Examples on page 309

 ➤  Legacy Queries on page 310
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Introducing the Generic Reporting Engine API

The recommended method for creating API-level queries to the profile 
database is building queries using the Custom Query Builder. The Custom 
Query Builder enables the building of queries using a graphical user 
interface, and facilitates the generation of reports, extraction of data in 
different formats, and generation of query URLs that can be used with 
third-party or custom tools. For details, see “Custom Query Builder” in 
Reports.

The Generic Reporting Engine API also enables manual creation of queries 
using the following methods:

➤ Web browser. The request is sent as an HTML query and the data is returned 
as HTML or as a CSV (Comma Separated Values) file that can be opened with 
Microsoft Excel or processed with a custom tool.

➤ Web Service. The return object contains the data in CSV format.

The remainder of this chapter describes how to create queries manually.

Prerequisite Knowledge
Users of the API should be familiar with SQL syntax and HP Business 
Availability Center administration and applications. Users of the API via 
Web Service should also be familiar with the SOAP specification and an 
object-oriented programming language such as C++ or Java.

Permissions
For a query to access the data using the API query syntax described below, 
the user and password parameters passed in the query must be those of a 
user with either System Viewer or Superuser permissions. (For details on 
setting permissions in the Permissions Manager, see “Permissions Overview” 
in Platform Administration.)

Configuration
You can configure the API options at Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Foundations > Generic Data Engine 
Open API. You can set the maximum number of data rows returned, as well 
as disable use of the Generic Reporting Engine API.
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Getting Metadata on the Samples
When building queries, you must know the data representation of the 
sample. For information on commonly queried samples and descriptions of 
their fields, see “Data Samples” in Reference Information.

Advanced Sample Retrieval
Users with special reporting needs can retrieve a list of all samples and their 
fields using the MBean Inspector. Access the MBean Inspector page by 
entering the following URL in your browser:

http://<server>[:port]/jmx-console/
HtmlAdaptor?action=inspectMBean&name=Topaz%3Aservice%3DMeta-Data+
Manager

The default port number is 8080. If this port is incorrect, consult your 
system administrator for the correct port number.

On the MBean Inspector page, click the Invoke button next to the operation 
showMetaDataDBMapping. The bean returns a list of fields in each sample.

Data Returned 

The same data is returned whether the request is made from a browser or 
with the Web Service. With a browser, the data resides in the response body, 
and for the Web Service, the data resides in the return object.

Web Browser Response Body
When the query is submitted from a browser, the response CSV or HTML 
contains the data, or error code and message. If the number of rows to be 
returned exceeds the maximum, the last row of the data is Returned X of Y 
rows, where X is the number of rows returned and Y is the actual number of 
rows that fulfil the conditions of the query. If there is an error at the engine 
level, the HTTP success code is returned, but the body of the response is 
<error code>, <error message>.
303



Chapter 5 • Working with the Generic Reporting Engine API
Web Service Return Object
The Web Service return object contains the following:

➤ retval. The data or an error message.

➤ errorCode. The error code (type int). Possible error codes are:

➤ 0 - Success

➤ 100 - Authorization error

➤ 101 - Processing error

➤ 102 - Open API has been disabled

➤ origRowCount. The actual number of rows the query should have returned 
(type int). If the number of rows to be returned exceeds the maximum, the 
origRowCount field is set to the actual number of rows that the query would 
have returned had the maximum not been exceeded.

Querying with a Browser

When querying with a browser, the getData service is called with the URL:

http://<server>[:port]/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=<username>&password=<password>&qu
ery=<query>

or with the optional result type parameter:

http://<server>[:port]/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=<username>&password=<password>&qu
ery=<query>&resultType=csv

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

The default return type is HTML. If resultType=csv is specified, a comma 
separated values file is returned.
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Using the Web Service

The API Web Service enables submitting a query consisting of a username, 
password, and an SQL-like select statement. The engine returns an error 
description if it cannot parse the statement or if there is a problem running 
the query. If there is no error, the results of the query are returned.

SOAP programmers can access the WSDL at:

http://<server>[:port]/topaz/gdeopenapi/services/GdeWsOpenAPI?wsdl

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

Supported SQL Syntax

The language supported is a subset of SQL and supports these keywords, 
modifiers, and operators:

➤ SELECT

➤ WHERE

➤ FROM

➤ TOP 

➤ HAVING 

➤ Aliasing with the AS keyword

➤ Logical operators OR , AND , NOT

➤ DISTINCT modifier 

➤ IN operator. Inner selects can be used to return the values for the IN 
operator.

➤ BETWEEN operator 

➤ IS NULL (IS NOT NULL is not supported) 

➤ LIKE. The wildcard character is the asterisk (*). Do not use the percent sign 
(%). The asterisk can not be used by itself (LIKE *). It must be used with 
other characters.
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➤ Comparators: =, IS, !=, <>, >, >=, <, <=

➤ Functions: MAX, MIN, SUM, COUNT, AVG, STDDEV, SUMOFSQR, LOG, 
CEIL, FLOOR, MOD, SQRT, REPLACENULL, IF, and the “byTime Function” 
described on page 308.

➤ ORDER BY and the ASC and DESC modifiers 

Query Limitations

The following limitations apply to queries submitted to the service: 

➤ Composite expressions in the SELECT clause using parenthesis are not 
supported. For example, you cannot select (a+b)/c. Use of parentheses for 
function arguments is supported, for example, max(a+b).

➤ Only one monitor type can be selected in a single query.

➤ The asterisk (*) is not supported as a wildcard character except in 
combination with the LIKE operator. It is supported as the multiplication 
operator.

➤ Inner selects and joins are not supported, with one exception: an inner 
select can be used to return the values for an IN clause.

➤ The ORDER BY clause requires a column number, for example ORDER BY 1. 
ORDER BY column name is not supported.

➤ The engine requires that queries contain a time limitation in the WHERE 
clause.

➤ The GROUP BY clause is not supported. It is unnecessary because the engine 
treats all fields that do not have an aggregate function as GROUP BY fields.

➤ When manually defining a filter that consists of strings containing white 
space or special characters (for example, where bb_guid IN (a b, c)), you must 
enclose the white space or special character string with quotes (for example, 
where bb_guid IN (‘a b’, c)). When you create filters on the Filter Builder page, 
HP Business Availability Center automatically adds the quotes. Special 
characters are defined as any characters other than digits, letters, and the 
following characters: "_", "$", "#".
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➤ When defining a filter that consists of strings containing one or more single 
quote characters, you must add a second single quote character beside each 
instance. For example, change szTransactionName = ('Login_to_O'brien') to 
szTransactionName = ('Login_to_O''brien').

➤ The columns in the returned data are labeled Column 0, Column 1, and so on. 
To return meaningful column labels, use the SQL AS operator. For example, 
Select time_stamp as TimeStamp. With this use of the AS operator, the 
column label is TimeStamp.

Date-Time Values

Time in queries and return data is specified in seconds since January 1, 1970. 
You can use Microsoft Excel to understand the time values. 

Time is most commonly used for time stamp fields.

To get a GMT time for use in a query, enter the date and time in a 
Date-formatted cell and in another cell, formatted as General, enter the 
formula:

=(<date cell> - 25569 ) * 86400

To correct for a local time zone, add the time zone offset times 3600 seconds 
to the result. For example, for Central Europe (GMT + 2):

=(<date cell> - 25569 ) * 86400 + ( 2 * 3600 )
To view a time value from a query as a GMT date in Excel, use a Date format 
for the cell and enter the formula:

=<time stamp> / 86400 + 25569

To correct for a local time zone, subtract the time zone offset times 3600 
seconds from the time stamp. For example, for the Eastern United States, 
standard time (GMT - 3):

=(<time stamp> - ( -3 * 3600 ) )/ 86400 + 25569
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byTime Function

The Generic Reporting Engine SQL supports the function byTime, which 
returns data grouped by time periods. For example, if you build a query that 
returns the average response time of a transaction for the past day, without 
the byTime function one value would be returned; using the byTime 
function, you could request to view the average response time of the 
transaction for each hour of the past day, in which case a value would be 
returned for each hour of the past 24 hours.

The function syntax is:

byTime(<timefield >, <step value>, <number of step>, <offset>)

For example, to return one value for each 3 days, corrected to two hours East 
of GMT:

byTime(time_stamp, 40, 3, 2) 

Argument Description

timefield Usually a timestamp field

step value One of:

-1 - Time not set
10 - Second
20 - Minute
30 - Hour
40 - Day
50 - Week 
60 - Month
70 - Quarter
80 - Year

number of step The number of the units specified in step value to 
group.

offset Time zone offset from GMT in hours. Positive 
numbers indicate time zones East of GMT. Negative 
numbers indicate time zones West of GMT.
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Query Examples

Below are several examples of query URLs that retrieve different types of 
data from the database.

Example of ss_t Sample
This example illustrates retrieving the average value for SiteScope samples 
on a given measurement and monitor.

http://myServer/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=admin&password=admin&query=select 
szMeasurementName, szMonitorName, avg(dValue) from ss_t where 
u_iStatus=1 and time_stamp > 123456 and szMeasurementName = 
‘myMeasurmentName’ and szMonitorName = ‘myMonitorName’

Example of trans_t Sample
This example illustrates retrieving the average response time, grouped by 
minutes and offset to GMT + 3 for Springfield_infra_ems_login transactions in 
the Springfield_Location profile on for a given period from BPM data.

http://myServer/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=admin&password=admin&query=select 
byTime(time_stamp, 20, 1, 3.0), profile_name  as ProfileName, 
szTransactionName as TransactionName, AVG(dResponseTime) from trans_t 
where time_stamp>=1126594800.64 and time_stamp<1126596000.64 and 
profile_name='Springfield_Location' and 
szTransactionName='Springfield_infra_ems_login' 
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Example of rum_server_t Sample
This example illustrates retrieving a list of all rum_server_t samples in a 
given day that failed on a specified server:

http://myServer/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=admin&password=admin&query=select 
time_stamp, engine_name, server_name from rum_server_t where 
availability=0 and total_hits > 0 and time_stamp > 1041379200 and time_stamp 
< 1136197020 and server_name = ‘myServerName’

Example of rum_page_t Sample
This example illustrates retrieving the total server time for each URL as 
measured by RUM.

http://myServer/topaz/gdeopenapi/
GdeOpenApi?method=getData&user=admin&password=admin&query=select 
page_url, sum(tot_server_time) from rum_page_t where time_stamp > 
1041379200 and time_stamp < 1136197020 &resultType=csv

Legacy Queries

From HP Business Availability Center version 6.0, it is possible to write SQL 
queries directly on samples, as described in the previous sections. Customers 
who used the previous version of the data engine API can use the 
information in this section to maintain older reports.

Structure of the Query
The query begins with the URL of the OpenAPI.jsp: http://<server_name>/
topaz/openapi/OpenAPI.jsp

Following this is a series of query parameter=value pairs. The pairs are 
separated with an ampersand (&). You build the query using required and 
optional parameters. 

You can also add filter parameters. For details, see “Filter Parameters” on 
page 321.
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➤ Required Parameters. The following parameters are required:

username The name of the HP Business Availability Center user 
running the query.

password The password of the HP Business Availability Center user 
running the query

function The type of the data to receive. One of:

transactions – Business Process Monitor response time data

transactions_breakdown – Business Process Monitor 
transaction breakdown data

sitescope – SiteScope measurement data

routings – WebTrace routing data

hops – WebTrace hop data

transactions_error – Business Process Monitor transaction 
error data

alerts – Business Process Monitor alert data

components_breakdown – Business Process Monitor 
component breakdown data

rowDataType The type of aggregation to use. One of:

row – raw data

hour – hourly aggregated data

day – daily aggregated data

The type of aggregation cannot be a larger unit than the one 
specified with the optional parameter, stepValueType.
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profileIds The IDs of the profiles for which to get data. Separate 
multiple IDs with a comma (,). 
For example: profileIds=2,7,9

To extract a profile’s ID from the database:

1  Open the page http://<servername>:8080/jmx-console/
index.jsp in a Web browser, where <servername> 
represents the name of the HP Business Availability 
Center server.

2  In the Topaz list, click the link service=OAPI Services.

3  Invoke com.mercury.infra.db.tools.oapiservices.
ProfileMapping getProfiles() to retrieve the profile ID 
information.

Time range

either
from and to
or
lastPeriod

Either use from and to to specify the start and end of the 
period, or use lastPeriod to specify the period or periods 
ending at the time the query is called.

The time format for from and to is:
dd/MM/yyyy HH:mm:ss

lastPeriod

is one of:

hour

day

week

month

quarter

year

To specify more that one unit of lastPeriod, use the parameter 
numStepUnit together with lastPeriod.
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➤ Optional Parameters. The following parameters are optional:

numStepUnit Used with <italic>lastPeriod to indicate the number of 
periods included in the data. For example, get data for the 
last two days with:

lastPeriod=day&numStepUnit=2

resultType The output file format. One of:

html

xml

csv

The default is html.

stepValueType The unit of time by which the data is grouped. One of:

minute

hour

day

week

month

Use stepValueType in conjunction with stepValue to see a 
larger grouping than that specified with rowDataType.

stepValue The number of the time units specified by stepValueType by 
which to group. For example

stepValueType=hour&stepValue=8

groups the data by 8-hour periods.

The default is 1.

dateFormat The format for date value output (that is, the way the date 
and time are displayed in the report). For example,

MM/dd/yyyy%20HH:mm:ss

The "%20" indicates a space. (A space is ASCII character 
number 32, written 20 in hexadecimal.)

timeZone A time zone specification in the form:
&timezone=<time zone value from below time zone list> 
For example: 
&timezone=Europe/London
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Time Zone List

ACT Antarctica/McMurdo Etc/GMT0

AET Antarctica/Palmer Etc/Greenwich

AGT Antarctica/Rothera Etc/UCT

ART Antarctica/South_Pole Etc/UTC

AST Antarctica/Syowa Etc/Universal

Africa/Abidjan Antarctica/Vostok Etc/Zulu

Africa/Accra Arctic/Longyearbyen Europe/Amsterdam

Africa/Addis_Ababa Asia/Aden Europe/Andorra

Africa/Algiers Asia/Almaty Europe/Athens

Africa/Asmera Asia/Amman Europe/Belfast

Africa/Bamako Asia/Anadyr Europe/Belgrade

Africa/Bangui Asia/Aqtau Europe/Berlin

Africa/Banjul Asia/Aqtobe Europe/Bratislava

Africa/Bissau Asia/Ashgabat Europe/Brussels

Africa/Blantyre Asia/Ashkhabad Europe/Bucharest

Africa/Brazzaville Asia/Baghdad Europe/Budapest

Africa/Bujumbura Asia/Bahrain Europe/Chisinau

Africa/Cairo Asia/Baku Europe/Copenhagen

Africa/Casablanca Asia/Bangkok Europe/Dublin

Africa/Ceuta Asia/Beirut Europe/Gibraltar

Africa/Conakry Asia/Bishkek Europe/Helsinki

Africa/Dakar Asia/Brunei Europe/Istanbul

Africa/Dar_es_Salaam Asia/Calcutta Europe/Kaliningrad

Africa/Djibouti Asia/Choibalsan Europe/Kiev

Africa/Douala Asia/Chongqing Europe/Lisbon
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Africa/El_Aaiun Asia/Chungking Europe/Ljubljana

Africa/Freetown Asia/Colombo Europe/London

Africa/Gaborone Asia/Dacca Europe/Luxembourg

Africa/Harare Asia/Damascus Europe/Madrid

Africa/Johannesburg Asia/Dhaka Europe/Malta

Africa/Kampala Asia/Dili Europe/Minsk

Africa/Khartoum Asia/Dubai Europe/Monaco

Africa/Kigali Asia/Dushanbe Europe/Moscow

Africa/Kinshasa Asia/Gaza Europe/Nicosia

Africa/Lagos Asia/Harbin Europe/Oslo

Africa/Libreville Asia/Hong_Kong Europe/Paris

Africa/Lome Asia/Hovd Europe/Prague

Africa/Luanda Asia/Irkutsk Europe/Riga

Africa/Lubumbashi Asia/Istanbul Europe/Rome

Africa/Lusaka Asia/Jakarta Europe/Samara

Africa/Malabo Asia/Jayapura Europe/San_Marino

Africa/Maputo Asia/Jerusalem Europe/Sarajevo

Africa/Maseru Asia/Kabul Europe/Simferopol

Africa/Mbabane Asia/Kamchatka Europe/Skopje

Africa/Mogadishu Asia/Karachi Europe/Sofia

Africa/Monrovia Asia/Kashgar Europe/Stockholm

Africa/Nairobi Asia/Katmandu Europe/Tallinn

Africa/Ndjamena Asia/Krasnoyarsk Europe/Tirane

Africa/Niamey Asia/Kuala_Lumpur Europe/Tiraspol

Africa/Nouakchott Asia/Kuching Europe/Uzhgorod

Africa/Ouagadougou Asia/Kuwait Europe/Vaduz
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Africa/Porto-Novo Asia/Macao Europe/Vatican

Africa/Sao_Tome Asia/Macau Europe/Vienna

Africa/Timbuktu Asia/Magadan Europe/Vilnius

Africa/Tripoli Asia/Makassar Europe/Warsaw

Africa/Tunis Asia/Manila Europe/Zagreb

Africa/Windhoek Asia/Muscat Europe/Zaporozhye

America/Adak Asia/Nicosia Europe/Zurich

America/Anchorage Asia/Novosibirsk GB

America/Anguilla Asia/Omsk GB-Eire

America/Antigua Asia/Oral GMT

America/Araguaina Asia/Phnom_Penh GMT0

America/Aruba Asia/Pontianak Greenwich

America/Asuncion Asia/Pyongyang HST

America/Atka Asia/Qatar Hongkong

America/Barbados Asia/Qyzylorda IET

America/Belem Asia/Rangoon IST

America/Belize Asia/Riyadh Iceland

America/Boa_Vista Asia/Riyadh87 Indian/Antananarivo

America/Bogota Asia/Riyadh88 Indian/Chagos

America/Boise Asia/Riyadh89 Indian/Christmas

America/Buenos_Aires Asia/Saigon Indian/Cocos

America/Cambridge_Bay Asia/Sakhalin Indian/Comoro

America/Cancun Asia/Samarkand Indian/Kerguelen

America/Caracas Asia/Seoul Indian/Mahe

America/Catamarca Asia/Shanghai Indian/Maldives

America/Cayenne Asia/Singapore Indian/Mauritius
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America/Cayman Asia/Taipei Indian/Mayotte

America/Chicago Asia/Tashkent Indian/Reunion

America/Chihuahua Asia/Tbilisi Iran

America/Cordoba Asia/Tehran Israel

America/Costa_Rica Asia/Tel_Aviv JST

America/Cuiaba Asia/Thimbu Jamaica

America/Curacao Asia/Thimphu Japan

America/Danmarkshavn Asia/Tokyo Kwajalein

America/Dawson Asia/Ujung_Pandang Libya

America/Dawson_Creek Asia/Ulaanbaatar MET

America/Denver Asia/Ulan_Bator MIT

America/Detroit Asia/Urumqi MST

America/Dominica Asia/Vientiane MST7MDT

America/Edmonton Asia/Vladivostok Mexico/BajaNorte

America/Eirunepe Asia/Yakutsk Mexico/BajaSur

America/El_Salvador Asia/Yekaterinburg Mexico/General

America/Ensenada Asia/Yerevan Mideast/Riyadh87

America/Fort_Wayne Atlantic/Azores Mideast/Riyadh88

America/Fortaleza Atlantic/Bermuda Mideast/Riyadh89

America/Glace_Bay Atlantic/Canary NET

America/Godthab Atlantic/Cape_Verde NST

America/Goose_Bay Atlantic/Faeroe NZ

America/Grand_Turk Atlantic/Jan_Mayen NZ-CHAT

America/Grenada Atlantic/Madeira Navajo

America/Guadeloupe Atlantic/Reykjavik PLT

America/Guatemala Atlantic/South_Georgia PNT
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America/Guayaquil Atlantic/St_Helena PRC

America/Guyana Atlantic/Stanley PRT

America/Halifax Australia/ACT PST

America/Havana Australia/Adelaide PST8PDT

America/Hermosillo Australia/Brisbane Pacific/Apia

America/Indiana/
Indianapolis

Australia/Broken_Hill Pacific/Auckland

America/Indiana/Knox Australia/Canberra Pacific/Chatham

America/Indiana/
Marengo

Australia/Darwin Pacific/Easter

America/Indiana/Vevay Australia/Hobart Pacific/Efate

America/Indianapolis Australia/LHI Pacific/Enderbury

America/Inuvik Australia/Lindeman Pacific/Fakaofo

America/Iqaluit Australia/Lord_Howe Pacific/Fiji

America/Jamaica Australia/Melbourne Pacific/Funafuti

America/Jujuy Australia/NSW Pacific/Galapagos

America/Juneau Australia/North Pacific/Gambier

America/Kentucky/
Louisville

Australia/Perth Pacific/Guadalcanal

America/Kentucky/
Monticello

Australia/Queensland Pacific/Guam

America/Knox_IN Australia/South Pacific/Honolulu

America/La_Paz Australia/Sydney Pacific/Johnston

America/Lima Australia/Tasmania Pacific/Kiritimati

America/Los_Angeles Australia/Victoria Pacific/Kosrae

America/Louisville Australia/West Pacific/Kwajalein

America/Maceio Australia/Yancowinna Pacific/Majuro

America/Managua BET Pacific/Marquesas
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America/Manaus BST Pacific/Midway

America/Martinique Brazil/Acre Pacific/Nauru

America/Mazatlan Brazil/DeNoronha Pacific/Niue

America/Mendoza Brazil/East Pacific/Norfolk

America/Menominee Brazil/West Pacific/Noumea

America/Merida CAT Pacific/Pago_Pago

America/Mexico_City CET Pacific/Palau

America/Miquelon CNT Pacific/Pitcairn

America/Monterrey CST Pacific/Ponape

America/Montevideo CST6CDT Pacific/Port_Moresby

America/Montreal CTT Pacific/Rarotonga

America/Montserrat Canada/Atlantic Pacific/Saipan

America/Nassau Canada/Central Pacific/Samoa

America/New_York Canada/
East-Saskatchewan

Pacific/Tahiti

America/Nipigon Canada/Eastern Pacific/Tarawa

America/Nome Canada/Mountain Pacific/Tongatapu

America/Noronha Canada/Newfoundland Pacific/Truk

America/North_Dakota/
Center

Canada/Pacific Pacific/Wake

America/Panama Canada/Saskatchewan Pacific/Wallis

America/Pangnirtung Canada/Yukon Pacific/Yap

America/Paramaribo Chile/Continental Poland

America/Phoenix Chile/EasterIsland Portugal

America/Port-au-Prince Cuba ROK

America/Port_of_Spain EAT SST

America/Porto_Acre ECT Singapore
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America/Porto_Velho EET SystemV/AST4

America/Puerto_Rico EST SystemV/AST4ADT

America/Rainy_River EST5EDT SystemV/CST6

America/Rankin_Inlet Egypt SystemV/CST6CDT

America/Recife Eire SystemV/EST5

America/Regina Etc/GMT SystemV/EST5EDT

America/Rio_Branco Etc/GMT+0 SystemV/HST10

America/Rosario Etc/GMT+1 SystemV/MST7

America/Santiago Etc/GMT+10 SystemV/MST7MDT

America/Santo_DomingoEtc/GMT+11 SystemV/PST8

America/Sao_Paulo Etc/GMT+12 SystemV/PST8PDT

America/Scoresbysund Etc/GMT+2 SystemV/YST9

America/Shiprock Etc/GMT+3 SystemV/YST9YDT

America/St_Johns Etc/GMT+4 Turkey

America/St_Kitts Etc/GMT+5 UCT

America/St_Lucia Etc/GMT+6 US/Alaska

America/St_Thomas Etc/GMT+7 US/Aleutian

America/St_Vincent Etc/GMT+8 US/Arizona

America/Swift_Current Etc/GMT+9 US/Central

America/Tegucigalpa Etc/GMT-0 US/East-Indiana

America/Thule Etc/GMT-1 US/Eastern

America/Thunder_Bay Etc/GMT-10 US/Hawaii

America/Tijuana Etc/GMT-11 US/Indiana-Starke

America/Tortola Etc/GMT-12 US/Michigan

America/Vancouver Etc/GMT-13 US/Mountain

America/Virgin Etc/GMT-14 US/Pacific
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Filter Parameters
There can be one filters clause in the query. It is not required. If there is 
more than one filter in the clause, the filters are separated by a semicolon (;). 

A filter consists of a report column name, a filter type, the number of 
patterns in the list, and a list of patterns. Each element in a filter is separated 
by a semicolon (;).

For example:

filters=MonitorTitle;in;2;9,12;Measurement;in;1;18

means:

select where (MonitorTitle equals 9 or 12) and (Measurement equals 18)

America/Whitehorse Etc/GMT-2 US/Pacific-New

America/Winnipeg Etc/GMT-3 US/Samoa

America/Yakutat Etc/GMT-4 UTC

America/Yellowknife Etc/GMT-5 Universal

Antarctica/Casey Etc/GMT-6 VST

Antarctica/Davis Etc/GMT-7 W-SU

Antarctica/
DumontDUrville

Etc/GMT-8 WET

Antarctica/Mawson Etc/GMT-9 Zulu 
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The following filter parameters are available:

Query Examples
Example 1:

http://<server_name>/topaz/openapi/OpenAPI.jsp?
username=fitzwilliam&password=darcy&function=transactions&profileIds=33&
lastPeriod=hour&rowDataType=raw&dateFormat=MM/dd/yyyy HH:mm:ss

Example 2:

http://<server_name>/topaz/openapi/OpenAPI.jsp?
username=fitzwilliam&password=darcy&function=transactions&profileIds=33&
from=10/12/2002 14:00:00&to=10/12/2002 15:00:00& rowDataType=raw&
dateFormat=MM/dd/yyyy%20HH:mm:ss

General Filter Types These types can be used with numerical or text columns.

in – Data is included in the report if it equals one of the 
items in the list of patterns.

not_in – Data is included in the report if it does not equal 
any item in the list of patterns.

Text Filter Types This type can be used with text columns.

like – Data is included in the report if it matches the pattern.

When like is used, the number of patterns in the list must be 
one (1).

The wildcard, asterisk (*), can be used with like.

For example:

filters=Host Name;like;1;ServerNum*

Numeric Filter Types These types can be used with numerical columns.

bigger

smaller

equals
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Example 3:

http://<server_name>/topaz/openapi/
OpenAPI.jsp?username=fitzwilliam&password=darcy&function=sitescope&profil
eIds=35&lastPeriod=day&numStepUnit=2&&rowDataType=hour&dateFormat=M
M/dd/
yyyy%20HH:mm:ss&filters=MonitorTitle;in;1;9;Measurement;in;1;18&stepValue
Type=hour&stepValue=6
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6
Working with the HP Universal CMDB API

Note to HP Software-as-a-Service customers: For details on how to use the 
UCMDB API in an HP Software-as-a-Service environment, contact 
HP Software-as-a-Service Support. 

This chapter explains how third-party or custom tools can use the 
HP Universal CMDB API to extract data and calculations and to write data to 
the UCMDB (Universal Configuration Management Database).

Use this chapter in conjunction with the UCMDB schema documentation, 
available in the on-line documentation library.

This chapter includes:

Concepts

 ➤  Conventions on page 326

 ➤  Using the HP Universal CMDB API on page 327

 ➤  HP UCMDB API Reference on page 328

Tasks

 ➤  Call the Web Service on page 329

 ➤  Create Queries to Return Unambiguous TopologyMap Elements on page 329

 ➤  Query the HP UCMDB Module on page 333

 ➤  Update the HP UCMDB Module on page 350

 ➤  Query the HP UCMDB Module Class Model on page 355
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 ➤  Query for Impact Analysis on page 357

Reference

 ➤  Use Cases on page 360

 ➤  Examples on page 361

 ➤  UCMDB General Parameters on page 388

 ➤  UCMDB Output Parameters on page 392
Concepts

Conventions

This chapter uses the following conventions:

➤ This style, Element, indicates that an item is an entity in the database or an 
element defined in the schema, including structures passed to or returned 
by methods. Plain text indicates that the item is being discussed in a general 
context. For example:

A third-party application collects information about CIs and relations in its 
domain, and uses the appropriate API to pass the information to the 
UCMDB. Using this information, the UCMDB creates CIs and Relations and 
creates a map of the client IDs and the UCMDB IDs.

In the first sentence, CI and relation are in plain text because they are not 
UCMDB elements. In the second sentence, the UCMDB has created entities 
according to the structure specified by the schema. Therefore, they are now 
CI and Relation.

➤ UCMDB elements and method arguments are spelled in the case in which 
they are specified in the schema. This usually means that a class name or 
generic reference to an instance of the class is capitalized. An element or 
argument to a method is not capitalized. For example:

A relation is an element of type Relation passed to a method.
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Using the HP Universal CMDB API

The HP Universal CMDB API is a Web Service API used to integrate 
applications with the Universal CMDB (UCMDB). The API provides methods 
to:

➤ add, remove, and update configuration items and relations in the CMDB

➤ retrieve information about the class model

➤ retrieve impact analyses

➤ retrieve information about configuration items and relationships

Methods for retrieving information about configuration items and 
relationships generally use the Topology Query Language (TQL). For details, 
see “Topology Query Language” in Model Management.

Users of the HP Universal CMDB API should be familiar with:

➤ The SOAP specification 

➤ An object-oriented programming language such as C++, C# or Java 

➤ HP Universal CMDB 

This section includes the following topics:

➤ “Uses of the API” on page 327

➤ “Permissions” on page 328

Uses of the API
The API is used to fulfill a number of business requirements. For example:

➤ A third-party system can query the Class Model for information about the 
available configuration item (CI) classes. These classes are called 
Configuration Item Types (CITs).

➤ A third-party asset management tool can update the UCMDB with 
information available only to that tool, thereby unifying its data with data 
collected by HP applications.

➤ A number of third-party systems can populate the UCMDB to create a 
central UCMDB that can track changes and perform impact analysis.
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➤ A third-party system can create entities and relations according to its 
business logic, and then write the data to the UCMDB to take advantage of 
the UCMDB query capabilities.

➤ Other systems, such as the Change Control Management (CCM) system, can 
use the Impact Analysis methods for change analysis.

Permissions
The administrator provides login credentials for connecting with the API. 
The required credentials depend on whether you are using HP Universal 
CMDB as a standalone application or from within HP Business Availability 
Center:

➤ HP Universal CMDB standalone. Log in using the credentials of a DDM user 
who has been granted permissions on the discovery resources. For details, . 

➤ HP Universal CMDB embedded in HP Business Availability Center. Log in 
using the credentials of a Business Availability Center  user. The user must 
have been granted the relevant permissions on the HP Universal CMDB 
resource in Business Availability Center.

HP UCMDB API Reference

For full documentation on the available APIs, refer to the HP UCMDB API 
Reference. These files are located in the following folder: 

\\<HP Business Availability Center root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Solutions_a
nd_Integrations\CMDB_Schema\webframe.html

Tasks
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Call the Web Service

The HP Universal CMDB Web Service enables calling server-side methods 
using standard SOAP programming techniques. If the statement cannot be 
parsed or if there is a problem invoking the method, the API methods throw 
a SoapFault exception. When a SoapFault exception is thrown, the UCMDB 
populates one or more of the error message, error code, and exception 
message fields. If there is no error, the results of the invocation are returned.

SOAP programmers can access the WSDL at:

http://<server>[:port]/axis2/services/UcmdbService?wsdl 

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

The URL for calling the service is:

http://<server>[:port]/axis2/services/UcmdbService

For examples of connecting to the UCMDB, see “Use Cases” on page 360.

Create Queries to Return Unambiguous TopologyMap 
Elements

Query methods that return the data in topology or topologyMap elements 
search the system for a match of a TQL query. The following diagrams 
illustrate how the resulting topology and topologyMap structures are affected 
by the use of unique labels in the query. 

Labels are user-specified names in the query for relations and configuration 
items in specific configurations. The labels specified in the query are used as 
the node labels in the returned map. If no labels are specified, the CI or 
Relation Type Name is used as the label in the resulting map. The following 
example illustrates specifying labels IISHost and DBHost in place of the 
default Host label, and labels ContainerIIS and ContainsDB in place of the 
default Container Link label.
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Example
This is a representation of a small IT universe model. There are three hosts: 
H1, H2, H3, which host Web servers (WS) and database managers (DB). WS1 
resides on H1. DB1 and WS2 both reside on H2. DB2 resides on H3.

This query is defined using the default labels:

The result of running this TQL query on the IT universe can be a Topology or 
TopologyMap.

Topology Response

CIs: H1,H2,H3,WS1,WS2,DB1,DB2
relations: H1-WS1, H1-H2, H2-H3, WS2-H2,DB1-H2, DB2-H3
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TopologyMap Response

In the above TopologyMap response, the first two CINodes contain identical 
Host labels, corresponding to the two Host configuration items in the query. 
Both of these CINodes contain host H2, with no indication of why H2 is 
duplicated. 

The last two relationNodes contain identical Contained labels, corresponding 
to the two Container link relations in the query. 

The duplications occur because no unique labels are specified in the query, 
resulting in the use of default labels, the type names Host and Container, in 
the map. To extract a more usable map, define queries with unique labels for 
each configuration to be matched, as shown in the following query.

CINode:
label: Host
CIs: H1,H2

CINode:
label: Host
CIs: H2,H3

CINode:
label: DB
CIs: DB1,DB2

CINode:
label: Webserver

CIs: IIS

relationNode:
label: talk
relations: H1-H2, H2-H3

relationNode:
label: Container Link
relations: WS1-H1, WS2-H2

relationNode:
label: Container Link
relations: DB2-H3, DB1-H2
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This query is defined with unique labels:

The topology result is identical to that of the TQL without unique labels. The 
topologyMap result, however, is different: Each label is now unique. 

In this map, it is clear why H2 is returned twice. The unique labels indicate 
that it is returned once as a Web server host and once as a database host.

CINode:
label: IISHOST
CIs: H1, H2

CINode:
label: DBHOST
CIs: H2, H3

...

relationNode:
label: ContainerIIS
relations: WS1-H1, WS2-H2

relationNode:
label: ContainerDB
relations: DB2-H3, DB1-H2
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Tip: Wherever possible in the UCMDB, apply unique, user-defined labels to 
specific configurations.

Query the HP UCMDB Module

The HP UCMDB is queried using the APIs described in “HP UCMDB Module 
Query Methods” on page 337.

The queries and the returned UCMDB elements always contain real 
UCMDB IDs. 

Some general information on queries is presented below. 

For examples of the use of the query methods, see “Query Example” on 
page 364.

This section includes the following topics:

➤ “Just In Time Response Calculation” on page 333

➤ “Processing Large Responses” on page 334

➤ “Specifying Properties to Return” on page 334

➤ “HP UCMDB Module Query Methods” on page 337

Just In Time Response Calculation
For all query methods, the UCMDB server calculates the values requested by 
the query method when the request is received, and returns results based on 
the latest data. The result is always calculated at the time the request is 
received, even if the TQL query is active and there exists a previously 
calculated result. Therefore, the results of running a query returned to the 
client application may be different than the results of the same query 
displayed on the user interface.
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Tip: If your application uses the results of a given query more than once and 
the data is not expected to change significantly between uses of the result 
data, you can improve performance by having the client application store 
the data rather than repeatedly running the query.

Processing Large Responses
The response to a query always includes the structures for the data requested 
by the query method, even if no actual data is being transmitted. For many 
methods where the data is a collection or map, the response also includes 
the ChunkInfo structure, comprised of chunksKey and numberOfChunks. The 
numberOfChunks field indicates the number of chunks containing data that 
must be retrieved.

The maximum transmission size of data is set by the system administrator. If 
the data returned from the query is larger than the maximum size, the data 
structures in the first response contain no meaningful information, and the 
value of the numberOfChunks field is 2 or greater. If the data is not larger 
than the maximum, the numberOfChunks field is 0 (zero), and the data is 
transmitted in the first response. Therefore, in processing a response, check 
the numberOfChunks value first. If it is greater than 1, discard the data in the 
transmission and request the chunks of data. Otherwise, use the data in the 
response.

For information on handling chunked data, see “pullTopologyMapChunks” 
on page 348 and “releaseChunks” on page 350.

Specifying Properties to Return
Configuration Items and Relations generally have many properties. Some 
methods that return collections or graphs of these items accept input 
parameters that specify which property values to return with each item that 
matches the query. The UCMDB does not return empty properties. 
Therefore, the response to a query may have fewer properties than requested 
in the query.
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This section describes the types of sets used to specify the properties to 
return.Properties can be referenced in two ways. First, properties can be 
referenced by their names. Second, they can be referenced by using names 
of predefined properties rules. Predefined properties rules are used by the 
UCMDB to create a list of real property names.

When an application references properties by name, it passes a 
PropertiesList.

Tip: Whenever possible, use a PropertiesList to specify the names of the 
properties in which you are interested, rather than a rule-based set. Using 
the predefined properties rules nearly always results in returning more 
properties than you need, and has a performance price.

There are two types of predefined properties: qualifier properties and simple 
properties.

To use qualifier properties, the client application passes a QualifierProperties 
element. QualifierProperties is a list of qualifies that can be applied to 
properties. The UCMDB converts the list of qualifies passed by the client 
application to the list of the properties to which at least one of the qualifiers 
apply. The values of those properties are returned with the CI elements or 
Relation elements.

To use simple rule-based properties, the client application passes a 
SimplePredefinedProperty or SimpleTypedPredefinedProperty element. These 
elements contain the name of the rule by which the UCMDB generates the 
list of properties to return. The rules that can be specified in a 
SimplePredefinedProperty or SimpleTypedPredefinedProperty element are 
CONCRETE, DERIVED, and NAMING. 

Concrete Properties

Concrete properties are the set of properties defined for the specified class 
type. The properties added by derived classes are not returned for instances 
of those derived classes.
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A collection of instances returned by a method may consist of instances of a 
class specified in the method invocation and instances of classes that inherit 
from that class. The derived classes inherit the properties of the specified 
class. In addition, the derived classes extend the parent class by adding 
properties.

Concrete properties are the properties defined in the specified class. 
Properties added by classes derived from the specified class are not included.

For example: 

Class T1 has properties P1 and P2. Class T11 inherits from T1 and extends 
T1 with properties P21 and P22.

The collection of CIs of type T1 includes the instances of T1 and T11. The 
concrete properties of all instances in this collection are P1 and P2.

Derived Properties

Derived properties are the set of properties defined for the specified class 
type and, for each derived class, the properties added by the derived class.

The derived properties of a class are all the properties inherited from the 
parent class and all the properties added by the derived class.

Continuing the example from concrete properties, the derived properties of 
instances of T1 are P1 and P2. The derived properties of instances of T11 are 
P1, P2, P21, and P22.

Naming Properties

The naming properties are display_label and data_name.

Other Property Specification Elements

➤ PredefinedProperties 

PredefinedProperties can contain a QualifierProperties element and a 
SimplePredefinedProperty element for each of the other possible rules. A 
PredefinedProperties set does not necessarily contain all types of lists.

➤ PredefinedTypedProperties 
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PredefinedTypedProperties is used to apply a different set of properties to 
each CI type. PredefinedTypedProperties can contain a QualifierProperties 
element and a SimpleTypedPredefinedProperty element for each of the other 
applicable rules. Because PredefinedTypedProperties is applied to each type 
individually, Derived properties are not relevant. A PredefinedProperties set 
does not necessarily contain all applicable types of lists.

➤ CustomProperties 

CustomProperties can contain any combination of the basic PropertiesList 
and the rule-based property lists. The properties filter is the union of all the 
properties returned by all the lists.

➤ CustomTypedProperties

CustomTypedProperties can contain any combination of the basic 
PropertiesList and the applicable the rule-based property lists. The properties 
filter is the union of all the properties returned by all the lists.

➤ TypedProperties 

TypedProperties is used to pass a different set of properties for each CI type. 
TypedProperties is a collection of pairs composed of type names and 
properties sets of all types. Each properties set is applied only to the 
corresponding type.

HP UCMDB Module Query Methods

getChangedCIs

getChangedCIs returns the change data for all CIs related to the specified 
CIs.

Input:
 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

ids The list of the IDs of the root CIs whose related CIs 
are checked for changes.

Only real UCMDB IDs are valid in this collection.
337



Chapter 6 • Working with the HP Universal CMDB API
Output: 

getCIsByID

getCIsByID retrieves configuration items by their UCMDB IDs.

Input:
 

Output: 

getCIsByType

getCIsByType retrieves configuration items according to the type specified.

fromDate The beginning of the period in which to check if CIs 
changed.

toDate The end of the period in which to check if CIs 
changed.

Parameter Comment

changeDataInfo Zero or more collections of ChangedDataInfo 
elements. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

CIsTypedProperties A typed properties collection. For details, see 
“TypedProperties” on page 337. 

IDs Only real UCMDB IDs are valid in this collection.

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 393 and 
“Processing Large Responses” on page 334.  

Parameter Comment
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getCIsByType returns the collection of configuration items of the specified 
type and of all types that inherit from the specified type.

Input: 

Output: 

getFilteredCIsByType 

getFilteredCIsByType retrieves the configuration items of the specified type 
that meet the conditions.

getFilteredCIsByType uses conditions. A condition is comprised of a name 
field containing the name of a property, an operator field containing a 
comparison operator, and an optional value field, containing a value or list 
of values. Together, they form a boolean expression: <item>.property.value 
[operator] <condition>.value. 

For example, if the condition name is root_actualdeletionperiod, the condition 
value is 40 and the operator is Equal, the boolean statement is: 
<item>.root_actualdeletionperiod.value = = 40. The query returns all items 
whose root_actualdeletionperiod is 40, assuming there are no other 
conditions.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

type The class name. For details, see “Type Name” on 
page 390.

properties The data to be returned on each configuration item. 

For details, see “CustomProperties” on page 337. 

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 393 and 
“Processing Large Responses” on page 334. 
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If the conditionsLogicalOperator argument is AND, the query returns the 
items that meet all conditions in the conditions collection. If 
conditionsLogicalOperator is OR, the query returns the items that meet at 
least one of the conditions in the conditions collection.

The following table lists the comparison operators: 

Operator Type of condition/comments

ChangedDuring Date 

This is a range check. The condition value is 
specified in hours. If the value of the date property 
is in the range of the time the method is invoked 
plus or minus the condition value, then the 
condition is true.

For example, if the condition value is 24, the 
condition is true if the value of the date property is 
between yesterday at this time and tomorrow at this 
time.

Note: The name ChangedDuring is kept to preserve 
backward compatibility. In previous versions, the 
operator was used only with create and modify time 
properties.

Equal String and numerical 

EqualIgnoreCase String

Greater Numerical

GreaterEqual Numerical

In String, numerical, and list 

The condition’s value is a list. The condition is true 
if the value of the property is one of the values in 
the list.
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InList List

The condition’s value and the property’s value are 
lists. 

The condition is true if all the values in the 
condition's list are also in the item's property list. 
There may be more property values than specified 
in the condition without effecting the truth of the 
condition.

IsNull String, numerical and list

The item's property has no value. When operator 
IsNull is used, the value of the condition is ignored, 
and in some cases can be nil.

Less Numerical

LessEqual Numerical

Like String 

The condition’s value is a substring of the value of 
the property’s value. The condition’s value must be 
bracketed with percent signs (%). For example, 
%Bi% matches ‘Bismark’ and ‘Bay of Biscay’, but 
not ‘biscuit’.

LikeIgnoreCase String

Use the LikeIgnoreCase operator as you use the Like 
operator. The match, however is not case-sensitive. 
Therefore, %Bi% matches ‘biscuit’.

Operator Type of condition/comments
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Example of setting up a condition:

Input: 

NotEqual String and numerical

UnchangedDuring Date 

This is a range check. The condition value is 
specified in hours. If the value of the date property 
is in the range of the time the method is invoked 
plus or minus the condition value, then the 
condition is false. If it is outside that range, the 
condition is true

For example, if the condition value is 24, the 
condition is true if the value of the date property is 
before yesterday at this time or after tomorrow at 
this time.

Note: The name UnchangedDuring is kept to 
preserve backward compatibility. In previous 
versions, the operator was used only with create and 
modify time properties.

FloatCondition fc = new FloatCondition();
FloatProp fp = new FloatProp();
fp.setName("attr_name");
fp.setValue(11);
fc.setCondition(fp);
fc.setFloatOperator(FloatCondition.floatOperatorEnum.Equal);

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

type The class name, see “Type Name” on page 390. 
The type can be any of the types defined using the 
CI Type Manager in the UCMDB user interface 

Operator Type of condition/comments
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Output:

getQueryNameOfView

getQueryNameOfView retrieves the name of the query (TQL) on which the 
specified view is based.

Input: 

 

Output:

 

properties The data to be returned on each configuration item. 
(Called the Query Layout in the user interface)

For details, see “CustomProperties” on page 337. 

conditions A collection of name-value pairs and the operators 
that relate one to the other. For example, 
host_hostname like QA. 

conditionsLogicalOperator If AND, all of the conditions must be met. If OR, at 
least one of the conditions must be met.

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 393 and 
“Processing Large Responses” on page 334. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

viewName The name of a view, that is, a sub-set of the IT 
universe in the UCMDB.

Parameter Comment

queryName The name of the TQL in the UCMDB on which the 
view is based.

Parameter Comment
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getTopologyQueryExistingResultByName

getTopologyQueryExistingResultByName Retrieves the most recent result 
of running the specifed TQL. The call does not run the TQL. If there are not 
results from a previous run, nothing is returned.

Input: 

 

Output:

 

getTopologyQueryResultCountByName

getTopologyQueryResultCountByName retrieves the number of instances 
of each node that matches the specified query.

Input: 

 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

queryName The name of a TQL.

CIsTypedProperties Properties used to filter the results. 

Parameter Comment

queryName The name of the TQL in the UCMDB on which the 
view is based.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

queryName The name of a TQL.

countInvisible If true, the output includes CIs defined as invisible 
in the query.
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Output:

 

executeTopologyQueryByName

executeTopologyQueryByName retrieves the topology map that matches the 
specified query. 

Tip: The map contains more information and is easier to understand if the 
label for each CINode and each relationNode in the TQL is unique. For 
details, see “Create Queries to Return Unambiguous TopologyMap 
Elements” on page 329.

Input: 

 

Output: 

 

executeTopologyQueryByNameWithParameters

executeTopologyQueryByNameWithParameters retrieves a topologyMap that 
matches the specified parameterized query. 

Parameter Comment

queryName The name of the TQL in the UCMDB on which the 
view is based.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

queryName The name of the TQL in the UCMDB for which to 
get the map.

CIsTypedProperties The properties for the query. 

Parameter Comment

topologyMap For details, see “TopologyMap” on page 393. 
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The values for the query parameters are passed in the parameterizedNodes 
argument. The specified TQL must have unique labels defined for each 
CINode and each relationNode or the method invocation fails.

Input: 

 

Output: 

 

executeTopologyQueryWithParameters 

executeTopologyQueryWithParameters retrieves a topologyMap that matches 
the parameterized query. 

The query is passed in the queryXML argument. The values for the query 
parameters are passed in the parameterizedNodes argument. The TQL must 
have unique labels defined for each CINode and each relationNode.

executeTopologyQueryWithParameters is used to pass ad-hoc queries, rather 
than accessing a query defined in the UCMDB. You can use this method 
when you do not have access to the UCMDB user interface to define a query, 
or when you do not want to save the query to the database.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

queryName The name of the parameterized TQL in the UCMDB 
for which to get the map.

parameterizedNodes The conditions each node must meet to be included 
in the query results.  

CIsTypedProperties The properties for the query. 

Parameter Comment

topologyMap For details, see “TopologyMap” on page 393. 

chunkInfo For details, see “ChunkInfo” on page 393 and 
“Processing Large Responses” on page 334. 
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Input: 

 

Output:

 

getCINeighbours

getCINeighbours returns the immediate neighbors of the specified CI. 

For example, if the query is on the neighbors of CI A, and CI A contains CI B 
which users CI C, CI B is returned, but CI C is not.

Only neighbors of the specified type are returned.

Input: 

 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

queryXML An XML representation of a TQL. 

parameterizedNodes The conditions each node must meet to be included 
in the query results.  

Parameter Comment

topologyMap For details, see “TopologyMap” on page 393. 

chunkInfo For details, see “ChunkInfo” on page 393 and 
“Processing Large Responses” on page 334. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

ID The ID of the configuration item for which to 
retrieve the neighbors. This must be a real UCMDB 
ID.
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Output:

 

pullTopologyMapChunks

pullTopologyMapChunks retrieves one of the chunks that contain the 
response to a method. 

Each chunk contains a topologyMap that is part of the response. The first 
chunk is numbered 1, so the retrieval loop counter iterates from 1 to 
<response object>.getChunkInfo().getNumberOfChunks().

For details, see “ChunkInfo” on page 393 and “Query the HP UCMDB 
Module” on page 333.

The client application must handle the partial maps. See the example of 
handling a CIs collection below and the example of merging chunks to a 
map, mergeMaps, in the “Query Example” on page 364.

neighbourType The Configuration Item Type Name of the 
neighbors to retrieve. Neighbors of the specified 
type and of types derived from that type are 
returned.

For details, see “Type Name” on page 390.

CIProperties The data to be returned on each configuration item, 
called the Query Layout in the user interface.

For details, see “TypedProperties” on page 337. 

relationProperties The data to be returned on each relation (called the 
Query Layout in the user interface). For details, see 
“TypedProperties” on page 337

Parameter Comment

topology For details, see “Topology” on page 392. 

comments Disregard this value. It is for internal use by HP.

Parameter Comment
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Input: 

Output:

 

This is an example of handling chunks:

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

ChunkRequest The number of the chunk to retrieve and the 
ChunkInfo that was returned by the query method.  

Parameter Comment

topologyMap For details, see “TopologyMap” on page 393. 

comments Disregard this value. It is for internal use by HP.

GetCIsByType request = 
new GetCIsByType(cmdbContext, typeName, customProperties);

GetCIsByTypeResponse response = 
ucmdbService.getCIsByType(request);

ChunkRequest chunkRequest = new ChunkRequest();
chunkRequest.setChunkInfo(response.getChunkInfo());
for(int j=1 ; j < response.getChunkInfo().getNumberOfChunks() ; j++) {
chunkRequest.setChunkNumber(j);
PullTopologyMapChunks req = new PullTopologyMapChunks(cmdbContext, 

chunkRequest);
PullTopologyMapChunksResponse res = 

ucmdbService.pullTopologyMapChunks(req);
for(int m=0 ; 

m < res.getTopologyMap().getCINodes().sizeCINodeList() ;
m++) { 
CIs cis = 

res.getTopologyMap().getCINodes().getCINode(m).getCIs();
for(int i=0 ; i < cis.sizeCIList() ; i++) {

// your code to process the CIs 
}

}

}
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releaseChunks

releaseChunks frees the memory of the chunks that contain the data from 
the query. 

Tip: The server discards the data after ten minutes. Calling this method to 
discard the data as soon as it has been read conserves server resources.

Input: 

Update the HP UCMDB Module

Update the UCMD with the update APIs. For details of the API methods, see 
“HP UCMDB Module Update Methods” on page 352.

For examples of the use of the update methods, see “Update Example” on 
page 379.

This section includes the following topics:

➤ “HP UCMDB Update Parameters” on page 350

➤ “Use of ID Types with Update Methods” on page 351

➤ “HP UCMDB Module Update Methods” on page 352

HP UCMDB Update Parameters 
This topic describes the parameters used only by the service’s update 
methods. For details, refer to the schema documentation.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

chunksKey The identifier of the data on the server that was 
chunked. The key is an element of ChunkInfo.  
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CIsAndRelationsUpdates

The CIsAndRelationsUpdates type consists of CIsForUpdate, 
relationsForUpdate, referencedRelations, and referencedCIs. A 
CIsAndRelationsUpdates instance does not necessarily have all three 
elements.

CIsForUpdate is a CIs collection. relationsForUpdate is a Relations collection. 
The CI and relation elements in the collections have a props element. When 
creating a CI or relation, properties that have either the required attribute or 
the key attribute in the CI Type definition must be populated with values. 
The items in these collections are updated or created by the method. 

referencedCIs and referencedRelations are collections of configuration items 
that are already defined in the UCMDB. The elements in the collection are 
identified with a temporary ID in conjunction with all the key properties. 
This items are used to resolve the identities of CS and Relations for update. 
The are never created or updated by the method. 

Each of the CI and relation elements in these collections has a properties 
collection. New items are created with the property values in these 
collections. 

Use of ID Types with Update Methods
The following describes all the possibilities with regard to ID types and 
configuration items and relations. When the ID is not a real CMDB ID, the 
type and key attributes are required.

Deleting or Updating Configuration Items

A temporary or empty ID may be used by the client when calling a method 
to delete or update an item. In this case, the CI type and the key attributes 
that identify the CI must be set. 

Deleting or Updating Relations

When deleting or updating relations, the relation ID may be empty, 
temporary, or real. 
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If a CI’s ID is temporary, then the CI must be passed in the referencedCIs 
collection and its key attributes must be specified. See referencedCIs in the 
CIsAndRelationsUpdates topic in this section.

Inserting New Configuration Items into the UCMDB

It is possible to use either an empty ID or a temporary ID to insert a new CI. 
However, if the ID is empty, the server cannot return the real UCMDB ID in 
the structure createIDsMap because there is no clientID. For details, see 
“addCIsAndRelations” on page 352.

Inserting New Relations into the UCMDB

The relation ID can be either temporary or empty. However, if the relation is 
new but the configuration items on either end of the relation are already 
defined in the UCMDB, then those Configuration Items that already exist 
must be identified by a real UCMDB ID or be specified in a referencedCIs 
collection.

HP UCMDB Module Update Methods

addCIsAndRelations

addCIsAndRelations adds or updates Configuration Items and relations. 

If the Configuration Items or relations do not exist in UCMDB, they are 
added and their properties are set according to the contents of the 
CIsAndRelationsUpdates argument. If they already exist, they are updated with 
the new data if updateExisting is true. If updateExisting is false, 
CIsAndRelationsUpdates cannot reference existing configuration items or 
relations. Attempting to reference existing items when updateExisting is false 
results in an exception.

If updateExisting is true, the add or update operation is performed without 
validating the CIs, regardless of the value of ignoreValidation.

If updateExisiting is false and ignoreValidation is true, the  add operation is 
performed without validating the CIs. If updateExisiting is false and 
ignoreValidation is false, the the CIs are validated before the add operation.

Relations are never validated.
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CreatedIDsMap is a map or dictionary of type ClientIDToCmdbID that 
connects the client’s temporary IDs with the corresponding real UCMDB 
IDs. 

Input:

Output: 

 

deleteCIsAndRelations

deleteCIsAndRelations removes the specified configuration items and 
relations from the UCMDB.

When a CI is deleted and the CI is one end of one or more Relation items, 
those Relation items are also deleted.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

updateExisting Set to true to update items that already exist in the 
UCMDB. Set to false to throw an exception if any 
item already exists. 

CIsAndRelationsUpdates The items to update or create. For details, see 
“CIsAndRelationsUpdates” on page 351.

ignoreValidation If is true, no check is performed before updating the 
uCMDB.

Parameter Comment

CreatedIDsMap The map of client IDs to UCMDB IDs. For details, 
see “addCIsAndRelations” on page 352.

comments Disregard this value. It is for internal use by HP.
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Input: 

updateCIsAndRelations

updateCIsAndRelations updates the specified Configuration Items and 
Relations. 

The update uses the property values from the CIsAndRelationsUpdates 
argument. If any of the configuration items or relations do not exist in the 
UCMDB, an exception is thrown.

CreatedIDsMap is a map or dictionary of type ClientIDToCmdbID that 
connects the client’s temporary IDs with the corresponding real UCMDB 
IDs. 

Input: 

Output: 

 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

CIsAndRelationsUpdates The items to delete. For details, see 
“CIsAndRelationsUpdates” on page 351

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

CIsAndRelationsUpdates The items to update. For details, see 
“CIsAndRelationsUpdates” on page 351

ignoreValidation If true, no check is performed before updating the 
uCMDB

Parameter Comment

CreatedIDsMap The map of client IDs to UCMDB IDs. For details, 
see “addCIsAndRelations” on page 352.
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Query the HP UCMDB Module Class Model 

The class model methods return information about CI and Relation types. 
The class model is configured using the CI Type Manager in the UCMDB 
user interface. 

For examples of the use of the class model methods, see “Class Model 
Example” on page 383.

This section includes the following topics:

➤ “HP UCMDB Module Class Model (CIT) Methods” on page 355

HP UCMDB Module Class Model (CIT) Methods
The following methods return information about CI and Relation types. 

getClassAncestors

getClassAncestors retrieves the path between the given CI Type and its root, 
including the root. 

Input: 

Output: 

 

getAllClassesHierarchy

getAllClassesHierarchy retrieves the entire class model tree.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

className The type name. For details, see “Type Name” on 
page 390.

Parameter Comment

classHierarchy A collection of pairs of class names and parent class 
name. 

comments Disregard this value. It is for internal use by HP.
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Input: 

 

Output:

 

getCmdbClassDefinition

getCmdbClassDefinition retrieves information about the specified class.

If you use getCmdbClassDefinition to retrieve the key attributes, you must 
also query the parent classes up to the base class. getCmdbClassDefinition 
identifies as key attributes only those attributes with the ID_ATTRIBUTE set 
in the class definition specified by className. Inherited key attributes are 
not recognized as key attributes of the specified class. Therefore, the 
complete list of key attributes for the specified class is the union of all the 
keys of the class and of all its parents, up to the root.

Input: 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

Parameter Comment

classesHierarchy A collection of pairs of class name and parent class 
name. 

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

className The type name. For details, see “Type Name” on 
page 390.
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Output: 

 

Query for Impact Analysis

The Identifier in the impact analysis methods points to the service’s response 
data. It is unique for the current response and is discarded from the server’s 
memory cache after 10 minutes of non-use.

For examples of the use of the impact analysis methods, see “Impact 
Analysis Example” on page 384.

HP UCMDB Module Impact Analysis Methods

calculateImpact

calculateImpact calculates what other configuration items are affected by 
the given CI according to the rules defined in the UCMDB. 

This shows the effect of an event triggering of the rule. The identifier output 
of calculateImpact is used as input for getImpactPath.

Input: 

Parameter Comment

cmdbClass The class definition, consisting of name, classType, 
displayLabel, description, parentName, qualifiers, and 
attributes.  

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

impactCategory The type of event that would trigger the rule being 
simulated.

IDs A collection of ID elements.  
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Output: 

 

getImpactPath

getImpactPath retrieves the topology graph of the path between the affected 
CI and the CI that affects it. 

The identifier output of calculateImpact is the used as the identifier input 
argument of getImpactPath.

Input: 

Output: 

 

impactRulesNames A collection of ImpactRuleName elements.

severity The severity of the triggering event.

Parameter Comment

impactTopology For details, see “Topology” on page 392. 

identifier The key to the server response. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

identifier The key to the server response that was returned by 
calculateImpact.

relation A Relation based on one of the ShallowRelations 
returned by calculateImpact in the impactTopology 
element. 

Parameter Comment

impactPathTopology A CIs collection and an ImpactRelations collection.  

comments Disregard this value. It is for internal use by HP.

Parameter Comment
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An ImpactRelations element consists of an ID, type, end1ID, end2ID, a rule, and 
an action.

getImpactRulesByNamePrefix

getImpactRulesByNamePrefix retrieves rules using a prefix filter.

This method applies to impact rules that are named with a prefix that 
indicates the context to which they apply, for example, SAP_myrule, 
ORA_myrule, and so on. This method filters all impact rule name for those 
beginning with the prefix specified by the ruleNamePrefixFilter argument.

Input: 

Output:

Reference

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 388.

ruleNamePrefixFilter A string containing the first letters of the rule names 
to match. 

Parameter Comment

impactRules impactRules is composed of zero or more 
impactRule. An impactRule, which specifies the 
effect of a change, is composed of ruleName, 
description, queryName, and isActive.
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Use Cases

The following use cases assume two systems:

➤ HP Universal CMDB server

➤ A third-party system that contains a repository of configuration items

This section includes the following topics:

➤ “Populating the UCMDB” on page 360

➤ “Querying the UCMDB” on page 360

➤ “Querying the Class Model” on page 361

➤ “Analyzing Change Impact” on page 361

Populating the UCMDB
Use cases:

➤ A third-party asset management updates the UCMDB with information 
available only in asset management 

➤ A number of third-party systems populate the UCMDB to create a central 
CMDB that can track changes and perform impact analysis

➤ A third-party system creates Configuration Items and Relations according to 
third-party business logic to leverage the CMDB query capabilities 

Querying the UCMDB 
Use cases:

➤ A third-party system gets the Configuration Items and Relations that 
represent the SAP system by getting the results of the SAP TQL

➤ A third-party system gets the list of Oracle servers that have been added or 
changed in the last five hours

➤ A third-party system gets the list of servers whose host name contains the 
substring lab

➤ A third-party system finds the elements related to a given CI by getting its 
neighbors
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Querying the Class Model
Use cases:

➤ A third-party system enables users to specify the set of data to be retrieved 
from the UCMDB. A user interface can be built over the class model to show 
users the possible properties and prompt them for required data. The user 
can then choose the information to be retrieved.

➤ A third-party system explores the class model when the user cannot access 
the UCMDB user interface.

Analyzing Change Impact 
Use case:

A third-party system outputs a list of the business services that could be 
impacted by a change on a specified host.

Examples

This section includes the following topics:

➤ “The Example Base Class” on page 361

➤ “Query Example” on page 364

➤ “Update Example” on page 379

➤ “Class Model Example” on page 383

➤ “Impact Analysis Example” on page 384

The Example Base Class
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.services.UcmdbService;
import com.hp.ucmdb.generated.services.UcmdbServiceStub;
import com.hp.ucmdb.generated.types.CmdbContext;
import org.apache.axis2.AxisFault;
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import org.apache.axis2.transport.http.HTTPConstants;
import org.apache.axis2.transport.http.HttpTransportProperties;

import java.net.MalformedURLException;
import java.net.URL;

/**
* User: hbarkai
* Date: Jul 12, 2007
*/
abstract class Demo {

UcmdbService stub;
CmdbContext context;

public void initDemo() {
try {

setStub(createUcmdbService("admin", "admin"));
setContext();

} catch (Exception e) {
//handle exception

}
}

public UcmdbService getStub() {
return stub;

}

public void setStub(UcmdbService stub) {
this.stub = stub;

}

public CmdbContext getContext() {
return context;

}

public void setContext() {
CmdbContext context = new CmdbContext();
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context.setCallerApplication("demo");
this.context = context;

}

//connection to service  - for axis2/jibx client

private static final String PROTOCOL = "http";
private static final String HOST_NAME = "host_name";
private static final int PORT = 8080;
private static final String FILE = "/axis2/services/UcmdbService";

protected UcmdbService createUcmdbService
(String username, String password) throws Exception{

URL url;
UcmdbServiceStub serviceStub;
try {

 url = new URL
(Demo.PROTOCOL, Demo.HOST_NAME, 
Demo.PORT, Demo.FILE);

 serviceStub = new UcmdbServiceStub(url.toString());
 HttpTransportProperties.Authenticator auth =

new HttpTransportProperties.Authenticator();
 auth.setUsername(username);
 auth.setPassword(password);

serviceStub._getServiceClient().getOptions().setProperty
(HTTPConstants.AUTHENTICATE,auth);

} catch (AxisFault axisFault) {
throw new Exception
("Failed to create SOAP adapter for "

+ Demo.HOST_NAME , axisFault);
} catch (MalformedURLException e) {

throw new Exception
("Failed to create SOAP adapter for "

+ Demo.HOST_NAME, e);
}
return serviceStub;

 }
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}

Query Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.query.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import com.hp.ucmdb.generated.services.UcmdbService;
import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.props.*;

import java.rmi.RemoteException;

public class QueryDemo extends Demo{

UcmdbService stub;
CmdbContext context;

public void getCIsByTypeDemo() {
GetCIsByType request = new GetCIsByType();
//set cmdbcontext
CmdbContext cmdbContext = getContext();
request.setCmdbContext(cmdbContext);
//set CIs type
request.setType("anyType");
//set CIs propeties to be retrieved
CustomProperties customProperties = new CustomProperties();
PredefinedProperties predefinedProperties = 

new PredefinedProperties();
SimplePredefinedProperty simplePredefinedProperty = 

new SimplePredefinedProperty();
simplePredefinedProperty.setName

(SimplePredefinedProperty.nameEnum.DERIVED);
SimplePredefinedPropertyCollection 

simplePredefinedPropertyCollection = 
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new SimplePredefinedPropertyCollection();
simplePredefinedPropertyCollection.addSimplePredefinedProperty

(simplePredefinedProperty);
predefinedProperties.setSimplePredefinedProperties

(simplePredefinedPropertyCollection);
customProperties.setPredefinedProperties(predefinedProperties);
request.setProperties(customProperties);
try {

GetCIsByTypeResponse response =
getStub().getCIsByType(request);

TopologyMap map =
getTopologyMapResultFromCIs

(response.getCIs(), response.getChunkInfo());
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getCIsByIdDemo() {
GetCIsById request = new GetCIsById();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set ids
ID id1 = new ID();
id1.setBase("cmdbobjectidCIT1");
ID id2 = new ID();
id2.setBase("cmdbobjectidCIT2");
IDs ids = new IDs();
ids.addID(id1);
ids.addID(id2);
request.setIDs(ids);
//set CIs properties to be retrieved
TypedPropertiesCollection properties = 

new TypedPropertiesCollection();
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TypedProperties typedProperties1 =
new TypedProperties();

typedProperties1.setType("CIT1");
CustomTypedProperties customProperties1 =

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties1 = 

new PredefinedTypedProperties();
SimpleTypedPredefinedProperty simplePredefinedProperty1 = 

new SimpleTypedPredefinedProperty();
simplePredefinedProperty1.setName

(SimpleTypedPredefinedProperty.nameEnum.CONCRETE);
SimpleTypedPredefinedPropertyCollection

simplePredefinedPropertyCollection1 = 
new SimpleTypedPredefinedPropertyCollection();

simplePredefinedPropertyCollection1
.addSimpleTypedPredefinedProperty

(simplePredefinedProperty1);

predefinedProperties1.
setSimpleTypedPredefinedProperties

(simplePredefinedPropertyCollection1);
customProperties1.

setPredefinedTypedProperties
(predefinedProperties1);

typedProperties1.setProperties(customProperties1);
properties.addTypedProperties(typedProperties1);

TypedProperties typedProperties2 = 
new TypedProperties();

typedProperties2.setType("CIT2");
CustomTypedProperties customProperties2 = 

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties2 = 

new PredefinedTypedProperties();
SimpleTypedPredefinedProperty simplePredefinedProperty2 = 

new SimpleTypedPredefinedProperty();
simplePredefinedProperty2.setName

(SimpleTypedPredefinedProperty.nameEnum.NAMING);
SimpleTypedPredefinedPropertyCollection
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simplePredefinedPropertyCollection2 = 
new SimpleTypedPredefinedPropertyCollection();

simplePredefinedPropertyCollection2.
addSimpleTypedPredefinedProperty

(simplePredefinedProperty2);
predefinedProperties2.setSimpleTypedPredefinedProperties

(simplePredefinedPropertyCollection2);
customProperties2.setPredefinedTypedProperties

(predefinedProperties2);
typedProperties2.setProperties(customProperties2);
properties.addTypedProperties(typedProperties2);

request.setCIsTypedProperties(properties);
try {

GetCIsByIdResponse response = 
getStub().getCIsById(request);

CIs cis = response.getCIs();
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getFilteredCIsByTypeDemo() {
GetFilteredCIsByType request = new GetFilteredCIsByType();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set CIs type
request.setType("anyType");
//sets Filter conditions
Conditions conditions = new Conditions();
IntConditions intConditions = new IntConditions();
IntCondition intCondition = new IntCondition();
IntProp intProp = new IntProp();
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intProp.setName("int_attr1");
intProp.setValue(100);
intCondition.setCondition(intProp);
intCondition.setIntOperator

(IntCondition.intOperatorEnum.Greater);
intConditions.addIntCondition(intCondition);
conditions.setIntConditions(intConditions);
request.setConditions(conditions);
//set logical operator for conditions
request.setConditionsLogicalOperator

(GetFilteredCIsByType.conditionsLogicalOperatorEnum.AND);
//set CIs properties to be retrieved
CustomProperties customProperties =

new CustomProperties();
PredefinedProperties predefinedProperties = 

new PredefinedProperties();
SimplePredefinedProperty simplePredefinedProperty = 

new SimplePredefinedProperty();
simplePredefinedProperty.setName

(SimplePredefinedProperty.nameEnum.NAMING);
SimplePredefinedPropertyCollection 

simplePredefinedPropertyCollection =
new SimplePredefinedPropertyCollection();

simplePredefinedPropertyCollection.
addSimplePredefinedProperty

(simplePredefinedProperty);
predefinedProperties.setSimplePredefinedProperties

(simplePredefinedPropertyCollection);
customProperties.setPredefinedProperties

(predefinedProperties);

request.setProperties(customProperties);
try {

GetFilteredCIsByTypeResponse response =
getStub().getFilteredCIsByType(request);

TopologyMap map =
getTopologyMapResultFromCIs

(response.getCIs(), response.getChunkInfo());
} catch (RemoteException e) {
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//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void executeTopologyQueryByNameDemo() {
ExecuteTopologyQueryByName request = new 

ExecuteTopologyQueryByName();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query name
request.setQueryName("queryName");

try {
ExecuteTopologyQueryByNameResponse response =

getStub().executeTopologyQueryByName(request);
TopologyMap map =

getTopologyMapResult
(response.getTopologyMap(), response.getChunkInfo());

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

// assume the follow query was defined at UCMDB
// Query Name: exampleQuery
// Query sketch:
//    Host
//    /  \
//  ip Disk
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// Query Parameters:
//   Host-
//   host_os (like)
//   Disk-
//   disk_failures (equal)

public void executeTopologyQueryByNameWithParametersDemo() {
ExecuteTopologyQueryByNameWithParameters request =

new ExecuteTopologyQueryByNameWithParameters();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query name
request.setQueryName("queryName");
//set parameters
ParameterizedNode hostParametrizedNode = 

new ParameterizedNode();
hostParametrizedNode.setNodeLabel("Host");
CIProperties parameters = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp = new StrProp();
strProp.setName("host_os");
strProp.setValue("%2000%");
strProps.addStrProp(strProp);
parameters.setStrProps(strProps);
hostParametrizedNode.setParameters(parameters);
request.addParameterizedNodes(hostParametrizedNode);
ParameterizedNode diskParametrizedNode = 

new ParameterizedNode();
diskParametrizedNode.setNodeLabel("Disk");
CIProperties parameters1 = new CIProperties();
IntProps intProps = new IntProps();
IntProp intProp = new IntProp();
intProp.setName("disk_failures");
intProp.setValue(30);
intProps.addIntProp(intProp);
parameters1.setIntProps(intProps);
diskParametrizedNode.setParameters(parameters1);
request.addParameterizedNodes(diskParametrizedNode);
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try {
ExecuteTopologyQueryByNameWithParametersResponse 

response =
getStub().executeTopologyQueryByNameWithParameters

(request);
TopologyMap map =

getTopologyMapResult
(response.getTopologyMap(), response.getChunkInfo());

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

/ // assume the follow query was defined at UCMDB
// Query Name: exampleQuery
// Query sketch:
//    Host
//    /  \
//  ip Disk
// Query Parameters:
//   Host-
//   host_os (like)
//   Disk-
//   disk_failures (equal)

public void executeTopologyQueryWithParametersDemo() {
ExecuteTopologyQueryWithParameters request = 

new ExecuteTopologyQueryWithParameters();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query definition
String queryXml = "<xml that represents the query above>";
request.setQueryXml(queryXml);
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//set parameters
ParameterizedNode hostParametrizedNode = 

new ParameterizedNode();
hostParametrizedNode.setNodeLabel("Host");
CIProperties parameters = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp = new StrProp();
strProp.setName("host_os");
strProp.setValue("%2000%");
strProps.addStrProp(strProp);
parameters.setStrProps(strProps);
hostParametrizedNode.setParameters(parameters);
request.addParameterizedNodes(hostParametrizedNode);
ParameterizedNode diskParametrizedNode = 

new ParameterizedNode();
diskParametrizedNode.setNodeLabel("Disk");
CIProperties parameters1 = new CIProperties();
IntProps intProps = new IntProps();
IntProp intProp = new IntProp();
intProp.setName("disk_failures");
intProp.setValue(30);
intProps.addIntProp(intProp);
parameters1.setIntProps(intProps);
diskParametrizedNode.setParameters(parameters1);
request.addParameterizedNodes(diskParametrizedNode);
try {

ExecuteTopologyQueryWithParametersResponse 
response = getStub().executeTopologyQueryWithParameters

(request);
TopologyMap map =

getTopologyMapResult
(response.getTopologyMap(), response.getChunkInfo());

 } catch (RemoteException e) {
 //handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}
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public void getCINeighboursDemo() {
GetCINeighbours request = new GetCINeighbours();
//set cmdbcontext
CmdbContext cmdbContext = getContext();
request.setCmdbContext(cmdbContext);
// set CI id
ID id = new ID();
id.setBase("cmdbobjectidCIT1");
request.setID(id);
//set neighbour type
request.setNeighbourType("neighbourType");
//set Neighbours CIs propeties to be retrieved
TypedPropertiesCollection properties = 

new TypedPropertiesCollection();
TypedProperties typedProperties1 = new TypedProperties();
typedProperties1.setType("neighbourType");
CustomTypedProperties customProperties1 = 

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties1 =

new PredefinedTypedProperties();
QualifierProperties qualifierProperties =

new QualifierProperties();
qualifierProperties.addQualifierName("ID_ATTRIBUTE");
predefinedProperties1.setQualifierProperties(qualifierProperties);
customProperties1.setPredefinedTypedProperties

(predefinedProperties1);
typedProperties1.setProperties(customProperties1);
properties.addTypedProperties(typedProperties1);
request.setCIProperties(properties);

TypedPropertiesCollection relationsProperties =
new TypedPropertiesCollection();

TypedProperties typedProperties2 = new TypedProperties();
typedProperties2.setType("relationType");
CustomTypedProperties customProperties2 = 
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new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties2 = 

new PredefinedTypedProperties();
SimpleTypedPredefinedProperty simplePredefinedProperty2 =

new SimpleTypedPredefinedProperty();
simplePredefinedProperty2.setName

(SimpleTypedPredefinedProperty.nameEnum.CONCRETE);
SimpleTypedPredefinedPropertyCollection

simplePredefinedPropertyCollection2 = 
new SimpleTypedPredefinedPropertyCollection();

simplePredefinedPropertyCollection2.
addSimpleTypedPredefinedProperty

(simplePredefinedProperty2);
predefinedProperties2.

setSimpleTypedPredefinedProperties
(simplePredefinedPropertyCollection2);

customProperties2.setPredefinedTypedProperties
(predefinedProperties2);

typedProperties2.setProperties(customProperties2);
relationsProperties.addTypedProperties(typedProperties2);
request.setRelationProperties(relationsProperties);

try {
GetCINeighboursResponse response =

getStub().getCINeighbours(request);
Topology topology = response.getTopology();

   } catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
 //handle exception

}

}

//get Topology Map for chunked/non-chunked result
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private TopologyMap getTopologyMapResult(TopologyMap topologyMap, 
ChunkInfo chunkInfo) {

if(chunkInfo.getNumberOfChunks() == 0) {
return topologyMap;

} else {
topologyMap = new TopologyMap();
for(int i=1 ; i <= chunkInfo.getNumberOfChunks() ; i++) {

ChunkRequest chunkRequest = new ChunkRequest();
chunkRequest.setChunkInfo(chunkInfo);
chunkRequest.setChunkNumber(i);
PullTopologyMapChunks req = 

new PullTopologyMapChunks();
req.setChunkRequest(chunkRequest);
req.setCmdbContext(getContext());
PullTopologyMapChunksResponse res = null;
try  {

res = getStub().pullTopologyMapChunks(req);
TopologyMap map = res.getTopologyMap();
topologyMap = mergeMaps(topologyMap, map);

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}
}

}
return topologyMap;

}

private TopologyMap getTopologyMapResultFromCIs(CIs cis, ChunkInfo 
chunkInfo) {

TopologyMap topologyMap = new TopologyMap();
if(chunkInfo.getNumberOfChunks() == 0) {

CINode ciNode = new CINode();
ciNode.setLabel("");
ciNode.setCIs(cis);
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CINodes ciNodes = new CINodes();
ciNodes.addCINode(ciNode);
topologyMap.setCINodes(ciNodes);

} else {
for(int i=1 ; i <= chunkInfo.getNumberOfChunks() ; i++) {

ChunkRequest chunkRequest =
new ChunkRequest();

chunkRequest.setChunkInfo(chunkInfo);
chunkRequest.setChunkNumber(i);
PullTopologyMapChunks req = 

new PullTopologyMapChunks();
req.setChunkRequest(chunkRequest);
req.setCmdbContext(getContext());
PullTopologyMapChunksResponse res = null;
try  {

res = getStub().pullTopologyMapChunks(req);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}
TopologyMap map = res.getTopologyMap();
topologyMap = mergeMaps(topologyMap, map);

}
//release chunks
ReleaseChunks req = new ReleaseChunks();
req.setChunksKey(chunkInfo.getChunksKey());
req.setCmdbContext(getContext());
try {

getStub().releaseChunks(req);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}
return topologyMap;

}
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//===================================================
/*  WARNING merge will be correct only if a each node is given

a unique name. This applies to both CI and Relation nodes .*/
//===================================================

private TopologyMap mergeMaps(TopologyMap topologyMap, TopologyMap 
newMap) {

for(int i=0 ; i < newMap.getCINodes().sizeCINodeList() ; i++ ) {
CINode ciNode = newMap.getCINodes().getCINode(i);
boolean alreadyExist = false;
if(topologyMap.getCINodes() == null) {

topologyMap.setCINodes(new CINodes());
}
for(int j=0 ; j < topologyMap.getCINodes().sizeCINodeList() ; j++) {

CINode ciNode2 = topologyMap.getCINodes().getCINode(j);
if(ciNode2.getLabel().equals(ciNode.getLabel())){

CIs cisTOAdd = ciNode.getCIs();
CIs cis =

mergeCIsGroups
(topologyMap.getCINodes().getCINode(j).getCIs(),

cisTOAdd);
topologyMap.getCINodes().getCINode(j).setCIs(cis);
alreadyExist = true;

}
}
if(!alreadyExist) {

topologyMap.getCINodes().addCINode(ciNode);
}

}

for(int i=0 ; i < newMap.getRelationNodes().sizeRelationNodeList() ; i++ ) {
RelationNode relationNode =

newMap.getRelationNodes().getRelationNode(i);
boolean alreadyExist = false;
if(topologyMap.getRelationNodes() == null) {

topologyMap.setRelationNodes(new RelationNodes());
}
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for(int j=0 ; 
j < topologyMap.getRelationNodes().sizeRelationNodeList() ;
j++) {

RelationNode relationNode2 =
topologyMap.getRelationNodes().getRelationNode(j);

if(relationNode2.getLabel().equals(relationNode.getLabel())){
Relations relationsTOAdd = relationNode.getRelations();
Relations relations =

mergeRelationsGroups
(topologyMap.getRelationNodes().

getRelationNode(j).getRelations(),
relationsTOAdd);

topologyMap.getRelationNodes().
getRelationNode(j).setRelations(relations);

alreadyExist = true;
}

}
if(!alreadyExist) {

topologyMap.getRelationNodes().addRelationNode(relationNode);
}

}

return topologyMap;

}

private Relations mergeRelationsGroups(Relations relations1, Relations 
relations2) {

for(int i=0 ; i < relations2.sizeRelationList() ; i++) {
relations1.addRelation(relations2.getRelation(i));

}
return relations2;

}

private CIs mergeCIsGroups(CIs cis1, CIs cis2) {
for(int i=0 ; i < cis2.sizeCIList() ; i++) {
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cis1.addCI(cis2.getCI(i));
}
return cis1;

}

}

Update Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.update.AddCIsAndRelations;
import 
com.hp.ucmdb.generated.params.update.AddCIsAndRelationsResponse;
import com.hp.ucmdb.generated.params.update.UpdateCIsAndRelations;
import com.hp.ucmdb.generated.params.update.DeleteCIsAndRelations;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.update.CIsAndRelationsUpdates;
import com.hp.ucmdb.generated.types.update.ClientIDToCmdbID;

import java.rmi.RemoteException;

public class UpdateDemo extends Demo{

public void getAddCIsAndRelationsDemo() {
AddCIsAndRelations request = new AddCIsAndRelations();
request.setCmdbContext(getContext());
request.setUpdateExisting(true);
CIsAndRelationsUpdates updates = new CIsAndRelationsUpdates();
CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("temp1");
id.setTemp(true);
ci.setID(id);
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ci.setType("host");
CIProperties props = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp = new StrProp();
strProp.setName("host_key");
String value = "blabla";
strProp.setValue(value);
strProps.addStrProp(strProp);
props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

AddCIsAndRelationsResponse response  =
getStub().addCIsAndRelations(request);

for(int i = 0  ;  i < response.sizeCreatedIDsMapList() ; i++) {
ClientIDToCmdbID idsMap = response.getCreatedIDsMap(i);
//do something

}
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getUpdateCIsAndRelationsDemo() {
UpdateCIsAndRelations request = new UpdateCIsAndRelations();
request.setCmdbContext(getContext());

CIsAndRelationsUpdates updates =
new CIsAndRelationsUpdates();

CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("temp1");
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id.setTemp(true);
ci.setID(id);
ci.setType("host");
CIProperties props = new CIProperties();
StrProps strProps = new StrProps();

StrProp hostKeyProp = new StrProp();
hostKeyProp.setName("host_key");
String hostKeyValue = "blabla";
hostKeyProp.setValue(hostKeyValue);
strProps.addStrProp(hostKeyProp);

StrProp hostOSProp = new StrProp();
hostOSProp.setName("host_os");
String hostOSValue = "winXP";
hostOSProp.setValue(hostOSValue);
strProps.addStrProp(hostOSProp);

StrProp hostDNSProp = new StrProp();
hostDNSProp.setName("host_dnsname");
String hostDNSValue = "dnsname";
hostDNSProp.setValue(hostDNSValue);
strProps.addStrProp(hostDNSProp);

props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

getStub().updateCIsAndRelations(request);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}
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public void getDeleteCIsAndRelationsDemo() {
DeleteCIsAndRelations request = 

new DeleteCIsAndRelations();
request.setCmdbContext(getContext());
CIsAndRelationsUpdates updates = 

new CIsAndRelationsUpdates();
CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("stam");
id.setTemp(true);
ci.setID(id);
ci.setType("host");
CIProperties props = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp1 = new StrProp();
strProp1.setName("host_key");
String value1 = "for_delete";
strProp1.setValue(value1);
strProps.addStrProp(strProp1);
props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

getStub().deleteCIsAndRelations(request);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

}
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Class Model Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.classmodel.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import 
com.hp.ucmdb.generated.types.classmodel.UcmdbClassModelHierarchy;
import com.hp.ucmdb.generated.types.classmodel.UcmdbClass;

import java.rmi.RemoteException;

public class ClassmodelDemo extends Demo{

public void getClassAncestorsDemo() {
GetClassAncestors request = 

new GetClassAncestors();
request.setCmdbContext(getContext());
request.setClassName("className");
try {

GetClassAncestorsResponse response  =
getStub().getClassAncestors(request);

UcmdbClassModelHierarchy hierarchy =
response.getClassHierarchy();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

public void getAllClassesHierarchyDemo() {
GetAllClassesHierarchy request = 

new GetAllClassesHierarchy();
request.setCmdbContext(getContext());
try {

GetAllClassesHierarchyResponse response  =
getStub().getAllClassesHierarchy(request);
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UcmdbClassModelHierarchy hierarchy =
response.getClassesHierarchy();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

public void getCmdbClassDefinitionDemo() {
GetCmdbClassDefinition request = 

new GetCmdbClassDefinition();
request.setCmdbContext(getContext());
request.setClassName("className");
try {

GetCmdbClassDefinitionResponse response  =
getStub().getCmdbClassDefinition(request);
UcmdbClass ucmdbClass = response.getUcmdbClass();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

}

Impact Analysis Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.impact.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
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import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.impact.*;

import java.rmi.RemoteException;

/**
 * User: hbarkai
 * Date: Jul 17, 2007
 */
public class ImpactDemo extends Demo{

//Impact Rule Name : impactExample
//Impact Query:
//  Network
//  |
// Host
//  |
//  IP
//Impact Action: network affect on ip ;severity 100% ; category: change
//
public void calculateImpactAndGetImpactPathDemo() {

CalculateImpact request = new CalculateImpact();
request.setCmdbContext(getContext());
//set root cause ids
IDs ids = new IDs();
ID id = new ID();
id.setBase("rootCauseCmdbID");
ids.addID(id);
request.setIDs(ids);
//set impact category
request.setImpactCategory("change");
//set rule Names
ImpactRuleNames impactRuleNames = new ImpactRuleNames();
ImpactRuleName impactRuleName = new ImpactRuleName();
impactRuleName.setBase("impactExample");
impactRuleNames.addImpactRuleName(impactRuleName);
request.setImpactRuleNames(impactRuleNames);
//set severity
request.setSeverity(100);
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CalculateImpactResponse response =
new CalculateImpactResponse();

try {
response  = getStub().calculateImpact(request);

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}
Identifier identifier= response.getIdentifier();
Topology topology = response.getImpactTopology();
Relation relation = topology.getRelations().getRelation(0);
GetImpactPath request2 = new GetImpactPath();
//set cmdb context
request2.setCmdbContext(getContext());
//set impact identifier
request2.setIdentifier(identifier);
//set shallowRelation
ShallowRelation shallowRelation = new ShallowRelation();
shallowRelation.setID(relation.getID());
shallowRelation.setEnd1ID(relation.getEnd1ID());
shallowRelation.setEnd2ID(relation.getEnd2ID());
shallowRelation.setType(relation.getType());
request2.setRelation(shallowRelation);

try {
GetImpactPathResponse response2 =

getStub().getImpactPath(request2);
ImpactTopology impactTopology =

response2.getImpactPathTopology();
} catch (RemoteException e) {

//To change body of catch statement
// use File | Settings | File Templates.
e.printStackTrace();

} catch (UcmdbFaultException e) {
//To change body of catch statement
// use File | Settings | File Templates.
e.printStackTrace();

}
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}

public void getImpactRulesByGroupName() {
GetImpactRulesByGroupName request =

new GetImpactRulesByGroupName();
//set cmdb context
request.setCmdbContext(getContext());
//set group names list
request.addRuleGroupNameFilter("groupName1");
request.addRuleGroupNameFilter("groupName2");
try {

GetImpactRulesByGroupNameResponse response  =
getStub().getImpactRulesByGroupName(request);

ImpactRules impactRules = response.getImpactRules();
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getImpactRulesByNamePrefix() {
GetImpactRulesByNamePrefix request =

new GetImpactRulesByNamePrefix();
//set cmdb context
request.setCmdbContext(getContext());
//set prefixes list
request.addRuleNamePrefixFilter("prefix1");
try {

GetImpactRulesByNamePrefixResponse response  =
getStub().getImpactRulesByNamePrefix(request);

ImpactRules impactRules = response.getImpactRules();
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {
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//handle exception
}

}

}

UCMDB General Parameters 

This section describes the most common parameters of the service’s 
methods. For details, refer to the schema documentation.

This section includes the following topics:

➤ “CmdbContext” on page 388

➤ “ID” on page 388

➤ “Key Attributes” on page 389

➤ “ID Types” on page 389

➤ “CIProperties” on page 390

➤ “Type Name” on page 390

➤ “Configuration Item (CI)” on page 390

➤ “Relation” on page 391

CmdbContext
All UCMDB API service invocations require a CmdbContext argument. 
CmdbContext is a callerApplication string that identifies the application that 
invokes the service. CmdbContext is used for logging and troubleshooting.

ID
Every CI and Relation has an ID field. It consists of a case-sensitive ID string 
and an optional temp flag, indicating whether the ID is temporary.
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Key Attributes
For identifying a CI or Relation in some contexts, key attributes can be used 
in place of a UCMDB ID. Key attributes are those attributes with the 
ID_ATTRIBUTE set in the class definition. 

In the user interface, the key attributes have a key icon next to them in the 
list of Configuration Item Type attributes in the user interface. For details, 
see “Add/Edit Attribute Dialog Box” in Model Management. For information 
about identifying the key attributes from within the API client application, 
see “getCmdbClassDefinition” on page 356.

ID Types
An ID element can contain a real ID, a temporary ID, or can be empty. 

A real ID is a string assigned by the UCMDB that identifies an entity in the 
database. A temporary ID can be any string that is unique in the current 
request. An empty ID means no value is assigned.

A temporary ID can be assigned by the client and often represents the ID of 
the CI as stored by the client. It does not necessarily represent an entity 
already created in the UCMDB. When a temporary ID is passed by the client, 
if the UCMDB can identify an existing data configuration item using the CI 
key properties, that CI is used as appropriate for the context as though it 
had been identified with a real ID. 

The real ID of a CI is calculated by the UCMDB based on a combination of 
the CI’s type and key properties. The real ID of a Relation is based on the 
relations’s type, the IDs of the two CIs that are part of the relationship, and 
the relation’s key properties. Therefore, key attribute values must be set 
during CI or Relation creation. If the key properties values are not specified 
when creating a CI, there are two possibilities. If the CIT has the 
RANDOM_GENERATED_ID qualifier, the server generates a unique ID. If 
not, an exception is thrown.

For details, see CI Attribute Customization.
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CIProperties
A CIProperties element is composed of collections, each containing a 
sequence of name-value elements that specify properties of the type 
indicated by the collection name. None of the collections are required, so 
the CIProperties element can contain any combination of collections. 

CIProperties are used by CI and Relation elements. For details, see 
“Configuration Item (CI)” on page 390 and “Relation” on page 391. 

The properties collections are:

➤ dateProps - collection of DateProp elements

➤ doubleProps - collection of DoubleProp elements

➤ floatProps - collection of FloatProp elements

➤ intListProps - collection of intListProp elements

➤ intProps - collection of IntProp elements

➤ strProps - collection of StrProp elements

➤ strListProps - collection of StrListProp elements

➤ longProps - collection of LongProp elements

➤ bytesProps - collection of BytesProp elements

➤ xmlProps - collection of XmlProp elements

Type Name
The type name is the class name of a configuration item type or relation 
type. The type name is used in code to refer to the class. It should not be 
confused with the display name, which is seen on the user interface where 
the class is mentioned, but which is meaningless in code.

Configuration Item (CI)
A CI element is composed of an ID, a type, and a props collection. 
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When using HP UCMDB Module Update Methods to update a CI, the ID 
element can contain a real UCMDB ID or a client-assigned temporary ID. If a 
temporary ID is used, set the temp flag to true. When deleting an item, the 
ID can be empty. HP UCMDB Module Query Methods take real IDs as input 
parameters and return real IDs in the query results.

The type can be any type name defined in the CI Type Manager. For details, 
see “CI Type Manager User Interface” in Model Management.

The props element is a CIProperties collection. For details, see “CIProperties” 
on page 390.

Relation
A Relation is an entity that links two configuration items. A Relation element 
is composed of an ID, a type, the identifiers of the two items being linked 
(end1ID and end2ID), and a props collection.

When using HP UCMDB Module Update Methods to update a Relation, the 
value of the Relation’s ID can be a real UCMBD ID or a temporary ID. When 
deleting an item, the ID can be empty. HP UCMDB Module Query Methods 
take real IDs as input parameters and return real IDs in the query results. 

The relation type is the Type Name of the HP UCMDB class from which the 
relation is instantiated. The type can be any of the relation types defined in 
the UCMDB. For further information on classes or types, see “Query the HP 
UCMDB Module Class Model” on page 355.

For details, see “CI Type Manager User Interface” in Model Management.

The two relation end IDs must not be empty IDs because they are used to 
create the ID of the current relation. However, they both can have 
temporary IDs assigned to them by the client. 

The props element is a CIProperties collection. For details, see “CIProperties” 
on page 390.
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UCMDB Output Parameters 

This section describes the most common output parameters of the service 
methods. For details, refer to the schema documentation.

This section includes the following topics:

➤ “CIs” on page 392

➤ “ShallowRelation” on page 392

➤ “Topology” on page 392

➤ “CINode” on page 392

➤ “RelationNode” on page 393

➤ “TopologyMap” on page 393

➤ “ChunkInfo” on page 393

CIs
CIs is a collection of CI elements.

ShallowRelation
A ShallowRelation is an entity that links two configuration items, composed 
of an ID, a type, and the identifiers of the two items being linked (end1ID 
and end2ID). The relation type is the Type Name of the UCMDB class from 
which the relation is instantiated. The type can be any of the relation types 
defined in the UCMDB. 

Topology
Topology is a graph of CI elements and relations. A Topology consists of a CIs 
collection and a Relations collection containing one or more Relation 
elements.

CINode
CINode is composed of a CIs collection with a label. The label in the CINode 
is the label defined in the node of the TQL used in the query.
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RelationNode
RelationNode is a set of Relations collections with a label. The label in the 
RelationNode is the label defined in the node of the TQL used in the query.

TopologyMap
TopologyMap is the output of a query calculation that matches a TQL query. 
The labels in the TopologyMap are the node labels defined in the TQL used in 
the query.

The data of TopologyMap is returned in the following form:

➤ CINodes. This is one or more CINode (see “CINode” on page 392).

➤ relationNodes. This is one or more RelationNode (see “RelationNode” on 
page 393).

The labels in these two structures order the lists of configuration items and 
relations.

ChunkInfo
When a query returns a large amount of data, the server stores the data, 
divided into segments called chunks. The information the client uses to 
retrieve the chunked data is in the ChunkInfo structure returned by the 
query. ChunkInfo is composed of the numberOfChunks that must be retrieved 
and the chunksKey. The chunksKey is a unique identifier of the data on the 
server for this specific query invocation.

For more information, see “Processing Large Responses” on page 334.
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7
Working with the Dashboard API

This chapter describes how to retrieve a list of all available views in an 
HP Business Availability Center system through a URL-based query to the 
database.

This chapter includes:

 ➤  Building Queries on page 395

 ➤  Query Examples on page 398

Building Queries

You use the Dashboard API to query the database and return a list of views 
in XML format.

Tip: You can use XSLT to convert the XML output into any other format 
(commonly text or HTML). For example, using basic XSLT transformations, 
you can produce HTML reports that are formatted to fit on mobile devices. 
These reports can be served via a mobile portal to display critical Business 
Availability Center views on users’ mobile phones.
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Query Syntax
The basic syntax of the query is as follows:

http://<Gateway Server>/topaz/bam/
BAMOpenApi?customerId=<customer ID>&userName=<user 
name>&password=<password>&command=<command parameter>

Depending on the command parameter defined, additional parameters may 
also be included.

Main Parameters Used in the Query
The table below lists the parameters that must be defined in the query.

Parameter Description

customerID HP Business Availability Center customers should 
specify 1. HP Software-as-a-Service customers 
should specify their unique customer ID.

userName Specify a user name defined in HP Business 
Availability Center. The query does not encrypt the 
login credentials.

password Specify the password for the user name provided. 
The query does not encrypt the login credentials.

command Specify one of the following values:

getViews – Specify to retrieve all views from the 
CMDB. No other parameters are required.

getNodes – Specify to retrieve all child nodes of a 
specified view (you must also specify the view for 
which to retrieve child nodes in the viewName 
parameter); if using this command parameter you 
can also set the following parameters: showTooltip, 
depth, layout, xsltURL, responseContentType

viewName If the getNodes command parameter is defined, 
include this parameter in the query and specify the 
view to retrieve. You can set the value to 
ticker_all_views to retrieve all views and their 
nodes.
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showTooltip If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify whether to display Dashboard’s KPI tooltip 
data, either true to display data or false to not. The 
default value is false.

depth If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the number of levels in the view to display. 
The default value is 1.

layout If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the layout for the query results, either 
hierarchical or flat. In flat mode all nodes are 
retrieved in a flat list, and in hierarchical mode 
nodes are retrieved in the same hierarchy as in the 
view. The default value is flat.

xsltURL If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify a URL to an .xslt file that transforms the 
.xml-format result of the query.

responseContentType If the getNodes command parameter is defined, 
and the xsltURL parameter is included in the query, 
you can include this parameter in the query to 
specify the response MIME type.

Parameter Description
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Query Examples

Below are examples of queries and the data they return.

➤ The query below returns a flat list of all views in the CMDB.

http://myserver/topaz/bam/
BAMOpenApi?customerId=1&userName=admin&password=admin&comma
nd=getViews

➤ The query below returns a hierarchical tree showing KPI status and tooltip 
information for the Service Measurements view, to a depth of three child 
nodes.

http://myserver/topaz/bam/
BAMOpenApi?customerId=1&userName=admin&password=admin&comma
nd=getNodes&viewName=Service%20Measurements&showTooltip=true&d
epth=3&layout=hierarchical
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Enterprise Management Systems 
Integration

This chapter describes the Enterprise Management Systems integration.

This chapter includes:

Concepts

 ➤  Enterprise Management Systems and the EMS Integrations Application 
Overview on page 402

 ➤  Understanding the Application<-->Host or Host Integration Adapters 
on page 403

 ➤  Reconciliation of Hosts on page 405

Tasks

 ➤  Integrate Data from Third-Party Sources (EMS Data) into HP Business 
Availability Center on page 407

Reference

 ➤  EMS User Interface on page 414
Concepts
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Enterprise Management Systems and the EMS 
Integrations Application Overview 

HP Business Availability Center has the ability to integrate with existing 
EMS (Enterprise Management Systems) software and provides the capability 
to build new integrations or to customize out-of-the-box integrations (for 
example: HP OVO, HP ServiceCenter, or Netscout nGenius).

SiteScope Integration Monitors integrate measurements, open incidents, 
alerts, and events generated by Enterprise Management Systems software 
into HP Business Availability Center reports. Enterprise Management 
Systems integrations can integrate alerts generated by HP Business 
Availability Center, Dashboard, and Service Level Management into your 
Enterprise Management Systems program.

The EMS Integrations application helps you customize the Integration 
Monitor configuration files to correctly map the data Integration Monitors 
collect to a format recognizable by HP Business Availability Center, provides 
out-of-the-box integrations, and enriches your business views. 

The EMS Integrations application enables you to sketch a CIT relationship 
map of the integration you are creating to help you formulate the KPI 
assignment rules that are described below.

You can directly access the System Availability Management Administration 
through a window in the EMS Integrations application, where you can 
access a SiteScope and deploy integration monitors to collect performance 
and availability data from your EMS system. This data, which can represent 
CPU, disk space, or other information, provides the global status of the EMS 
Monitor CI. 

You can create or customize a KPI assignment rule for each integration CI 
type in the CIT relationship map you sketched previously. An assignment 
rule includes a condition and a task. The condition describes specific 
characteristics of a CI. The task describes the context menus, KPIs, rules, rule 
parameters, and selectors that are to be assigned automatically to the CI 
when the condition occurs, if the assignment is running. For details, see 
“Assignment Rules Mechanism and KPI Propagation” in Using Dashboard.
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You can then display the view that is created by the integration.

An EMS integration is used to display, in Dashboard, an overview of data 
from other applications. It is not a run-time solution where you can see 
events and errors as they occur.

Note: To change the logic, use one of the following options:

➤ For a specific CI in a specific view, modify the logic for that CI in Admin 
> Dashboard > KPIs.

➤ For all the appropriate instances of a CI, retroactively, modify the logic in 
Admin > EMS Integrations. This change is valid for future instances of 
the CI.

Understanding the Application<-->Host or Host 
Integration Adapters

This section describes the main concepts of the Application <--> Host or 
Host integration adapter. 

The out-of-the-box Application <--> Host and Host integration adapters use 
out-of-the-box Jython scripts to create the appropriate topology. 

This section includes the following topics:

➤ “Application <--> Host Integration Adapter” on page 404

➤ “Host Integration Adapter” on page 404

➤ “EMS Monitor CI” on page 405
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Application <--> Host Integration Adapter
The integration adapter adds the EMS Monitor CI to the Application CI, 
assigns the Application KPI to the Application CI, adds the Host CI to the 
topology, assigns the System KPI to the Host CI. It also adds the Clear Events 
context menu item that enables you to clear an event. All the host 
information (for example: CPU or disk space) available from the sample 
provides status information to the EMS Monitor CI. 

Note: The integration adapter automatically runs on all existing CIs and 
applies to those CIs the topology changes described above.

The status of the Host CI in that topology is grey. To display the status of the 
Host CI, set the flag to Host in Jython. By default the flag is set to 
Application. For details, see “Topology Settings” in Using System Availability 
Management.

For details about the System KPI, see “System” in CI Attribute Customization.

For details about the Clear Events context menu item, see “Show Events” in 
CI Attribute Customization.

Host Integration Adapter
The Host integration adapter adds the EMS Monitor CI to the Host CI in the 
topology, and adds the System KPI to the Host CI. It also adds the Clear 
Events context menu item that enables you to clear an event. All the host 
information (for example, CPU or disk space), available from the sample 
provides status information to the Host CI through the EMS Monitor CI. 
The status of the Host CI represents the global status of the host.

For details about the System KPI, see “System” in CI Attribute Customization.

For details about the Clear Events context menu item, see “Show Events” in 
CI Attribute Customization.
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EMS Monitor CI
When running the EMS integration generally only one EMS Monitor CI is 
created per Host CI. In the process of the integration, if there is a problem 
with identifying the DNS name of the host while creating the monitor, more 
than one EMS Monitor CI can be created for the host. (For example, one 
monitor CI has the IP address and the other monitor CI has the DNS name.)

When reporting status to the Host CI, only one monitor CI receives the data 
and passes status onto the Host CI. The other CIs remain empty and  
eventually disappear due to the Aging Mechanism. For details, see 
“Removing Out of Date CIs Using the Aging Mechanism” in Model 
Management.

Note: The integration adapter automatically run on all existing CIs and 
applies to those CIs the topology changes described above.

Reconciliation of Hosts

The CMDB reconciliation service is used to reconcile incomplete hosts with 
complete hosts. Incomplete hosts are created in the CMDB after they are 
discovered by the discovery process (from Discovery and Dependency 
Mapping) or by SiteScope (the Enable host topology reporting option is set 
by default). Complete hosts are created in the CMDB after they are 
discovered by the discovery process.

A complete host is a host with the complete flag set. It is identified by its 
MAC address.

The CMDB performs the following actions:

 1 Copies each Depends on, System monitor, or Monitored by link that links 
to an incomplete Host CI to the corresponding complete Host CI (linked to 
the same IP), in the CMDB. The default KPIs attached to the incomplete 
Host CIs are also copied to the complete Host CI. If an incomplete Host CI is 
part of an SLA, the SLA is copied to the corresponding complete Host CI.
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 2 Erases the incomplete Host CI from the CMDB.

The CMDB_ID_MAPPING table in the Management database lists the pairs 
of the CMDB IDs of incomplete hosts to the CMDB IDs of the complete 
hosts that were processed by the service.

Limitations
The limitations of the reconciliation of hosts are as follows:

➤ After the reconciliation of hosts takes place, the historical reports of 
reconciled Host CIs display data at the level of the complete Host CI, only 
from the date and time when the reconciliation took place. Host CIs, which 
do not need reconciliation, continue to display data. 

➤ To restore data at the level of the Host CI, you can run an SLA recalculation 
taking into account the recalculation limitations. For details, see 
“Recalculation for Agreements” in Using Service Level Management.

➤ Manually modified properties of incomplete Host CIs are not copied to the 
complete Host CI.

Tasks
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Integrate Data from Third-Party Sources (EMS Data) into 
HP Business Availability Center

This section describes the processes for integrating data from third-party 
sources (EMS data) into HP Business Availability Center, and gives examples.

The flowchart below describes the process required to integrate data from 
third-party enterprise management systems (EMS data) into HP Business 
Availability Center using SiteScope Integration Monitors. 

x
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This task includes the following steps:

➤ “Plan EMS Strategy” on page 408

➤ “Configure the Integration” on page 408

➤ “Display Data in the Event Log” on page 414

➤ “Configure Measurement Filters” on page 414

➤ “Assign Group Permissions” on page 414

 1 Plan EMS Strategy
Review the Integration Monitor types. Consider the type of information you 
want to see in HP Business Availability Center from your EMS system. 
Determine whether one of the specific Integration Monitors meets your 
organization’s needs or whether a generic Integration Monitor (Technology 
Log File, Database, SNMP Trap, Web Service) is required.

Review the Event and Metrics samples and fields to understand how the 
incoming EMS metadata maps to HP Business Availability Center metadata. 

For more information, see “Working with SiteScope Integration Monitors” 
in Using System Availability Management.

 2 Configure the Integration
In the EMS Integrations application, configure the integration as follows:

➤ Sketch a CIT relationship map of the integration you are creating to help 
you formulate the KPI assignment rules that are described below and to 
understand which topology to create.

➤ Open the System Availability Management Administration window where 
you can access a SiteScope and deploy integration monitors to collect 
performance and availability data from your EMS system. For details, see  
“Working with SiteScope Integration Monitors” in Using System Availability 
Management.
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➤ Create or customize a KPI assignment rule for each integration CI type in 
the CIT relationship map you sketched previously. An assignment rule 
includes a condition and a task. The condition describes specific 
characteristics of a CI. The task describes the KPIs, rules, and context menus 
that are to be assigned automatically to the CI when the condition occurs, if 
the assignment is running. For details, see “Configure a KPI Assignment 
Rule” in Using Dashboard.

➤ You can then display the view that is created by the integration.

The view displays the following:

➤ EMS Monitor CIs that were created by the EMS integration

➤ CIs that were created by the EMS integration and that have a relationship 
to the above EMS Monitor CIs. 

➤ All hosts with a relationship to either of the CIs mentioned above.

Note: Do not edit or change the view – parts of the view are hidden in 
Dashboard. To view the integration topology in a different way, create 
another view.

The HP OVO and HP ServiceCenter integrations are out-of-the-box 
integrations that enable the user to view HP OVO and HP ServiceCenter 
data in HP Business Availability Center.

Example – Create an Application <--> Host Integration

To create an Application <--> Host integration:

 a Integrate HP Business Availability Center and the appropriate SiteScope. 
To specify the name of the host, select Admin > System Availability 
Management. Right-click Summary and select New SiteScope. In Main 
Settings, enter the name of the host in the Display Name and Host Name 
boxes.
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 b Select Admin > EMS Integrations, and click to open the Add Integration 
dialog box. Enter emsTest in the Data Source box, select Application <--> 
Host in the Type list, and enter a description in the Description box.

 c In the Integrations Implementation Test area, click 1. Define the CIT 
relationships map to display the sketch of relationships for a typical 
Application <--> Host integration.

 d In the Integrations Implementation Test area, click 2.  Retrieve data from 
EMS system using BAC's System Availability Management Administration 
(SAM Admin) to open the Summary page of System Availability 
Management. In that page, perform the following:

➤ Right-click the SiteScope monitor you set up previously. 

➤ Create a new group EMS.

➤ Under new monitor, select the Integration Monitor and the Log File 
Integration.

➤ Enter content match and the log file path name. 

➤ Click Load File. 

➤ Click Test Script.
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➤ In the Topology Settings, select Host-Application, Load, Test Script, 
and click OK.

For additional information about the monitor, see “Technology Log File 
Integration Monitor”&&& in System Availability Management.

 e In the Integrations Implementation Test area, under 3. Define the data 
assignments rules, select the Host Monitor CIs assignment rule and then 
click  Start  to run the assignment rule. Do the same for the Application 
Monitor CIs assignment rule.

 f In the Integrations Implementation Test area, click 4. View the 
integration results, to display the topology of the default view named 
after the name you gave in the Data Source box in the steps above.

 g Select Applications > Dashboard, select the Console tab, and click 
emsExample. The topology of the new view is displayed with data.

The integration is complete.

Example – Create a Technology Log File Integration Monitor

To create the Technology Log File Integration monitor, access SiteScope and 
create a new monitor. Select the Integration Monitor category, and click 
Technology Log File Integration to open the New Technology Log File 
Integration monitor page. Enter the following values:

➤ In Content Match, use the following example:

/(.*),(.*),(.*),(.*),(.*),(.*)/
411



Chapter 8 • Enterprise Management Systems Integration
➤ In Sample type, use the following example:

➤ In Fields mapping, enter the following example:

8,event8,1,espresso,emsLog,app
8,event8,1,espresso,emsLog,app

#####################################################################
#   EMS Integrations event config file           #
# Use this file to send events to Business Availability Center      #
#             #
# Refer to "Integration Monitor Configuration Files" in SiteScope   #
#  documentation for more information.          #  
#####################################################################

[$DEFAULT_PARAMETERS$]
################################################
# NOTE: the following parameters are mandatory #
################################################
# Time stamp in seconds since Jan 1st 1970 format. 
# Use time() to get the sitescope host time or str_to_seconds() to read a value from the 
input event
time_stamp:DOUBLE=time()
# Severity of event. Possible values are: 
# SEVERITY_UNKNOWN , SEVERITY_INFORMATIONAL , SEVERITY_WARNING , 
SEVERITY_MINOR , SEVERITY_MAJOR, SEVERITY_CRITICAL 
severity:INT=$group2

# The name of the host / device that caused this event. If the name cannot be 
determined an IP address can be used instead
target_name=$group3
# Event status or type (e.g "OPEN", "ASSIGNED", "CLOSED")
status="OPEN"

# Subject of event (e.g. CPU , SAP application, Hard Disk ). Middle / High level of 
hierarchy describing the event source
# The hierarchy describing an event is in the following format:
# monitor_group (optional) --> object (optional) --> subject --> instance
# More levels can be added above monitor_group by using logical_group, and attr1 - 5
subject=$group4

# Instance of subject that generated the event (e.g "D:\\" ). The lowest level of hierarchy 
describing the event source.
# See Subject explanation above.
instance=$group4
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# Event description. Up to 2000 characters.
description=$group1

# Application / Software from which this event was collected
data_source=$group4
###################################################
# NOTE: The following parameters are optional.   #
# Remove comments from entries you wish to use  #
###################################################
# IP of the host \ device that caused this event
#target_ip=
# Object of this event (e.g. OS, Network, etc). optional level in the hierarchy describing 
the event source

# See Subject explanation above.
#object=
# A unique identifier for this event
event_id=$group0
# For logical grouping
# See Subject explanation above.
#logical_group=
# Monitor group that reported this event. optional level in the hierarchy describing the 
event source
# See Subject explanation above.
#monitor_group=

# Severity name in integrated system terminology
#orig_severity_name=
# Operator who acknowledged this event
#acknowledged_by=
# Operator who owns this event
#owner=
# Use with any numeric values you wish to send to Business Availability Center
#value:DOUBLE=

# Additional attributes 1..5
attr1=$group5
#attr2=
#attr3=
#attr4=
# For long string values up to 2000 use attr5
#attr5=
[allRecords]
$MATCH=true
$ACTION=TOPAZ_BUS_POST(event)
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➤ In Topology Settings, select the Host--Applications topology.

Test the script by clicking Test Script to view the expected results of the 
monitor.

For details, see “Technology Log File Integration Monitor” in System 
Availability Management.

 3 Display Data in the Event Log
After monitors are defined in System Availability Management 
Administration, data can be seen in the Event Log and in Dashboard.

Depending on whether you configure Integration Monitors that use the 
metrics data template or Integration Monitors that use the event data 
template, you proceed differently to enable the data to be viewed in 
HP Business Availability Center.

 4 Configure Measurement Filters
If you configure a generic integration monitor with an Events sample script, 
you must configure measurement filters to enable viewing Integration 
Monitor event data in trend reports. In addition, each measurement filter 
you create gets added to the UDX Measurement Filters view as a CI. These 
CIs can be added to Dashboard views and SLAs. For more information, see 
“Working with Measurement Filters” in Platform Administration.

 5 Assign Group Permissions
If you configure a generic integration monitor with a Measurements sample 
script, you must assign for each defined user, permissions to view SiteScope 
groups and their subgroups in System Availability Management reports and 
custom reports. For more information, see “Permissions Overview” in 
Platform Administration.

Reference

EMS User Interface

This section describes:

 ➤  Add Integration Dialog Box on page 415
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 ➤  Edit Integration Dialog Box on page 417

 ➤  CIT Relationships Map Dialog Box on page 421

 ➤  Define Assignment Configuration Dialog Box on page 422

 ➤  EMS Integrations Admin Page on page 424

Add Integration Dialog Box

The initial dialog box includes the following elements:

Description Enables you to create a new integration.

To access: Click  in the EMS Integrations page. 

Included in Tasks “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 407

Useful Links “Enterprise Management Systems and the EMS 
Integrations Application Overview” on page 402

GUI Element (A-Z) Description

Data Source Enter the name of the integration data source when 
you create a custom integration.

Note: The same data source must be used in the 
mapping fields and in the topology section in the 
integration monitor. For details, see 2. Retrieve data 
from EMS system using BAC’s System Availability 
Management Administration (SAM Admin) in “Edit 
Integration Dialog Box” on page 417.

Note: The sample must be part of the same data source.

Description A description of the integration you are creating. The 
description is displayed in the EMS Integrations page.

OK Click to open the Edit Integration dialog box.
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Type Select the type of integration you want to create. Select:

➤ Custom. To create a custom integration.

➤ Host. To create a host integration that adds hosts or 
reconciles the new hosts with existing hosts and 
sends data into the hosts. For details, see 
“Understanding the Application<-->Host or Host 
Integration Adapters” on page 403.

➤ Application <---> Host. To create an application to 
host integration. For details, see “Reconciliation of 
Hosts” on page 405. When you select Host or 
Application <---> Host, the integration automatically 
runs the assignment rules on all the existing CIs.

➤ ServiceCenter. To create a business service 
connected to EMS monitor entities. For details, see 
“Understanding the Application<-->Host or Host 
Integration Adapters” on page 403.

➤ HP Business Process Insight. To integrate 
HP Business Process Insight data into HP Business 
Availability Center. For details, see “Understanding 
the Application<-->Host or Host Integration 
Adapters” on page 403.

➤ Netscout. To integrate Netscout data into 
HP Business Availability Center. For details, see 
“NetScout Integration Overview” on page 461.

GUI Element (A-Z) Description
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Edit Integration Dialog Box

General Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit an existing integration or to enter 
the details of a new integration.

To access: In the EMS Integrations page, select an 
integration and click .

Important 
Information

Complete each step of the procedure before starting on 
the next one.

Do not remove the data source when editing an 
integration.

It is recommended to work as much as possible with 
the out-of-the-box solutions: HP ServiceCenter, HP 
OVO, HP Business Process Insight, Host, or 
Application<-->Host.

Included in Tasks “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 407

Useful Links “Enterprise Management Systems and the EMS 
Integrations Application Overview” on page 402

GUI Element (A-Z) Description

HP OVO Host For OVO integration only.

The name of the HP OVO host. 

This field is not mandatory.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.
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HP OVO User Name For OVO integration only.

The name of the HP OVO user.

This field is not mandatory.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.

HP OVO User 
Password

For OVO integration only.

This field is not mandatory.

The password of the HP OVO user.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.

GUI Element (A-Z) Description
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Integration Implementation Steps Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Switch to Advanced 
Mode

For OVO integration only.

Click to add the Network and Security KPIs enrichment 
to the existing Application Monitor CIs and Host 
Monitor CIs data assignment rules.

The enrichment rules cause the Network and Security 
KPIs to be automatically attached to all OVO CIs 
(except to the EMS Monitor CIs directly under the 
Application CIs) in the Dashboard views in addition to 
the Application, and System KPIs. For details, see 
“Network” or “Security” in CI Attribute Customization.

Clicking the button has no impact in Service Level 
Management: Network and Security KPIs are not 
automatically attached to the OVO CIs when the CIs 
are added to an SLA in Service Level Management. For 
information on attaching these KPIs, see “CIs and KPIs 
for HP OVO” on page 426.

Note: If you change mode after the integration 
topology was created, it is recommended to select the 
assignment rules and to re-run them, with the Run on 
existing CIs option selected, in order to re-attach the 
proper KPIs and rules to the existing CI. For details, see 
“Define Assignment Configuration Dialog Box” on 
page 422.

Description Enables you to specify and implement the integration.

GUI Element (A-Z) Description

Click to create a data assignment rule in the Define 
Assignment Configuration dialog box.

Select a data assignment rule and click to edit the rule 
in the Define Assignment Configuration dialog box.

GUI Element (A-Z) Description
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Select a data assignment rule and click to delete.

Not applicable.

Select a data assignment rule and click to synchronize 
the selected rule.

Select a data assignment rule and click to start the 
assignment of the rule to existing and new CIs.

Select a data assignment rule and click to stop the 
assignment of the rule.

1. Define the CIT 
relationships map

Click to open the CIT relationship map dialog box 
where you can sketch the relationship map for the 
integration. This schema is useful to help you draw 
which CI types are created and where the EMS 
monitors are located so assignment rules can run on 
those EMS monitors. For details, see “CIT Relationships 
Map Dialog Box” on page 421.

2. Retrieve data from 
EMS system using 
BAC’s System 
Availability 
Management 
Administration (SAM 
Admin)

Click to open the System Availability Management 
application. For details, see “System Availability 
Management Administration” in Using System 
Availability Management.

Select from where the data is extracted (for example: 
Database) and which type of data (measurements, 
events or open incidents) is needed. 

To set up the HP OVO Event Monitor, see “HP OVO 
Event Monitor” in Using System Availability 
Management.

To set up the HP Service Center Monitor, see “HP 
ServiceCenter Monitor” in Using System Availability 
Management.

Limitation: If you have previously defined a SiteScope 
using this option and you reopen System Availability 
Management, the application does not display the 
SiteScope you have previously defined.

GUI Element (A-Z) Description
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CIT Relationships Map Dialog Box

3. Define the data 
assignements rules

Lists the existing data assignment rules for the current 
EMS integration adapter. 

One rule should be defined per EMS Monitor CI.

Use the available buttons to create, edit, activate or 
deactivate rules that map between fields and create the 
topology.

Note: It is important to validate the data assignment 
rule enrichment and if you create a custom enrichment 
to select the Run on existing CIs option in the Define 
Assignment Configuration dialog box.

4. View the 
integration results

Click to display the view that corresponds to the 
integration you have created with all the CIs that were 
created by the integration. 

Description The description of the assignment.

Name The name of the assignment.

Status The status: 

➤ Running. The assignment is running on the 
appropriate CIs.

➤ Stopped. The assignment is not running.

Description Enables you to add elements and relationships to the 
CIT relationships map.

To access: Click Define the CIT relationships map in 
the Add Integration Dialog Box.

Important 
Information

Sketch the relationships map to help you when you 
define the data assignment rules in 1. Define the CIT 
relationships map in  “Edit Integration Dialog Box” on 
page 417. 

GUI Element (A-Z) Description
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Define Assignment Configuration Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure an assignment.

To Access: Click the  button in the KPI Enrichment 
Configuration page.

Important 
Information

After you have created an assignment you cannot 
modify the condition. A workaround is to delete the 
assignment and to recreate it with a new condition.

Included in Tasks “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 407

GUI Element (A-Z) Description

Condition The condition is written in XML. It uses parameters to 
specify the criteria used to trigger the Task. For details 
about the parameters, see “KPI Assignment Rule – 
Condition” on page 441.

For details about creating a condition, see “Define the 
Condition” in Using Dashboard.

Description The description of the assignment. 

Name The name of the assignment.

Mandatory.

Run on existing CIs Set to retroactively run the assignment on existing CIs. 

When you select this option, and click OK, the 
assignment is run retroactively on the appropriate CIs 
with the appropriate conditions. 

Note: Selecting this option does not change the status 
of the KPI assignment itself.
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Status It can be:

➤ Assignment Configuration will be stopped after 
creation when you are creating a new assignment. 
After you configure the assignment the status of the 
assignment is automatically set in Stopped status in 
the Edit Group page if you are using KPI 
Assignments in Dashboard or in the Add Integration 
page if you are using EMS Integration.

➤ Stopped or Running depending on the status of the 
assignment you are editing.

Task The task is written in XML. It uses parameters to define 
the tasks used to assign the KPIs, rules, and context 
menus to the selected CI are listed in the following 
table. The task that is performed after the assignment is 
triggered. For details, see “KPI Assignment Rule – Task” 
on page 444.

For details about creating a task, see “Define the Task” 
in Using Dashboard.

Validate Click to validate the XML code in both the Condition 
and Task areas and to perform the indentation of the 
code.

GUI Element (A-Z) Description
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EMS Integrations Admin Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Lists existing EMS integrations, and enables you to 
define new integrations or edit existing ones.

To access: Select Admin > EMS Integrations > EMS 
Integrations Admin

Important 
Information

This dialog box also enables you to access the HP OVO 
and HP Service Center predefined integrations to 
integrate HP OVO or HP Service Center data into 
HP Business Availability Center.

Included in Tasks “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 407

GUI Element (A-Z) Description

Click to create a new integration. The Add Integration 
dialog box opens.

Select an integration and click to edit. The Add 
Integration dialog box opens.

Select an integration and click to delete.

Name The name of the integration.

Description The description of the integration.
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HP OVO Integration 

This chapter describes the HP OVO integration.

This chapter includes:

Concepts

 ➤  Understanding the HP OVO Integration on page 425

Tasks

 ➤  Use the EMS Integration Tool for HP OVO Server Events on page 429
Concepts

Understanding the HP OVO Integration

The HP OVO Integration enables connecting to the HP OVO message 
infrastructure, receiving events from the HP OVO server, and forwarding 
these events to the SiteScope machine.

This section describes the main concepts of the HP OVO integration adapter. 
For details on creating an HP OVO integration, see “Use the EMS Integration 
Tool for HP OVO Server Events” on page 429.

This section includes the following topics:

➤ “Overview of HP OVO” on page 426

➤ “OVO Hierarchies” on page 426

➤ “CIs and KPIs for HP OVO” on page 426

➤ “OVO Rules” on page 428
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➤ “OVO Context Menus, Context Menu Items, and Tooltips in Dashboard” on 
page 428

➤ “CI Update Mechanism” on page 429

Overview of HP OVO
HP OVO is a suite of software applications, which allow large-scale system 
and network management of your organization's IT assets.

OVO Hierarchies
When you select this integration adapter and enable the KPI enrichment, 
the relevant CIs, hierarchy, and pattern view are created in the CMDB. You 
can then view the hierarchy in the OVO Hosts and Applications view in the 
View Manager tab in UCMDB Administration.

CIs and KPIs for HP OVO
EMS Monitor CIs for the monitored OVO system are created in the CMDB, 
based on the samples sent by the SiteScope HP OVO Event monitor. The 
OVO KPI enrichment adds KPIs, rules, context menus, context menu items, 
and tooltips to those CIs. Status for these CIs can be viewed in Dashboard in 
the OVO Hosts and Applications view.  and the CIs are available to add to 
SLAs in Service Level Management.

Service Level Management has its own sets of KPIs and rules that are 
attached to CIs within agreements.
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For details about SiteScope samples, see “Data Samples for SiteScope” in 
Reference Information.

Note: Host CIs created in the CMDB by the discovery process and Host CIs  
created by SiteScope must be reconciliated. For details, see “Reconciliation 
of Hosts” on page 405.

The following KPIs are preconfigured to work with OVO EMS Monitor CIs in 
Dashboard and in Service Level Management: Application, Network, 
Security, and System. For details, see “Use the EMS Integration Tool for HP 
OVO Server Events” on page 429.

Note: When multiple KPIs are assigned to an EMS Monitor CI, the status of a 
KPI that did not correspond to a sample is Not up to date. The date 
displayed in the Held status since field displays the date and time 
corresponding to the first time the rule was activated by a sample. The Not 
up to date status persists until the rule is activated by a sample that 
corresponds to the KPI.
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OVO Rules
The rules are as follows:

➤ Dashboard rules for OVO: In Dashboard, each OVO KPI (attached to an EMS 
Monitor CI) uses the SiteScope EMS Multiple Events monitor rule. The rule 
handles the samples sent to HP Business Availability Center by the EMS 
system. It aggregates all the samples received from a specified CI. The rule 
saves up to ten events. If there are more than ten events, the rule discards 
samples with the lowest severity (critical is highest) and then the oldest 
samples.

For details, see “List of Dashboard Business Rules” in CI Attribute 
Customization.

➤ Service Level Management rules for OVO: In Service Level Management, 
each OVO KPI (attached to an EMS Monitor CI) uses its own monitor rule. 
For details, see “List of Service Level Management Business Rules” in 
CI Attribute Customization.

OVO Context Menus, Context Menu Items, and Tooltips in 
Dashboard
The EMS Clear Event context menu, Clear Event context menu item, and 
SiteScope EMS Rule tooltip are preconfigured to work with OVO EMS 
Monitor CIs in Dashboard. 

For details about the context menu, see “EMS Show Events” in CI Attribute 
Customization.

For details about the context menu item, see “Show Events” in CI Attribute 
Customization.

For details about the tooltip, see “SiteScope EMS Rule” in CI Attribute 
Customization.

The OVO Drill Down event enables you to access the HP OVO application. 
For details about the context menu, see “OVO Drill Down Event” in 
CI Attribute Customization.
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CI Update Mechanism
Any time an event is updated in HP OVO, another sample is sent to 
HP Business Availability Center and the status of the relevant CI is updated. 
This includes events that cause a status change and a Clear Event that 
changes the current status back to green. The period of time from the time 
the last sample was received for a KPI until the KPI is timed out (and its 
status changes to grey) is defined in the KPI’s No data timeout rule 
parameter that can be specified in Admin > Dashboard > KPIs or for the 
individual KPI, in the rule definition (global change) in Admin > Dashboard 
> Repositories > Business Rules.

Tasks

Use the EMS Integration Tool for HP OVO Server Events

You can collect performance and availability data from an existing HP OVO 
Server and view the events in HP Business Availability Center applications.

To integrate events from an existing HP OVO Server, use the following steps:

Note: Complete each step before starting on the next step.

For additional information about EMS integration, see “Enterprise 
Management Systems and the EMS Integrations Application Overview” on 
page 402.

This task includes the following steps:

➤ “Install HP OVO Integration Add-on” on page 430

➤ “Specify the Server Where HP OVO is Running” on page 430

➤ “Configure the HP OVO Event Monitor” on page 431

➤ “Customize the Integration – Optional” on page 431

➤ “Activate the Data Assignment Rules” on page 431

➤ “Display the HP OVO View” on page 431
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➤ “Activate OVO Hosts and Applications View” on page 432

➤ “Customize Automated Mapping Between OVO Event Fields and KPIs – 
Optional” on page 432

➤ “Assign the OVO EMS Monitor CI to SLAs and Add Optional KPIs” on 
page 433

➤ “Results” on page 433

 1 Install HP OVO Integration Add-on
The HP OVO Integration Add-on enables connecting to the HP OVO 
message infrastructure, receiving events from the HP OVO server, and 
forwarding these events to the SiteScope machine. For details, see “HP OVO 
Event Monitor” in Using System Availability Management.

 2 Specify the Server Where HP OVO is Running
This information is used to drill down from HP Business Availability Center 
to HP OVO using the OVO Drill Down context menu option in Dashboard 
from the HP OVO view.  To specify the server information, use one of the 
following options:

➤ Select Admin > EMS Integrations, select HP OVO and click Edit. In the 
Edit Integration dialog box, enter the Host and User information. For 
details, see “Edit Integration Dialog Box” on page 417.

➤ Select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Foundations, select Integrations with other 
applications, and in the Integrations with other applications – HP OVO 
table, use of the following options:

➤ Enter the appropriate information in The OVO Host, User of the OVO, 
and User Password of the OVO entries.

➤ Enter the URL of the server where HP OVO is running in the HP OVO 
drilldown url entry. For example: http://OVOHostExample:3443/OvCgi/
ito_op_applet_cgi.ovpl? gui.dftlayout=true
&gui.msgbrw.brwpane=true&https=true

This information is reflected in the Add Integration dialog box for HP 
OVO.
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 3 Configure the HP OVO Event Monitor
The monitor is used to retrieve data from the HP OVO server using System 
Availability Management Administration. You add the HP OVO Event 
Monitor to a SiteScope monitor group created for this monitor and other 
Integration Monitor types. It is recommended that you configure 
Integrations Monitors only after a connection between the SiteScope and 
HP Business Availability Center is established. For details, see “HP OVO 
Event Monitor” in System Availability Management.

Note: SiteScope cannot be deployed behind a firewall. SiteScope and the 
monitored system must be on the same LAN or special firewall 
configuration might be required.

 4 Customize the Integration – Optional
You can use the EMS Integrations application to customize an HP OVO 
integration. The integration forwards the retrieved data captured from the 
OVO system by the SiteScope HP OVO Event monitor to HP Business 
Availability Center, and creates the appropriate topology (host and 
application CIs). For details on the available customizations, see “Define 
Assignment Configuration Dialog Box” on page 422. 

 5 Activate the Data Assignment Rules
By default, HP OVO data Assignment rules are stopped. 

To activate the data assignment rules, select Admin > EMS Integrations, 
select HP OVO, click Edit, select the assignment rule, and click  Activate.

 6 Display the HP OVO View
This view is similar to the OVO Hosts and Applications view. It is 
automatically activated. The topology of the HP OVO integration is 
displayed in this view and in the OVO Hosts and Applications View. 
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 7 Activate OVO Hosts and Applications View
This view is mainly used for backward compatibility. To see the topology in 
this view, you must activate the view and assign the view to the required 
Business Availability Center applications. For details on activating the view, 
see Activate/Deactivate View in “View Manager Window” in Model 
Management.

 8 Customize Automated Mapping Between OVO Event Fields and 
KPIs – Optional
The HP OVO integration is configured to automatically map the events 
retrieved from the HP OVO system to the appropriate KPIs for the 
corresponding EMS Monitor CIs. The appropriate KPIs, rule, context menu 
items, and tooltips are used to display the retrieved data. 

Use the Clear Event context menu item to clear events in Dashboard only. 

Use the OVO Drill Down context menu items to open the HP OVO 
application. For details, see “Understanding the HP OVO Integration” on 
page 425.

After you begin working with the data, you can optionally customize these 
mappings. For details, see “HP OVO Event Monitor” in System Availability 
Management.
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 9 Assign the OVO EMS Monitor CI to SLAs and Add Optional KPIs
You can include OVO EMS Monitor CIs in your SLAs in Service Level 
Management. Service Level Management contains KPIs and rules specifically 
configured for OVO EMS Monitor CIs, including optional KPIs for network 
and security. For details, see “Integration with HP OVO” in Using Service 
Level Management.

 10 Results
After the task is performed, HP OVO data is integrated into HP Business 
Availability Center as described in this section.

➤ View OVO Events in Dashboard and Service Level Manager Views

SiteScope automatically creates the appropriate topology when HP OVO 
events are integrated into HP Business Availability Center. HP Business 
Availability Center adds the data to the views in Dashboard and Service 
Level Management. 

In both Dashboard and Service Level Management, the Application, System, 
Network, and Security KPIs are defined as default KPIs for the OVO EMS 
Monitor CIs. For details on the KPIs, see “KPI Repository” in CI Attribute 
Customization. 

➤ Drill Down to HP OVO from the Dashboard and Service Level Manager 
Views

Use the right-click menu option: OVO Drill Down for the appropriate CIs in 
the Dashboard and Service Level Management views to access the HP OVO 
application. 

Note: If the drill down option does not work, check that you using LW-SSO.   
For details about LW-SSO, see “Lightweight Single Sign-On Authentication” 
in Platform Administration.
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Configure HP ServiceCenter for 
Integration with HP Business Availability 
Center

This chapter describes how to configure HP ServiceCenter before performing 
its integration with HP Business Availability Center.

This chapter includes:

Tasks

 ➤  Configure HP ServiceCenter on page 435

 ➤  Before you Upgrade HP ServiceCenter From Previous Versions on page 449
Tasks

Configure HP ServiceCenter

This task describes how to configure HP ServiceCenter.

This task includes the following steps:

➤ “Prerequisites” on page 436

➤ “Set Up the sc.cfg File” on page 436

➤ “Load the Integration Tailoring Materials” on page 438

➤ “Configure URLs for the Integration” on page 439

➤ “Modify the web.xml File” on page 443

➤ “Configure the Symphony Adapter for ServiceCenter and Service Manager” 
on page 444
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➤ “Modify the application-context.xml File” on page 446

➤ “Initial Sample Event in ServiceCenter” on page 447

➤ “Set Up and Configure Connect-IT” on page 448

➤ “Perform the Integration” on page 448

 1 Prerequisites

➤ The ServiceCenter server, ServiceCenter Web tier, and ServiceCenter 
Windows client components of HP ServiceCenter must be installed. For 
details, see ServiceCenter Installation guide.

➤ Optional. If you want HP ServiceCenter to use the SSL-based Trusted Sign-on 
protocol, configure it according to the instructions in the HP ServiceCenter 
on-line help.

Note: Plan to put both the ServiceCenter Web tier and the Symphony 
Adapter webapp in the same container, so you can use the same certificate 
for both.

Support Matrix

The support matrix for HP ServiceCenter is as follows: 

 2 Set Up the sc.cfg File
Once the server is installed, you can start and stop it using the Windows 
services utility, or by using net start and net stop commands. It is 
recommended that you do the following immediately upon completion of 
the installation and configuration dialogs:

Integration Matrix ServiceCenter 6.26 Service Manager 7.0

Incident Submission Supported Not supported

Problem Isolation Supported Not supported

Federation Supported Supported

Ticketing Supported Supported
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 a Stop the server using a net stop ServiceCenter command.

 b Edit the sc.cfg file found in the RUN folder of the Server installation 
folder. Typically the location of this folder is
c:\Program Files\Peregrine Systems\ServiceCenter 6.2\Server\RUN

 c Enable the servlet and the listener for connect-it on port 12670, the other 
parameters should be commented out to disable unnecessary processes 
that might slow down startup and shutdown and to avoid cluttering the 
sc.log file with lots of unnecessary messages.  

Make sure that the bolded lines in the modified sc.cfg file are as follows 
(the line scenter -listener:<listener_port> should provide the port of the 
listener):

#
# ServiceCenter Server Configuration File
#
# Used by ServiceCenter service to start the ServiceCenter processes.
#
####################################################################
#
# Copyright 1994-2007 Hewlett-Packard Development Company, L.P.
# All Rights Reserved
#
####################################################################
#
# start a J2EE/servlet listener for HTTP clients: Windows, web, SOAP-API
#
scenter -servletcontainer -httpPort:13080 -httpsPort:13443
#
# Start a listener for Get-It, Connect-It, ODBC driver
#
scenter -listener
#
# start a listener for SCAuto
#
scenter -listener:12670
#
# start background schedulers
#
#scenter system.start
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 3 Load the Integration Tailoring Materials
ServiceCenter uses a proprietary binary file format known as unload files to 
contain packages of scripts, forms, file records, and other materials. By 
convention, these files have a filetype of .unl on Windows platforms.

 a Copy the UNL file required for integration from the following location:
<installation_root_directory>\BACUnload\BAC_PI_62_v(X).unl
to an accessible network location.

 b In the Windows client, select Start > Programs > Service Center 6.2, and 
log in as a user with Administrator privileges, such as falcon (no 
password).

 c Locate the command line text widget in the menu bar at the top of the 
client display, to the right of the Printer icon.

 d Type db and press enter to start the Database Manager application.
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 e Right-click anywhere on the white background, and select Import / Load 
from the context menu that displays to start the ServiceCenter File Load/
Import application.

 f Click the manila folder icon  at the end of the File Name box and 
navigate to the BAC_PI_62_v(X).unl file you saved previously, select it, 
and click Open. The screen shown above refreshes and displays with the 
path to the selected file.

 g Click the Load FG button on the toolbar to load the file.

 h Log out of the client, and restart the ServiceCenter server using the Net 
stop servicecenter and Net start servicecenter commands.

 4 Configure URLs for the Integration
To configure the integration, use the following steps:
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 a Select Utilities > Administration menu:
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 b Click the System Information Record menu:
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 c Click the Active Integrations tab:

 d Select the HP Business Availability Center checkbox.

 e In the BAC URL box enter the URL to the BAC Gateway server (for 
example: 
http://<HP Business Availability Center host>/topaz/framework/
topaz_frames.jsp). This setting is used when launching Problem Isolation 
(the hostname should be the FQDN).

 f In the BAC webservice URL box enter the URL for the EntityNotification 
endpoint (for example: 
http://<HP ServiceCenter host>:<PORT>/SymphonyAdapter/outbound/
ws?endpoint=http://<HP Business Availability Center host>/topaz/
services/EntityNotificationPort (the hostnames should be the FQDN).
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Note: If you are using the SymphonyAdapter for LW-SSO single sign-on, the 
URL for the EntityNotification endpoint must be specified as the endpoint 
parameter of the SymphonyAdapter outbound URL (for example: http://
FQDNsymphonyadapterhost:8080 /SymphonyAdapter/outbound/
ws?endpoint=http://FQDNbachost:80/topaz/services/EntityNotificationPort

 g Click Save.

 5 Modify the web.xml File
This step is needed for the integration of HP ServiceCenter and HP Business 
Availability Center.

After installing and configuring LW-SSO, you must modify the web.xml file. 
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 a Access the web.xml file located at: \Apache Software 
Foundation\Tomcat 5.5\webapps\sc\WEB-INF by changing the 
param-name to the value indicated in bold in the code below.

 b Restart the Tomcat container using the Net stop tomcat and Net start 
tomcat commands.

 6 Configure the Symphony Adapter for ServiceCenter and Service 
Manager
This section describes how to configure the Symphony Adapter for 
ServiceCenter and Service Manager:

<!-- Enables submission of form when the user presses the ENTER key. -->
        <init-param>
            <param-name>sc.autosubmit</param-name>
            <param-value>true</param-value>
        </init-param>

    <!-- Change value (e.g. 1, or 2) to increase horizontal spacing, useful for avoiding
      clipping problems with localized versions -->
        <init-param>
            <param-name>sc.hscale</param-name>
            <param-value>0</param-value>
        </init-param>

    <!--
    ********************************************************
      The following parameters can't be supplied in the URL: they can only be changed in 
web.xml
    ********************************************************
    -->
        <init-param>
          <param-name>sc.querysecurity</param-name>
          <param-value>false</param-value>
        </init-param>

      <!-- Control the encryption of network communication between the application server
        and the ServiceCenter server -->
        <init-param>
          <param-name>sc.ssl</param-name>
          <param-value>false</param-value>
        </init-param>
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 a Locate the web-inf\classes folder for the SymphonyAdapter webapp. 

 b Copy the cacerts file and client keystore file you created using the 
makeadaptercert script into the web-inf\classes folder of the 
SymphonyAdapter webapp. For details, see the HP ServiceCenter on-line 
help. 

 c Edit the SymphonyAdapter.properties file to correct these settings for 
your installation:

➤ servicecenter.ws.targetLocationURL. Edit the host and port as 
appropriate for your installation. You should use the fully qualified 
domain name to specify the host.

➤ servicecenter.webtier.URL. Update this property to make the hostname 
and port correct for the current Tomcat container. You must provide the 
fully qualified domain name, because this information is going to be 
used to rewrite URLs, which is sent back to HP Business Availability 
Center with a 307 redirect. DO NOT SPECIFY LOCALHOST. If you do, 
HP Business Availability Center tries to launch the ServiceCenter web 
user interface locally, which does not work!

➤ clientcerts.keystore. Update this parameter to point to the client keystore 
you created using makeadaptercert. You must use a full path name 
starting from the C: drive and using double slashes, for example:

D:\\Program Files\\Apache Software Foundation\\Tomcat 
5.5\\webapps\\SymphonyAdapter\\WEB-INF\\classes\\<machine 
name>.client.keystore

➤ clientcerts.keystore.password. Specify the correct pass-phrase for the 
client keystore specified above.

➤ truststore. Specify the full path to the updated cacerts file you created.

➤ truststore.password. Specify the pass-phrase for the cacerts file. If you 
did not change it, it should still be changeit.

Note: If a single sign-on technology is configured (LW-SSO or SiteMinder), 
the ServiceCenter login panel is not displayed.
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 d In the Acegi configuration in the ServiceCenter web tier or Symphony 
Adapter for LW-SSO, edit the lwssofmconf.xml file in WEB-INF/classes 
directory of the location where the ServiceCenter webtier was deployed.

Locate the <domain> element under <web-lwsso>:

Replace the bolded strings in the file with the fully qualified domain to 
which the web tier servers belong and where those servers are sharing 
authentication credentials via LW-SSO. In addition, replace the bolded 
password string with the password to the server where the ServiceCenter 
webtier was deployed; it has to match between the systems that are 
sharing credentials using LW-SSO in their respective config files. For 
example, if your HP ServiceCenter web tier is installed on 
sc.mydomain.com and HP Business Availability Center is set up on 
bac.mydomain.com, the domain you would use in this configuration file 
is mydomain.com (both in the <lwsso><domain>mydomain.com</
domain> part and under the <protectedDomains><url>mydomain.com</
url></protectedDomains>) below.

Add your domains to the <protectedDomains> element as follows:

Save changes.

 7 Modify the application-context.xml File
This section describes how to modify the applicaton-context.xml file:

<web-lwsso>
<lwsso startLWSSO="enabled">

<domain>my.domain.com</domain>
 <crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC"   keySize="256"  
encodingMode="Base64Url"initString="password">
</crypto>
 <expirationPeriod>60</expirationPeriod>

 </lwsso>

<protectedDomains>
<url>fully_qualified_domain</url>
<url>fully_qualified_domain</url>
<url>fully_qualified_domain</url>

</protectedDomains>
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 a You must modify the application-context.xml file in WEB-INF/classes 
directory of the ServiceCenter webtier. Make sure that the 
filterChainProxy bean definition contains the lwSsoFilter string as shown 
in the sample:

 b Make sure that the following lines are available (uncommented) at the 
bottom of the application-context.xml:

For detailed instructions on configuring LWSSO please refer to the 
LWSSO documentation. Save changes.

 c Restart the Tomcat container using Net stop tomcat and Net start tomcat 
commands.

 8 Initial Sample Event in ServiceCenter
Open the ServiceCenter application and perform the following steps:

 a From the System Navigator, select Menu Navigation > Tailoring > 
Database Manager.

  <bean id="filterChainProxy" class="net.sf.acegisecurity.util.FilterChainProxy">
    <property name="filterInvocationDefinitionSource">
      <value>
        CONVERT_URL_TO_LOWERCASE_BEFORE_COMPARISON
        PATTERN_TYPE_APACHE_ANT
        /**=httpSessionContextIntegrationFilter,lwSsoFilter,anonymousProcessingFilter
      </value>
    </property>
  </bean>

    <bean id="lwSsoFilter" 
class="com.peregrine.eclipse.web.lwsso.LwSsoPreAuthenticationFilter">
    <property name="authenticationManager">
      <ref bean="authenticationManager"/>
    </property>
    <property name="defaultRole">
      <value>ROLE_PRE</value>
    </property>
  </bean>

  <bean id="lwSsoIntegrationBean" 
class="com.peregrine.eclipse.web.lwsso.LwSsoIntegration"/>  </bean>
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 b Select the Administrative Mode option. 

 c Enter apm.global.list.entry in the Form box. 

 d Click Search to open a blank record from the globallists file. 

 e Click Search to display a list of lists. 

 f Select Mass Update. A blank update screen opens. This form is identical 
in appearance to the lister record, but contains different option buttons.

 g Set the date in the Expiration box to any date in the past, for example, 
01/01/90. 

 h Click Simple Update to reset the expiration date of all the lists in the 
globallists file. 

 i Return to the home menu. 

 j Enter *aapm.server.initer in the command line and click Enter.

 k Log out of ServiceCenter and log in again.
All the lists in the system are regenerated and ServiceCenter processes all 
the current records.

 9 Set Up and Configure Connect-IT
You must set up and configure Connect-IT for the integration with 
HP Business Availability Center if you want to automatically open tickets in 
HP ServiceCenter when relevant alerts are triggered in HP Business 
Availability Center. For details, see the BAC KPI Monitoring to Incident 
Management Integration guide.

 10 Perform the Integration
After you finish configuring HP ServiceCenter you must perform the 
integration between HP ServiceCenter and HP Business Availability Center. 
For details, see “Use the EMS Integration Tool for HP ServiceCenter Data” on 
page 456.
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Before you Upgrade HP ServiceCenter From Previous 
Versions

It is recommended to back up the following files before performing the 
upgrade procedure to version 6.26. For details about the upgrade see 
HP ServiceCenter documentation.

➤ ServiceCenter Server

➤ <ServiceCenter Server Home>/RUN/sc.ini

➤ <ServiceCenter Server Home>/RUN/cacerts

➤ <ServiceCenter Server Home>/RUN/trustedclients.jks

➤ <ServiceCenter Server Home>/RUN/hostname.devlab.ad.keystore (this 
filename varies by machine)

➤ ServiceCenter Webtier

➤ <SC.WAR DIR>/WEB_INF/cacerts

➤ <SC.WAR DIR>/WEB_INF/ hostname.devlab.ad.client.keystore (this 
filename varies by machine)

➤ <SC.WAR DIR>/WEB_INF/web.xml

➤ <SC.WAR DIR>/WEB_INF/classes/application-context.xml

➤ <SC.WAR DIR>/WEB_INF/classes/lwssofmconf.xml

➤ Symphony Adapter

➤ < SymphonyAdapter.war DIR>/WEB_INF/classes/ 
hostname.devlab.ad.client.keystore (this filename varies by machine)

➤ < SymphonyAdapter.war DIR>/WEB_INF/classes/cacerts

➤ < SymphonyAdapter.war DIR>/WEB_INF/classes/lwssofmconf.xml

➤ < SymphonyAdapter.war DIR> /WEB_INF/classes/
SymphonyAdapter.properties

The Data files are not overwritten. If you want to start with clean data, you 
need to delete the Data folder. After you reapply the BAC_PA_62_v1.unl you 
must reconfigure the two URL settings.
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HP ServiceCenter Integration

This chapter describes the HP ServiceCenter integration.

Note: HP Business Availability Center integrates with both HP ServiceCenter 
and HP ServiceManager though only HP ServiceCenter is mentioned in this 
chapter.

This chapter includes:

Concepts

 ➤  Understanding the HP ServiceCenter Integration on page 451

Tasks

 ➤  Use the EMS Integration Tool for HP ServiceCenter Data on page 456
Concepts

Understanding the HP ServiceCenter Integration

This section describes the main concepts of the HP ServiceCenter 
integration adapter.

This section includes the following topics:

➤ “Overview of HP ServiceCenter” on page 452

➤ “HP ServiceCenter Integration” on page 452

➤ “CIs and KPIs for HP ServiceCenter” on page 454

➤ “HP ServiceCenter Rules” on page 455
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➤ “HP ServiceCenter Context Menus, Context Menu Items, and Tooltip” on 
page 455

Overview of HP ServiceCenter
HP ServiceCenter software is a comprehensive and fully integrated IT service 
management suite that helps you decrease the time it takes to resolve 
problems. ITIL-based best practices and a highly scalable service-oriented 
architecture let you deploy consistent, integrated processes throughout your 
IT organization. HP ServiceCenter provides the following capabilities:

➤ Automate service management processes for incident, problem, change, 
configuration, availability, release, contract, catalog-based requests and 
service level management.

➤ Use built-in workflows to document, route and escalate issues for IT service 
management processes.

➤ Gain access to comprehensive configuration data through a powerful 
CMDB.

➤ Deploy solution easily across heterogeneous environments using an open 
architecture and web-based framework.

HP ServiceCenter Integration
The integration of HP ServiceCenter in HP Business Availability Center 
offers the following capabilities:

➤ In Dashboard: 

➤ You can view the Number of Opens Incidents KPI (based on data from 
HP ServiceCenter) at the business service level in the Dashboard views 
and reports. For details, see “Dashboard Tabs” in Using Dashboard.

For example: the Operator/Application support can get visibility and 
alerts based on the Number of Open Incidents in HP Business Availability 
Center Dashboard alongside operational KPIs. 

➤ You can drill down from Dashboard views at the business service level to 
HP ServiceCenter to view the details of the related incidents.
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For example: The support person can drill down to HP ServiceCenter to 
view the details on the open incidents of the selected service.  Based on 
the number of incidents and their details, the support person can 
prioritize the issues that are the most important.

➤ Incident submission:

You can define, in Alerts Administration, CI Status Alerts that automatically 
open a related incident in HP ServiceCenter when the alert is triggered. 

For details, see “Set Up to Open a Ticket in HP ServiceCenter When the Alert 
is Triggered” in Alerts.

➤ Service Level Management:

You can define SLAs based on Serviceability KPIs (MTTR, MTBF, or MTBSI 
KPIs) that are calculated based on incidents that come from 
HP ServiceCenter. For details, see “Agreements in Service Level 
Management” in Using Service Level Management.

For example: the Service Manager manages SLAs with operational 
(Availability, Performance, or other KPIs) and serviceability (MTTR, MTBF, or 
MTBSI KPIs) using HP Business Availability Center Service Level 
Management. The Service Manager can review the SLAs statuses according 
to the service Availability, Performance, MTTR and MTBF side-by-side.

➤ Problem isolation:

You can:

➤ Attach a problem in Problem Isolation to an existing or new incident in 
HP ServiceCenter.

➤ Attach a problem snapshot to the incident in HP ServiceCenter.

➤ Drill down from the incident context in HP ServiceCenter to the appropriate 
problem in Problem Isolation.

➤ Proactively manage problems using the correlation of incidents and requests 
for change in HP ServiceCenter with the operational matrix like Availability 
or Performance that are integrated from different sources like End User 
Management, into Problem Isolation

For details about Problem Isolation, see “Problem Isolation and 
HP ServiceCenter Integration” in Using Problem Isolation.
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For example: 

 1 The operator detects a problem in the CRM application through the 
HP Business Availability Center Dashboard and selects to go to Problem 
Isolation.  

 2 The operator opens an incident/problem in HP ServiceCenter from Problem 
Isolation or associates the isolation to an existing incident/problem (for 
example an incident/problem automatically opened through the incident 
submission). 

 3 Once associated the incident/problem details are available in the isolation 
properties.  Going through the isolation process, the operator finds that the 
problem resides in the Database and in HP ServiceCenter, assigns the 
incident to the DBAs.  

 4 The operator generates a snapshot report that includes all the isolation 
details and attaches it to the incident/problem so the DBAs have all the 
required information for further analysis.

 5 In HP ServiceCenter, the incident/problem owner reviews the incident/
problem information and finds the Problem Isolation snapshot report that 
is attached to the incident/problem. The incident/problem owner reviews 
the snapshot report to understand the different aspects of the problem, and 
has the option of drilling down from the snapshot report to the specific 
problem in HP Business Availability Center – Problem Isolation to further 
triage the problem.

CIs and KPIs for HP ServiceCenter
The HP ServiceCenter integration creates EMS Monitor CIs for the 
monitored HP ServiceCenter system, based on the samples sent by the 
SiteScope HP ServiceCenter Monitor. Status for these CIs can be viewed in 
Dashboard in the Business Services and the Service Measurements views, 
and the CIs are available to add to SLAs in Service Level Management.

The KPIs that are preconfigured to work with HP ServiceCenter Monitor CIs 
are Number of Open Incidents in Dashboard and MTTR (Mean Time to 
Repair), MTBF (Mean Time Between Failures), and MTBSI (Mean Time 
Between System Incidents) in Service Level Management. Each KPI uses 
different business rules and logic in each application. 
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HP ServiceCenter Rules
The HP ServiceCenter integration uses the following rules:

➤ Dashboard rule for HP ServiceCenter: In Dashboard, each HP ServiceCenter 
KPI (attached to an EMS Monitor CI) uses the Number of Open Incidents 
monitor rule. The rule handles the samples sent to HP Business Availability 
Center by the EMS system. 

For details about the rule, see “Number of Open Incidents” in CI Attribute 
Customization.

➤ Service Level Management rules for HP ServiceCenter: In Service Level 
Management, each HP ServiceCenter KPI (attached to an EMS Monitor CI) 
uses its own monitor rule. For details, see “List of Service Level Management 
Business Rules” in CI Attribute Customization.

HP ServiceCenter Context Menus, Context Menu Items, 
and Tooltip
The HP SC Menu context menu, HP ServiceCenter context menu item, and 
SiteScope EMS Rule tooltip are preconfigured to work with OVO EMS 
Monitor CIs in Dashboard. 

For details about the context menu, see “HP SC Menu” in CI Attribute 
Customization.

For details about the context menu item, see “HP ServiceCenter” in 
CI Attribute Customization.

For details about the tooltip, see “Number of Open Incidents Sentence” in 
CI Attribute Customization.

Tasks
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Use the EMS Integration Tool for HP ServiceCenter Data

You can collect performance and availability data from an existing 
HP ServiceCenter Server and view the data in HP Business Availability 
Center applications.

To integrate data from an existing HP ServiceCenter, use the following steps:

Note: Complete each step before beginning the next step.

This task includes the following steps:

➤ “Prerequisite Step” on page 456

➤ “Configure the HP ServiceCenter Monitor” on page 457

➤ “Specify the HP ServiceCenter URL” on page 457

➤ “Specify the State and Severity of Open Incidents to Be Displayed” on 
page 457

➤ “Configure the ServiceCenter Integration” on page 458

➤ “Automatically Open a Ticket in HP ServiceCenter When an Alert is 
Triggered” on page 459

➤ “Customize the Integration Adapter – Optional” on page 459

➤ “Include Service Center CIs in Service Level Management Agreements” on 
page 459

➤ “Enable Accessing HP ServiceCenter from Within Dashboard” on page 459

➤ “Results” on page 460

 1 Prerequisite Step
Perform the HP ServiceCenter configuration steps described in “Configure 
HP ServiceCenter” on page 435.
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 2 Configure the HP ServiceCenter Monitor
In SiteScope, you must provide external access to the clocks and 
probe_summary_tables, edit the topology script, create the peregrine.jar 
file, edit the attributes mapping files and the ticket.config file, and more. For 
details, see “HP ServiceCenter Integration – Workflow” in Using System 
Availability Management.

 3 Specify the HP ServiceCenter URL
To specify the HP ServiceCenter URL, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, select Foundations, select 
Integrations with other applications, and, in the Integrations with other 
applications - Incidents Integration table, enter the appropriate URL in the 
ServiceCenter/ServiceManager web tier URL entry, using the following 
format: <protocol>://<host_name>:<port>/<web_app_name>/ where 
host_name is the name of the ServiceCenter server, port is the port number 
of the ServiceCenter server, and web_app_name is the name of the 
application (for example the URL for HP Business Availability Center would 
be: <protocol>://<host_name>:<port>/topaz/).

 4 Specify the State and Severity of Open Incidents to Be 
Displayed
To specify the state and severity of the open incidents to be displayed, you 
can edit the parameters of the Number of incidents rule parameters:

➤ For the Number of Open Incidents KPIs attached to a specific EMS Monitor 
CI. Access the Edit KPI dialog box, expand the Business Rule area and modify 
the state and severity values. For details, see “How Dashboard KPIs Work” in 
Using Dashboard. 

➤ Globally, for all KPIs defined with the Number of Open Incidents rule. 
Override the Number of Open Incidents rule in the Repositories, edit the 
Initial State, Final State, and Severity parameters. For details, see“Rule 
Details Dialog Box” in CI Attribute Customization.

For details about the parameters, see “Number of Open Incidents” in 
CI Attribute Customization.
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Note: The values available for the Initial State, Final State, and Severity 
parameters reflect the values defined in HP ServiceCenter.

 5 Configure the ServiceCenter Integration
The HP ServiceCenter integration adapter is predefined. 

Select Admin > EMS Integrations, select ServiceCenter and click Edit. In the 
Edit Integration dialog box: 

➤ Configure the HP ServiceCenter Monitor. The monitor is used to retrieve 
data from EMS system using System Availability Management 
Administration. You add the HP ServiceCenter Monitor to a SiteScope 
monitor group created for this monitor and other Integration Monitor 
types. It is recommended that you configure Integrations Monitors only 
after a connection between the SiteScope and HP Business Availability 
Center is established. 

Note: SiteScope cannot be deployed behind a firewall. SiteScope and the 
monitored system must be on the same LAN or special firewall 
configuration might be required.

➤ Activate the data assignment rules. Select the assignment rule and click  
Activate.

When the EMS monitor sample includes open incidents in its data source, 
the Number of Open Incidents KPI (2600), the Number of Open Incidents 
rule (2600), the HP SC Menu context menu (hpsc), the HP ServiceCenter 
context menu item, and the HP Open Incidents tooltip (2600) are assigned 
to the EMS Monitor CI. 

For details, see “Add Integration Dialog Box” on page 415.
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 6 Automatically Open a Ticket in HP ServiceCenter When an 
Alert is Triggered
You can automatically open a ticket in HP ServiceCenter when a CI Status is 
triggered. For details, see “Set Up to Open a Ticket in HP ServiceCenter 
When the Alert is Triggered” in Alerts.

 7 Customize the Integration Adapter – Optional
You can use the EMS Integrations application to customize an 
HP ServiceCenter integration. The integration forwards the retrieved data 
captured from the HP ServiceCenter system by the SiteScope 
HP ServiceCenter monitor to HP Business Availability Center, and creates 
the appropriate topology that is used to display the data in Dashboard. 

For details on the available customizations, see “Define Assignment 
Configuration Dialog Box” on page 422. 

 8 Include Service Center CIs in Service Level Management 
Agreements
You can include Service Center EMS Monitor CIs in your agreements in 
Service Level Management. Service Level Management contains KPIs and 
rules specifically configured for Service Center EMS Monitor CIs. The MTTR, 
MTBF, and MTBSI KPIs and the MTTR, MTBF, and MTBSI rules are dedicated 
for this integration. 

You must also configure the incident initial and final state in those rules. For 
details, see “Incident State and Severity Values” in Using Service Level 
Management.

For details about the integration, see “Integration with HP ServiceCenter” in 
Using Service Level Management.

 9 Enable Accessing HP ServiceCenter from Within Dashboard
You must disable query security to the HP ServiceCenter application to 
enable accessing the application, through the right-click HP ServiceCenter 
menu option in Dashboard. You still have the necessary capabilities to 
properly secure your system without the query hash. 

To enable accessing HP ServiceCenter from within Dashboard:
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 a Edit the web.xml file. The location of the file depends on the type of web 
application server the web tier is deployed on.

 b In the file, locate the <!-- Specify the ServiceCenter server host and port 
location --> section.

 c Add the following strings into the section:
<context-param>
<param-name>sc.querysecurity</param-name>
<param-value>false</param-value>
</context-param>

 10 Results
After the task is performed, HP ServiceCenter data is integrated into 
HP Business Availability Center as described in this section.

➤ View ServiceCenter Data in Dashboard and Service Level Management:

SiteScope automatically creates the appropriate topology when 
HP ServiceCenter data is integrated into HP Business Availability Center. 
HP Business Availability Center adds the data to the Business Services and 
Service Measurement views, and you can display these views in Dashboard 
and Service Level Management.

➤ Drill down to HP ServiceCenter from Dashboard views:

In Dashboard, in the Business Services and Service Measurement views, use 
HP ServiceCenter option available for HP ServiceCenter CIs to access the 
relevant incident in the HP ServiceCenter application. For information 
about the HP ServiceCenter application, consult the HP ServiceCenter 
documentation.

Note: You can also integrate Problem Isolation with HP ServiceCenter to 
link isolation data (from Problem Isolation) with incident or problem data 
(from HP ServiceCenter), to create a complete problem management 
lifecycle. For details, see “Problem Isolation and HP ServiceCenter 
Integration” in Using Problem Isolation.
460



12
NetScout nGenius Integration

This chapter describes the NetScout nGenius integration.

This chapter includes:

Concepts

 ➤  NetScout Integration Overview on page 461

Tasks

 ➤  Use the EMS Integration Tool for NetScout Data on page 463
Concepts

NetScout Integration Overview

This section provides an overview of NetScout and describes the main 
concepts of the NetScout integration.

Overview of NetScout
NetScout nGenius monitors network traffic and reports performance metrics 
about applications routing through that network. NetScout integration 
shows NetScout alarms in HP Business Availability Center Dashboard. 
NetScout sends SNMP traps containing information about the alerting 
instances that could map to existing CI types in the CMDB.

NetScout View and Topology
NetScout analyzes packets that include information about the applications 
running through specific routers or switches. When there is a problem, the 
packets can send in alarms with information about the problematic 
application.
461



Chapter 12 • NetScout nGenius Integration
The SNMP trap for application alarms reports about problems discovered in 
an application, using information analyzed from packets. The application 
information is not linked to the router information as the routing path is 
not constant and may vary depending on network traffic decisions.

The NetScout integration creates the NetScout view. The NetScout view 
includes CIs that represent the application alarms.

The NetScout view includes the Application CI, the EMS Monitor CI, and 
their relationship.

For details about integrating NetScout data in HP Business Availability 
Center, see “Use the EMS Integration Tool for NetScout Data” on page 463.

All the sample information sent by NetScout is displayed by the Application 
KPIs attached to the Application Monitor CIs. The SiteScope EMS Multiple 
Events Rule calculates the statuses of those KPIs based on data obtained from 
NetScout samples.

The EMS Show Event context menu, Show Events context menu item, and 
the SiteScope EMS Rule tooltip corresponding to the SiteScope EMS 
Multiple Events Rule, are preconfigured to provide the appropriate 
infrastructure to work with the NetScout-related CIs in Dashboard. For 
details about the Application KPI, see “Application” in CI Attribute 
Customization. 

For details about:

➤ The SiteScope EMS Multiple Events Rule, see “SiteScope EMS Multiple 
Events Rule” in CI Attribute Customization. 

➤ The EMS Show Event context menu, see “EMS Show Events” in CI Attribute 
Customization. 
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➤ The Show Events context menu item, see “Show Events” in CI Attribute 
Customization. 

➤ The SiteScope EMS Rule tooltip, see “SiteScope EMS Rule” in CI Attribute 
Customization.

Tasks

Use the EMS Integration Tool for NetScout Data

NetScout data can be displayed in HP Business Availability Center using the 
EMS Integration tool.

For additional information about EMS integration, see “Enterprise 
Management Systems and the EMS Integrations Application Overview” on 
page 402.

This task includes the following steps:

➤ “Prerequisite” on page 463

➤ “Configure the Integration” on page 464

➤ “Customize the Integration – Optional” on page 465

➤ “View NetScout Data in the NetScout View and Enrich the View” on 
page 465

➤ “Access the NetScout Application from HP Business Availability Center” on 
page 465

 1 Prerequisite
In the NetScout nGenius server, select Device > Global settings, and enter, in 
the Server IP Addresses box, the SiteScope Server IP address of the SiteScope 
that reports to HP Business Availability Center.
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 2 Configure the Integration
The NetScout integration is predefined. The integration retrieves the 
samples provided by the NetScout nGenius system, creates the appropriate 
topology in HP Business Availability Center (application CIs), creates a view, 
assigns the appropriate KPIs, rules, context menus, context menu items, and 
tooltips depending on the type of sample and displays the information 
using the created view. 

To configure the NetScout integration, select Admin > EMS Integrations, 
select NetScout and click Edit. In the Edit Integration dialog box:

 a Add the NetScout Event Monitor to a SiteScope monitor group created 
for this monitor and other Integration Monitor types in Step 2. Retrieve 
data from EMS system using System Availability Management. The 
monitor is used to retrieve data from the NetScout server using System 
Availability Management Administration. It is recommended that you 
configure Integrations Monitors only after a connection between the 
SiteScope and HP Business Availability Center is established. For details, 
see “NetScout Event Monitor” in System Availability Management.

 b Activate the Application Monitor CIs data assignment rule in Step 3. 
Define the data assignments rules. The data assignment rule is 
automatically deactivated, by default. The data assignment rule includes 
the enrichment rules to create the topology for the Application Monitor 
CIs.

For details about the enrichment rules, see “Edit Integration Dialog Box” 
on page 417.

Note: SiteScope cannot be deployed behind a firewall. SiteScope and the 
monitored system must be on the same LAN or special firewall 
configuration might be required.
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 3 Customize the Integration – Optional
You can use the EMS Integrations application to customize a NetScout 
integration. The integration forwards the retrieved data captured from the 
NetScout system by the SiteScope NetScout Event Monitor to HP Business 
Availability Center, and creates the appropriate topology (Application CIs). 
For details on the available customization, see “Define Assignment 
Configuration Dialog Box” on page 422.

 4 View NetScout Data in the NetScout View and Enrich the View
You can view NetScout application alarms in the NetScout view. For details, 
see “NetScout View and Topology” on page 461.

To enrich the view, attach IT Universe CIs to the appropriate Application 
Monitor CIs. For details about attaching KPIs to a CI, see “Attach KPIs to CIs 
and Configure the KPIs” on page 373.

 5 Access the NetScout Application from HP Business Availability 
Center
From the NetScout view in Dashboard, you can connect to the NetScout 
application using the Show Event right-click menu option on the NetScout 
EMS monitor CIs. The context menu uses the NetScout server URL included 
in the samples to perform the drilldown to the NetScout server. 
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HP Diagnostics and HP Business 
Availability Center Integration

This chapter provides information on the HP Diagnostics and HP Business 
Availability Center integration.

This chapter includes:

Concepts

 ➤  HP Diagnostics and HP Business Availability Center Integration Overview 
on page 470

Tasks

 ➤  Access Online Help for HP Diagnostics in HP Business Availability Center 
on page 470

 ➤  View HP Diagnostics Data in HP Business Availability Center on page 471

Troubleshooting and Limitations on page 472
Concepts
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HP Diagnostics and HP Business Availability Center 
Integration Overview

HP Diagnostics is a composite application triage and diagnostics solution 
that is designed to help you improve the performance of your J2EE, .NET, 
and ERP/CRM enterprise applications throughout the application lifecycle.

HP Diagnostics is integrated with HP Business Availability Center, allowing 
you to monitor the availability and performance of your production 
enterprise application. This integration enables you to significantly reduce 
the Mean Time To Resolution of problems and thus increase the availability 
and value of the business applications.

From within HP Business Availability Center, you can track the performance 
status of your applications that are being monitored by HP Diagnostics. 

The Diagnostics integration with Business Availability Center allows you to 
drill down to Diagnostics data from specific Business Availability Center 
configuration items and reports. You can also generate high level reports in 
HP Business Availability Center about the performance of applications and 
Business Process Monitor (BPM) transactions that are monitored by 
Diagnostics.

Tasks

Access Online Help for HP Diagnostics in HP Business 
Availability Center

Click Help > Diagnostics Help to access the online HP Diagnostics 
Documentation Library, for the Diagnostics application or for Diagnostics 
administration in HP Business Availability Center. 
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View HP Diagnostics Data in HP Business Availability 
Center

To view HP Diagnostics data in HP Business Availability Center, you must 
register the HP Diagnostics server machine in HP Business Availability 
Center.

 1 Register HP Diagnostics
Access Admin > Diagnostics, to open the HP Diagnostics Server Details page. 
Enter the details of the server as follows:

➤ Diagnostics server host name. Enter the name of the machine that is 
host to the HP Diagnostics Server.

Even when the Diagnostics Server is installed on the same system as 
HP Business Availability Center you must enter the actual name of the 
host in the box. Do not enter localhost.

➤ Diagnostics server port number. Accept the default port number (2006) 
or enter the port number through which HP Diagnostics listens to server 
traffic.

➤ Diagnostics server protocol. Select the communication protocol (HTTP 
or HTTPS) through which HP Business Availability Center connects to 
HP Diagnostics.

If you select HTTPS, additional configuration steps are required. For 
details, see HP Diagnostics Installation and Configuration Guide.

Click Submit to register the server with HP Business Availability Center. The 
Diagnostics Server details are saved in HP Business Availability Center and 
HP Business Availability Center server details are automatically registered on 
the HP Diagnostics machine.

If the server name is incorrect or the server is unavailable, an error message 
is displayed.

If the user name with which you logged in does not have permissions for 
making changes on the HP Diagnostics server, a message is displayed instead 
of the HP Diagnostics page.
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 2 Proceed with Setting Up HP Business Availability Center to 
Work with Diagnostics
For help with the remainder of this procedure for registering the server, see 
the HP Diagnostics Installation and Configuration Guide (select Help > 
Diagnostics HP Diagnostics Installation and Configuration Guide).

 3 View HP Diagnostics Data in HP Business Availability Center
To view relevant Diagnostics information, select Application > Dashboard, 
select the Diagnostics View in View Explorer and click the appropriate tab.

For information on the HP Diagnostics data displayed in HP Business 
Availability Center, see the HP Diagnostics User’s Guide (select Help > 
Diagnostics Help >  HP Diagnostics User’s Guide).

 4 Access HP Diagnostics from HP Business Availability Center
You can access HP Diagnostics from HP Business Availability Center using 
right-click options in views and drill-downs from some reports.

Troubleshooting and Limitations

Problem: After connecting HP Business Availability Center to the 
HP Diagnostics server, a message is displayed: "Session does not exist."

Solution: Check that Internet Explorer is set up to allow the browser to 
submit cookies to the HP Diagnostics server.

To set up Internet Explorer to allow the browser to submit cookies:

 1 In Internet Explorer (version 6.0), select Tools > Internet Options > Privacy.

 2 In the Web Sites section, click the Edit button.

 3 In the Per Site Privacy Actions dialog box, enter the HP Diagnostics server 
DNS domain name.

 4 Click Allow, OK, and OK.
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Application Performance Lifecycle

Application Performance Lifecycle is designed to integrate between 
HP Business Availability Center and HP Performance Center, enabling you 
to construct load tests based on real-user transaction data collected by the 
Real User Monitor.

This chapter includes:

Concepts

 ➤  Application Performance Lifecycle Overview on page 476

 ➤  Application Performance Lifecycle Reports on page 476

Tasks

 ➤  Application Performance Lifecycle Workflow on page 480

 ➤  Analyze the Business Process Distribution Report on page 481

 ➤  Replay a Session on page 484

 ➤  Generate a Script Template on page 485

 ➤  Analyze a Typical Transaction Load Report on page 486

 ➤  Analyze the Location Load Analysis Report on page 488

 ➤  Use Application Performance Lifecycle Reports – A Case Scenario on page 489

 ➤  Refine Your Script Template in VuGen on page 492

 ➤  Configure and Run a Load Test on page 496

 ➤  Work with the Central Repository Service (CRS) on page 501

Reference

 ➤  Application Performance Lifecycle User Interface on page 505
Concepts
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Application Performance Lifecycle Overview

Application Performance Lifecycle enables quality assurance engineers to 
design load tests based on data leveraged from a production environment, 
rather than a testing environment. Using Application Performance 
Lifecycle, the QA engineer can construct load tests that are based on 
real-user transaction data and are therefore a more accurate simulation of 
load than standard Performance Center load tests. Application Performance 
Lifecycle thus increases the effectiveness of load tests and provides the QA 
team with more accurate test results.

To achieve this goal, Application Performance Lifecycle provides the 
following:

➤ Production Analysis reports from which the QA engineer can extract 
real-user transaction data to be used in Performance Center load tests

➤ The ability to create Virtual User Generator (VuGen) script templates, based 
on real-user activity

Application Performance Lifecycle Reports

Use Application Performance Lifecycle Production Analysis reports to 
pinpoint data that you want to use in building your Performance Center 
load test.

This section includes the following topics:

➤ “Business Process Distribution Report” on page 477

➤ “Typical Transaction Load Report” on page 478

➤ “Location Load Analysis Report” on page 479
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Business Process Distribution Report
The report enables you to view transaction run and transaction response 
time data over time for the configured transactions monitored by the Real 
User Monitor, create VuGen script templates that can be used in a 
Performance Center load test. You can create a VuGen script template either 
by instructing Application Performance Lifecycle to automatically generate 
a script template based on a session it selects, or by manually selecting the 
specific session you want to include in your script template. 
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For details, see “Business Process Distribution Page” on page 506.

Typical Transaction Load Report
This report enables you to view the average transaction load (the number of 
Real User Monitor transaction runs) during a typical hour, day, or week 
within a larger time frame that you select. Use the data in this report to:

➤ View the typical load on your system during specific time frames, which can 
assist you in determining the time frame you want to use for your 
Performance Center load test.

➤ Assist you, together with the data in the Business Process Distribution 
report, in selecting the transactions to include in your VuGen script 
templates.

For details, see “Typical Transaction Load Report” on page 517.
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Location Load Analysis Report
This report enables you to view the transaction load (the number of Real 
User Monitor transaction runs) and bit rate (bits per second) per end-user 
location. 

Use the data in this report in configuring Vusers and load generators for 
your Performance Center load test, as well as the run-time settings for your 
Application Performance Lifecycle-generated VuGen script.

For details, see “Location Load Analysis Report” on page 512.

Tasks
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Application Performance Lifecycle Workflow

Working with Application Performance Lifecycle involves performing the 
following procedures:

➤ “Configure Real User Monitor Transactions and Schedule the Snapshot 
Collection” on page 480

➤ “Analyze Production Analysis Reports” on page 480

➤ “Refine Script Templates” on page 480

➤ “Setup and Run a Load Test or Scenario That Includes the Scripts” on 
page 481

 1 Configure Real User Monitor Transactions and Schedule the 
Snapshot Collection
Ensure that Real User Monitor transactions are defined and that a 
transaction snapshot collection schedule is configured.

For details on configuring Real User Monitor transactions, see “New/Edit 
Transaction Page” in Using End User Management. For details on configuring 
a transaction snapshot collection schedule, see “New/Edit Web or SOAP 
Application Page” in Using End User Management.

 2 Analyze Production Analysis Reports
In the Production Analysis reports, analyze production performance data, 
export the data you want to use when building a Performance Center load 
test, select the real-user transactions and sessions you want to use in your 
VuGen scripts, and generate script templates.

For details, see “Application Performance Lifecycle User Interface” on 
page 505.

 3 Refine Script Templates
In VuGen, adjust the scripts generated by Application Performance Lifecycle 
for use in a Performance Center load test.

For details, see “Refine Your Script Template in VuGen” on page 492.
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 4 Setup and Run a Load Test or Scenario That Includes the Scripts
In Performance Center or LoadRunner, set up and run a load test or scenario 
that incorporates the scripts you created and refined and emulates the 
real-user behavior displayed in the Production Analysis reports.

For details, see “Configure and Run a Load Test” on page 496.

Analyze the Business Process Distribution Report

You use the Business Process Distribution report to pinpoint the Real User 
Monitor transactions with the greatest number of runs and the highest 
session popularity. You then drill down in this report to view the individual 
sessions in which these transactions were run. You can also use the Business 
Process Distribution report to pinpoint the transactions that were 
problematic in terms of response time and availability and drill down so 
that you can isolate the sessions, and pages within the sessions, that were 
problematic.

You select a session—either one that was popular and contained a large 
number of transaction runs, or one that was problematic in terms of 
response time or availability—as the basis for your VuGen script template. 
Alternatively, you can select transactions from the Business Process 
Distribution report and instruct Application Performance Lifecycle to 
automatically select a session for each transaction and generate a VuGen 
script template based on this session. For each transaction, Application 
Performance Lifecycle selects the session with a combination of the greatest 
number of runs, the shortest duration, and the least number of errors.

Note: You can use this report in conjunction with the Typical Transaction 
Load report to ensure that the transactions you select reflect typical 
transaction behavior during the selected time period. For details of a case 
scenario describing the use of the Business Process Distribution report in 
conjunction with the Typical Transaction Load report, see “Use Application 
Performance Lifecycle Reports – A Case Scenario” on page 489.
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To analyze the Business Process Distribution report, access the Business 
Process Distribution report. For details, see “Business Process Distribution 
Page” on page 506. 

Example

 1 Access the Business Process Distribution report, select a transaction, based 
on the total number of runs for the transaction as well as the transaction’s 
session popularity (or response time/availability data), and click the View 
Sessions button to open the Sessions page. It displays data for each session 
in which the selected transaction was run and a transaction snapshot was 
collected, as well as certain key statistic averages of all the displayed 
sessions. For additional information on the Sessions page, see “Session 
Analyzer Report” in Using End User Management.
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 2 Select the session you want to use for your VuGen script, based on page hit 
and error data, and click the View Session Details button. The Session 
Details page opens, displaying general session and event information, as 
well a list of all the pages accessed as part of the session and the events and 
response time for each page. The pages that were included in the selected 
transaction’s definition are highlighted.

Note: Event data is displayed only if you configured events for the 
application with which the transaction you are viewing is associated. For 
information on events and their configuration, see “Real User Monitor 
Administration” in Using End User Management.

For additional information on the Session Details page, see “Session Details 
Report” in Using End User Management.
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Replay a Session

To replay a session page by page in your Web browser, in the Session Details 
page (which you access by clicking the View Sessions button for a selected 
transaction in the Business Process Distribution report), click Session 
Replay. The Session Viewer window opens, displaying three panes.

The upper-left pane displays a hierarchal tree of the pages included in the 
session, and their components. There is also an entry for the session details. 
Click on the item in the tree you want to view. Page and component names 
that are preceded by a camera icon, are pages and components for which 
snapshots exist.

The lower-left pane displays general details of the selected page or 
component, or details of the session if Session Details is selected in the 
upper-left pane.

The right-hand pane includes the following tabs:

➤ Snapshot View. Displays a picture of the page accessed by the user.

➤ Page Source. Displays the HTML source code of the snapshot.

➤ Events. Displays the configured events that occurred on the page.

Note: If Session Details is selected for viewing, only the Events tab is 
enabled.

To download all the snapshots included in a session to a zip file, click the 
Download button above the left pane. The Save dialog box opens. Select the 
path and file name you want and click Save. The saved zip file includes a 
Java applet for viewing the saved information.
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Note: If the snapshot requested is one of an HTTP Not Found error (HTTP 
error code 404), in some instances the link to the referring machine is to an 
HP Business Availability Center server machine instead of to the original 
Web server machine that reported the error. This is due to an html script 
that generates a link being stored in the snapshot, rather than the actual 
link itself.

Generate a Script Template

From the Session Details page, you click Generate Script Template to 
generate a template for your VuGen script that includes the pages in the 
current session. If you have enabled the CRS on the Infrastructure Settings 
Manager page, you are prompted to save the script template in the 
repository. For details on enabling the CRS and saving scripts in the 
repository, see “Save a Script Template or Scenario Package in the CRS” on 
page 502. If the CRS is not enabled, you are prompted to save the script 
template in your regular directory structure.

You should generate a script template for each transaction you would like to 
include in your Performance Center load test.

Tip: Save all your script templates in the same directory so that they are all 
easily accessible when constructing a Performance Center load test.
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Analyze a Typical Transaction Load Report

You use the Typical Transaction Load report to view the average transaction 
load during a typical week, day, or hour. In general, you use the Typical 
Transaction Load report, and the ability to drill down within this report, to 
pinpoint the time frame you want to use for your Performance Center load 
test. 

Example

If you selected to view a typical week during the past month, the Typical 
Transaction Load report may display data such as the following.
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Since Wednesday is typically the day with the greatest number of 
transaction runs, you would choose to run your load test on a Wednesday. 
To view the specific hours on Wednesday at which transaction load was 
typically at its peak, click one of the bars in the Wednesday column. The 
Typical Transaction Load graph displays the typical load for each hour on 
Wednesday.

Since load is typically greatest at 9:00 AM or 11:00 AM, you would choose to 
run your load test during this time range. You can also drill down to view 
the minutes during which transaction load was typically at its peak, 
however this data is less relevant for the construction of a load test than the 
typical daily and hourly data.

Note: You can also use this report in conjunction with the Business Process 
Distribution report to determine whether a large number of runs displayed 
for a transaction in the Business Process Distribution report is typical of the 
transaction’s behavior during the selected time period. If the Typical 
Transaction Load report indicates that the transaction load displayed in the 
Business Process Distribution report is typical of the transaction’s load 
during the selected time period, it is recommended that you use the 
transaction for your VuGen script.
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Analyze the Location Load Analysis Report

You use the Location Load Analysis report to view the distribution of Real 
User Monitor transaction runs among end-user locations, as well as the bit 
rate of each transaction at each location. You then use the location data in 
selecting load generators, the transaction run data in distributing Vusers 
among load generators, and the bit rate data in configuring each script’s 
network speed simulation settings.

Example

For example, if you selected to view location data for four transactions—
APL_BuyTx, APL_MyAccountTx, APL_SearchTx, and APL_MyOrdersTx—
during the past month, the Location Load Analysis report may display data 
such as the following.

Based on this report, you may choose to select load generators from one or 
more of the above locations when configuring your load test. Your 
distribution of Vusers among the load generators would most likely be based 
on the distribution of transaction load (that is, the number of transaction 
runs being run) among the above locations. For an explanation of 
configuring load tests based on Production Analysis report data, see 
“Configure and Run a Load Test” on page 496.

In addition, you would use the bit rate data in this report in configuring the 
Network: Speed Simulation VuGen run-time settings of the Application 
Performance Lifecycle-generated scripts that you are using for your load test. 
For example, if you generated a script based on the APL_SearchTx 
transaction and planned to run this script from two load generators—one 
located in Los Angeles and the other in San Francisco—you would do the 
following:

➤ create two copies of the script;

➤ set the custom bandwidth for the script being run from Los Angeles at 
182,127,139 bits per second;
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➤ set the custom bandwidth for the script being run from San Francisco at 
231,718,670 bits per second.

For details on configuring Application Performance Lifecycle-generated 
scripts based on data from the Location Load Analysis report, see the Set the 
Speed Simulation step in “Refine Your Script Template in VuGen” on 
page 492.

Use Application Performance Lifecycle Reports – A Case 
Scenario

This section describes a typical case scenario in which a user worked with all 
three Application Performance Lifecycle reports to obtain the information 
he required to construct a Performance Center load test. 

Initially, the user accessed the Business Process Distribution report to view 
data for the five transactions with the greatest number of run instances 
during the period of a week, from January 26, 2006 to February 2, 2006. The 
Business Process Distribution report showed that APL_SearchTx was the 
transaction with the greatest number of runs—a total of 4,114 transaction 
runs—as well the most popular transaction (run in 18% of the sessions).

To verify that this data reflected the typical transaction load for the 
APL_SearchTx transaction during this time period, the user accessed the 
Typical Transaction Load report and viewed data for a typical week during 
the monthly period of January 2, 2006 to February 2, 2006. The Typical 
Transaction Load report showed that the average transaction load for the 
APL_SearchTx transaction was indeed significant during this period of time.
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The user then drilled down further in the Typical Transaction Load report to 
discover the specific hours on Wednesday (the day with the greatest number 
of transaction runs) during which transaction load was typically at its peak. 

The drilldown showed that load was typically greatest at 9:00 AM, so the 
user decided that he would later run his load test at this hour. To be able to 
use this data as well as the average transaction run data later on, when 
configuring a load test, the user saved the report in .PDF format.

Having received confirmation of the significance of the APL_SearchTx 
transaction, the user returned to the Business Process Distribution report to 
generate a VuGen script of a session in which the APL_SearchTx transaction 
was run. To view the sessions in which APL_SearchTx was run and a 
transaction snapshot was collected, the user clicked the View Sessions 
button. After viewing error and page hit data for each displayed session, the 
user selected to view details of a session with 1 application error, 1 HTTP 
error, and 13 page hits.

The user then clicked the View Session Details button to view details of the 
end user that ran the selected session, as well as the pages that were accessed 
as part of the session (with those included in the transaction highlighted).
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After viewing all of this data, the Application Performance Lifecycle user 
decided to use this session as the basis for a VuGen script and clicked 
Generate Script Template on the Session Details page to Application 
Performance Lifecycle to create a script template from the session. The user 
saved the generated script to the CRS.

To prepare additional data for the configuration of his load test, the user 
accessed the Location Load Analysis report and selected to view location 
data for the APL_SearchTx transaction. The Location Load Analysis report 
showed that end users at three locations—Los Angeles, San Diego, and San 
Francisco—ran the APL_SearchTx transaction.

To be able to use this data for his Performance Center load test, the user 
saved the Location Load Analysis report in .PDF format.

Based on this report, the user decided to run the script he generated from 
three different load generators, each located at one of the above locations. 
To do so, the user created three different copies of the script and set the 
Network: Speed Simulation VuGen run-time settings for each script 
according to the bit rate for the location from which the script was going to 
be run (for details, see “Set the Speed Simulation” on page 495). The user 
also based his distribution of Vusers among the load generators on the 
distribution of total runs among the above locations. (For details on 
configuring load tests, see “Configure and Run a Load Test” on page 496.)

Note: The above case scenario describes the generation of one script, based 
on one transaction, however a true use case typically includes several scripts, 
based on several different transactions. 
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Refine Your Script Template in VuGen

To use Application Performance Lifecycle-generated scripts in a Performance 
Center load test, you must first customize them using VuGen.

Note: If you exported the script templates you created in Application 
Performance Lifecycle to the CRS, see “Open a Script Saved in the CRS” on 
page 503 for details on how to open the script templates in VuGen.

This task includes the following steps:

➤ “Parameterize Recorded Values” on page 493

➤ “Correlate Recorded Values” on page 494

➤ “Set the Speed Simulation” on page 495
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 1 Parameterize Recorded Values
When you generate a script using Application Performance Lifecycle, the 
script contains the actual end-user values that the Real User Monitor 
recorded. To perform the script’s actions (query, submit, and so on) using 
different values from those recorded by the Real User Monitor, you must 
replace the values with parameters.

Example

Suppose you generated a script containing the following statement that 
searches a library’s database for the title UNIX: 

When you run this script in a Performance Center load test, you do not 
want to repeatedly use the same value, UNIX. You therefore replace the 
constant value with a parameter:

 web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value=UNIX",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);

;

web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value={Book_Title}",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);
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When you run a load test using a parameterized script, Vusers substitute the 
parameter with different values from a data source that you specify. The 
data source can be either a file or internally generated variables.

For detailed instructions on replacing the constant values in your generated 
script with parameters, as well as setting the properties and data source for 
these parameters, see HP Virtual User Generator User’s Guide.

Notes:

➤ You can parameterize complete strings or parts of strings.

➤ You can define more than one parameter for functions with multiple 
arguments (such as URLs, server names, and IP addresses).

 2 Correlate Recorded Values
In addition to parameterizing the script you generated using Application 
Performance Lifecycle, you must correlate certain statements within the 
script. Correlation allows you to link statements by using the results of one 
statement as input for another.

You correlate statements for one or both of the following reasons:

➤ to generate dynamic data – For example, if the Real User Monitor session 
from which you generated your script was identified by the date and time, 
when you try to replay a script of this session, it fails because the current 
time is different than the original recorded time. Only if you correlate the 
date and time can you save it as dynamic data and use it throughout the 
load test or session step run.

➤ to accommodate unique data records – For example, if the Real User 
Monitor recorded a session requiring the use of unique values, such as the 
process of opening a new bank account, replaying a script of the session fails 
because the recorded value already exists and cannot be recreated. 
Correlating the value enables you to create additional unique values—based 
on the recorded value—to be used throughout the load test or session step 
run.
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For detailed instructions on correlating a script, see HP Virtual User Generator 
User’s Guide.

 3 Set the Speed Simulation
You set the speed simulation for your Application Performance 
Lifecycle-generated script based on data contained in the Location Load 
Analysis report.

To set the speed simulation for a script:

 a In VuGen, select Vuser > Run-Time Settings or click the Run-Time 
Settings button on the toolbar to open the Run-Time Settings dialog box.

 b In the Run-Time Settings tree, select the Network: Speed Simulation 
node.

 c Select Use custom bandwidth and specify the bit rate of the location 
from which you want to run the script, according to the bit rate 
displayed for this location (for the transaction upon which the script is 
based) in the Location Load Analysis report. For example, if the 
transaction upon which your script is based was run by a significant 
number of users in Los Angeles, California, you would specify the bit rate 
displayed for Los Angeles in the Location Load Analysis report’s 
Transaction Bit Rate Per Location graph.
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Note: To run the same script from several different locations, you can 
save several copies of the script and assign each copy a custom 
bandwidth reflecting the bit rate of a specific location. For details on 
assigning load generators to each copy of the script, see “Configure and 
Run a Load Test” on page 496.

 d Click OK to apply the updated run-time settings.

Configure and Run a Load Test

This section describes how to configure and run Performance Center and 
LoadRunner load tests that incorporate the scripts you created using 
Application Performance Lifecycle and emulate the real-user behavior 
displayed in the Production Analysis reports.

This task includes the following steps:

➤ “Configure and Run a Load Test in Performance Center” on page 496

➤ “Configure and Run a Scenario in LoadRunner” on page 498

 1 Configure and Run a Load Test in Performance Center
After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a load test in Performance Center that 
incorporates these scripts and emulates the real-user behavior displayed in 
the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a load test. For detailed instructions on creating a load test, see the 
HP Performance Center User’s Guide. 
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To incorporate Application Performance Lifecycle-generated scripts in a 
load test:

Connect VuGen to the Performance Center Web server and either upload 
your script files directly to the Performance Center Web server or save them 
in the file system. For detailed instructions, see HP Virtual User Generator 
User’s Guide.

If you saved the Application Performance Lifecycle-generated scripts in the 
CRS, see “Upload Scripts from the CRS to Performance Center” on page 504 
for details on uploading the scripts to the Performance Center Web server.

To incorporate the Production Analysis report data in a load test:

 a Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, emailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieve a Report Saved in the CRS” on 
page 504.

 b In Performance Center, select Load Tests > Create/Edit from the left 
menu to open the Load Tests page.

 c Click New Load Test to create a new load test. 

 d In the Design Groups tab, select the scripts you generated using 
Application Performance Lifecycle and customized in VuGen. Select one 
or more load generators to run each script, based on the location data in 
the Location Load Analysis report. For example, if the transaction upon 
which one of your scripts is based was run from Los Angeles, California, 
you would select one or more load generators located in Los Angeles to 
run this particular script.

Note: Ensure that the Network: Speed Simulation run-time settings of 
each script are set to match the bit rate specified in the Location Load 
Analysis report for the location from which the script is being run. For 
details on configuring Network: Speed Simulation run-time settings, see 
“Set the Speed Simulation” on page 495.
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 e Distribute the Vusers among the Vuser groups based on the distribution 
of transaction load among the locations displayed in the Location Load 
Analysis report, represented by the load generators you selected for each 
group. For example, if the transactions upon which your scripts are based 
were run from three locations and each location ran approximately one 
third of the transactions, you would distribute the Vusers evenly among 
the Vuser groups.

 f The overall number of Vusers for your load test should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers to run, however, ensure that you take 
into account the difference in scaling between load test and production 
environments.

 g In the Scheduler tab, configure the Ramp Up and Ramp Down of Vusers 
based on data in the Typical Transaction Load report. For example, if the 
Typical Transaction Load report showed that an average of 100 
transactions were run at the beginning of the time period you selected to 
use for your load test and 80 transactions were run at the end of this time 
period, you might configure your load test to start 100 Vusers every hour 
and stop 80 Vusers every hour. Note, however, that you must take into 
account the difference in scaling between load test and production 
environments.

 h Complete your load test configuration and run the load test from the 
Load Tests Configuration page by clicking Start, or from the Load Tests 
page by clicking the Run Test icon in the row of the load test that you 
want to run. For details on configuring and running a load test, see the 
HP Performance Center User’s Guide.

 2 Configure and Run a Scenario in LoadRunner
After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a manual scenario in the LoadRunner 
Controller that incorporates these scripts and emulates the real-user 
behavior displayed in the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a manual scenario. For detailed instructions on creating a manual scenario, 
see the HP LoadRunner Controller User’s Guide. 
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To incorporate Application Performance Lifecycle-generated scripts in a 
scenario:

 a In the New Scenario dialog box, choose Manual Scenario. Do not select 
the Use the Percentage Mode check box.

 b Click the Browse button, navigate to the directory in which you saved 
the Application Performance Lifecycle-generated scripts that you 
modified using VuGen, and select the scripts.

 c If these scripts are saved in the CRS, see “Open a Script Saved in the CRS” 
on page 503 for details on selecting them.

 d Click the Add button to add the scripts to your scenario.

To incorporate the Production Analysis report data in a scenario:

 a Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, emailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieve a Report Saved in the CRS” on 
page 504.

 b In LoadRunner, to the right of the Scenario Groups pane, click the Add 
Group button. Select a script you generated using Application 
Performance Lifecycle and customized in VuGen. Select one or more load 
generators to run the script, based on the Location Load Analysis report’s 
location data for the transaction upon which the script is based. For 
example, if the transaction upon which one a script is based was run 
from Los Angeles, California, you would select one or more load 
generators located in Los Angeles to run this script.

Note: Ensure that the Network: Speed Simulation run-time settings of the 
script are set to match the bit rate specified in the Location Load Analysis 
report for the location from which the script is being run. For details on 
configuring Network: Speed Simulation run-time settings, see “Set the 
Speed Simulation” on page 495.
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Select a quantity of Vusers for the group. Vusers should be distributed 
among Vuser groups based on the distribution of transaction load among 
the locations displayed in the Location Load Analysis report, represented 
by the load generators you selected for each group. For example, if the 
transactions upon which your scripts are based were run from three 
locations and each location ran approximately one third of the 
transactions, you would distribute the Vusers evenly among the Vuser 
groups.

The overall number of Vusers for your scenario should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers, however, ensure that you take into 
account the difference in scaling between load test and production 
environments.

Note: You use the Add Group dialog box to add each Application 
Performance Lifecycle-generated script you want to include in your 
scenario. Since each location requires specific script network run-time 
settings, each location requires its own unique script. For details on 
preparing a script to be run from each location, see “Set the Speed 
Simulation” on page 495.

 c In the Schedule Builder, configure the Ramp Up and Ramp Down of 
Vusers based on data in the Typical Transaction Load report. For 
example, if the Typical Transaction Load report showed that an average 
of 100 transactions were run at the beginning of the time period you 
selected to use for your load test and 80 transactions were run at the end 
of this time period, you might configure your load test to start 100 Vusers 
every hour and stop 80 Vusers every hour. Note, however, that you must 
take into account the difference in scaling between load test and 
production environments.

 d Complete your scenario configuration and run the scenario from the Run 
tab of the Controller. For details on configuring and running a scenario, 
see the HP LoadRunner Controller User’s Guide.
500



Chapter 14 • Application Performance Lifecycle
Work with the Central Repository Service (CRS)

This section describes how to export Production Analysis reports to the CRS, 
generate a script template or scenario package and save it in the CRS, open 
scripts saved in the CRS, retrieve reports saved in the CRS, and upload 
scripts saved in the CRS to Performance Center.

When working with the Central Repository Service, you are only able to see 
the folders in the Central Repository Service for which you, the logged-in 
user, have permissions to view. For details on setting permissions for the 
Central Repository Service, see “Central Repository Service Permissions” in 
Platform Administration.

This task includes the following steps:

➤ “Export a Report to the CRS” on page 501

➤ “Save a Script Template or Scenario Package in the CRS” on page 502

➤ “Open a Script Saved in the CRS” on page 503

➤ “Retrieve a Report Saved in the CRS” on page 504

➤ “Upload Scripts from the CRS to Performance Center” on page 504

 1 Export a Report to the CRS
By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can export the Production Analysis reports to the CRS.

Note: If the CRS is disabled, re-enable it by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Foundations, 
select Production Analysis, and locate the CRS Enabled entry in the 
Production Analysis - Central Repository Service table. Modify the value to 
true.

To export a report to the CRS:

 a From the toolbar at the top right-hand corner of the report, select 
Export > Central Repository Service. A new browser window opens, 
displaying Report under Type. 
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 b In the Name text box, enter the name under which you want to save the 
report in the repository. 

 c In the Description text box, enter a description of the report. This field is 
optional. 

 d Browse the Root directory tree to select the folder in which you want to 
save the report. The files that are currently stored in the selected folder 
are displayed in the Folder Content table on the right. 

 e To save the report in a new folder, click the Create New Folder button, 
enter the folder name and description, click OK, and then click the 
Refresh button to view the new folder in the directory tree. 

 f To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. 

 g To delete a folder, click the Delete Folder button and click Yes. 

 h Click Save. If the save process has been completed successfully, Report 
saved to repository is displayed at the top of the browser window. 

 i Click Close to close the browser window and return to the report you 
were viewing.

 2 Save a Script Template or Scenario Package in the CRS
By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can save your generated script templates or a scenario package in 
the CRS.

Note: If the CRS is disabled, re-enable it by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Foundations, 
select Production Analysis, and locate the CRS Enabled entry in the 
Production Analysis - Central Repository Service table. Modify the value to 
true.
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To save a scenario package or script template in the CRS:

 a Click the Generate Scenario Package button in the Business Process 
Distribution report, or the Generate Script Template button at the top of 
the Session details page. A new browser window opens, displaying 
Scenario Package or VuGen Script under Type. 

 b In the Name text box, enter the name under which you want to save the 
scenario package or script template in the repository. 

 c In the Description text box, enter a description of the scenario package or 
script template. This field is optional. 

 d Browse the Root directory tree to select the folder in which you want to 
save the scenario package or script template. The files that are currently 
stored in the selected folder are displayed in the Folder Content table on 
the right. 

 e To save the scenario package or script template in a new folder, click the 
Create New Folder button, enter the folder name and description, click 
OK, and then click the Refresh button to view the new folder in the 
directory tree. 

 f To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. 

 g To delete a folder, click the Delete Folder button and click Yes. 

 h Click Generate. If the generation process has been completed 
successfully, Scenario package saved to repository or VuGen script 
template saved to repository is displayed at the top of the browser 
window. 

 i Click Close to close the browser window and return to main page or 
Session Details page of the Business Process Distribution report.

 3 Open a Script Saved in the CRS
You can open scripts saved in the CRS from both VuGen and the 
LoadRunner Controller.

To open a script saved in the CRS:

 a In the main VuGen window, select Tools > Quality Center Connection. 
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 b In the LoadRunner Controller’s New Scenario dialog box, click the 
Quality Center button. 

 c In the Quality Center Connection dialog box, enter the CRS URL, http://
<HP Business Availability Center server machine>:8080/qcbin, and click 
Connect. 

 d Click Browse in the Controller, or select File > Open in VuGen, to select 
the scripts you saved in the CRS. If the scripts were automatically 
generated by Application Performance Lifecycle, they are located in a zip 
file within the scenario package file you created.

Note: When you save your scripts after editing them in VuGen, they are 
automatically saved in the CRS.

 4 Retrieve a Report Saved in the CRS
You can retrieve a report saved in the CRS to incorporate its data in your 
Performance Center load test or LoadRunner scenario.

To retrieve a report saved in the CRS:

 a Access the CRS URL (http://<HP Business Availability Center server 
machine>:8080/qcbin). 

 b Download the report PDF saved in the CRS by clicking the Download 
button. If the report is a Summary report that is part of a scenario 
package, it can be downloaded from the scenario package zip file.

 5 Upload Scripts from the CRS to Performance Center
To incorporate scripts saved in the CRS in your Performance Center load 
test, you must upload the scripts to the Performance Center Web server.

To upload scripts from the CRS to Performance Center:

 a In the main VuGen window, select Tools > Quality Center Connection 
and open the scripts you saved in the CRS as described in “Open a Script 
Saved in the CRS” on page 503. 
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 b Connect VuGen to the Performance Center Web server as described in HP 
Virtual User Generator User’s Guide. 

 c Upload the script files to the Performance Center Web server as described 
in HP Virtual User Generator User’s Guide.

Reference

Application Performance Lifecycle User Interface

This section describes:

 ➤  Business Process Distribution Page on page 506

 ➤  Location Load Analysis Report on page 512

 ➤  Select Locations Dialog Box on page 514

 ➤  Select Transactions Dialog Box on page 515

 ➤  Typical Transaction Load Report on page 517
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Business Process Distribution Page

Description Enables you to:

➤ View transaction run and transaction response time 
data over time for the configured transactions 
monitored by the Real User Monitor. 

➤ Create VuGen script templates that can be used in a 
Performance Center load test. You can create a 
VuGen script template in one of two ways:

➤ by instructing Application Performance Lifecycle 
to automatically generate a script template based 
on a session it selects

➤ by manually selecting the specific session you 
want to include in your script template

To Access: Select Applications > Application 
Performance Lifecycle > Production Analysis > Business 
Process Distribution

Important 
Information

You can drill down in this report to view data for each 
session in which the displayed transactions were run.

Note: If the Central Repository Service (CRS) is 
enabled, you can export a PDF of the report to the CRS 
by selecting Export and clicking the Central Repository 
Service button . For details on exporting the report 
to the CRS, see “Export a Report to the CRS” on 
page 501.

Included in Tasks ➤ “Analyze the Business Process Distribution Report” 
on page 481

➤ “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 489
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Note: If you already selected a time range in one of the 
other Production Analysis reports, the time range you 
previously selected is automatically displayed in the 
Business Process Distribution report.
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Show <nn> 
transactions 
<condition> from 
<application>

Select and specify:

➤ <nn>. The number of real-user transactions you 
want the report to display.

➤ <condition>. Select one of the following:

➤ with the greatest number of runs. To display the 
real-user transactions that experienced the 
highest total number of run instances.

➤ with the worst response times. To display the 
real-user transactions that experienced the 
greatest overall transaction time.

➤ with the highest session popularity. To display 
the real-user transactions that were most popular 
among the sessions. Popularity is determined by 
dividing the number of unique sessions running a 
transaction by the total number of sessions.

➤ with the lowest availability. To display the 
real-user transactions that experienced the lowest 
transaction availability. 

➤ <application>. Select to display the transactions 
from all monitored applications (All applications) 
that meet the selected criteria, or only transactions 
that were defined for a specific application.

Transaction Selection Select this option and click Transaction Selection to 
open the Select Transaction dialog box.

Note:

➤ If you already selected transactions in one of the 
other Production Analysis reports, these transactions 
are automatically be selected in the Business Process 
Distribution report.

➤ You can select a maximum of 20 transactions.

GUI Element (A–Z) Description
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Summary Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Select a transaction, based on the total number of runs 
for the transaction as well as the transaction’s session 
popularity (or response time/availability data), and 
click the button.

The Sessions page opens, displaying data for each 
session in which the selected transaction was run and a 
transaction snapshot was collected, as well as certain 
key statistic averages of all the displayed sessions. 

For additional information on the Sessions page, see 
“Session Analyzer Report” in Using End User 
Management.

Application The application with which the transaction is 
associated.

Application Response 
Time (seconds)

Displays the net time, in seconds, of the transaction 
(that is, server time + network time + client time of all 
the pages included in the transaction).

Availability The transaction’s availability. 

Note: The color-coding of the column is based on the 
transaction’s availability in relation to the transaction 
availability threshold you defined in End User 
Management Administration.
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Generate Scenario 
Package

Select one or more transactions and click the button to 
instruct Application Performance Lifecycle to 
automatically select a session for each transaction and 
generate a VuGen script template based on this session. 

For each transaction, Application Performance 
Lifecycle selects the session with a combination of the 
greatest number of runs, the shortest duration, and the 
least number of errors. Application Performance 
Lifecycle then generates a VuGen script template based 
on each session, as well as a Summary report 
containing the Business Process Distribution report, 
the Typical Transaction Load report, and the Location 
Load Analysis report for the selected transactions.

If you have enabled the CRS on the Infrastructure 
Settings Manager page, you are prompted to save the 
scenario package in the repository. For details on 
enabling the CRS and saving the package in the 
repository, see “Save a Script Template or Scenario 
Package in the CRS” on page 502. 

If the CRS is not enabled, you are prompted to save the 
scenario package in your regular directory structure.

➤ When you click the button the CRS page is 
displayed, enabling you to generate VuGen script 
templates. You specify a file name and a description 
for the script and select a location in the repository 
in which to save the file. 

Popularity The percentage of unique sessions in which the 
transaction was run over the last day.

Total Runs The total number of run instances for the transaction.

Transaction The transaction name.

GUI Element (A–Z) Description
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Transaction Runs Over Time Graph

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Transaction Response Time Over Time Graph

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Data points> Displays for each period of time on the Time axis, the 
number of transaction runs for the configured 
transactions monitored by the Real User Monitor.

Tooltip: The transaction name and the number of 
transaction runs.

<Legend> Describes the color coding used in the graph.

Runs <y-axis> Displays the number of transaction runs.

Time <x-axis> Displays the time division units for the time range that 
you defined when generating the report. 

GUI Element (A–Z) Description

<Data points> Displays for each period of time on the Time axis, the 
transaction response time data for the configured 
transactions monitored by the Real User Monitor.

Tooltip: The transaction name and response time.

<Legend> Describes the color coding used in the graph.

Response Time (ms) 
<y-axis>

Displays the transaction response time in milliseconds.

Time <x-axis> Displays the time division units for the time range that 
you defined when generating the report. 
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Location Load Analysis Report

Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the transaction load (the number 
of Real User Monitor transaction runs) and bit rate (bits 
per second) per end-user location. 

Use the data in this report in configuring Vusers and 
load generators for your Performance Center load test, 
as well as the run-time settings for your Application 
Performance Lifecycle-generated VuGen script.

To Access: Select Application > Application 
Performance Lifecycle > Production Analysis > Location 
Load Analysis

Important 
Information

For details about analyzing the report, see “Analyze a 
Typical Transaction Load Report” on page 486.

Included in Tasks ➤ “Analyze a Typical Transaction Load Report” on 
page 486

➤ “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 489

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Note: If you already selected a time range in one of the 
other Production Analysis reports, the time range you 
previously selected is automatically displayed in the 
Location Load Analysis report.
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Report Content Viewed as a Graph

The View as Graph tab includes the following graphs:

Runs per Location 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Location Selection To select locations to be displayed in the Location Load 
Analysis report, click the link to open the Select 
Locations dialog box. 

Transaction Selection If you already selected transactions in one of the other 
Production Analysis reports, by default the Location 
Load Analysis report displays data for the previously 
selected transactions. 

If the Location Load Analysis report is the first 
Production Analysis report you are accessing, or to 
display data for a different group of transactions, click 
the link to open the Select Transaction dialog box.

GUI Element (A–Z) Description

<Bars> Display the total number of transaction runs for each 
location at which the selected transactions were run.

Tooltip: The number of transaction runs.

<Legend> Describes the color coding used in the graph.

Location <x-axis> Displays the locations.

Total Runs <y-axis> Displays the number of transaction runs.

GUI Element (A–Z) Description
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Bitrate

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content Viewed as a Table

Select Locations Dialog Box

GUI Element (A–Z) Description

<Bars> Display the transaction bit rate (bits per second) for 
each location at which the selected transactions were 
run.

Tooltip: The transaction bit rate (bits per second).

<Legend> Describes the color coding used in the graph.

Bitrate (Bits/sec) 
<y-axis>

Displays the transaction bit rate (bits per second).

Location <x-axis> Displays the locations.

Description Displays a table listing the bit rate (bits/second) and 
total number of runs for each transaction at each 
location, as well as an average of the bit rates and total 
runs of all the transactions at a location, an average of 
the bit rates and total runs for each transaction across 
all locations, and an overall average bit rate and total 
run calculation for all transactions across all locations.

Description Enables you to select the locations on which you want 
to run the Location Load Analysis report.

To access: Click Location Selection in the Location 
Load Analysis report.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Transactions Dialog Box

GUI Element (A–Z) Description

Locations in the 
report

Use the first left-pointing arrow to move the 
appropriate locations from this area to the Locations 
not in the report area to exclude them from the report. 
Use the second left-pointing arrow to move all the 
locations from this area.

Locations not in the 
report

By default, the Select Locations dialog box displays the 
locations associated with the transactions you selected.

Select the locations for which you want to view data, 
and click the first right-pointing arrow to move them 
to the Locations in the report area to include them in 
the report. To view data for all the locations listed, 
click the second right-pointing arrow.

Use unknown 
locations

Select this check box to view data for locations that 
have not been assigned names.

Description Enables you to select the transactions on which you 
want to run the Business Process Distribution report.

To access: Click Transaction Selection in the Business 
Process Distribution report or Transaction Selection in 
the Location Load Analysis report.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Application Select All applications to display the transactions from 
all monitored applications, or choose a specific 
application to display only transactions that were 
defined for that application. Select the transactions for 
which you want to view data, and click the first arrow. 
To view data for all the transactions listed, click the 
second arrow. Click OK to close the dialog box and 
save your settings.

Transactions in the 
report

Use the first left-pointing arrow to move selected 
transactions from this area to the Transactions not in 
the report area to exclude them from the report. Use 
the second left-pointing arrow to move all the 
transactions.

Transactions not in 
the report

Use the first right-pointing arrow to move selected 
transactions from this area to the Transactions in the 
report area to include them in the report. Use the 
second right-pointing arrow to move all the 
transactions.
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Typical Transaction Load Report

Description Enables you to view the average transaction load (the 
number of Real User Monitor transaction runs) during 
a typical hour, day, or week within a larger time frame 
that you select. 

Use the data in this report to:

➤ View the typical load on your system during specific 
time frames, which can assist you in determining 
the time frame you want to use for your 
Performance Center load test.

➤ Assist you, together with the data in the Business 
Process Distribution report, in selecting the 
transactions to include in your VuGen script 
templates.

To Access: Select Application > Application 
Performance Lifecycle > Production Analysis > Typical 
Transaction Load

Important 
Information

For details about analyzing the report, see “Analyze the 
Business Process Distribution Report” on page 481.

Included in Tasks “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 489
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Note: If you already selected a time range in one of the 
other Production Analysis reports, the time range you 
previously selected is automatically displayed in the 
Location Load Analysis report.

Transaction Selection By default, the Typical Transaction Load report 
displays data for the transactions you previously 
selected in the Business Process Distribution report. If 
the Typical Transaction Load report is the first 
Production Analysis report you are accessing, or to 
display data for a different group of transactions, click 
the Transaction Selection link to open the Select 
Transactions dialog box.

View a typical... Select Hour, Day, or Week. 

Working Days Click the Working Days link to open the Working Days 
dialog box, where you select the days of the week for 
which data is included in the report.

Note: This link is only available when viewing a typical 
day or hour.

Working Hours Click the Working Hours link to open the Working 
Hours dialog box, where you select the hours of the 
day for which data is included in the report. 

Note: This link is only available when viewing a typical 
hour.
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Report Content Viewed as a Graph

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Bars> Display the average number of transaction runs for the 
selected transactions during a typical hour, day, or 
week within the time frame you specified.

Note:

➤ Click a bar to drill down to a component of the time 
period you selected in the View a typical field in 
report settings. For example, if you have selected a 
typical week, click on a day in the week to display 
the data for a typical day.

➤ The transaction runs for each sub-unit of time are an 
average of the transaction runs for all the 
occurrences of that sub-unit of time during the 
specified time frame. For example, if you choose to 
view a typical week during the period of a month, 
the average number of each of the selected 
transactions for each day in the week are displayed. 
The transaction runs listed for a specific transaction 
on Tuesday are an average of all that transaction’s 
runs on Tuesdays over the course of the specified 
month.

Tooltip: The average number of transaction runs.

<Legend> Describes the color coding used in the graph.

<Time period> 
<x-axis>

Displays the sub-units of time for the unit selected in 
the View a typical field in report settings. For example, 
if you choose to view a typical week, the individual 
days of the week are displayed on the Time period axis.

Runs <y-axis> Displays the number of transaction runs.
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Report Content Viewed as a Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Subunit of time> The average number of transaction runs for each 
subunit of time (day, hour or minute), for each selected 
transaction.

Average <column> The average number of transaction runs for all subunits 
of time for each transaction.

Average <row> The average number of transaction runs for all the 
transactions for each subunit of time.

Transaction Transaction name.
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Business Process Recognition

This chapter describes the Business Process Recognition (BPR) application.

This chapter includes:

Concepts

 ➤  Business Process Recognition Application – Overview on page 521

 ➤  Business Process Recognition Architecture on page 523

Tasks

 ➤  Convert Real User Monitor Data into Business Process Recognition Data 
on page 524

 ➤  Deploy Business Process Recognition and Analyze the Results on page 525

 ➤  Customize Business Process Recognition on page 527

Reference

 ➤  Business Process Recognition User Interface on page 528
Concepts

Business Process Recognition Application – Overview

Use the Business Process Recognition (BPR) application to discover business 
processes that can help you monitor what really matters.

The application uses a Web mining algorithm to discover frequently 
occurring process/transaction patterns in the use of Web applications. Such 
patterns could indicate business processes.
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The Business Process Recognition application is part of the APL (Application 
Performance Lifecycle) package. As part of Application Performance 
Lifecycle it extends the abilities of the Real User Monitor solution. Business 
Process Recognition works on Real User Monitor raw data (session click 
streams kept in the Real User Monitor MySQL database). This data is first 
processed into Business Process Recognition format and then can be used as 
an input to the Business Process Recognition reports applet that discovers 
business processes and other useful information.

Both the administration applet and the reports applet work in the context of 
specific Real User Monitor defined applications.

The user selects to run the discovery on specific pages that are Business 
Critical Pages, on all pages (by giving them a new unique Id), or on both 
types of pages. Business Critical Pages are the pages you configure for an 
application in End User Management Administration. 

You can discover business processes day by day up to a maximum of 40 
days. When you want to run the discovery on additional days above the 
maximum, you must remove the equivalent number of days from the 
planned discovery. Data is accumulated using a scheduled process, around 
midnight on the scheduled day. To configure the maximum number of 
processing days, see “Modify the Maximum Number of Processing Days per 
Application” on page 527.

You can also perform emergency import of data. After the data is gathered 
from the Real User Monitor engine files, the discovery is run on all files that 
include data. One applet is used for configuration and one applet for 
reports. The process may take a while, and can also lower Real User Monitor 
performance during business hours.

On the days you analyze the data, you can tune the discovery as follows:

➤ Specify the minimum session length (minimum number of pages in the 
session)

➤ Remove duplicate pages (automatically refreshed pages for example)

➤ Ignore meaningless pages. For example, if your application pings the server 
regularly, the ping page has no business meaning and can be ignored.
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➤ Include sessions that contain specific pages. For example, if you would like 
to find out why users leave the site after a certain page, filter only sessions 
that include this page, so BPR can find the most common business processes 
which lead to leaving the application though this page.

Before generating the report, you must schedule the import and conversion 
of data from the Real User Monitor. After you generate the report, the 
discovery is run on the imported data. The HPWebAlgorithm.exe process 
(the data mining/analysis process) takes place on the client machine and 
might have an impact on the CPU.

While running, the report is saved in the temporary memory/file, which is 
erased at the end of the session. You can save the report or export it to a 
recipient who can then open the file in the Business Process Recognition 
application.

Business Process Recognition Architecture

The Business Process Recognition process retrieves data from the Real User 
Monitor database at night. The data is then converted to reduce the data 
size.
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Once Real User Monitor sessions are exported into small size format you can 
start to filter/manipulate the data. From this point, you can run the 
algorithm over and over again with no effect on the Real User Monitor 
engine and database. 

You can filter the data by the number of pages in the session. You can 
remove duplicate consecutive pages, ignore pages, include sessions that 
include specific pages, and so on.

Tasks

Convert Real User Monitor Data into Business Process 
Recognition Data

This section describes the processes used to convert the Real User Monitor 
data into Business Process Recognition data.

To convert Real User Monitor data into Business Process Recognition data, 
click Application > Application Performance Lifecycle > Business Process 
Recognition > Business Process Recognition Settings and specify how to 
process Real User Monitor sessions data into Business Process Recognition 
format, and schedule the dates on which to process the data.

Note: Business Process Recognition tasks automatically stop after two hours 
of processing, whether or not they have completed, to avoid placing a heavy 
load on Real User Monitor resources. Tasks stopped before completion are 
marked as successful and are available for analysis, but only contain the Real 
User Monitor traffic up to the time they stopped and not for the entire date 
as configured.

For details, see “Business Process Recognition Settings Page” on page 530.
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Deploy Business Process Recognition and Analyze the 
Results

This task describes how to run the Business Process Recognition tool and 
analyze the resulting data.

This task includes the following steps:

➤ “Set Up Business Process Recognition” on page 525

➤ “Customize Business Process Recognition” on page 526

➤ “Generate and Analyze the Report” on page 526

 1 Set Up Business Process Recognition 
Once Business Process Recognition data is available, create a report by 
clicking Application > Application Performance Lifecycle > Business Process 
Recognition > Business Process Recognition Settings, select the date range, and 
filter the pages on which you want to run the Business Process Recognition 
tool. 

For details, see “Business Process Recognition Tool Page” on page 532.
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 2 Customize Business Process Recognition
You can modify:

➤ the default threshold settings for brownouts. For details, see “Modify the 
Threshold Defaults for Brownouts” on page 527.

➤ the maximum number of exported days for each application. For details, see 
“Modify the Maximum Number of Processing Days per Application” on 
page 527.

➤ the maximum size of the results. For details, see “Modify the Number of 
Business Processes That Can be Displayed in the Main View” on page 527.

 3 Generate and Analyze the Report
Click Business Process Recognition tools, select the application, select the 
report data, and click the Generate button. The applet downloads the 
Business Process Recognition data in the requested time range, filters the 
data to find business processes, and runs the data mining algorithm to find 
the business processes. Use the different filters to tune the data you want to 
display and use the buttons in the report to configure the graph. You can 
then analyze the displayed data.

For details, see “Business Process Recognition Tool Page” on page 532.
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Customize Business Process Recognition

You can customize Business Process Recognition using the following 
options:

 1 Modify the Threshold Defaults for Brownouts
To modify the default threshold settings for brownouts, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Business Process Recognition, and locate the Critical 
threshold, Major threshold, Minor threshold, and Warning threshold 
entries in the Business Process Recognition - Brownout Settings table. 
Modify the value of those thresholds.

 2 Modify the Maximum Number of Processing Days per 
Application
To modify the maximum number of processing days per application, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Business Process Recognition, and locate the 
Maximum export days entry in the Business Process Recognition - 
Parameter Settings table. Modify the value of this entry.

 3 Modify the Number of Business Processes That Can be 
Displayed in the Main View
To modify the number of Business Processes that can be displayed in the 
main view of the Business Process Recognition Tool, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Business Process Recognition, and locate the Maximum results size 
entry in the Business Process Recognition - Parameter Settings table. 
Modify the value of this entry. Default is 100.

Reference
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Business Process Recognition User Interface

This section describes:

 ➤  Advanced Algorithm Setting Dialog Box on page 528

 ➤  Business Process Recognition Settings Page on page 530

 ➤  Business Process Recognition Tool Page on page 532

 ➤  Data Selection Dialog Box on page 541

 ➤  Raw Data Information Page on page 544

 ➤  Select Pages Dialog Box on page 544

 ➤  Unique ID Settings Dialog Box on page 545

Advanced Algorithm Setting Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to specify if you want to find Business 
Processes, by their popularity level, automatically using 
an algorithm or manually.

To Access: Click Advanced Algorithm Settings in the 
Data Selection dialog box.

Important 
Information

The quality of a Business Process is characterized by its 
length (number of pages) and its popularity. The 
popularity is defined by percentage of sessions where 
the sequence of pages that represents the Business 
Process is included. 

GUI Element (A–Z) Description

Business Process 
length

Specify the minimum and maximum number of pages 
in the Business Process.

Business Process 
minimal length

Specify the minimum number of pages in the Business 
Process.
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Business Process 
popularity initial 
level

Select the popularity level that interests you the most.

Manual mode Select to manually set the algorithm parameters.

Popularity level Select the minimum and maximum popularity levels.

Smart mode Select to make the Web mining algorithm run in smart 
mode.

Smart mode automatically runs the algorithm with a 
high popularity level. It then checks the results and 
decides one of the following:

➤ lower the popularity level and run the algorithm 
again

➤ stop the process (when more than 20 results have 
been discovered) and return the results to the user. 
This enables you to display the most popular 
Business Processes. 

You can define the initial popularity level to shorten 
the running time needed for getting the result. For 
example, if you know (from prior runs) that the 
maximum popularity level is 25%, set the default at 
25% and avoid waiting till the smart mode processes 
down to this range.

GUI Element (A–Z) Description
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Business Process Recognition Settings Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to manage the processing task and to 
configure how exactly to process Real User Monitor 
sessions data.

To access: Click Application > Application Performance 
Lifecycle > Business Process Recognition > Business 
Process Recognition Settings

Important 
Information

Limitation: For each application you can process only 
40 days. The current status appears in the upper right 
corner of the month view (for example: 20 out of 40 
export days in use). When reaching the quota of 40 
days, clean some of existing dates to enable defining 
more dates. This value is customizable. For details, see 
“Modify the Maximum Number of Processing Days per 
Application” on page 527.

Included in Tasks “Convert Real User Monitor Data into Business Process 
Recognition Data” on page 524

GUI Element (A–Z) Description

Cancels the processing tasks that were assigned to the 
selected dates.

Clears the processed data that exists for the selected 
dates. This date becomes available for reprocessing.
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Activates the processing tasks immediately.

Note: 

➤ The task processes each date one day at a time. The 
processing task takes time and depends on the 
amount of session click streams for the selected data 
and on the availability of the Real User Monitor 
engine. 

➤ This operation is not recommended for day to day 
use, except for testing or troubleshooting purposes. 
It is recommended, instead, to use the Process 
Selected Date option.

Note: The process may take a while, and can also lower 
Real User Monitor performance during business hours.

Click to schedule a processing task for the dates you 
selected. You can select a range of dates and apply the 
selected schedule for the range.

Note: This operation only schedules a future task for 
the Real User Monitor engine. 

<Legend> The legend describes the meaning of the possible colors 
of the cells in the calendar.

Application Select the Real User Monitor application.

Clear downloaded 
data from local Client 
machine

Select to remove the data downloaded from the Real 
User Monitor server from the local Client machine. 

Clear the option to save the data downloaded from the 
Real User Monitor server on the local Client machine 
after you close the session.

Next Month with 
Data

Click to display the next month, if it includes data. If 
the next month does not include data, the month after 
that is displayed, if it includes data, and so forth.

Previous Month with 
Data

Click to display the previous month, if it includes data. 
If the previous month does not include data, the 
month before that is displayed, if it includes data, and 
so forth.

GUI Element (A–Z) Description
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Business Process Recognition Tool Page

Refresh Updates the calendar view to show when the operation 
started at the time you clicked the button for the 
immediate activation of processing tasks .

UID Setting Click to open the Unique ID Settings dialog box.

Description Helps you discover frequently used processes/
transactions patterns that might represent Business 
Processes. Also generates and displays multiple reports 
that provide data about the discovered Business 
Processes, simultaneously. Each tab on the application 
displays a different business process report.

To access: Click Application > Application Performance 
Lifecycle > Business Process Recognition > Business 
Process Recognition Tool

Important 
Information

➤ You can close a tab (report), print it, save it, rename 
it, and create a new tab.

➤ Only the first 100 Business Processes are displayed.

➤ For more information about the Business Process 
Recognition, see “Business Process Recognition 
Application – Overview” on page 521.

➤ Customization: You can customize the number of 
Business Processes that can be displayed. For details, 
see “Modify the Number of Business Processes That 
Can be Displayed in the Main View” on page 527.

Included in Tasks “Deploy Business Process Recognition and Analyze the 
Results” on page 525

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to create a new Business Process Recognition 
report.

A new tab is created in the page.

Click to open an existing Business Process Recognition 
report. For example, use this option to open a report 
that was sent to you. 

Click to print the report.

Click to save the changes.
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Business Process Recognition Filter Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Tabs> Each discovered business process report is displayed on 
a separate tab. A new tab is created with a default name 
when you click New. Right-click the tab to display the 
following options:

➤ Rename. Opens the Rename dialog box where you 
can change the name of the tab.

➤ Close. Closes the current tab.

➤ Close All Other Tabs. Closes all tabs except the 
current one.

➤ Close All. Closes all the tabs.

➤ New. Creates a new tab.

Applications Select the Real User Monitor application. 

Information about the date and the size of the data 
that was imported when you generated the report is 
displayed on the right of the Applications box. For 
example:

Generate Click to generate a report.

Select Report Data Click to open the Data Selection dialog box where you 
can select the data on which the report is based. For 
details, see “Data Selection Dialog Box” on page 541.
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Results Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description By default, in each tab, the business processes are 
grouped into one presentation layer. Initially, every 
page that appears on several business process appears 
only once on the generated report. 

You can then filter the pages, group or ungroup pages, 
and select buttons to display different aspects of the 
data.

Important 
Information

Using the buttons and options available on this panel, 
you modify how you display the report (without 
changing the actual contents).

You can adjust the business process display so that each 
business process is displayed separately even if it has a 
shared page with other business processes. 

You can also select to display business processes that 
include specific pages. 

You can:

➤ show only business processes with specified pages.

➤ group pages (aggregate business processes to find the 
common paths between them). 

➤ ungroup pages (view each business processes 
separately).

GUI Element (A–Z) Description

Click to return the graph to the original layout. The 
layout displays the percentage of participation of a 
page compared to the total number of sessions of the 
Business Process.

Display the current report raw data information 
(sessions include, average sessions size and more). For 
details, see “Raw Data Information Page” on page 544.
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Select a page and click the button to open the Define 
Page dialog box in the EUM Administration, where you 
can create a Business Critical Page corresponding to the 
selected RUM page. The page is saved in End User 
Management as a Business Critical page. For details, see 
“Define Page Dialog Box” in Using End User 
Management.

Select two or more pages that you defined as Business 
Critical Pages and click the button to open the Define 
Transaction dialog box, where you can create a 
transaction that is saved in End User Management. 

Note: If you select a page that is not defined as a 
Business Critical Page, the transaction creation fails. 

Fit the complete view in the window. If, for example, 
you have enlarged the view in such a way that it does 
not fit in the window, click the button, to shrink the 
graph so that it fits in the window.

To move pages, click the button, select pages and drag 
them to the required location. To curve a link, click the 
button, click the link where you want to give it a curve, 
and drag until you obtain the right curve.

Click the button. A small window opens. Drag the 
rectangle in that window to magnify the 
corresponding area in the main view.

Click the button and click and drag the graph to shift 
the location of the complete graph in the main view.

GUI Element (A–Z) Description
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Click the button, click the graph in the main view, 
move the cursor up to shrink the graph, and move the 
cursor down to enlarge the graph.

Click to toggle the display of the minimum and 
maximum number of flows that include the page.

GUI Element (A–Z) Description
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Click to display the percentage of brown-out for the 
pages (a page is brownout when the incoming traffic is 
larger than the outgoing traffic, for example, the 
incoming traffic is 75% while the outgoing traffic is 
35%).

The colors of the brown-out levels are as follows:

➤ Green. 0%-25% (Normal)

➤ Yellow. 25% - 35% (Minor)

➤ Light olive. 35% - 55% (Warning)

➤ Orange. 55% - 75% (Major) 

➤ Red. 75% - 100% (Critical)

Customization: You can change the threshold values. 
For details, see “Customize Business Process 
Recognition” on page 526.

GUI Element (A–Z) Description
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Toggle to display the diagram with:

➤ Percentage values: 

➤ Accurate values:

Note: The diagram is initially displayed with 
percentage values.

GUI Element (A–Z) Description
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Group by: Select:

➤ Identical linked pages. Superimposes identical pages 
that have links to identical pages and superimposes 
the links.

➤ Identical pages. Creates a separate path for each link 
to a different page or when the percentage of links 
to the same page is different for different Business 
Processes. Similar pages are displayed one under the 
other so you can see each link separately.

➤ Do not group. Shows each Business Process 
individually.

GUI Element (A–Z) Description
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Displayed Business Process Pages Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Data Selection Dialog Box

View Business 
Processes Containing 
Page

Select to open the Select Pages dialog box where you 
can select the pages you want to display. The dialog 
box displays all the pages that are displayed in the 
graph in the Results area.

Description Shows details about all the pages that where discovered 
during the Business Process Recognition process and 
that appear in the graph.

GUI Element (A–Z) Description

Max Popularity Displays the highest number of times the page was 
included in any of the discovered Business Processes.

Min Popularity Displays the least number of times the page was 
included in any of the discovered Business Processes.

Nbr. of Business 
Processes Using the 
Page

The number of discovered Business Processes in which 
this page is included.

Page Name The unique page ID or the name of the page.

Description Enables you to select the data on which the Business 
Process is to be discovered.

To Access: Click Select Report Data in the Business 
Process Recognition Reports page.

Included in Tasks “Convert Real User Monitor Data into Business Process 
Recognition Data” on page 524

GUI Element (A–Z) Description
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Pages Filter Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Sessions Filter Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Ignore selected 
pages

Lists the pages that you selected to filter out in the 
Select Pages dialog box.

Remove consecutive 
duplicate pages

Select to ignore multiple consecutive instances of the 
same page (leave only one instance). For example, if 
the session includes the following sequence of hits: 
login, choose package, choose package, choose package, 
submit, it is reduced to: login, choose package, submit.

Select Pages Click to open the Select Pages dialog box. You can filter 
out pages that are common and that have no impact 
on the business (for example, Welcome page).

GUI Element (A–Z) Description

Include only sessions 
that contain the 
following page

Lists the pages that must be included in the session. For 
example, sessions that include the log out page.

Include only sessions 
that have more than 
<min> or less than 
<max> number of 
pages

Specify the minimum and maximum number of pages 
of the session. Helps you ignore sessions that are too 
short or too long.

By default, those values are 5 and 200.

Select Pages Click to open the Select Pages dialog box.
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Date Filter Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select which date you want to analyze 
(remember that first you have to process them into BPR 
format using the administration applet).

Important 
Information

The colors of the cells in the date table indicates 
whether the date has been selected, there is data 
available for processing at that date, and the current 
date.

GUI Element (A–Z) Description

<Legend> The legend describes the meaning of the possible colors 
of the cells in the calendar.

Advanced algorithm 
setting

Click to open the Advanced Algorithm Setting dialog 
box.

Clear All Click to clear the dates you selected for the month.

Next Month with 
Data

Click to display the next month, if it includes data. If 
the next month does not include data, the month after 
that is displayed, if it includes data, and so forth.

Previous Month with 
Data

Click to display the previous month, if it includes data. 
If the previous month does not include data, the 
month before that is displayed, if it includes data, and 
so forth.

Selected Date 
Summary

Click to display the selected dates. The legend below 
the monthly calendar indicates the selected dates, the 
days that have data assigned to them, and the 
non-selectable data.

View Selected Date Click to display the dates you selected.
543



Chapter 15 • Business Process Recognition
Raw Data Information Page

Select Pages Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays raw data information about the report and 
about the algorithm parameters that were used to run 
the report.

To access: Click the  button in the Business Process 
Recognition Tool Page.

Description Enables you to select the pages that are to be ignored 
when running Business Process Recognition.

To Access: Click Edit in the Pages filter area of the 
Select Report Data dialog box.

GUI Element (A–Z) Description

<arrows> Click the single arrows to select/unselect the selected 
elements. Click the double arrows to select/unselect all 
the elements at a time.

Filter Enter a string to help you filter the list below. 

The string behaves as if it had a star (*) wildcard before 
and a star (*) wildcard after - you do not need to enter 
those characters. 

You can also insert a star (*) wild card in the string. 

Selected pages Select the pages and click the arrows to move the 
selection back to the Unselected pages box.

Unselected pages Lists the available pages. Select them using the filter or 
select the pages and click the arrows to move the 
selection to the Selected pages box.
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Unique ID Settings Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to specify the export method and the URL 
ID setting.

To Access: Click the URL Unique ID Setting button in 
the Business Process Recognition Settings dialog box.

Important 
Information

The first step in analyzing a web application depends 
on the ability to identify its pages. Since the same page 
in a web application probably has different URLs due 
to different session ID, end users, and other 
parameters, it is important to configure how to identify 
the same page across all sessions. To do so, you must 
supply to the Business Process Recognition application 
a simple configuration that helps it to identify pages. 

The unique ID can rely on existing naming methods 
(Business Critical Pages and the meaningful names 
feature).

GUI Element (A–Z) Description

Add/Remove Use to add or remove specific parameters.

Export method Select one of the following:

➤ Use only named hits (Business Critical Pages and 
named pages). To use the business critical pages that 
are defined in End User Management 
Administration and pages to which meaningful 
names were given.

➤ Create unique ID for all hits. To use all pages in the 
click stream and assign a unique Business Process 
Recognition ID to each one of them.

➤ Both. To provide a unique ID to all pages in the click 
stream that do not have a name or are not Business 
Critical Pages. The named pages retain their original 
name.
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Include URI in 
Unique ID

Select to specify which components of the URL are 
used in the generated unique ID. You can select 
whether to include the URI and set of parameters 
(GET/POST) that are to be included in the unique ID.

Parameters Enter the URL parameters. The pages whose URL 
includes those parameters, which should be referred to 
for page identification, are included in the export 
operation.

For example, if the source URL is:
http://micrm.hp.com/callcenter_enu/
start.swe?SWECmd=GotoPageTab&SWEBID=-1&SWEV
iew=All Service Request List 
view&SWEC=2&SWETS=&SWEScreen=Service Request 
Screen&SWEVST=-1&SWEStrCCnt=372&SWECacheId=
1&SWEJFN=top._swe._swejssview.s00

and you enter the SWECmd and SWEView parameters 
to identify this page, the result is: 
SWECmd=GotoPageTab&SWEView=All Service 
Request List view

GUI Element (A–Z) Description
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